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します。本書を参照するうえで、他リソースの情報は無視してください。
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HPSMU ○ ○
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MCSMU ○ ○ ○
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EasyEXPERT ソフトウェア

EasyEXPERT ソフトウェアは、測定の実行および測定結果の解析のために、
Keysight B1500シリーズの本体にインストールされています。
また、外部 PC向け EasyEXPERTを使用することによって、以下の使い方も
可能となります。これによって、計測器本体でのオフライン作業を減らし、

測定の稼働率を上げることができます。

･ Keysight B1500、B2900, 4155、 4156、E5260、または E5270を外部 PCから
制御する（オンライン）

･ テスト定義やテスト セットアップを外部 PCで作成する（オフライン）

･ 測定結果の解析を外部 PCで実施する（オフライン）

外部 PCへのインスタレーション情報、および注意点については、
「EasyEXPERTユーザ・ガイド Vol. 2」を参照してください。

EasyEXPERT
Data server

EasyEXPERT
Data server
Print server

Network Printer

Line Printer

Clean Room Office

To export test record
To import/export test setup
via LAN

The B1500 cannot be controlled via LAN.Note: 

LAN

LAN

LAN

HUB

To control B1500
via GPIB

Keysight B1500



本書の構成

本書は、Keysight Technologies EasyEXPERTのリファレンス情報を記しており、
以下の章で構成されています。EasyEXPERTは Keysight Technologies プレシジョ
ン電流－電圧アナライザ シリーズのシステム・ソフトウェアです。

1. メイン GUI

EasyEXPERTのメイン GUIを説明しています。

2. クラシック・テストの定義

クラシック・テスト設定用 GUIを説明しています。

3. アプリケーション・テストの定義

アプリケーション・テスト定義作成用 GUIを説明しています。

4. 機能の説明

EasyEXPERTの様々な機能と初期設定を説明しています。

5. プログラミング・ツール

組み込み関数とリードアウト関数を説明しています。

「ユーザ・ガイド Vol. 2」は、以下の章で構成されています。

6. リモート・コントロール・インタフェース

7. 外部 PCで EasyEXPERTを使うには

8. ユーティリティ

9. アプリケーション・ライブラリ

10. 困ったときに見てみましょう

11. エラー・メッセージ

A. 付録

NOTE 最新版ファームウェア、ソフトウェア、マニュアル、仕様、サポート情報

を入手するには http://www.keysight.com/find/easyexpertにアクセスしてくださ
い。



NOTE 本ソフトウェアの性能・機能の向上などによって、予告なく記載内容が変

更されることがあります。

本ソフトウェアの実際の画面表示は、本書に掲載された画面表示と異なる

場合があります。
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メイン GUI
Keysight EasyEXPERTソフトウェアのメイン GUIのリファレンス情報を記
しています。

• Start EasyEXPERT

• ユーザ・レベルの設定

• Workspace Configurator

• メイン画面

• Application Test

• Tracer Test

• Quick Test

• Repeat Measurement Setup

• Organize Preset Group

• Calibration

• Configuration

• Switching Matrix Operation Panel

• Standby Channel Definition

• Data Display

• Preview

• Text File Export settings

• Excel Data Export settings

NOTE タッチ スクリーン操作
マウス操作よりもタッチ スクリーン操作を頻繁に行う場合は、メニューの

文字サイズを 14に設定することをお勧めします。

コントロール パネルをオープンして、Appearance and Themes、Displayを選

択します。Display Propertiesダイアログ ボックスがオープンします。
Appearanceタブ、Advancedボタンをクリックします。Advanced Appearance
ダイアログ ボックスがオープンします。ItemをMenu、Fontの Sizeを 14に
設定します。
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メイン GUI
EasyEXPERTを開始するには｢ Start EasyEXPERT (p. 1-4) ｣および｢ Workspace 
Configurator (p. 1-10) ｣を参照してください。
アプリケーション・テストの設定を行うには｢ Application Test (p. 1-56) ｣を参
照してください。

クラシック・テストの設定を行うには｢クラシック・テストの定義 (p. 2-1) ｣
を参照してください。

トレーサ・テストの設定を行うには｢ Tracer Test (p. 1-59) ｣を参照してくださ
い。

クイック・テストの設定を行うには｢ Quick Test (p. 1-79) ｣を参照してくださ
い。

測定を実行するには｢メイン画面 (p. 1-17) ｣を参照してください。
測定データの表示、解析を行うには｢ Data Display (p. 1-123) ｣を参照してくだ
さい。

セルフテストや診断を実施するには｢Configuration (p. 1-98)｣を参照してくだ
さい。

セルフキャリブレーションを実施するには｢ Calibration (p. 1-92) ｣を参照して
ください。

Keysight B2200A/B2201A/E5250Aスイッチング・マトリクスの接続制御を
行うには｢ Switching Matrix Operation Panel (p. 1-119) ｣を参照してください。

スタンバイ機能の設定を行うには｢Standby Channel Definition (p. 1-122)｣を参
照してください。

アプリケーション・テストを定義するには「アプリケーション・テストの

定義 (p. 3-1)」を参照してください。

NOTE 演算精度の向上と互換性

EasyEXPERTリビジョン A.06.20において、内部解析処理が単精度浮動小

数点から倍精度浮動小数点に変更されました。Windows 環境変数

EE_DATA_ANALYSIS_COARSE_RESOLUTIONを設定（値は任意）すると

従来通り単精度で解析を行い、互換性を維持することができます。
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メイン GUI
Start EasyEXPERT
Start EasyEXPERT
Start EasyEXPERTウインドウは、B1500のブート後、または Startメニュー
の Start EasyEXPERTかデスクトップの Start EasyEXPERTアイコンによって
開きます。ただし、オートスタート機能が有効な場合、このウインドウは

開きません。このウインドウには、次のグラフィカル ユーザ インタフェー
スがあります。

Start EasyEXPERT このボタンは EasyEXPERTを起動します。

ただし、パスワードが設定されたユーザ・レベルで EasyEXPERTを Exitし
ていた場合は、パスワードの入力を求められます。「ユーザ・レベルの設定 
(p. 1-7)」を参照してください。

パスワードの入力後、再度、Start EasyEXPERTボタンをクリックすると、
EasyEXPERTが起動します。

File メニュー Exit Start EasyEXPERTウインドウを閉じます。

Options メニュー Execution Mode... 外部 PCで実行時に有効。EasyEXPERTの実行
モードを選択する Execution Modeダイアログ 
ボックスを開きます。詳細は「Execution Mode
ダイアログ ボックス (p. 1-6)」を参照してくだ
さい。

Auto Start of EasyEXPERT B1500本体に有効。オートスタート機能をオ
ン、オフします。

このラベルをチェックすると機能がオンしま

す。次回のブートまたはログオンから Start 
EasyEXPERTウインドウがスキップされて

EasyEXPERTが自動起動します。この機能をオ

フするには、EasyEXPERTメイン画面の File > 
Exitメニューで開かれる Start EasyEXPERTウイ
ンドウを使用します。
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EasyEXPERT Database 次の機能を提供します。

• Backup EasyEXPERT Database

EasyEXPERTデータベースのバックアップ
に使用する EasyEXPERT Database Backup 
Creationウィザードを開きます。ウィザード

を用いて簡単にバックアップの作成が行え

ます。

• Restore EasyEXPERT Database

EasyEXPERTデータベース・バックアップ
のリストアに使用するEasyEXPERT Database 
Restorationウィザードを開きます。ウィザー

ドを用いて簡単にバックアップのリストア

が行えます。

• Move EasyEXPERT Database
外部 PCで実行時に有効。EasyEXPERTデー
タベースの移動に使用する EasyEXPERT 
Databaseダイアログ ボックスを開きます。

データベースの移動先となるフォルダ名を

Move Toフィールドに入力します。
（例：C:\EasyEXPERT_user_1\database）

 EasyEXPERTデータベースは、セットアップ 
データなどを格納するフォルダです。また、動

作の所要時間はデータベースの大きさに依存し

ます。

User Level... ユーザ・レベルを選択するためのダイアログ 
ボックスが開きます。ユーザ・レベルの選択を

行い、必要ならばパスワードを入力し OKをク
リックします。「ユーザ・レベルの設定 (p. 1-7)」
を参照してください。
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Execution Mode ダイアログ ボックス

Execution Modeダイアログ ボックスには、次のグラフィカル ユーザ インタ
フェースがあります。 

Online オンライン実行モード（Onlineモード）に設定します。次の設定フィール

ドが有効となります。

VISA interface ID コンピュータに装着されている GPIBインタフェースの
VISA interface ID値を設定します。

GPIB address 測定器（B1500A、B1505A、またはその他のサポートさ

れているモデル）の GPIBアドレス 0 ～ 30を設定しま
す。 

Offline オフライン実行モード（Offlineモード）に設定します。また EasyEXPERT
が想定する測定器の設定を行います。

Model 選択肢（B1500A、B1505Aなど、測定器のモデル番号に

相当する文字列）の中からひとつを選択します。

Config... このボタンをクリックすると EasyEXPERT のオフライン
実行時の B1500 または E5270B 構成を設定するための
Offline Configuration Toolユーティリティを起動します。

Offline Configuration Toolについての詳細は「Keysight 
EasyEXPERT ユーザ・ガイド Vol.2」を参照してくださ
い。

NOTE @ANALYZER関数
この関数はModelの現在の設定を返します。アプリケーション・テスト定

義の中で使用可能です。以下のように文字列変数（例：String1）を用いて、
戻り値（B1500A、B1505Aなど、測定器のモデル番号に相当する文字列）
を読み取ることができます。

例：String1=@ANALYZER
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ユーザ・レベルの設定

EasyEXPERTソフトウェアは、Windowsユーザ・アカウント毎にユーザ・

レベルを設定することで、使用可能な機能を制限することができます。

この機能は、予期せぬ削除や上書きなどからテストセットアップを保護す

るのに有用です。

以下に各ユーザ・レベルとその制限される機能を示します。

NOTE パスワードの設定がされていない場合は、すべてのユーザは Administrator
とみなされます。

ユーザ・レベル 制限される機能

Administrator ありません。

Engineer Administratorのパスワードを設定すること。
パスワードで保護されている項目をパスワード

無しで開くこと。

Operator Administrator/Engineerのパスワードを設定するこ
と。

テスト定義、パラメータ、およびMy Favorites
セットアップを保存すること。
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User Level Configuration
このダイアログ ボックスは、メイン画面で Tools > User Level > Config...を
クリックすることによって開き、Windowsアカウントに対して

EasyEXPERTユーザ・レベルを設定できます。

Close ダイアログ ボックスを閉じます。

Administrator’s 
Password Status

Administratorのパスワードの設定状況を示します。

Engineer’s 
Password Status

Engineerのパスワードの設定状況を示します。

Clear 設定されているパスワードを削除します。

Set... パスワードを設定する Change Passwordダイアログ ボックスを開きます。

Windows Account 
Name

ユーザ・レベルが設定されているWindowsアカウント名。

User Level Windowsアカウントに設定されているユーザ・レベル

Add... Windowsアカウントにユーザ・レベルを設定する Add User Accountダイア
ログ ボックスを開きます。

Delete 選択しているユーザ・レベルの設定を削除します。
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Change Password
このダイアログ ボックスは、User Level Configurationダイアログ ボックス
で Set...をクリックすることによって開き、EasyEXPERTの各ユーザ・レベ
ルのパスワードを設定することができます。

OK 現在の設定を定義・記憶し、ダイアログ ボックスを閉じます。

Cancel 現在の設定を破棄し、ダイアログ ボックスを閉じます。

New Password: 新しく設定するパスワードを入力します。

Retype New 
Password

確認のため新しく設定するパスワードをもう一度入力します。

Add User Account
このダイアログ ボックスは、User Level Configurationダイアログ ボックス
で Add...をクリックすることによって開き、Windowsアカウントに

EasyEXPERTユーザ・レベルを設定することができます。

OK 現在の設定を定義・記憶し、ダイアログ ボックスを閉じます。

Cancel 現在の設定を破棄し、ダイアログ ボックスを閉じます。

Windows Account: EasyEXPERTユーザ・レベルを設定するWindowsアカウントを選択しま

す。

User level: 設定するユーザ・レベルを選択します。
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Workspace Configurator
ワークスペースとは、EasyEXPERTによりソリッドステートドライブ 
(SSD)上に作成されるデータ領域で、テスト セットアップやテスト データ
などの保存に使用されます。ユーザ毎にワークスペースを作成することも

可能です。Workspace configuratorは Keysight EasyEXPERTの起動後に実行

され、ワークスペースの作成・選択に使用されます。 表示画面は、既存

ワークスペースの数によって異なります。

• ワークスペースが存在しない場合

• ワークスペースが 1つだけ存在する場合

• 複数のワークスペースが存在する場合
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ワークスペースが存在しない場合

ワークスペース（Name: Initial Workspace、Scope: Private、Owner:Windows
ログイン・アカウント）が自動的に作成され、EasyEXPERTメイン画面が
表示されます。
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ワークスペースが 1 つだけ存在する場合

ワークスペースを作成するかどうかを尋ねる画面が表示されます。 メッ
セージに対して、Yes、Noどちらかを選択し OKをクリックします。

• OKボタン

指定されたワークスペースを用いて EasyEXPERTメイン画面を開きま

す。

• Work on the same setups and data next time.

このチェックボックスをチェックしておくと、次回起動時にワークス

ペース選択画面がスキップされます。EasyEXPERTは最終実行時に使用
されたワークスペースを用いて起動されます。再度、この設定を行うに

は EasyEXPERTメイン画面の File > Close Workspaceメニューをクリッ
クします。

• Yes, I want to continue working on the previous setups and data

既存ワークスペースを使用する場合は、このボタンを選択します。

OKボタンを選択すると、メイン画面が開きます。
1-12 Keysight EasyEXPERT ユーザ・ガイド Vol. 1、第 5版



メイン GUI
Workspace Configurator
• No, I want to start a new session

ワークスペースを作成する場合は、このボタンを選択します。選択する

と、OKボタンのラベルが Nextに変わります。

Nextボタンを選択すると、ワークスペース名の設定に使用する、次の

入力フィールドが表示されます。

• 新規ワークスペース名の入力フィールド

• 既存ワークスペース名の入力フィールド

既存ワークスペースの名称を変更する場合に使用します。この

フィールドは、そのワークスペースの所有者だけに有効です。

Public（全ユーザ用）ワークスペースを作成する場合は Allow other users 
to access this workspaceボックスをチェックします。

OKボタンを選択すると、ワークスペースの作成またはワークスペース

名の変更が行われます。そしてメイン画面が開きます。

Prevボタンを選択すると、ワークスペースの作成がキャンセルされ、前

ステップのメッセージが表示されます。
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• No, I want to manage Workspaces

ワークスペースの管理を行う場合は、このボタンを選択します。選択す

ると、OKボタンのラベルが Nextに変わります。

Nextボタンを選択すると、表示内容が「複数のワークスペースが存在

する場合」の表示に変わります。

複数のワークスペースが存在する場合

次の例に示す画面が表示されます。

• Continue

指定されたワークスペースを用いて EasyEXPERTメイン画面を開きま

す。

• Choose the same Workspace in the next time

このチェックボックスをチェックしておくと、次回起動時にワークス

ペース選択画面がスキップされます。EasyEXPERTは最終実行時に使用
されたワークスペースを用いて起動されます。再度、この設定を行うに

は EasyEXPERTメイン画面の File > Close Workspaceメニューをクリッ
クします。
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• Create a new Workspace

新しいワークスペースを作成する場合は、このボタンを選択します。

Workspace Nameフィールドにワークスペースの名前を入力します。

Public（全ユーザ用）ワークスペースを作成する場合は Allow other users 
to access this workspace ボックスをチェックします。

Includes Application Test Libraryがチェックされているとアプリケーショ
ン テスト ライブラリもロードされます。

• Open an existing Workspace

• Your workspaces

自分のワークスペースを開きたい場合は、このボタンを選択します。 

名前を選択して、開くワークスペースを指定します。

• Name: ワークスペース名

• Scope: Private （所有者専用）または Public（全ユーザ用）

Manage Workspacesボタンを選択するとWorkspace Managerが開きま

す。 ワークスペースの管理に使用する、以下のボタンを利用できま
す。ワークスペース名を選択し、目的のボタンをクリックします。

• Delete: 選択されたワークスペースを削除します。

• Rename: 選択されたワークスペースの名前を変更します。

• Duplicate: 選択されたワークスペースをコピーします。

• Password: パスワードを設定するダイアログ ボックスを開きます。

• Public: 選択されたワークスペースを Public（全ユーザ用）に変更

します。

• Import: ワークスペースのインポートに使用するダイアログ ボッ
クスを開きます。

• Export: 選択されたワークスペースのエクスポートに使用するダ

イアログ ボックスを開きます。ワークスペースは、拡張子 xws
のファイルとしてエクスポートされます。

• Close: Workspace Managerを閉じます。
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• Public Workspaces owned by other users

他のユーザが作成した Publicワークスペースを開く場合は、このボ

タンを選択します。 名前を選択して、開くワークスペースを指定し
ます。

• Name: ワークスペース名

• Owner: ワークスペースの所有者

NOTE Privateワークスペース

Privateワークスペースは、その所有者のユーザ・アカウントよって保護さ

れます。所有者以外のユーザ・アカウントが Privateワークスペースを開く

ことはできません。

所有者のユーザ・アカウント :<ドメイン名 >\<ユーザ名 >

例 : B1500A-12345678\Keysight B1500 User

ドメインに参加しないでローカル・コンピュータにログインする場合の

<ドメイン名 >は、コンピュータ名となります。

NOTE ユーザ・アカウントを変更する場合

ドメイン名、コンピュータ名、あるいはユーザ名の変更が必要な場合は、

変更を行う前に、EasyEXPERTデータベース内すべてのワークスペースの

Scopeを Publicに変更してください。

新しいユーザ・アカウントでは、以前のユーザ・アカウントで作成された

Privateワークスペースを開くことはできません。

また、Scopeを Publicに変更後、ユーザ・アカウントの変更を行う前に、

EasyEXPERTデータベースのバックアップを行うことをお勧めします。
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メイン画面
Workspace configuratorを用いてワークスペースを指定する、または作成す

ると EasyEXPERTメイン画面が表示されます。このセクションではメイン
画面の機能を説明します。

• メイン画面の GUI
• Run Options

• Data Display Manager

• Test Result Editor

• Test Results Data Filter

• Export in My Format

• Test Results Data Folder Export

• Test Results Data Auto Export

• Test Result Manager

• Preference

• Global Variables
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メイン画面の GUI
ここでは EasyEXPERTメイン画面のグラフィカル ユーザ インタフェース
を説明します。

File メニュー 次の機能を提供します。

メニュー 説明

New Test Definition... Test Definitionウインドウを開

きます。

Open Test Definition... 編集するテスト セットアップ
を指定して、Test Definitionウ
インドウを開きます。

Import Test Setup... インポートするテスト セット
アップを指定するためのダイ

アログ ボックスを開きます。

Test Definition... インポートするテスト定義を

指定するためのダイアログ 
ボックスを開きます。

My Favorite... 現在のMy Favoriteグループ
（プリセット グループ）にイン
ポートするテスト セットアッ
プを指定するためのダイアロ

グ ボックスを開きます。

My Favorite Group... インポートするプリセット グ
ループを指定するためのダイ

アログ ボックスを開きます。

Import Test Result... インポートするテスト結果

データを指定するためのダイ

アログ ボックスを開きます。
1-18 Keysight EasyEXPERT ユーザ・ガイド Vol. 1、第 5版



メイン GUI
メイン画面
Export Test Setup... 現在のテスト セットアップを
エクスポートするファイルを

指定するためのダイアログ 
ボックスを開きます。

Test Definition... Library 領域で選択しているテ

スト定義をエクスポートする

ためのダイアログ ボックスを
開きます。

Save Data As... (Tracer Testのみ）
ファイル名を指定してテスト

結果をセーブするための Save 
Dataダイアログ ボックスを開

きます。

データフォーマットは、Text、
XMLスプレッドシート、CSV、
BMP、EMF、GIF、PNGが指

定できます。

My Favorite... My Favorite 領域で選択されて

いるテスト セットアップをエ
クスポートするためのダイア

ログ ボックスを開きます。

My Favorite Group... 現在のプリセット グループを
エクスポートするためのダイ

アログ ボックスを開きます。

メニュー 説明
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Export Data As Test Result... Test Result Exportダイアログ 
ボックスを開きます。Results
領域で選択されているテスト 
レコードを EasyEXPERTデー
タ形式でエクスポートします。

As Compressed Test 
Result...

Compressed Test Result Export
ダイアログ ボックスを開きま

す。Results 領域で選択されて

いるテスト レコードを
Compressed EasyEXPERTデー
タ形式でエクスポートします。

As Text File... Text File Exportダイアログ ボッ
クスを開きます。Results 領域

で選択されているテスト レ

コードを Text File Export 
settings (p. 1-156)ダイアログ 
ボックスに設定されたスタイ

ルでエクスポートします。

As CSV... CSV File Exportダイアログ 
ボックスを開きます。Results
領域で選択されているテスト 

レコードを CSVデータ形式で

エクスポートします。

As XML Spread 
Sheet...

XML Style Sheet Exportダイア
ログ ボックスを開きます。 
Results 領域で選択されている

テスト レコードを XMLスプ
レッドシート形式でエクス

ポートします

メニュー 説明
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Export Data In My Format... Export in My Format (p. 1-43)ダ
イアログ ボックスを開きます。

ダイアログ ボックスに指定さ

れる XSLTフィルタを用いて、
Results 領域で選択されている

テスト レコードのスタイルを
変更しエクスポートします。

Data to Folder... Test Results Data Folder Export 
(p. 1-43)ダイアログ ボックス
を開きます。複数のテスト レ
コードを指定フォルダにエク

スポートします。

Data Export 
Options

Text File 
Export...

Text File Export settings (p. 
1-156)ダイアログ ボックスを
開きます。As Text Fileメ
ニューでエクスポートされる

テスト レコードのスタイルを
定義します。

Auto 
Export...

Test Results Data Auto Export (p. 
1-45)ダイアログ ボックスを開

きます。自動データ エクス
ポート機能、自動データ保存

機能の設定を行います。

Excel 
Export...

Excel Data Export settings (p. 
1-161)ダイアログ ボックスを
開きます。Export to Excel でエ
クスポートされるテスト レ
コードのスタイルを定義しま

す。

Favorites Save 現在のテスト セットアップを、
現在のプリセット グループに、
新しいテスト セットアップと
して保存します。

メニュー 説明
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Favorites Recall 選択したテスト セットアップ
をリコールします。これに

よって、選択されたテスト 
セットアップの測定条件が表

示されます。

Rename 選択したテスト セットアップ
の名前を変更します。

Duplicate 選択したテスト セットアップ
のコピーを作成します。

Delete 選択したテスト セットアップ
を現在のプリセット グループ
から削除します。

Group New... 新しいプリセット グループを
指定した名前で作成します

Rename... 開いているプリセット グルー
プの名前を変更します。

Duplicate... 開いているプリセット グルー
プのコピーを指定した名前で

作成します。

Delete 開いているプリセット グルー
プを削除することができます。

Organize... Organize Preset Group (p. 1-90)
ダイアログ ボックスを開きま

す。プリセット グループの整

理に使用します。

Close Workspace ワークスペースを閉じ、

Workspace configuratorの画面
に戻ります。

Exit EasyEXPERTソフトウェアを
終了します。

メニュー 説明
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Edit メニュー 次の機能を提供します。

メニュー 説明

Cut 選択した文字列を削除し内容をクリップボードにコ

ピーします。

Copy 選択した文字列をクリップボードにコピーします。

Paste クリップボードの内容を挿入します。

Rename 選択した名前を変更します。

Delete 選択部分を削除します。

Select テスト定義やテスト項目の選択を行います。

Select All アクティブなリスト領域内の全アイテムを選択します。

Unselect All アクティブなリスト領域内の全アイテムの選択を解除

します。

Extended 
Setup...

拡張パラメータ入力フィールドを表示する Extended 
Setupダイアログ ボックスを開きます。このダイアログ 
ボックスに表示されるパラメータについては、｢ Ext (p. 
3-6) ｣を参照してください。

Flag Remarks... Test Result Editor (p. 1-41) ダイアログ ボックスを開きま

す。テスト レコードにフラグや文字列を設定すること
ができます。
Keysight EasyEXPERT ユーザ・ガイド Vol. 1、第 5版 1-23



メイン GUI
メイン画面
View メニュー 次の機能を提供します。

メニュー 説明

Test Application Test EasyEXPERTのアプリケーション・テスト・
モードを選択します。 このモードのグラフィカ

ル ユーザ インタフェースについては
｢ Application Test (p. 1-56) ｣を参照してください。

Classic Test EasyEXPERTのクラシック・テスト・モードを
選択します。 このモードのグラフィカル ユーザ 
インタフェースについては ｢クラシック・テス
トの定義 (p. 2-1) ｣を参照してください。

Tracer Test EasyEXPERTのトレーサ・テスト・モードを選

択します。 このモードのグラフィカル ユーザ イ
ンタフェースについては｢Tracer Test (p. 1-59) ｣を
参照してください。

Quick Test EasyEXPERTのクイック・テスト・モードを選

択します。 このモードのグラフィカル ユーザ イ
ンタフェースについては ｢Quick Test (p. 1-79)｣を
参照してください。

Data Display テスト結果データの表示に使用するData Display 
(p. 1-123)を開きます。
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Run メニュー 次の機能を提供します。

メニュー 説明

Single シングル測定を開始します。 

Append 重ね書き測定を開始します。測定結果は、前回の測定結果を

表示している Data Displayウインドウに重ね書きされます。

Data Displayウインドウは最大 10 個の測定結果用表示層を持

つことができます

Repeat 自動データ保存機能（Auto Recordと Auto Export）の設定状
態によって、次のように異なる動作を行います。データ保存

機能の状態については「Run Options (p. 1-38)」を参照してく
ださい。

Auto Recordと Auto Exportが OFFの場合、繰り返し測定が開

始されます。

Auto Recordまたは Auto Exportが ONの場合、Repeat 
Measurement Setup (p. 1-81)ダイアログ ボックスが開かれま

す。このダイアログ ボックスは繰り返し測定の条件設定に使

用されます。

Stop 実行中の測定を中止します。

Recall 選択されたテスト セットアップをリコールします。これに
よって、選択されたテスト セットアップの測定条件が表示さ

れます。

Options... Run Options (p. 1-38)ダイアログ ボックスを開きます。自動

データ保存機能（Auto Recordと Auto Export）とMulti 
Display機能の設定をすることができます。
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Tools メニュー 次の機能を提供します。

メニュー 説明

Preference... Preferenceダイアログ ボックスを開き、メ

イン、Data Display、Test Definitionウイン
ドウの GUI表示のデフォルト設定を行い

ます。詳細は Preference (p. 1-49)を参照し
てください。

Data Display... Data Display Window Managerダイアログ 
ボックスを開きます。詳細は Data Display 
Manager (p. 1-39)を参照してください。

Test Result... Test Result Managerダイアログ ボックスを
開きます。詳細は Test Result Manager (p. 
1-48)を参照してください。

System Configuration... モジュール構成の表示、セルフテスト結

果の表示、セルフテストの実行、Keysight 
B2200A/B2201A/E5250Aスイッチング・
マトリクスとの GPIB接続の構築、イベン

ト ログの表示に使用する Configuration (p. 
1-98) を開きます。

Calibration... セルフキャリブレーション結果の表示、

セルフキャリブレーションの実行、電流

オフセット除去の実行に使用する

Calibration (p. 1-92) を開きます。

Switching 
Matrix...

B1505Aには無効。Keysight 
B2200A/B2201A/E5250Aスイッチング・
マトリクスのコントロールに使用する

Switching Matrix Operation Panel (p. 1-119) 
を開きます。

Standby 
Channel...

スタンバイ・チャネルの定義とスタンバ

イ・モードの設定に使用する Standby 
Channel Definition (p. 1-122)を開きます。
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Global Variables... Global変数を定義するための Global 
Variables (p. 1-54)を開きます。

User Level Configure... EasyEXPERTのユーザ・レベルのパスワー
ドおよびWindowsアカウントとの対応を

設定するためのUser Level Configuration (p. 
1-8)を開きます。

User Level Configurationダイアログ ボック
スが開くまでには時間がかかる場合があ

ります。

Elevate... 現在の EasyEXPERTユーザ・レベルを変
更するためのダイアログ ボックスを開き

ます。

メニュー 説明
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Options メニュー トレーサ テストに有効。

メニュー 説明

Oscilloscope View オシロスコープ・ビューを起動／

終了します。詳細は、

「Oscilloscope View (p. 1-72)」を参
照してください。

Arithmetic Operation Arithmetic Operationエリアの表示
／非表示を切り替えます。また、

そのエリアで定義された演算式を

それぞれ有効・無効に設定しま

す。詳細は、「Arithmetic Operation
エリア (p. 1-77)」を参照してくだ
さい。

Classic Test Conversion トレーサ テストセットアップを
Classic Testでリコールする、また
は Quick Testで実行する場合に、
測定レンジをコンプライアンスレ

ンジに固定するか、オートレンジ

を有効にするかを指定します。

Fixed Measurement Rangeがチェッ
クされていると、コンプライアン

ス・レンジに固定されます。

Data 
Acquisition

All Data テストセットアップの全てのチャ

ネルの測定データを保存します。

Displayed Data トレース表示している測定データ

のみを保存します。

As Default Defaultでの指定に従って測定デー

タを保存します。

Default All Data テストセットアップの全てのチャ

ネルの測定データを保存します。

Displayed 
Data

トレース表示している測定データ

のみを保存します。
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Help メニュー

メニュー 説明

Contents... EasyEXPERT ヘルプ ウインドウを開

きます。

About Selected Test... テスト内容を説明するダイアログ 
ボックスを開きます。

About Workspace... Workspace Propertiesダイアログ ボッ
クスを開き、開いているワークス

ペースの説明を表示します。

Keysight 
on the 
Web

Keysight EasyEXPERT ウェブ ブラウザを起動し、対応する

Keysightのウェブ ページを開きます。Keysight 
B1500ASemiconductor 
Device Analyzer

Keysight B1505A 
Power Device Analyzer 
/ Curve Tracer

Keysight Technologies 
Home Page

Generate Report for Technical 
Support

Keysightがテクニカルサポートする際

に役立つレポートを作成します。

Event Log... Event Logダイアログ ボックスを開

き、EasyEXPERTソフトウェアのイ
ベント ログを表示します。

What’s New in EasyEXPERT... EasyEXPERTの機能の紹介が表示され

ます。

About EasyEXPERT... EasyEXPERTのリビジョン情報等を表

示します。
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Application Test EasyEXPERTのアプリケーション・テスト・モードを選択します。 この

モードのグラフィカル ユーザ インタフェースについては｢ Application Test 
(p. 1-56) ｣を参照してください。

Classic Test EasyEXPERTのクラシック・テスト・モードを選択します。 このモードの

グラフィカル ユーザ インタフェースについては ｢クラシック・テストの定
義 (p. 2-1) ｣を参照してください。

Tracer Test EasyEXPERTのトレーサ・テスト・モードを選択します。 このモードのグ

ラフィカル ユーザ インタフェースについては｢Tracer Test (p. 1-59)｣を参照し
てください。

Quick Test EasyEXPERTのクイック・テスト・モードを選択します。 このモードのグ

ラフィカル ユーザ インタフェースについては ｢ Quick Test (p. 1-79) ｣を参照
してください。

Single シングル測定を開始します。 測定を中止するには、Abortボタンをクリック
します。

Append 重ね書き測定を開始します。測定結果は、前回の測定結果を表示している

Data Displayウインドウに重ね書きされます。Data Displayウインドウは最
大 10 個の測定結果用表示層を持つことができます。測定を中止するには、

Singleボタンの代わりに現れる Stopボタンをクリックします。

Repeat 自動データ保存機能（Auto Recordと Auto Export）の設定状態によって、次
のように異なる動作を行います。データ保存機能の状態については「Run 
Options (p. 1-38)」を参照してください。

Auto Recordと Auto Exportが OFFの場合、繰り返し測定が開始されます。

Auto Recordまたは Auto Exportが ONの場合、Repeat Measurement Setup (p. 
1-81)ダイアログ ボックスが開かれます。このダイアログ ボックスは繰り

返し測定の条件設定に使用されます。

Abort 実行中の測定を中止します。

Save Last Data 自動データ保存機能（Auto Recordと Auto Export）が OFFの状態で測定を
実行すると、Run Optionボタンの右側にこのボタンが現れます。このボタ

ンをクリックすることによって、最新の測定データをテスト結果レコード
に保存することが可能です。
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Device ID テスト レコードに文字列を入力するために使用します。 文字列は、データ
ID、デバイス ID、テスト IDなど何でもかまいません。

測定の実行、テスト セットアップの変更によって、このフィールドの値は
変化しません。 従って、必要なときにユーザが値を変更する必要がありま

す。

Data Display テスト結果データの表示に使用する Data Display (p. 1-123)を開きます。

EasyEXPERTは常に、最後にアクティブにされた Data Displayウインドウ
に対応するテスト セットアップをハンドルします。

Calibration セルフキャリブレーション結果の表示、セルフキャリブレーションの実行、

電流オフセット除去の実行に使用する Calibration (p. 1-92) を開きます。

Configuration モジュール構成の表示、セルフテスト結果の表示、セルフテストの実行、

Keysight B2200A/B2201A/E5250Aスイッチング・マトリクスとの GPIB接続
の構築、イベント ログの表示に使用する Configuration (p. 1-98) を開きます。

Switching Matrix B1505Aには無効。Keysight B2200A/B2201A/E5250Aスイッチング・マトリ
クスのコントロールに使用する Switching Matrix Operation Panel (p. 1-119) を
開きます。

Standby Channel 
Definition

スタンバイ・チャネルの設定に使用する Standby Channel Definition (p. 1-122) 
を開きます。スタンバイ・チャネルは、スタンバイ・モード ONかつ非測

定状態において、指定された出力を続けるチャネルです。

Running Status 測定実行中は緑色に変化し、実行ステータスを示します。

Count 現在開かれているテスト セットアップに対して実行されるシングル測定の
回数を表示します。 Singleと Repeatの両方でトリガされる測定に対して有

効です。 ボタンは Countフィールドを 0に設定します。

My Favorite 作成または変更したテスト セットアップを再利用するには、セットアップ

をMy Favoriteグループ（プリセット グループ）に保存しておきます。
My Favorite Setupボタンは、次の機能を有するメニューを表示します。プ

リセット グループを選択するにはボタン下のフィールドを使用します。

Cancel このメニューを閉じます。
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New... Add Preset Groupダイアログ ボックスを開きま

す。新しいプリセット グループを指定した名前

で作成します。

Rename... Rename Preset Groupダイアログ ボックスを開き

ます。開いているプリセット グループの名前を

変更することができます。

Duplicate... Duplicate Preset Groupダイアログ ボックスを開き

ます。開いているプリセット グループのコピー

を指定した名前で作成します。

Delete 開いているプリセット グループを削除すること

ができます。

Import... Preset Group Importダイアログ ボックスを開きま

す。指定したプリセット グループをインポート
します。

Export... Preset Group Exportダイアログ ボックスを開きま

す。開いているプリセット グループを指定した

名前でエクスポートします。

Organize... Organize Preset Group (p. 1-90)ダイアログ ボック
スを開きます。プリセット グループの整理に使

用します。

Lock... 予期せぬ削除や変更から保護するために、開いて

いるプリセット グループにパスワードを設定ま
たは変更してロックするためのダイアログ ボッ
クスを開きます。

Unlock... パスワードで保護された開いているプリセット 
グループのロックを解除するためにパスワードを

入力するダイアログ ボックスを開きます。

Read Only 開いているプリセット グループへの読取り専用

属性の設定または解除します。

Properties 開いているプリセット グループのファイル情報
を表示します。

テスト セットアップを選択して、右クリックすることにより次の機能を有

するメニューを表示します。

Cancel このメニューを閉じます。

Rename 選択されたテスト セットアップの名前を変更す

ることができます。
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Duplicate 選択されたテスト セットアップのコピーを作成

します。

Delete 選択されたテスト セットアップを削除します。

Delete All 開いているプリセット グループ内の全テスト 
セットアップを削除します。

Import... Favorite Setup Importダイアログ ボックスを開き

ます。指定したテスト セットアップをインポー
トします。

Export... Favorite Setup Exportダイアログ ボックスを開き

ます。選択されたテスト セットアップを指定し

た名前でエクスポートします。

View テスト セットアップのアイコンのサイズを Large 
Iconsまたは Small Iconsから選択します。

Lock... 予期せぬ削除や変更から保護するために、選択さ

れたテスト セットアップにパスワードを設定ま
たは変更してロックするためのダイアログ ボッ
クスを開きます。

Unlock... パスワードで保護されている、選択されたテスト 
セットアップのロックを解除するためにパスワー

ドを入力するダイアログ ボックスを開きます。

Read Only 選択されたテスト セットアップへの読取り専用

属性の設定または解除します。

Properties 選択されたテスト セットアップのファイル情報
を表示します。

Save 現在のテスト セットアップを、現在のプリセット グループに、新しいテス
ト セットアップとして保存します。

Recall 選択されたテスト セットアップをリコールします。これによって、選択さ

れたテスト セットアップの測定条件が表示されます。
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NOTE トレーサ・テスト セットアップを他テストモードでリコールする
トレーサ・テスト セットアップはMulti Channel I/V Sweepテスト セット
アップに変換されてリコールされます。

この変換処理では、VAR1の両方向掃引（Dual Polarity）の設定は無視され
ます。正方向掃引 スタート→ストップの設定は変換されますが、負方向掃

引 -1（スタート→ストップ）の設定は変換されません。

Flag テスト レコードに設定された重要 (!, Important)、有効 (#, Valid)、疑問

(?, Questionable)の各フラグを表示します。最上部のボタンはデータ リスト
を Flagで並べ替えます。 

Resultメニューの Filter > Show Deleted Data (p. 1-36)がチェックされていれ
ば、Deleteグループのテスト レコードもリスト表示されます。Deleteグ
ループのテスト レコードには、Flag列左側の列に * がつけられます。最上
部のボタンはテスト レコードを * で並べ替えます。

Setup Name テスト セットアップ名を表示します。最上部のボタンはテスト レコードを
Setup nameの辞書順で並べ替えます。

Date テスト結果が記録された日付を表示します。最上部のボタンはテスト レ
コードを Dateの時間順で並べ替えます。

Count Countフィールドに示された測定カウントを表示します。最上部のボタン

はテスト レコードを Countの数値順で並べ替えます。

Device ID Device IDフィールドを用いてテスト レコードに設定された文字列を表示し
ます。最上部のボタンはテスト レコードを Device IDの辞書順で並べ替え

ます。

Remarks テスト レコードに設定された注釈を表示します。最上部のボタンはテスト 
レコードを Remarksの辞書順で並べ替えます。

Auto Record OFF このインジケータは、自動データ保存機能（Auto Record）がオフに設定さ
れている時に点灯します。メイン画面下部に配置されています。

Auto Export ON このインジケータは、自動データ エクスポート機能（Auto Export）がオン
に設定されている時に点灯します。メイン画面下部に配置されています。

SMU Zero ON このインジケータは、SMU電流オフセット除去機能がオンに設定されてい

る時に点灯します。メイン画面下部に配置されています。
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Standby ON このインジケータは、スタンバイ・モードがオンに設定されている時に点

灯します。メイン画面下部に配置されています。

Multi Display ON このインジケータは、Multi Display機能がオンに設定されている時に点灯

します。メイン画面下部に配置されています。

Thermometer OFF このインジケータは、温度計が有効である時に点灯します。メイン画面下

部に配置されています。また、“Thermometer OFF”の代わりに以下の情報

を表示します。インジケータをクリックすることで、表示される情報が変

わります。ここで、XXは温度値を示しています。

• T1: XX deg C

温度計チャネル 1で測定された温度。

• T2: XX deg C

温度計チャネル 2で測定された温度。

• dT: XX deg C

温度計チャネル 1と 2で測定された温度の差。

ワークスペース名 Resultsボタン下のフィールドは、現在開かれているワークスペースの名称

を表示します。

Results 次の機能を提供するメニューを表示します。リスト エリアは、テスト レ
コードを表示します。上下矢印ボタンは、このエリアを拡大／縮小します。

Cancel このメニューを閉じます。

Select All すべてのレコードを選択します。

Unselect All すべてのレコードの選択を解除します。

Display Data Data Display (p. 1-123)を開いて、選択状態にある

レコードのテスト結果データを表示します。この

ファンクションを用いて表示できるウインドウの

数は 15 個までです。

Recall 選択されたレコードのテスト セットアップをリ
コールします。
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Filter > Show Deleted 
Data Saveグループと Deleteグループ両方のテスト レ

コードをリストするには、ここをチェックしま

す。グループの設定は「Edit > Flag and Remarks 
(p. 1-36)」で行います。「Test Result Editor (p. 
1-41)」も参照してください。

Filter > Filter... Test Results Data Filter (p. 1-41)ダイアログ ボック
スを開きます。リスト エリア内 テスト レコード
のフィルタリングを行います。

Filter > Expand 
Application Test Results アプリケーション・テストの内部で使用されるテ

ストが作成したテスト レコードをリストするに
は、ここをチェックします。チェックのない状態

でテスト レコードのエクスポートを実行すると、
内部のテストが作成したレコードも同じファイル

に出力されます。ただし、Export As Text Fileでエ
クスポートする場合は、そのアプリケーション・

テストのテスト レコードだけが出力されます。
Filter > Show All Append 
Data 重ね書き測定によって作成された全テスト レ

コードをリストするには、チェックします。

重ね書き測定によって得られたテスト レコード
には A、シングル測定によって得られたテスト 
レコードには Sがついてリスト表示されます。

Edit > Flag and Remarks Test Result Editor (p. 1-41)を開きます。選択され

たテスト レコードを Saveグループまたは Delete
グループに加えます。また、フラグと備考を設定

します。フラグには、重要（！、Important）、
有効（＃、Valid）、
疑問（？、Questionable）が有効です。

Edit > Delete 選択されたテスト レコードを Deleteグループに
加えます。テスト レコードは Filter > Show 
Deleted Data (p. 1-36)がチェックされている場合
にリスト表示されます。

Import... Test Result Importダイアログ ボックスを開きま

す。指定されたテスト レコードをインポートし
ます。

Export 次の機能を提供します。
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Export > As Test Result... Test Result Exportダイアログ ボックスを開きま

す。選択されたテスト レコードを EasyEXPERT
データ形式でエクスポートします。

Export > As Compressed 
Test Result... Compressed Test Result Exportダイアログ ボックス

を開きます。選択されたテスト レコードを
Compressed EasyEXPERTデータ形式でエクスポー

トします。

Export > As Text File... Text File Exportダイアログ ボックスを開きます。

Text File Export settings (p. 1-156)ダイアログ ボッ
クスに設定されたスタイルで、選択されたテスト 
レコードをエクスポートします。

Export > As CSV... CSV File Exportダイアログ ボックスを開きます。

選択されたテスト レコードを CSVデータ形式で

エクスポートします。スプレッドシート ソフト
ウェアを用いて出力データを読むことができま

す。

Export > As XML Spread 
Sheet... XML Style Sheet Exportダイアログ ボックスを開

きます。選択されたテスト レコードを XMLスプ
レッドシート形式でエクスポートします。スプ

レッドシート ソフトウェアを用いて出力データ
を読むことができます。

Export > In My Format... Export in My Format (p. 1-43)ダイアログ ボックス
を開きます。ダイアログ ボックスに指定される

XSLTフィルタを用いて、選択されたテスト レ
コードのスタイルを変更しエクスポートします。

Export to Folder... Test Results Data Folder Export (p. 1-43)ダイアログ 
ボックスを開きます。複数のテスト レコードを
指定フォルダにエクスポートします。

Export Options > Text File 
Export... Text File Export settings (p. 1-156)ダイアログ ボッ

クスを開きます。As Text Fileメニューでエクス
ポートされるテスト レコードのスタイルを定義
します。

Export Options > Auto 
Export... Test Results Data Auto Export (p. 1-45)ダイアログ 

ボックスを開きます。自動データ エクスポート
機能、自動データ保存機能の設定を行います。
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Export Options > Excel 
Export... Excel Data Export settings (p. 1-161)ダイアログ 

ボックスを開きます。Export to Excel でエクス
ポートされるテスト レコードのスタイルを定義
します。

Customize... Test Result Manager (p. 1-48)ダイアログ ボックス
を開きます。リスト エリア内にリスト可能なテ
スト レコードの数、Deleteグループ内のリカバ

リ可能なレコードの数を設定します。

Properties... 選択されたテスト レコードのファイル名、種類、

サイズ、および更新日時を表示するダイアログ 
ボックスを開きます。

Preference... Test Result List Preference ダイアログ ボックスを
開きます。Results エリアに表示される項目を設

定します。Preference (p. 1-49)ダイアログボック
スの Generalグループ -Test Resultsタブページに
よる設定と同じです。

1つ以上のテスト レコードを選択すると、このエリアの右下に Exportボタ
ンが現れます。このボタンをクリックすると、Test Results Data Auto Export 
(p. 1-45)ダイアログボックスの設定に基づいて、データのエクスポートが

行われます。

Run Options
このダイアログ ボックスは Run > Options...をクリックすることによって現

れ、自動データ保存機能（Auto Recordと Auto Export）とMulti Display機
能の設定に使用されます。下記チェックボックスがあります。

• Record Test Result Data Automatically

自動データ保存機能（Auto Recordと Auto Export）の設定を変更します。
この機能には Table 1-1に見られる 4つの状態があります。チェックを
外すと Auto Export=Auto Record=OFFの状態になり、チェックをつける
と元の状態に戻ります。

チェックがついている状態では自動データ保存機能を自由に設定するこ

とができます。但し Auto Export=Auto Record=OFFに設定することはで
きません。設定には Test Results Data Auto Export (p. 1-45)を使用します。

Auto Export=Auto Record=OFFの状態ではデータの自動保存が行われま

せん。この状態で測定を実行すると、Run Optionボタンの右側に Save 
Dataボタンが現れ、このボタンをクリックすることによって、最新の

測定データをテスト レコードに保存することができます。
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自動データ保存機能は、テスト 1 回の実行結果を 1つのテスト レコー
ドに記録します。クラシック・テストの場合、テスト結果 1つが記録さ
れます。アプリケーション・テストの場合、1 回の実行で得られるテス

ト結果すべてが記録されます。ただし、Text Fileタイプによる Auto 
Export（自動データ エクスポート）では、テスト結果毎にファイル出力

が行われます。

Table 1-1 Record Test Result Data Automatically チェックボックスとデータ保存機能

• Show Test Result Editor

チェックがついている状態では、各測定の終了時に Test Result Editor (p. 
1-41)が自動的に起動します。

• Allocate Data Display for each test

Multi Display機能を ON（チェックがついている状態）または OFFに設
定します。この機能は Data Displayウインドウの動作を制御します。
OFF テスト結果データは常に同じ Data Displayウインドウに表示

されます。

ON 同じ名前のテスト セットアップによるテスト結果データは
共通の Data Displayウインドウに、異なる名前のテスト セッ
トアップによるデータは新しい Data Displayウインドウに表
示されます。

Data Display Manager
このダイアログ ボックスは、Tools > Data Display...をクリックすることに
よって現れ、Data Displayウインドウの外観の設定に用いられます。このダ

イアログ ボックスには次の 3つのボタンがあります。

OK セットアップの変更を適用し、このダイアログ ボックス
を閉じます。

Cancel セットアップの変更をキャンセルし、このダイアログ 
ボックスを閉じます。

チェックがついている状態 チェックが外された状態

Auto Export Auto Record Auto Export Auto Record

ON OFF OFF OFF

ON ON

OFF ON
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Apply セットアップの変更を適用します。

Data Display 
Window Order

開かれている Data Displayウインドウの Setup nameがリストされます。エ
リア内の上から下にかけてリストされている項目は、それぞれ画面上の手

前から奥に置かれているウインドウに対応します。このエリアでは次のボ
タンが有効です。項目を選択するには、リスト内の項目をクリックします。

Up 選択された項目を上に移動します。

Down 選択された項目を下に移動します。

Select All すべての項目を選択します。

Minimize 選択された項目に対応するウインドウを最小化します。

リスト項目はMinimized Data Displaysエリアに移動しま

す。

Close 選択された項目に対応するウインドウを閉じます。

Minimized Data 
Displays

最小化された Data Displayウインドウの Setup nameがリストされます。こ
のエリアでは次のボタンが有効です。 項目を選択するには、リスト内の項
目をクリックします。

Select All すべての項目を選択します。

Restore 選択された項目に対応するウインドウを復元します。

Close 選択された項目に対応するウインドウを閉じます。

Data Display 
Window 
Configuration

次のラジオ ボタンとチェックボックスがあり、Data Displayウインドウの
外観を変更するために使用します。 すべての機能は開いているウインドウ
に対して有効です。

Keep Setup Data Displayウインドウの現在の構成を維持します。

Tiling Data Displayウインドウを画面上に並べて表示します。

Stacking Data Displayウインドウを画面上に重ねて表示します。

Overlaying すべての Data Displayウインドウを画面上に重ね合わせ

て表示します。いちばん手前の Data Displayウインドウ
の位置、サイズ、表示状態が、すべての Data Displayウ
インドウに適用されます。いちばん奥のウインドウ以外
の X-Y Graph 背景はクリアされます。

Apply same scale 
to all graph

すべてのグラフに同じグラフ スケールを適用するには、このチェックボッ

クスをチェックします。
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Test Result Editor
Test Result Editorは、測定終了時、あるいは Results > Edit > Flag & Remarks
をクリックすることによって現れます。対応するテスト レコードにフラグ
や文字列を設定することができます。Test Result Editorには、次の GUIが
あります。

Save, Delete テスト レコードを Saveまたは Deleteにグループ分けします。

Saveグループのテスト レコードは、EasyEXPERTメイン画面下方に常にリ

スト表示されます。

Deleteグループのテスト レコードは、Results > Filter > Show Deleted Dataが
チェックされている場合にリスト表示されます。

Flags 次のボタンが有効です。テスト レコードに下記フラグのどれか１つをつけ

ることができます。

• Important !ボタン

テスト レコードに重要フラグ（！）を設定します。

• Valid #ボタン

テスト レコードに有効フラグ（＃）を設定します。

• Questionable ?ボタン

テスト レコードに疑問フラグ（？）を設定します。

Remarks テスト レコードの Remarksに入力される文字列を設定します。

OK Test Result Editor上の設定を確定し、ダイアログ ボックスを閉じます。

Test Results Data Filter
このダイアログ ボックスは Results > Filter > Filter...をクリックすることに
よって現れ、EasyEXPERTメイン画面下方にリスト表示されるテスト レ
コードを限定するために使用されます。

以下の設定によりフィルタの手順を作成することができます。

Add 新規フィルタ条件を追加します。

Delete 現在選択されているフィルタ条件を削除します。

Up 現在選択されているフィルタ条件を上に移動します。
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Down 現在選択されているフィルタ条件を下に移動します。

ラジオ ボタン Delete/Up/Downの対象フィルタ条件を選択します。フィルタ条件行の左端

にあります。

And/Or 複数のフィルタ条件を設定する場合に複合条件（Andまたは Or）を選択し

ます。

Object 1行目には、フィルタ対象のテストレコード（Data records）が表示されま
す。2行目以降では、使用するフィルタの種類（Flag、Setup Name、Date 
(From/To)、Count、Device ID、または Remarks）を選択します。

Condition 1行目では、対象テストレコードの所属グループ（Save-group、
Delete-group、または ALL）を選択します。

2行目以降では、使用するフィルタに必要な情報を選択または入力します。

Objectで選択されたフィルタの種類に依存して設定フィールドが変わりま

す。

Group 複数のフィルタ条件を設定する場合にフィルタ条件をグループ化するため

に選択します。複数のフィルタ条件をまとめて、1セットのフィルタ条件

として扱うことができます。

OK リスト表示されるテストレコードのフィルタリングを実行し、ダイアログ

ボックスを閉じます。

Cancel 実行をキャンセルし、ダイアログボックスを閉じます。

Apply リスト表示されるテストレコードのフィルタリングを実行します。

Legacy Mode このチェックボタンが選択されるとダイアログの表示内容が以下のように

変わります。

Data records in 
Save-group

Saveグループのテスト レコードをリスト表示するには、このチェックボッ
クスをチェックします。

Data records in 
Delete-group

Deleteグループのテスト レコードをリスト表示するには、このチェック
ボックスをチェックします。

Flag 特定するフラグがついたテスト レコードだけをリスト表示するには、その

フラグを選択または入力します。
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Setup Name 特定するセットアップ名のテスト レコードだけをリスト表示するには、そ

のセットアップ名を選択または入力します。

Date 特定する期間に得られたテスト レコードだけをリスト表示するには、その

期間を from/toフィールドで指定します。

Count 特定するカウント範囲に入っているテスト レコードだけをリスト表示する
には、その範囲を指定します。

Device ID 特定する Device IDのテスト レコードだけをリスト表示するには、その

Device IDを選択または入力します。

Remarks 特定する Remark値のテスト レコードだけをリスト表示するには、その

Remark値を入力します。

OK リスト表示されるテスト レコードのフィルタリングを実行し、ダイアログ 
ボックスを閉じます。

Cancel 実行をキャンセルし、ダイアログ ボックスを閉じます。

Export in My Format
このダイアログ ボックスは Results > Export > In My Format...をクリックす
ることによって現れます。XSLTフィルタを用いたスタイル変更を施すこ
とによってテスト レコードをエクスポートします。

My Format スタイル変更に使用する XSLTフィルタ（XMLスタイル・シート）をフル
パスで指定します。Browse...ボタンは、ファイルの選択に使用可能な

Select XML Style Sheet Fileダイアログ ボックスを開きます。

Export As... Export As...ダイアログ ボックスを開きます。ファイル名とファイル・タイ

プを指定して、　テスト レコードをエクスポートします。

Cancel 実行をキャンセルし、ダイアログ ボックスを閉じます。

Test Results Data Folder Export
このダイアログ ボックスは、テスト結果レコードを選択してから、Results 
> Export to Folder...をクリックすることによって現れます。
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この機能は、複数のテスト レコードをエクスポートするために使用されま
す。対象となるテスト レコード、エクスポート先フォルダの名前、ファイ

ル名のスタイルとファイル タイプ、を指定することによって、複数のテス

ト レコードを指定フォルダにエクスポートすることができます。

Destination for 
Export

エクスポート先のフォルダを選択します。Browse...ボタンは、フォルダの

選択に用いる Browse For Folderダイアログ ボックスを開きます。

File Name エクスポートされるテストレコードのファイル名のスタイルを指定します。

ファイル名は、メイン画面で設定される Setup Name、Device ID、Count、
Dateの値を用いて自動生成されます。それらの値にファイル名として使用

できない文字が存在する場合、その文字は自動的に _と置き換えられます。

• Default Formatに設定すると、次のスタイルでファイル名が自動生成さ

れます。ここでは拡張子は省略されています。

Flag SetupName [DeviceID(Count) _Remarks_; Date]
例： # Id-Vd [cmos1(1) _ok_; 1_22_2006 3_44_55 PM]

• Custom Formatに設定すると、File Name Formatダイアログ ボックスで
設定したスタイルでファイル名が自動生成されます。

File Name Formatダイアログ ボックスは Settings...ボタンをクリックす
ることで開きます。ダイアログ ボックスの Formatフィールドに希望す

るスタイルを入力します。例えば、次の入力例では、Default Formatと
同じスタイルになります。

例： {4} {0} [{3}({2}) {5}; {1}]
{0}:セットアップ名 (SetupName)

{1}:時間 (Date, mm_dd_yyyy hh_mm_ss AM/PM)

{2}: カウント (Count)

{3}:デバイス ID (DeviceID)

{4}:フラグ (Flag)

{5}: 備考 (Remarks)

File Type ファイル タイプ（データ フォーマット）を選択します。

Test Result EasyEXPERTデータ フォーマット

Compressed Test Result Compressed EasyEXPERTデータ フォーマット

CSV CSVフォーマット
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XML Spread Sheet XMLスプレッドシート フォーマット

My Format XSLTフィルタを用いた専用フォーマット。下記 2
設定フィールドが有効となります。

• My Format

テスト レコードのエクスポートに使用する XSLTフィルタ（XMLスタ
イル シート）のファイル名をフル パスで指定します。Browse...ボタン
は、ファイルの選択に使用可能な Select XML Style Sheet Fileダイアログ 
ボックスを開きます。

• File Extension

エクスポートするデータ ファイルの拡張子を入力するか、xml、txt、
csv、xlsから選択します。

Text File Text File Export settings (p. 1-156)ダイアログ ボック
スに設定された専用フォーマット。Settings...ボタ
ンは、このダイアログ ボックスを開きます。

Export フォルダ エクスポートを開始します。エクスポート完了後、このダイアロ

グ ボックスは閉じます。

Cancel フォルダ エクスポートの実行をキャンセルし、ダイアログ ボックスを閉じ

ます。

Test Results Data Auto Export
このダイアログ ボックスは Results > Export Options > Auto Export ...をク
リックすることによって現れ、自動データ保存機能（Auto Recordと Auto 
Export）の設定に使用されます。

NOTE 自動データ保存機能の出力

自動データ保存機能は、テスト 1 回の実行結果を 1つのテスト レコードに
記録します。クラシック・テストの場合、テスト結果 1つが記録されます。
アプリケーション・テストの場合、1 回の実行で得られるテスト結果すべ

てが記録されます。ただし、Text Fileタイプによる Auto Export（自動デー
タ エクスポート）では、テスト結果毎にファイル出力が行われます。

Data Fileタブ
このページの一番上には下記チェックボックスがあります。

• Enable automatic data export to the specified storage device
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このチェックボックスをチェックすることによって Auto Export機能（自動
データ エクスポート）が ONに設定され、以下の GUIが有効になります。

Destination for 
Export

エクスポート先のフォルダを選択します。Browse...ボタンは、フォルダの

選択に用いる Browse For Folderダイアログ ボックスを開きます。

File Name エクスポートされるテストレコードのファイル名のスタイルを指定します。

ファイル名は、メイン画面で設定される Setup Name、Device ID、Count、
Dateの値を用いて自動生成されます。それらの値にファイル名として使用

できない文字が存在する場合、その文字は自動的に _と置き換えられます。

• Default Formatに設定すると、次のスタイルでファイル名が自動生成さ

れます。ここでは拡張子は省略されています。

Flag SetupName [DeviceID(Count) _Remarks_; Date]
例： # Id-Vd [cmos1(1) _ok_; 1_22_2006 3_44_55 PM]

• Custom Formatに設定すると、File Name Formatダイアログ ボックスで
設定したスタイルでファイル名が自動生成されます。

File Name Formatダイアログ ボックスは Settings...ボタンをクリックす
ることで開きます。ダイアログ ボックスの Formatフィールドに希望す

るスタイルを入力します。例えば、次の入力例では、Default Formatと
同じスタイルになります。

例： {4} {0} [{3}({2}) {5}; {1}]
{0}:セットアップ名 (SetupName)

{1}:時間 (Date, mm_dd_yyyy hh_mm_ss AM/PM)

{2}: カウント (Count)

{3}:デバイス ID (DeviceID)

{4}:フラグ (Flag)

{5}: 備考 (Remarks)

File Type ファイル タイプ（データ フォーマット）を選択します。

Test Result EasyEXPERTデータ フォーマット

Compressed Test Result Compressed EasyEXPERTデータ フォーマット

CSV CSVフォーマット

XML Spread Sheet XMLスプレッドシート フォーマット
1-46 Keysight EasyEXPERT ユーザ・ガイド Vol. 1、第 5版



メイン GUI
メイン画面
My Format XSLTフィルタを用いた専用フォーマット。下記 2
設定フィールドが有効となります。

• My Format

テスト レコードのエクスポートに使用する XSLTフィルタ（XMLスタ
イル シート）のファイル名をフル パスで指定します。Browse...ボタン
は、ファイルの選択に使用可能な Select XML Style Sheet Fileダイアログ 
ボックスを開きます。

• File Extension

エクスポートするデータ ファイルの拡張子を入力するか、xml、txt、
csv、xlsから選択します。

Text File Text File Export settings (p. 1-156)ダイアログ ボック
スに設定された専用フォーマット。Settings...ボタ
ンは、このダイアログ ボックスを開きます。

Data Storage Auto Record機能（自動データ保存）を OFFにするには、このチェック
ボックスからチェックを外します。

• Enable automatic data record to the internal storage device

OK 設定を確定し、ダイアログ ボックスを閉じます。

Cancel 設定をキャンセルし、ダイアログ ボックスを閉じます。

Othersタブ

Microsoft Excel Microsoft Excel への自動データ転送 /保存方法を選択します。

• Enable automatic data export to Microsoft Excel

このチェックボックスをチェックすると、Microsoft Excelへの自動デー
タ転送機能が有効になります。

• Enable automatic export in Microsoft Excel format

このチェックボックスをチェックすると、Microsoft Excel 形式での自動

データ保存機能が有効になります。

出力先を Folder Pathフィールドで設定し、ファイル形式を Formatフィール
ドで選択します。

Image File Export このチェックボックスをチェックすると、イメージファイルの自動データ

転送機能が有効になります。
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出力先を Folder Pathフィールドで設定し、ファイル形式を Formatフィール
ドで選択します。

OK 設定を確定し、ダイアログ ボックスを閉じます。

Cancel 設定をキャンセルし、ダイアログ ボックスを閉じます。

Test Result Manager
このダイアログ ボックスは Results > Customize...をクリックすることに
よって現れ、リスト表示可能なテスト レコードの最大数、Deleteグループ
に保管可能なテスト レコードの最大数を設定するために使用されます。

Test Result List 
View

リスト表示可能なテスト レコードの最大数を設定します。

Non-preserved 
data

Deleteグループに保管可能なテスト レコードの最大数を設定します。

Close ダイアログ ボックスを閉じます。
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Preference

このダイアログ ボックスは、Tools > Preferenceメニューを選択することに

より開きます。EasyEXPERTメイン ウインドウのレイアウト、Data Display
の表示、Test Definitionウインドウのレイアウトの初期設定に使用します。

Preference Group Preference Groupで設定を行う対象を以下から選択します。

General メインウインドウの GUIレイアウトの初期設定を行
います。詳細は「General (p. 1-50)」を参照してくだ
さい。

Data Display Data Displayの初期表示設定を行います。詳細は

「Data Display (p. 1-51)」を参照してください。
Test Definition Editor Test Definitionウインドウのレイアウトの初期設定を

行います。詳細は「Test Definition Editor (p. 1-54)」を
参照してください。

Measurement Classic Testセットアップの初期条件を設定します。

詳細は「Measurement (p. 1-54)」を参照してくださ
い。

Reset to Factory 
Default

Preference Groupで選択されている対象の設定を工場出荷時の設定に戻しま

す。
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Reset All to 
Factory Default

すべての設定を工場出荷時の設定に戻します。

OK 変更した設定を反映してダイアログ ボックスを閉じます。

Cancel 変更した設定を無効にします。

Apply 変更した設定を反映します。ダイアログ ボックスは開いたままにします。

General

Legacy (A.05.60 
Compatible)

チェックボックスをチェックすると GUIレイアウトが EasyEXPERTリビ

ジョン A.05.60以前と同様になります。

Window Layout タ
ブ

Sub Window チェックボックスで表示 / 非表示を選択します。チェッ

クされているパネル /ツールバーのみ表示されます。

Panel / Toolbar 説明

Category Categoryパネルの表示／非表示。

Library Libraryパネルの表示／非表示。

Test Results Resultsパネルの表示／非表示。

Run Control Run Controlパネルの表示／非表示。

Administrative Tools & 
Soft Keys

Administrative Tools & Soft Keysパネルの表示／
非表示。

My Favorite My Favoriteパネルの表示／非表示。

Toolbar Toolbarの表示／非表示。

Workspace 
Name

Toolbar上のワークスペース名の表示／非表示。

Run Control Toolbar上のRun Controlボタンの表示／非表示。

Counter Toolbar上の Count 欄の表示／非表示。

DeviceID Toolbar上の Device ID 欄の表示／非表示。
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Test Results タブ Resultsエリアに表示される項目を設定します。

Data Display

Use Present Graph 
Colors

プリセットされた設定またはカスタマイズ設定を選択します。

Standard Standardプリセット設定
Tracer Test Tracer Testプリセット設定
Grayscale Grayscaleプリセット設定
Customized 独自の設定を行う場合に選択します。またはプリセット

設定に変更を行うと自動的に Customizedになります。

Reset to Default デフォルト設定に戻します。デフォルト設定は、Data Displayウインドウの
X-Y Graph Plot 領域または List Display 領域の Preference > Save as Defaultを
クリックすることによって記憶されます。

Color and Style タ

ブ

色と表現方法を選択します。

Administrative 
Tools

Toolbar上のAdministrative Toolsボタンの表示／
非表示。

Input 
Assistance

Toolbar上の入力補助機能ボタンの表示／非表

示。

Running 
Animation

Toolbar上の実行ステータス表示の表示／非表

示。

Panel / Toolbar 説明

Color Style

Background: 背景色の設定 n.a.

Text: テキストの色の設定 n.a.

Grid: グラフ罫線の色の設定 グラフ罫線の実線／破線の設定

Line/Cursor: グラフの線／カーソル

の色の設定

グラフの線／カーソルの実線／

破線の設定
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Graph Trace Color
タブ

グラフにプロットされるデータ トレース Y1から Y8の表示／非表示、色、

プロットのスタイル、線の太さ設定します。

Visible データ トレースの表示／非表示の選択。表示す

る場合はチェックボックスをチェックします。

Color データ トレースの表示色。カラーパターンをを

クリックするとカラーパレットが開き、表示色

の変更ができます。

Style データ トレースの表現スタイル。線またはプ

ロットの形を選択します。

Thickness データ トレースの線の太さ。

VAR2 Label: VAR2ラベルの色の設

定

VAR2ラベルの位置の設定

Adjacent 対象ラインの近傍に

表示されます。

Adjacent, 
Pointing 
Line

対象ラインの近傍に

表示され、指示線も

同時に表示されます。

Adjacent, 
Merge

各対象ラインの近傍

の表示され、位置が

近いラベルはまとめ

て表示されます。

Adjacent, 
Pointing 
Line, 
Merge

各対象ラインの近傍

の表示され位置が近

いラベルはまとめて

表示されます。また

指示線も同時に表示

されます。

Line Up, 
Pointing 
Line

各ラベルは一列に表

示され、指示線も同

時に表示されます。

Color Style
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Change Line Color with 
Append Measurement: Enableをチェックすると Append測定時に線の

表示色がカラー パターンの色に変わります。カ

ラーパターンををクリックするとカラーパレッ

トが開き、表示色の変更ができます。

Format タブ Maximum decades to 
show minor ticks ログ軸上の細かい目盛の表示を可能とするディ

ケード数の最大値を設定します。

Grid Rule (Linear): リニア軸の目盛の本数設定。

Auto 自動設定。

10 Line Fixed 10本固定。

Analytic Values’ Display 
Format: Cursor（カーソル）、Marker（マーカ）、Intercept

（交点）の値の表示桁数、フォーマットを設定しま

す。

Format Engineering（工学表記）または

Scientific（指数表記）。

No. of Digits 表示桁数。

Text Size タブ グラフ上の文字サイズを設定します。設定値には Largest、Large、Medium、
Small、Smallest、Fixed が有効です。Fixed以外の設定では、グラフの大き
さに応じた文字サイズが自動選択されます。Fixedに設定した場合は、文字
サイズ入力フィールドが有効となり、グラフの大きさに関係なく、入力さ
れた文字サイズが適用されます。

X/Y Axis Title 軸タイトルの文字サイズを設定します。

Scale X 座標値、Y 座標値の文字サイズを設定します。

Legend グラフ凡例の文字サイズを設定します。

Options タブ Data Display上の以下の項目の表示／非表示を設定します。

Setup Name テスト セットアップ名のウインドウ左上への表

示／非表示。

Keysight Logo グラフ・エリア左上への Keysightロゴの表示／

非表示。

Grid グラフのグリッドの表示／非表示。

Marker Guide Line マーカを選択するためのガイド ラインの表示／
非表示。
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Active Side Indicator 有効サイドを示すラインの表示／非表示。

All Subscale Values 全てのサブスケール値を表示するかどうか。

Unit Symbols スケール値への単位シンボルの表示／非表示。

Secondary Sweep Labels 二次掃引のラベルの表示／非表示。

Device ID Device IDの表示／非表示。

Setup Summary I/V SweepとMulti Channel I/V Sweepクラシッ
ク・テストに有効。グラフ・エリア下部にチャ

ネル設定の簡易情報の表示／非表示。「セット

アップ・サマリ (p. 1-145)」を参照してくださ
い。

Parameters Parametersエリアの有効／無効。
Always on Top Data Displayウインドウを常に一番上に表示す

る。

List タブ List Display におけるデータ表示の書式設定に用いられます。「List Display 
Preference (p. 1-141)」を参照してください。

Test Definition Editor

Legacy (A.05.60 
Compatible)

チェックボックスをチェックすると Test Definitionウインドウの GUIレイ
アウトが EasyEXPERTリビジョン A.05.60以前と同様になります。

Measurement

Channels タブ Use dummy SMUs 
(NONx:NC)  チェックボックスをチェックすると、Classic Testの測定

リソースの選択肢にダミーの SMU NONx:NC (x=1, 2, ...)
が 追加されます。NONx:NCを選択した場合、そのチャ

ネルは測定実行時に無視されます。VAR1に NONx:NC
を選択している場合には、実行エラーが発生します。

Global Variables
このダイアログ ボックスは、Tools > Global Variables...をクリックすること
で開き、Global変数の定義に使用します。

Add 新規 Global変数をリストに追加します。

Delete 選択している Global変数をリストから削除します。
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Up 選択している Global変数をリストの一つ上に移動します。

Down 選択している Global変数をリストの一つ下に移動します。

Copy 選択している Global変数定義をクリップ ボードにコピーします。

Paste クリップボードの Global変数定義をリストに追加します。

Name : 変数名。変数名に使用可能な文字：

• アルファベット Aから Z、aから z（大文字と小文字は区別されます）

• アンダースコア _ 

• 数字 0から 9（変数名の先頭には使用できません）

• アットマーク@（変数名の先頭には使用できません）

Type : 変数の型。Numeric（数値）、String（文字列）、または Vector（ベクター）。

Default : デフォルト値。

Description : 変数の説明。

OK 定義の変更を反映してダイアログ ボックスを閉じます。

Cancel 定義の変更を破棄してダイアログ ボックスを閉じます。
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アプリケーション・テスト・モードでは、次のグラフィカル ユーザ インタ
フェースがメイン画面に追加されます。

Category アプリケーション・テスト定義の分類項目をリストします。チェックボッ

クスを用いてカテゴリの選択を行います。選択する項目によって Libraryエ
リアに表示されるテスト定義が変更されます。

Categoryボタンは、カテゴリ選択に使用可能な Categoriesダイアログ ボッ
クスを開きます。

test name, i 開いているアプリケーション・テストのテスト定義の名前を表示します。 

右側の iボタンをクリックするとヘルプが表示されます。

Library 選択されたカテゴリに属するアプリケーション・テスト定義（セットアッ

プ）を表示します。

アイコンをクリックすると、簡単なメッセージと Selectボタンが表示され
ます。 Selectボタンをクリックすると、アプリケーション・テスト定義が
ロードされます。 これで測定の準備は完了です。

Libraryボタンは、次の 6つの機能を提供します。

Cancel このメニューを閉じます。
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New... 新規アプリケーション・テストの作成に使用

する｢Test Definitionウインドウ (p. 3-3)｣を開き
ます。

Open... 現在のアプリケーション・テストの定義内容

を表示または変更するために｢ Test Definition
ウインドウ (p. 3-3) ｣を開きます。

Delete 選択されたアプリケーション・テストを削除

します。 テストはアプリケーション・ライブ
ラリから削除されます。

Import... テスト定義のインポートに使用するダイアロ

グ ボックスを開きます。

Export... 現在のアプリケーション・テスト定義のエク

スポートに使用するダイアログ ボックスを開

きます。 テスト定義は指定したファイルに保
存されます。

View アイコンの大きさを選択します。

Large Icons 大きいアイコン

Small Icons 小さいアイコン

Lock... 選択しているテスト定義をロックし、オープ

ンや削除をする際のパスワードを設定するた

めのダイアログ ボックスを開きます。

Unlock... 選択しているテスト定義をアンロックするた

めにパスワードを入力するダイアログ ボック
スを開きます。

Read Only 選択しているテスト定義を読取り専用に設定

します。

Properties... ダイアログ ボックスを開き、選択しているテ

スト定義のファイル属性を表示します。

Search インクリメンタル サーチ。Libraryに表示されるアプリケーション・テスト
定義の絞込み検索を行います。

Setup Name テスト セットアップの名前を設定します。My Favoriteグループ（プリセッ
ト グループ）に保存されるテスト セットアップは、この名前で識別される

ので、他の定義と区別できる一意の名前を入力してください。

この名前はテスト結果データの中に保存され、テスト レコードのリスト エ
リアではレコードを識別するために用いられます。
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Device Parameters アプリケーション・テスト定義でデバイス パラメータが変数として定義さ

れている場合は、このエリアにデバイス パラメータ入力フィールドが表示
されます。 測定開始前に、入力フィールドに適切な値を入力します。

Test Parameters アプリケーション・テスト定義にデバイス接続図が指定されている場合、

このエリアに接続図が表示されます。

アプリケーション・テスト定義でテスト パラメータが変数として定義され

ている場合は、テスト パラメータ入力フィールドも表示されます。 測定開
始前に、入力フィールドに適切な値を入力します。ベクター データの入力
が必要な場合は、｢ Define vector data (p. 2-19) ｣を参照してください。

Extended Setup このボタンは、拡張パラメータ入力フィールドを表示する Extended Setup
ダイアログ ボックスを開きます。このダイアログ ボックスに表示されるパ
ラメータについては、｢ Ext (p. 3-6) ｣を参照してください。

入力フィールドに適切な値を入力し、Closeをクリックします。
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トレーサ・テスト・モードでは、I/V Trace画面を設定するだけで、I/V掃
引測定を簡単かつ迅速に実行することができます。次のグラフィカル ユー
ザ インタフェースがメイン画面に追加されます。

Setup Name テスト セットアップの名前を設定します。この名前でMy Favoriteグルー
プ（プリセット グループ）に保存されるテスト セットアップが識別されま

す。 他のセットアップと区別できる一意の名前を入力してください。

この名前はテスト結果データに記録され、テスト レコードのリスト エリア
でデータを区別するために用いられます。

グラフ領域 この領域は測定結果グラフを表示します。グラフ表示の設定・変更を行う

には「グラフ設定ツール」と「オプション・ツール」を使用します。

マウスのドラッグ操作でグラフが拡大されます。最大値・最小値を直接設

定するには表示値のクリックによって現れる入力フィールドを使用します。

チャネル領域 チャネル定義および、チャネル出力／測定データの変数定義を行います。
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Add クリックによって現れるメニューから SMUを選択する

とチャネル・セットアップの行が追加されます。

Delete 選択されているチャネル・セットアップを削除します。

Up / Down 選択されているセットアップを上または下に移動します。

Unit 出力または測定に使用される測定リソース。

V Name 電圧出力または測定データの変数名。

I Name 電流出力または測定データの変数名。

Mode 出力モード。V（電圧）、I（電流）、VPULSE（電圧パル
ス）、または IPULSE（電流パルス）。

Function 出力機能。VAR1（一次掃引）、VAR2（二次掃引）、また

は CONST（一定）。

チャネル・セットアップを選択するには、セットアップ左側のラジオ ボタ
ンを使用します。複数の出力チャネルが設定されている場合、セットアッ

プの上から下の順番でチャネル出力が開始されます。出力停止の順番はそ

の逆となります。

Sample setups このボタンをクリックすると、サンプル セットアップのメニューが現れま

す。セットアップ名をクリックするとその設定条件がトレーサ・テスト環

境に適用されます。

B1500Aには次のサンプルが提供されます。

• MOSFET: ID-VDS, ID-VGS, ID(off)-VDS, BVDSS

• Diode: IF-VF, IR-VR

• BJT: IC-VCE, IC-VCEO, BVCEO

B1505Aには次のサンプルが提供されます。

• MOSFET: ID-VDS, ID-VGS, ID(off)-VDS, BVDSS

• Diode: IF-VF, IR-VR

• IGBT: IC-VCE, IC-VGE, IC(off)-VCE, BVCES

• BJT: IC-VCE, IC-VCEO, BVCEO, IC-VCBO, BVCBO

• GaN FET (N1267A): ID-VDS, ID(off)-VDS, ID-VDS Current Collapse, FET 
Current Collapse Oscilloscope View

• GaN Diode (N1267A): IF-VF, IR-VR, IF-VF Current Collapse, Diode Current 
Collapse Oscilloscope View
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VAR1 一次掃引源出力を定義します。フルモードでは下記パラメータ全てが表示

されます。ショートモードではMode、Stop、No. of Steps、Complianceだけ
が表示されます。モード切替には VAR1タイトルバーをクリックします。
Mode 掃引モード。シングルはスタート→ストップの掃引、ダ

ブルはスタート→ストップ→スタートの掃引を行います。

LIN-SGL リニア掃引、シングル

LOG-SGL ログ掃引、シングル

LIN-DBL リニア掃引、ダブル

LOG-DBL ログ掃引、ダブル

Start 掃引スタート値。

Stop 掃引ストップ値。

Step 掃引出力のステップ変化量。この値は、Start値、Stop
値、No. of Steps値から自動的に計算されます。

No. of Steps 掃引ステップ数 N。
1 ～ 1001（B2900の場合、1 ～ 2500）。

Interlacing インタレース掃引回数M。1 ～ 100。

最終的な掃引ステップが Step/Mとなるように、掃引を
M 回繰り返します。全ステップ数は N+(N-1)(M-1)。

Compliance コンプライアンス値。 電圧源の電流制限値、または電流

源の電圧制限値を入力します。測定は、この値の範囲内

で行われます。

Pwr Comp. パワー・コンプライアンス値 (W)、または OFF。B2900
の場合、OFFのみ。

V Compliance UHCU、UHVU、HVMCUに有効。電圧掃引出力のリ
ミット値。これら測定リソースの出力電圧は自動的に測

定され、その測定値はリミット値と比較されます。そし

て、測定値がリミット値を越えると、測定ステータスが

コンプライアンス・ステータスにセットされ、掃引測定

は停止します。電圧範囲、設定分解能は、使用する測定

リソースに準じます。

Dual Polarity 両極性掃引 ONまたは OFF。ONの場合、正方向の掃引 
スタート→ストップと負方向の掃引 -1（スタート→ス

トップ）を順に行います。負方向のパルス掃引の場合、

パルス・ベース値は -1 倍されます。
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Hold Time ホールド時間。一次掃引源の掃引開始前の出力維持時間

(s)。0 ～ 655.35 s。設定分解能 : 10 ms。B2900の場合、0
～ 100000 s。
ホールド時間中は、階段波掃引の場合には掃引スタート

値、パルス掃引の場合にはパルス・ベース値を出力しま

す。

一次掃引測定の第一点目では、VAR1および VAR2の
Hold Time設定値の、どちらか長い方が適用されます。

VAR1チャネルに IPULSEまたは VPULSEが設定されている場合、フル
モードでは次のパラメータも表示されます。

Pulse Base パルス・ベース値。

Pulse Delay パルス・ディレイ時間。HR/MP/HPSMUの場合、0に設
定します。

Pulse Width パルス幅。HR/MP/HPSMUの場合、全チャネルに同じ値

を設定します。

VAR2 二次掃引源出力を定義します。VAR2チャネルはリニア、シングルの掃引
動作を行います。フルモードでは下記パラメータ全てが表示されます。

ショートモードでは Start、Stop、Step、No. of Stepsだけが表示されます。
モード切替には VAR2タイトルバーをクリックします。
Start 掃引スタート値。

Stop 掃引ストップ値。

Step 掃引出力のステップ変化量。この値は、Start値、Stop
値、No. of Steps値から自動的に計算されます。

No. of Steps 掃引ステップ数。 1 ～ 101。
Compliance コンプライアンス値。 電圧源の電流制限値、または電流

源の電圧制限値を入力します。測定は、この値の範囲内

で行われます。

Pwr Comp. パワー・コンプライアンス値 (W)、または OFF。B2900
の場合、OFFのみ。

V Compliance UHCU、UHVU、HVMCUに有効。電圧掃引出力のリ
ミット値。これら測定リソースの出力電圧は自動的に測

定され、その測定値はリミット値と比較されます。そし

て、測定値がリミット値を越えると、測定ステータスが

コンプライアンス・ステータスにセットされ、掃引測定

は停止します。電圧範囲、設定分解能は、使用する測定

リソースに準じます。
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Hold Time ホールド時間。二次掃引源の掃引開始前の出力維持時間

(s)。0 ～ 655.35 s。設定分解能 : 10 ms。B2900の場合、0
～ 100000 s。
ホールド時間中は、階段波掃引の場合には掃引スタート

値、パルス掃引の場合にはパルス・ベース値を出力しま

す。

一次掃引測定の第一点目では、VAR1および VAR2の
Hold Time設定値の、どちらか長い方が適用されます。

VAR2チャネルに IPULSEまたは VPULSEが設定されている場合、フル
モードでは次のパラメータも表示されます。

Pulse Base パルス・ベース値。

Pulse Delay パルス・ディレイ時間。HR/MP/HPSMUの場合、0に設
定します。

Pulse Width パルス幅。HR/MP/HPSMUの場合、全チャネルに同じ値

を設定します。

CONST 定電圧源／定電流源の定義を行います。

Unit 定電圧／電流源に使用する測定リソース。複数の

CONSTチャネルが存在する場合は、チャネルの選択に

使用します。

Source 出力値。

Compliance コンプライアンス値。 電圧源の電流制限値、または電流

源の電圧制限値を入力します。測定は、この値の範囲内

で行われます。

V Compliance UHCU、UHVU、HVMCUに有効。電圧掃引出力のリ
ミット値。これら測定リソースの出力電圧は自動的に測

定され、その測定値はリミット値と比較されます。そし

て、測定値がリミット値を越えると、測定ステータスが

コンプライアンス・ステータスにセットされ、掃引測定

は停止します。電圧範囲、設定分解能は、使用する測定

リソースに準じます。

CONSTチャネルに IPULSEまたは VPULSEが設定されている場合、フル
モードでは次のパラメータも表示されます。モード切替には CONSTタイ
トルバーをクリックします。Pulse Peakフィールドは Sourceフィールドの
代わりに表示されます。

Pulse Peak パルス・ピーク値。

Pulse Base パルス・ベース値。
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Pulse Delay パルス・ディレイ時間。HR/MP/HPSMUの場合、0に設
定します。

Pulse Width パルス幅。HR/MP/HPSMUの場合、全チャネルに同じ値

を設定します。

Meas. Time 掃引ステップ毎の測定時間を設定します。

Meas. Delay Time パルス毎の測定ディレイ時間（パルス周期開始点から測定開始までの時間）

を設定します。パルス出力チャネルが存在する場合に表示されます。

2 s ～パルス周期 - 測定時間 -2 ms、2 s 分解能

B2900の場合、0 s ～ 100000 s。

測定ディレイ時間に 0 (AUTO)を設定すると、最初に立ち下がるパルスの

ピーク出力が終了する時点で測定が完了するように自動設定されます。

Step Time 掃引ステップ毎の出力時間を設定します。500 s ～ 5 s、100 sステップ。

B2900の場合、5 ms ～ 100000 s。

Pulse Period パルス周期を設定します。パルス出力チャネルが存在する場合、Step Time
フィールドの代わりに表示されます。

NOTE 測定時間と測定誤差について

トレーサ・テスト・モードの測定では、以下の設定が常に用いられます。

• A/Dコンバータ：HS ADC（高速 A/Dコンバータ）

• 測定レンジング・モード：コンプライアンス・レンジ、固定

• 電流測定レンジの有効値：全レンジ（階段波掃引出力）、10 nA以上
（バイアス出力、パルス出力）

• 測定時間：Meas. Timeフィールドに入力された値

これら項目の設定値の違いによって、他のテスト・モードによる測定結果

とは異なる結果が得られるかもしれません。他のテスト・モードにおいて

HR ADC（高分解能 A/Dコンバータ）とオート・レンジを使用する場合と
比較すると、測定時間が短縮されて、測定誤差が増加する傾向にあります。

NOTE VAR1, VAR2, CONST

この領域は、全設定項目を表示できなくなると、マウスのドラッグ操作に

よってスクロールします。
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グラフ設定ツール

グラフ表示を設定するにはグラフ設定ツールの以下の GUIを使用します。

X 軸方向 X 軸方向、左から右 ()または右から左 ()を選択します。

Y 軸方向 Y 軸方向、下から上 (  )または上から下 (  )を選択します。

変数 X 軸または Y 軸にプロットする変数を設定します。

掃引出力または測定に使用される V Nameまたは I Nameを設定します。

Scale X 軸または Y 軸のスケール、リニア (LIN)またはログ (LOG)を選択しま

す。

Polarity X 軸または Y 軸のグラフ表示極性、正 (+)、負 (-)、または正負 ()を選択

します。正負 ()はリニア (LIN)スケールのグラフに設定できます。

オプション・ツール

グラフ表示を変更するにはグラフ設定ツールの以下の GUIを使用します。

Trace Style 
(Line/Dot)

トレースの描画スタイル、線または点を選択します。

Auto Scale このボタンをクリックすると、オート スケールを実行します。

またボタン右側の矢印をクリックすると以下のオプションを選択すること

ができます。

Run Time Auto Scale on Y Axis チェックすると測定時の Y 軸方向オート 
スケールの自動実行が有効になります。

Run Time Auto Scale on X Axis チェックすると実行時の X 軸方向オート 
スケールの自動実行が有効になります。

Undo Scaling このボタンはグラフがズームされている場合に有効です。このボタンをク

リックすると、直前のスケーリング操作を無効にします。グラフをズーム

するにはポイント・アンド・ドラッグ操作を行います。
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Redo Scaling このボタンは Undo Scaling操作が行われた場合に有効です。このボタンを

クリックすると、直前の Undo Scaling操作を無効にします。

Set Stop Condition 
Area

このボタンはグラフ上に異常領域を設定するために使用します。またボタ

ン内の信号で、現在の異常領域設定状態を表します。異常領域が設定され

ている場合は、測定データがこの領域に入ると測定を自動停止します。

緑 異常領域は設定されていません。このボタンをクリックすると、

ボタン内の信号の点灯色が黄に変わります。

黄 異常領域を定義可能な状態。このボタンをクリックすると、ボ

タン内の信号の点灯色が緑に変わります。

異常領域を定義するにはポイント・アンド・ドラッグ操作を行

います。赤色のグリッドに囲まれた領域として表されます。

定義が完了するとボタン内の信号の点灯色が赤に変わります。

赤 異常領域が設定されています。このボタンをクリックすると、

ボタン内の信号の点灯色が緑に変わります。

Replay Traces このボタンはトレースの記録・再生の管理に使用するダイアログ ボックス
をオープン／クローズします。ダイアログ ボックスについては「Replay 
Traces (p. 1-67)」を参照してください。

Capture a 
Reference trace

このボタンはトレースをリファレンス・トレースとしてキャプチャします。

このボタンをクリックすることで、リファレンス・トレース 1つをキャプ

チャし、10トレースまでキャプチャできます。リファレンス・トレースの

管理を行うには、リファレンス・トレース ボタンをクリックします。

Select Reference 
Traces

このボタンはリファレンス・トレースの管理に使用するダイアログ ボック

スをオープン／クローズします。ダイアログ ボックスについては
「Reference Traces (p. 1-69)」を参照してください。

Select Tracking 
Traces

このボタンは重ね書き測定によって 2つ以上のトレースを含んだ測定結果

に有効です。トラッキング・トレースとは、このような測定結果の各ト

レースを指しています。このボタンはトラッキング・トレースの管理に使

用するダイアログ ボックスをオープン／クローズします。ダイアログ ボッ
クスについては「Tracking Traces (p. 1-70)」を参照してください。

Marker このボタンはマーカを有効／無効にします。マーカはアクティブなトレー

ス上を動いて、マーカが示す点の X、Y 座標データはグラフ左上に表示さ

れます。マーカを動かすにはロータリーノブまたはマウスを使用します。
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Tangent Line このボタンはマーカを有効にし、Tangentラインを有効／無効にします。ラ
インの X 軸切片、Y 軸切片、傾きがグラフ右上に表示されます。Tangent
ラインは Regressionラインを無効にします。Tangentラインとは、マーカが

示す点でトレースに引かれる接線を指しています。

Regression Line このボタンはマーカを有効にし、Regressionラインを有効／無効にします。
ラインの X 軸切片、Y 軸切片、傾きがグラフ右上に表示されます。

Regressionラインは Tangentラインを無効にします。Regressionラインは回

帰計算によって与えられます。回帰計算に用いる測定データを特定するに

はポイント・アンド・ドラッグ操作を行います。

Oscilloscope View このボタンは出力信号波形のモニタに使用する Oscilloscope Viewウインド
ウをオープン／クローズします。Oscilloscope Viewウインドウについては
「Oscilloscope View (p. 1-72)」を参照してください。

Color, Thickness, 
and Data Format

このボタンはグラフの色、トレースの太さおよび値の表示フォーマットの

変更に使用するダイアログ ボックスをオープン／クローズします。ダイア
ログ ボックスについては「Color, Thickness, and Data Format (p. 1-70)」を参
照してください。

Replay Traces
このダイアログ ボックスは Replay Tracesボタンをクリックすることでオー
プン／クローズし、トレースの記録・再生を管理するために使用します。

ON / OFF このボタンは自動トレース記録機能を有効・無効にします。このボタンが

ONを表示している間、自動トレース記録機能は有効であり、測定トレー
スの記録を続けます。

Open このボタンは Open Trace Recordダイアログ ボックスを開きます。Save 
Trace Recordダイアログ ボックスを用いて保存された記録トレースを開く

ために使用します。
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Save このボタンは Save Trace Recordダイアログ ボックスを開きます。記録ト

レースを保存するために使用します。トレースは EasyEXPERT圧縮トレー

ス・レコード フォーマット（.gtr）で保存されます。

スライドバー スライドバーは、グラフに表示する記録トレースを選択するために使用し

ます。トレースは、スライドバー右横のスペースに置かれている N/Mで特

定されます。Nはグラフに表示されている記録トレースにアサインされて
いる記録番号、Mは記録トレースの総数を表しています。

<< このボタンは、表示される記録トレースを記録番号 N-1のトレースに変更
します。長押しによって変更動作が速くなります。

< このボタンは、表示される記録トレースを記録番号 N-1のトレースに変更
します。

> このボタンは、表示される記録トレースを記録番号 N+1のトレースに変更
します。

>> このボタンは、表示される記録トレースを記録番号 N+1のトレースに変更
します。長押しによって変更動作が速くなります。

Replay Interval このフィールドは <<／ >>ボタン動作の時間間隔を設定します。 

Maximum Records このフィールドは最大記録数を設定します。 記録番号がこの値に達した後、

記録番号は新しいトレースの方向にシフトされ、最も古いトレースが削除

されます。この番号は常に最新のトレースにアサインされます。

Recording Interval このフィールドは自動トレース記録動作の時間間隔を設定します。 
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Reference Traces
このダイアログ ボックスは、リファレンス・トレース ボタンをクリックす
ることでオープン／クローズし、キャプチャ ボタンをクリックすることに
よって記憶されるリファレンス・トレースを管理するために使用します。

Show/Hide 
selected trace

このボタンは、このダイアログ ボックス上で選択されたトレースのグラフ

表示を有効・無効にします。

Inversion このボタンは、このダイアログ ボックス上で選択されたトレースの反転を

有効・無効にします。

Erase このボタンは、このダイアログ ボックス上で選択されたトレースを削除し

ます。

Open このボタンは Open Reference Traceダイアログ ボックスを開きます。 Save 
Reference Traceダイアログ ボックスを用いて保存されたリファレンス・ト
レースを開くために使用します。

Save このボタンは Save Reference Recordダイアログ ボックスを開きます。リ

ファレンス・トレースを保存するために使用します。トレースは XMLス
プレッドシート フォーマット（.xml）で保存されます。

Time このフィールドはリファレンス・トレースのタイムスタンプを表示します。

Trace このフィールドはリファレンス・トレースのタイトルを表示します。グラ

フ・フレームの上方に記される文字がタイトルになります。
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Tracking Traces
このダイアログ ボックスは、トラッキング・トレース ボタンをクリックす
ることでオープン／クローズし、トラッキング・トレースを管理するため

に使用します。

Erase このボタンは、このダイアログ ボックス上で選択されたトレースを削除し

ます。

Time このフィールドはトラッキング・トレースのタイムスタンプを表示します。

Trace このフィールドはトラッキング・トレースのタイトルを表示します。グラ

フ・フレームの上方に記される文字がタイトルになります。

Color, Thickness, and Data Format
このダイアログ ボックスは、Color, Thickness, and Data Formatツール ボタ
ンをクリックすることでオープン／クローズし、グラフの色、トレースの

太さおよび値の表示フォーマットを変更するために使用します。
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Color and 
Thickness

グラフの色とトレースの太さの設定をします。

エレメントとして、バックグラウンド、テキスト、X 軸、Y 軸、グリッド、

フレーム、マーカ、ライン、トレースが対象となります。

カラー・パターンをクリックすると色の選択に使用されるカラー・パレッ

トが開きます。カラー・パレットにはカスタム色を追加する機能がありま

す。

Format 値の表示フォーマットの設定をします。工学表記または指数表記の選択、

およびその桁数の指定ができます。

エレメントとして、マーカ、モニタ値、X、Y 切片が対象となります。

Options 以下のトレース描画設定ができます。

Clear traces on each 
measurement start 各測定前にトレースを消去する。

Retain previous traces by 
dimming 以前のトレースを薄表示して残す。

Use Preset Graph 
Colors

あらかじめ用意されているプリセット設定を選択できます。

Apply このボタンは、ダイアログ上で行われた設定変更をグラフに適用します。

Reset このボタンは、初期設定をダイアログ ボックスとグラフに適用します。
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Oscilloscope View

このウインドウは、Tracer Test画面の Oscilloscope Viewボタンのクリック、
あるいは Option > Oscilloscope Viewメニューの選択でオープン／クローズ

します。

この機能は、パルス掃引測定またはパルス・スポット測定の 1点を観測し、

その波形を表示します。観測点は、トレース上に矩形マーカで示されます。

複数チャネルによる出力・測定タイミング、ゲート駆動チャネルの出力レ

ベル変化、などの観測に使用します。

この機能は、VPULSEまたは IPULSEモードに設定されたチャネルが 1つ
以上ある場合に有効です。また、下記測定リソースには使用できません。

• HRSMU, HPSMU, MPSMU

• MFCMU

• WGFMU

• SPGU

• GNDU

Oscilloscope View
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モニタ対象の信号の指定には、チャネル・エリアの V Nameおよび I Name
フィールドで指定されたデータ名が使われます。

トレーサ・テストを実行すると、指定された期間の波形がリアルタイムに

このウインドウにグラフ表示されます。グラフの表示分解能は 2 sです。

Oscilloscope Viewウインドウ GUI
Oscilloscope Viewウインドウは次の GUIを提供します。Figure 1-1を参照し
てください。

Figure 1-1 Oscilloscope View ウインドウ

File メニュー 以下の機能を提供します。

Save Setting 波形モニタ用の設定データを保存します。データはト

レーサ・テストセットアップの一部として保存されます。

Save Data As... Save Waveform Dataダイアログ ボックスを開きます。表

示されている波形データを保存するファイル名を設定し

ます。

Text（セパレータはタブ）、CSV、XML スプレッドシー
ト、BMP、EMF、GIF、または PNG 形式で保存できま

す。

Close Oscilloscope Viewウインドウを閉じます。

Data メニュー このメニューは、現在のトレーサ・テスト内で使用されている出力電圧／

電流のデータ名をすべて、通し番号付きでリスト表示します。

Oscilloscope Viewウインドウで波形表示するためには、観測したい信号に

対応するデータ名をここでチェックします。
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Setup メニュー 以下の機能を提供します。

Time > 
Scale&Origin... 時間軸スケールおよび時間軸原点を変更するためのダイ

アログ ボックスを開きます。

Time > Auto Scale 時間軸のオート スケールを実行します。
Time > Scaling 
Option 時間軸スケールの拡大の基準点をグラフの中心か 0か選

択します。

Sampling Sampling Setupダイアログ ボックスを開きます。詳しく

は、「Sampling Setup (p. 1-75)」を参照してください。
Data Scale > Auto 
Scale データ値のオート スケールの実行または取り消しをしま

す。

Data > Scaling 
Option データ軸スケールの拡大の基準点をグラフの中心か 0か

選択します。

N. data name Dataメニューで指定したデータ名が、メニュー項目とし

て表示されます。Data Viewダイアログ ボックスを開き

ます。ここで、Nは通し番号です。詳しくは、「データ表

示変更ダイアログ ボックス (p. 1-75)」を参照してくださ
い。

Window メニュー 以下の機能を提供します。

 Large Oscilloscope Viewウインドウのサイズを規定の大型サイ

ズに変更します。

 Small Oscilloscope Viewウインドウのサイズを規定の小型サイ

ズに変更します。

Monitor エリア このエリアの中央には波形グラフが表示されます。モニタ対象波形がすべ

て 1つのグラフ上に表示されます。縦線状のマーカを使って、あるタイミ

ングでの全波形上のデータを読み取ることができます。

波形とその関連情報は色分けされて表示されます。色を変更するには、

Setup > N. data nameメニューを選択して Data Viewダイアログ ボックスを
開きます。Data Viewダイアログ ボックスについては、「データ表示変更ダ
イアログ ボックス (p. 1-75)」を参照してください。

Monitorエリアの表示項目を以下に説明します。

Marker position 
1-74 Keysight EasyEXPERT ユーザ・ガイド Vol. 1、第 5版



メイン GUI
Tracer Test
マーカの位置情報（X 軸（時間）データ）。グラフの左上

に表示されます。マーカを動かすにはロータリーノブま

たはマウスを使用します。

Data at Marker position 
各波形上の、マーカが示す Y 軸（電圧または電流）デー

タ。グラフの左側にデータ名と共に表示されます。

Time/division 
X 軸（時間）のスケール値。グラフの最上部に表示され

ます。変更するには、表示されている値をクリックして

Time Scaleダイアログ ボックスを開きます。このダイア

ログ ボックスで、スケール値を書き換えます。

Time Origin 
時間軸原点値。グラフの最下部に表示されます。変更す

るには、表示されている値をクリックして Time Originダ
イアログ ボックスを開きます。このダイアログ ボックス
で、原点値を書き換えます。

Duration of measurement 
現在モニタされている掃引ステップでの測定期間。グラ

フの上下に表示される緑色の横線で示されます。これに

より、波形と測定期間との時間的関係を観測できます。

Vertical data/division and offset value 
Y 軸のスケール値とオフセット値。グラフの右側に表示

されます。変更するには、表示されている値をクリック

して Data Viewダイアログ ボックスを開きます。Data 
Viewダイアログ ボックスについては、「データ表示変更
ダイアログ ボックス (p. 1-75)」を参照してください。

データ表示変更ダイアログ ボックス
このダイアログ ボックスは、Setup > N. data nameメニューを選択する、あ

るいはグラフの右に表示された Y 軸のスケール値やオフセット値をクリッ

クすることによって開きます。Y 軸のスケール値、オフセット値、表示さ

れるグラフ線や文字の色、グラフ線種の変更に使用されます。

カラー・パターンをクリックすると色の選択に使用されるカラー・パレッ

トが開きます。カラー・パレットにはカスタム色を追加する機能がありま

す。

Sampling Setup
このダイアログ ボックスは、Setup > Samplingメニューを選択することに

よって開きます。波形モニタのサンプリング条件の設定に使用されます。
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観測対象のステップは、以下の組み合わせで決まります。

• 一次掃引源出力の掃引ステップの序数 (VAR1 Step)

• 二次掃引源出力の掃引ステップの序数 (VAR2 Step)

波形サンプリングは、この観測対象ステップ期間に出力されるパルスの周

期開始点を基点として、開始されます。そして、サンプリング開始遅延時

間（Delay）とサンプリング期間（Duration）を設定することで、観測期間

が最終的に決まります。Figure 1-2に設定例を示します。

NOTE 測定期間が観測期間内に完全に収まっていない場合、当該ステップの測定

データは NaN（非数値）となります。

Figure 1-2 サンプリング設定例

VAR1 Step: 一次掃引源出力の掃引ステップの序数（N)。N 番目のス

テップが指定されます。両極性掃引の場合、正方向への

掃引ステップの序数のみが有効。

インターレース掃引の場合には、各繰り返し掃引上のス

テップが指定されます。

最後のステップを指定するには LASTを入力します。こ
の場合、トレーサ・テストのステップ条件が変っても影

響されません。

インターレース掃引の場合には各繰り返し掃引上の最後

のステップが指定されます。

VAR1

VAR2

VAR1 Step = 2
VAR2 Step = EACH
Delay = 0 s
Duration = pulse_period

1st

2nd

3rd

1st
2nd

3rd
Pulse 
period

Oscilloscope View monitors 
waveforms in these timeframes.
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VAR2 Step: 二次掃引源出力の掃引ステップの序数（M)。M 番目のス

テップが指定されます。

毎ステップを指定するには EACHを入力します。
Delay:  サンプリング開始遅延時間。パルス周期開始点から波形

サンプリング開始点までの時間。設定範囲は、-30 s か
らパルス周期まで。

Duration: 波形サンプリング期間。設定範囲は、22 sから 24 msま
で。

Arithmetic Operation エリア

Arithmetic Operationエリアは、Option > Arithmetic Operation > Operation N
（N：1、2、または 3）メニューをクリックすることによってグラフ上部に
現れます。このエリアは、測定データを用いる算術演算式を定義するため

に使用します。この機能は、演算によって得られるパラメータのグラフ表

示に役立ちます。

このエリアには、最大 3つの演算式を Operation 1、Operation 2、Operation 3
として定義できます。演算式を定義するには、2つの演算数と 1つの演算

子 +（加算）、-（減算）、*（乗算）、または /（除算）を使用します。演算

数には以下の要素を使用することができます。

• 測定データ（例：Imeas）
• 出力データ（例：Vset）
• 実数のリテラル定数（例：2、0.123、100E-3）
• Operation 1の結果（例：Vdrop）、Operation 2および 3の演算式に有効

• Operation 2の結果（例：Vout）、Operation 3の演算式に有効

例 以下の例は、100 k直列抵抗と測定電流（Imeas）による電圧降下

（Vdrop）を電圧設定値（Vset）から減算することによって、被測定デバ

イスに印加される電圧値（Vout）を求めます。

Operation 1:

[ Vdrop ] = [ 100e3 ] * [ Imeas ]
Operation 2:

[ Vout ] = [ Vset ] - [ Vdrop ]

NOTE 演算処理できない場合には、NaN（非数値）が返されます。
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NOTE Operationを無効にするには、Option > Arithmetic Operation > Operation Nメ
ニューをクリックして、Operation Nメニューからチェックを外します。
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Quick Test
クイック・テスト・モードでは、My Favorite Setup（プリセット グループ）
に保存されている複数のテスト セットアップを順番に実行することができ

ます。次のグラフィカル ユーザ インタフェースがメイン画面に追加されま

す。

My Favorite Setup このボタンをクリックすると、次のメニューが現れます。

Cancel このメニューを閉じます。

Duplicate... Duplicate Preset Groupダイアログ ボックスを開きます。

現在のプリセット グループのコピーを指定した名前で作

成します。

Import... Preset Group Importダイアログ ボックスを開きます。指

定したプリセット グループをインポートします。

Export... Preset Group Exportダイアログ ボックスを開きます。現

在のプリセット グループを指定した名前でエクスポート

します。

Organize... Organize Preset Groupダイアログ ボックスを開きます。

プリセット グループの整理に使用します。｢ Organize 
Preset Group (p. 1-90) ｣を参照してください。

NOTE プリセット グループにトレーサ・テスト セットアップがある場合
トレーサ・テスト セットアップはMulti Channel I/V Sweepテスト セット
アップに変換されてリコールされます。

この変換処理では、VAR1の両方向掃引（Dual Polarity）の設定は無視され
ます。正方向掃引 スタート→ストップの設定は変換されますが、負方向掃

引 -1（スタート→ストップ）の設定は変換されません。

NOTE ホールド時間の変換に関する制約

VAR1のホールド時間（Hold Time)の設定が使われ、VAR2のホールド時間

（Hold Time）の設定は無視されます。
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Preset Group オープンするプリセット グループを選択します。

Setup Name プリセット グループに保存されているテスト セットアップすべてをリスト

します。

クイック・テストの設定操作の対象となるセットアップを選択・解除する

には、その行をクリックします。複数のセットアップを選択するには、

Ctrl-クリック、Shift-クリック、Select Allを使用します。

クイック・テスト設定操作画面が選択されている時には、テスト セット
アップ名をラベルとするソフトキーが現れます。このソフトキーを押すと、

対応するテストが即時実行されます。

Quick Test List クイック・テストの設定操作を行うには次のボタンを使用します。

Select All 設定リストの全テスト セットアップを選択します。

実行オン／オフ ボタンは選択されたテスト セットアップに有効であ
り、テストの実行／非実行を設定します。クイック・テ
ストを開始すると、設定リストの上から順に マークの

ついたテストだけが実行されます。

データ保存オン／

オフ ボタンは選択されたテスト セットアップに有効であ
り、テスト結果データの保存／非保存を設定します。

マークのついていないテストのデータは保存されませ

ん。

Up 選択されたテスト セットアップを 1つ上に移動します。

Down 選択されたテスト セットアップを 1つ下に移動します。

Recall 選択されたテスト セットアップをリコールします。
Application Testまたは Classic Test画面に変わります。

Edit Repeat Repeat 欄に表示される繰り返し実行回数を変更できま

す。

Rename 選択されたテスト セットアップの名前を変更することが

できます。

Duplicate 選択されたテスト セットアップのコピーを作成し、設定

リストの一番下に配置します。

Delete 選択されたテスト セットアップを削除することができま

す。
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Repeat Measurement Setup
このダイアログ ボックスは Repeatボタンをクリックすることで開かれ、繰

り返し測定の条件を設定します。このダイアログ ボックスには次のボタン

があります。

Run 測定を開始します。

Abort 測定を中止します。

Cancel 繰り返し測定の実行をキャンセルし、このダイアログ 
ボックスを閉じます。

繰り返し測定の実行フローを Figure 1-3に記します。繰り返し測定の動作

は Countと statusの値に依存します。Countはメイン画面 Countフィールド
に表示される数値、statusは Start Procedure、Before Measurement Procedure、
および After Measurement Procedureによって生成されるレスポンス（Figure 
1-6）の 1パラメータを示しています。

Figure 1-3 繰り返し測定実行フロー

If Abort is clicked

Final Procedure

End

Measurement

No

Yes

status = True ?

Count = Count+1

Yes

Start

Start Procedure

No

status = True ?

Yes

No

Count >= limit

Count = 0

Before Measurement
Procedure

Yes
status = True ?

No

After Measurement
Procedure

Abort Procedure

Abort
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Run Control タブ

Figure 1-4 Repeat Measurement Setup ダイアログボックス（Run Control タブ）

Repeat Stop 
Condition

繰り返し測定の終了条件を設定します。次の終了条件が有効です。

• Counter Reaching to: limit

Count  limitが成立することによって、繰り返し測定は終了します。

Reset counter before repeatingボックスをチェックすると、繰り返し測定

開始時に Countは 0に設定されます。
• Procedure return condition

status = Trueのレスポンスによって、繰り返し測定は終了します。
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Procedures (1)/(2) タブ

Figure 1-5 Repeat Measurement Setup ダイアログボックス（Procedures (1)/(2) タブ）

Repeat 
Procedures

繰り返し測定実行中にコールされるプロシジャ（実行ファイル、.EXE）を
指定します。プロシジャが不要な場合は、このフィールドを空白にします。

Browseボタンはファイル ブラウザを開きます。

プロシジャに引数が必要な場合は、Argumentsフィールドに設定します。

Start Procedure 繰り返し測定開始時に実行されるプロ

シジャを特定します。

Before Measurement Procedure 各測定の前に実行されるプロシジャを

特定します。

After Measurement Procedure 各測定の後に実行されるプロシジャを

特定します。

Final Procedure 繰り返し測定の後に実行されるプロシ

ジャを特定します。

Abort Procedure 測定が中断された場合に実行されるプ

ロシジャを特定します。
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Start Procedure、Before Measurement Procedureおよび After Measurement 
Procedureによって特定されるプロシジャが Figure 1-6のようなレスポンス
を生成する場合、EasyEXPERTはレスポンスに応じた動作を行います

（Figure 1-3）。パラメータ statusには文字列 Trueまたは False、パラメータ
device_idには適当な文字列が設定される必要があります。EasyEXPERTは
異なるフォーマットのレスポンスを無視します。

この機能を使用して、ウェーハ・プローバを制御できます。詳細は、ユー

ザ・ガイド Vol.2の第 8章 「ユーティリティ・プログラム」の「プローバ
制御」を参照してください。

Automatically fill 
in Device ID

このチェックボックスは Procedure return conditionボックスがチェックされ
ている時に有効であり、デバイス ID自動入力機能を設定します。この機能
は、Start Procedure、Before Measurement Procedureおよび After Measurement 
Procedureによって生成されるレスポンスの device_ID値をテスト レコード
の Device IDに自動入力します。

Figure 1-6 EasyEXPERT が期待するレスポンス

• Response (input to EasyEXPERT ):
XML format data

status: True (break) or False
device_id : Device ID

• Example:

<Response>
<Break>status</Break>
<Target> device_id </Target> 

</Response>

<Response>
<Break>False</Break>
<Target>waf1a:3 1</Target> 

</Response>
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Options タブ

Figure 1-7 Repeat Measurement Setup ダイアログボックス（Options タブ）

Thermo-trigger N1265A 超大電流エクスパンダ／フィクスチャを用いた温度トリガ機能を

設定します。

Enable 
Thermo-trigger 温度トリガ機能を有効／無効にします。

N1265A 
Thermo-trigger 
List... Thermo-trigger Listダイアログ ボックスを開きます。温度

トリガ機能の設定に使用します。Thermo-trigger List (p. 
1-86)を参照してください。

温度トリガ機能を有効にすると、繰り返し測定の実行フローは Figure 1-8
のように変更され、次のステップが追加されます。

1. Countの判定後、温度（Temp)を測定します。

2. 測定温度が温度条件（Centerと Radius）の範囲内にある場合は、待機時

間（Delay)後に指定した動作（Action)を開始します。範囲内にない場

合は、温度測定と判定を繰り返します。

ここで（ ）は Thermo-trigger Listダイアログ ボックスでの設定項目です。
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Figure 1-8 温度トリガ機能を用いた繰り返し測定実行フロー

Thermo-trigger List
このダイアログ ボックスは、N1265A Thermo-trigger List...ボタンをクリッ
クすることでオープンし、温度トリガ機能の設定に使用します。温度条件

と条件成立時の動作をリスト形式で設定します。リスト一行の設定は、繰

り返し測定一回のループ・シーケンスに使用されます。1行目の設定は初

回のシーケンス用、2行目の設定は 2 回目のシーケンス用、という規則に

従って使用されます。リストの設定行数以上に繰り返し測定が行われる場

合には、最終行後、先頭行に戻り、リストは繰り返し使用されます。最大 
1001行の設定が可能です。

また、このダイアログ ボックスでは、温度条件および動作を外部のファイ

ルから読み込んだり、外部のファイルへ書き出したりすることができます。

CSVと XMLSSのファイル形式がサポートされています。

Final Procedure

End

No

Yes

status = True ?

Count = Count+1

Yes

Start

Start Procedure

No

status = True ?

Yes

No

Count >= limit

Count = 0

Before Measurement
Procedure

Yes
status = True ?

No

After Measurement
Procedure

TRIGAction: NOP END
(Status=True)

Delay time

End

Yes

Temp Condition = True?
No

Measurement
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Figure 1-9 Thermo-trigger List ダイアログ ボックス

N
（インデックス） 編集時に操作対象のエントリー行を選択します。リピー

ト測定実行時には、現在待機中のエントリーを示します。

Temp 以下から、条件に使われる温度を選択します。

T1: 温度計チャネル 1で測定した温度。 

T2: 温度計チャネル 2で測定した温度。

T1-T2: T1と T2の温度差。

Center 温度範囲の中心値（摂氏）を特定します。範囲 : 273 ～

倍精度浮動小数点数の最大値

（1.7976931348623157E+308）、設定分解能 : 0.5。
Radius 中心値からの半径（摂氏）を特定します。範囲 : 0.5 ～

50、設定分解能 : 0.5。
Delay 温度条件が成立してから、動作開始までの遅延時間（秒）

を特定します。範囲 : 0 ～倍精度浮動小数点数の最大値

（1.7976931348623157E+308）、設定分解能 : 1。
Action 測定温度が指定範囲になった場合の動作を選択します。

TRIG: 指定遅延時間の後、測定を実行し、次

の動作へ移行します。これは、特定温

度範囲内で測定を実行するのに役立ち

ます。
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NOP: 何も実行せず（測定をスキップし）、

指定遅延時間の後、次の動作へ移行し

ます。 これは、特定温度範囲での待機

に有用です。

END:  statusを Trueに設定し、指定遅延時間

の後、繰り返し測定を終了します。こ

れは、特定温度範囲での繰り返し測定

の終了に有用です。

Add 新規エントリー行を 1行追加します。

Delete 選択したエントリー行を削除します。

Up/Down 選択したエントリー行を 1行上に、または下に移動しま

す。

OK セットアップの変更を適用し、このダイアログ ボックス
を閉じます。

Cancel セットアップの変更をキャンセルし、このダイアログ 
ボックスを閉じます。

Apply セットアップの変更を適用します。

Import... Open Fileダイアログ ボックスを開きます。指定したファ

イル (.csvまたは .xml)をインポートします。 
Export...  Save Fileダイアログ ボックスを開きます。ダイアログ 

ボックス内でファイル形式を指定します。

CSV: 

現在の設定を CSV データ形式で指定したファイルにエク

スポートします。スプレッドシート ソフトウェアを用い
て出力データを読むことができます。データは画面上の

設定と同じ順序でセーブされています。 
XML Style Sheet: 

現在の設定を XMLスプレッドシート形式で指定した

ファイルにエクスポートします。 スプレッドシート ソフ
トウェアを用いて出力データを読むことができます。使

用されるタグは以下のようです。

<Thermo-trigger List>
  <Temp>A</Temp>
  <Center>B</Center> 
  <Radius>C</Radius> 
  <Delay>D</Delay>
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  <Action>E</Action> 
</Thermo-trigger List>
ここで、

A: Tempフィールドの設定、T1、T2、または T1-T2、文
字列。

B: Centerフィールドの設定、数値。

C: Radiusフィールドの設定、数値。

D: Delayフィールドの設定、数値。

E: Actionフィールドの設定、TRIG、NOP、または END、
文字列。
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Organize Preset Group
このダイアログ ボックスはメイン画面、Quick Test設定画面、または
Switching Matrix Operation Panelの Organize Preset Groupファンクションを選

択することによって開かれ、プリセット グループの整理に使用されます。

Preset Group List ワークスペースに登録されているプリセット グループをリストします。次

のボタンが有効です。

Add Add Preset Groupダイアログ ボックスを開きます。新し

いプリセット グループを指定した名前で作成します。

Rename Rename Preset Groupダイアログ ボックスを開きます。選

択されたプリセット グループの名前を変更することがで

きます。

Duplicate Duplicate Preset Groupダイアログ ボックスを開きます。

選択されたプリセット グループのコピーを指定した名前

で作成します。

Delete 選択されたプリセット グループを削除することができま

す。

Import Quick Test設定時に有効。Preset Group Importダイアログ 
ボックスを開きます。指定したプリセット グループをイ
ンポートします。

Export Quick Test設定時に有効。Preset Group Exportダイアログ 
ボックスを開きます。選択されたプリセット グループを
指定した名前でエクスポートします。

Copy >>ボタンと <<ボタンの動作をコピーまたは移動のどちらかに設定します。

このチェックボックスがチェックされている時にはコピー動作が行われま
す。チェックが外れている時には、移動動作となります。

>> ボタン左に配置された Preset Groupボックスで選択されているプリセット 
セットアップを、ボタン右に配置された Preset Groupボックスにコピーま

たは移動します。

<< ボタン右に配置された Preset Groupボックスで選択されているプリセット 
セットアップを、ボタン左に配置された Preset Groupボックスにコピーま

たは移動します。
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Close Organize Preset Groupダイアログ ボックスを閉じます。

Preset Group ワークスペースに登録されているプリセット グループをリストします。次

のボタンが有効です。

Preset Group プリセット グループを選択します。

Setup Name 選択されたプリセット グループに保存されているプリ
セット セットアップすべてをリストします。

Select All 全プリセット セットアップを選択します。

Unselect All 全プリセット セットアップの選択を解除します。

Rename 選択されたプリセット セットアップの名前を変更するこ

とができます。

Duplicate 選択されたプリセット セットアップのコピーを作成し、

設定リストの一番下に配置します。

Delete 選択されたプリセット セットアップを削除することがで

きます。
Keysight EasyEXPERT ユーザ・ガイド Vol. 1、第 5版 1-91



メイン GUI
Calibration
Calibration
Calibrationウインドウは、Calibrationボタンをクリックすることで開かれ、

セルフキャリブレーションを実行するために用いられます。

• Module Self Calibration

• SMU Zero Cancel

• CMU Calibration

Module Self Calibration
モジュールのセルフキャリブレーションを実行します。実行対象モジュー

ルを選択するには、Name 左のチェックボックスをチェックします。実行
前にはケーブル端にて、測定端子を開放してください。

Module Self 
Calibration

次の値を表示します。

Name モジュール名。

Full Range SMU+ASUのフルレンジ測定 Onまたは Off。

Status キャリブレーション・ステータス。 パスまたはフェイル。

Notes キャリブレーションにフェイルした場合のエラー情報。

Select All すべてのモジュールをキャリブレーション対象として選択します。 これに

より、すべてのモジュールのチェックボックスがチェックされます。

Unselect All すべてのモジュールの選択を解除します。 これにより、すべてのモジュー

ルのチェックボックスのチェックが外されます。

Start Calibration 選択したモジュールのキャリブレーションを開始します。

Abort キャリブレーションを中止します。

Full Range 
Calibration

B1500A/E5270Bに有効。SMU+ASUの 1 pAレンジを有効にするには、こ
のボックスをチェックします。

1 pAレンジを使用しない場合は、このボックスのチェックを外します。
1 pAレンジ・オフセット・データ測定と 1 pAレンジのキャリブレーショ

ンは行われません。
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Enable Auto 
Calibration

オート・キャリブレーションを有効または無効に設定します。オート・

キャリブレーションを有効にしている場合（チェック時）、全モジュールの

出力スイッチがオフになってから 30分経過した後、30分毎に、自動的に

全モジュールのキャリブレーションを開始します。オート・キャリブレー

ションを有効にしている場合は、測定後、測定端子を開放するか、被測定

デバイスを測定端子から切り離すようにしてください。

SMU Zero Cancel
SMUパスのオフセット電流測定の実行とオフセット除去機能の設定を行い

ます。対象モジュールを選択するには、Name 左のチェックボックスを
チェックします。実行前にはケーブル端にて、測定端子を開放してくださ

い。本機能は以下のモジュールに有効です。

｢電流オフセット除去機能 (p. 4-45) ｣も参照してください。

• SMU+ASU

• HRSMU

• MPSMU

• HPSMU

• HVSMU

SMU Zero Cancel 次の値を表示します。

Name モジュール名。

Full Range SMU+ASUのフルレンジ測定 Onまたは Off。

1nA 1 nAレンジにおけるオフセット電流測定値。 SMU+ASU、
HRSMU、MPSMU、HPSMU、HVSMUに有効です。

100pA 100 pAレンジにおけるオフセット電流測定値。
SMU+ASUと HRSMUに有効です。

10pA 10 pAレンジにおけるオフセット電流測定値。SMU+ASU
と HRSMUに有効です。

1pA 1 pAレンジにおけるオフセット電流測定値。SMU+ASU
に有効です。

Full Range 選択された SMU+ASUの 1 pAレンジを有効 (On)または無効 (Off)に設定し
ます。

Integration Time 選択された SMUパスのオフセット電流測定に使用する積分時間を設定し
ます。1 PLC (power line cycle) ～ 100 PLC、初期値 16 PLC。
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Select All すべてのモジュールを選択します。 これにより、すべてのモジュールの

チェックボックスがチェックされます。

Unselect All すべてのモジュールの選択を解除します。 これにより、すべてのモジュー

ルのチェックボックスのチェックが外されます。

Measure... 対象モジュールの SMUパスのオフセット電流測定を実行します。

CMU Calibration
CMU Calibrationタブ画面は、マルチ周波数キャパシタンス測定ユニット

(MFCMU)の測定データ補正を実行するために用いられます。 簡単な方法と

しては、位相補償とオープン補正だけを実行します。

｢測定データの補正について (p. 4-26) ｣も参照してください。

NOTE 精度の高い容量測定を行うには、測定を開始する前に、測定周波数と同じ

周波数で補正データ測定を実行する必要があります。

測定周波数が下記デフォルト周波数に含まれていない場合は、Advanced 
Options...ボタンをクリックし、Advanced Options for CMU Calibrationウイン
ドウの Frequencyに全測定周波数を設定してください。

デフォルト周波数：

1 k、2 k、5 k、10 k、20 k、50 k、100 k、200 k、500 k、1 M、1.2 M、1.5 M、
2 M、2.5 M、2.7 M、3 M、3.2 M、3.5 M、3.7 M、4 M、4.2 M、4.5 M、
5 MHz

Measure... 位相補償データまたは補正データ測定を実行するためのダイアログ ボック
スを開きます。 測定を実行するには、ダイアログ ボックスに従います。

測定された位相補償データおよび補正データはワークスペース単位で保存、

管理されます。次回、ワークスペースを開く時には、最後に測定された

データがロードされます。

Advanced 
Options...

補正データ測定の周波数とワーキング スタンダードのリファレンス値を設
定する｢ Advanced Options for CMU Calibration (p. 1-96) ｣ダイアログ ボックス
を開きます。

Phase 
Compensation

このチェックボックスは、位相補償データを測定した後で有効になり、位

相補償をオン／オフするために用いられます。 このボックスからチェック
をはずすと、位相補償が無効になります。

位相補償データを測定するには、デバイス端で測定端子を開放し、

Measure...ボタンをクリックします。
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4端子対法によってデバイス端までケーブル延長する場合は、デバイス端

にて以下の端子を接続すること。

• Hp (high potential)と Hc (high Current)

• Lp (low potential)と Lc (low Current)

Open Correction このチェックボックスは、オープン補正データを測定した後で有効になり、

オープン補正をオン／オフするために用いられます。 このボックスから
チェックをはずすと、オープン補正が無効になります。

補正データを測定するには、校正値またはリファレンス値を持つオープン 
スタンダードを接続するか、デバイス端で測定端子を開放し、Measure...ボ
タンをクリックします。

4端子対法によってデバイス端までケーブル延長する場合は、デバイス端

にて以下の端子を接続すること。

• Hp (high potential)と Hc (high Current)

• Lp (low potential)と Lc (low Current)

スタンダードを使用する場合は、Advanced Options...ボタンをクリックし、
OPEN Reference入力フィールドにリファレンス値を入力します。 スタン
ダードを使用しない場合は、フィールドに 0を入力します。

Short Correction このチェックボックスは、ショート補正データを測定した後で有効になり、

ショート補正をオン／オフするために用いられます。このボックスから

チェックをはずすと、ショート補正が無効になります。

補正データを測定するには、校正値またはリファレンス値を持つショート 
スタンダードを接続するか、デバイス端で測定端子を短絡し、Measure...ボ
タンをクリックします。

スタンダードを使用する場合は、Advanced Options...ボタンをクリックし、
SHORT Reference入力フィールドにリファレンス値を入力します。 スタン
ダードを使用しない場合は、フィールドに 0を入力します。

Load Correction このチェックボックスは、ロード補正データを測定した後で有効になり、

ロード補正をオン／オフするために用いられます。 このボックスから
チェックをはずすと、ロード補正が無効になります。

補正データを測定するには、校正値またはリファレンス値を持つロード ス
タンダードを接続し、Measure...ボタンをクリックします。

補正データ測定を開始する前に、Advanced Options...ボタンをクリックし、
LOAD Reference入力フィールドにリファレンス値を入力します。
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Advanced Options for CMU Calibration
このダイアログ ボックスは Advanced Options...ボタンをクリックすること
で開かれ、オープン／ショート／ロード補正データと位相補償データの測
定に必要な情報を設定するために用いられます。 このダイアログ ボックス
には次のボタンがあります。

OK 設定変更を適用し、ダイアログ ボックスを閉じます。

Cancel 設定変更をキャンセルし、ダイアログ ボックスを閉じます。

Frequency 次のラジオ ボタンから 1つを選択することで、測定周波数セットアップ 
モードを選択できます。通常は Defaultを使用します。

• Use factory specified frequencies (Default)

測定周波数には 1 k、2 k、5 k、10 k、20 k、50 k、100 k、200 k、500 k、
1 M、1.2 M、1.5 M、2 M、2.5 M、2.7 M、3 M、3.2 M、3.5 M、3.7 M、
4 M、4.2 M、4.5 M、5 MHzが自動的に設定されます。

• Specify list of calibration frequencies

このモードを選択すると、周波数を個別に設定できます。 周波数は
1 kHz ～ 5 MHzの範囲内でなければなりません。 周波数の数は 1 ～ 101
です。

Addをクリックしてダイアログ ボックスを開き、値を入力します。 

不要な値がある場合は、値を選択して Deleteをクリックします。
• Specify frequencies by range

このモードを選択すると、一連の周波数を自動的に設定できます。

スタート周波数、ストップ周波数、ステップ数、スケール（LINEAR/ 
LOG）を指定します。スタート周波数はストップ値より小さく、1 kHz
以上でなければなりません。 ストップ周波数はスタート値より大きく、
5 MHz以下でなければなりません。有効なステップ数は 2 ～ 1001です。

NOTE デバイス測定周波数が補正データ測定周波数と一致しない場合は、デバイ

ス測定周波数における補正データが自動的に計算され、それを用いて測定

データの補正が行われます。

Integration Time このエリアは、位相補償データまたはオープン／ショート／ロード補正

データの測定時に設定される積分時間を定義します。Mode=AUTOの場合
は測定サンプル数、Mode=PLCの場合は積分時間を設定します。

Mode A/Dコンバータ動作モード、AUTOまたは PLC。
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Factor 既定値に対する係数。「Mode、Factor (p. 4-21)」を参照してくだ
さい。

Reference 
Standard Values

オープン／ショート／ロード スタンダードの校正値またはリファレンス値
を設定するために、次の入力フィールドがあります。 スタンダードを使用
する場合は、次の入力フィールドに値を入力します。

• OPEN Reference: Capacitance と Conductance

スタンダードを使用しない場合は、両方のフィールドに 0を入力しま
す。

• SHORT Reference: Inductance と Resistance

スタンダードを使用しない場合は、両方のフィールドに 0を入力しま
す。

• LOAD Reference: Inductance と Resistance
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Configuration
Configurationウインドウは、Configボタンをクリックすることで開かれ、

システム情報およびイベント ログの表示と、診断およびセルフテストの実

行に用いられます。

• Main Frame

• Modules

• ASU

• Switching Matrix

• SMU/PG Selector

• Module Selector

• Dual HCSMU Combination

• UHC Expander / Fixture

• HVSMU Current Expander

• UHV Expander

• Device Capacitance Selector

• Gate Charge Adapter

• SMU Output Setting Limits

• Event Log

• Extended Configuration

Main Frame
Main Frameタブ画面は、システム情報の表示と診断の実行のために用いら

れます。

Model 
Identification

モデル IDを表示します。

Line Frequency 電源周波数 50 Hzまたは 60 Hzを表示・設定します。

複数台の B2900で構成されている場合、すべての B2900の設定を変更しま
す。
1-98 Keysight EasyEXPERT ユーザ・ガイド Vol. 1、第 5版



メイン GUI
Configuration
EasyEXPERT Rev. EasyEXPERTのリビジョン番号を表示します。

Firmware Rev. Keysight B1500または B2900のファームウェアのリビジョン番号を表示し
ます。

HOST ID Keysight B1500または B2900内蔵コンピュータのホスト IDを表示します。

Main Frame 
Diagnosis
または
B2900 Diagnosis

このエリアには、Itemと Statusが表示されます。

Item 診断項目の名前。 選択するには、左側のチェックボック

スをチェックします。

Status 診断ステータス。 パスまたはフェイル。

Select All すべての項目を診断対象として選択します。 これにより、すべての項目の

チェックボックスがチェックされます。

Unselect All すべての項目の選択を解除します。 これにより、すべての項目のチェック

ボックスのチェックが外されます。

Start Diagnosis 選択した項目の診断を開始します。

診断を実行するには、実行する項目を指定して、このボタンをクリックし

ます。 診断ボックスが表示されます。 ダイアログ ボックスに従って診断を

実行します。ユーザがパス／フェイルを判定する項目もあります。また、

アダプタ接続、キーの操作、LEDのチェックなどをユーザが行います。

Modules
Moduleタブ画面は、モジュールのセルフテストを実行するために用いられ
ます。

Slot Configuration このエリアには、Slot、Module Type、Name、Statusが表示されます。

Slot モジュールが装着されているスロット番号。 選択するに

は、左側のチェックボックスをチェックします。

Module Type モジュールのモデル番号。

Name モジュール名。Table 1-2を参照してください。
Status セルフテスト・ステータス。 Pass、Failed、Recovered、

----（セルフテストが実行されなかった）のいずれか。
SCUU モジュールが SCUUに接続されているか否かを示しま

す。
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Notes モジュールのセルフテストにフェイルした場合のエラー

情報。

Select All すべてのモジュールをセルフテストの対象として選択します。 これにより、

すべてのモジュールのチェックボックスがチェックされます。

Unselect All すべてのモジュールの選択を解除します。 これにより、すべてのモジュー

ルのチェックボックスのチェックが外されます。

Start Self Test 選択したモジュールのセルフテストを開始します。

Recover Module このボタンはサービス専用です。 フェイルしたモジュールが再び応答する

ようにします。 このボタンをクリックしても、Failedステータスの原因と
なった問題は解決しません。

Abort セルフテストを中止します。

Status LED アト・センス／スイッチ・ユニット (ASU)、SMU CMUユニファイ・ユ
ニット (SCUU)、モジュール・セレクタのステータス・インジケータ (LED)
を有効 (ON)または無効 (OFF)にします。

Table 1-2 モジュール名

モジュール名 測定リソース

GNDU+ASU B1500メインフレーム

SMU<N>:HP HPSMU

SMU<N>:MP MPSMU

SMU<N>:HR HRSMU

SMU<N>:HR/AS SMU+ASU

SMU<N>:HC HCSMU

SMU<N>:DHC デュアル HCSMU

SMU<N>:MC MCSMU

SMU<N>:HV HVSMU

SMU<N>:UHC500 UHCU（標準 )

SMU<N>:UHC1500 UHCU（オプション N1265A-015付き）

SMU<N>:HVMC HVMCU
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ここで、<N>はチャネル番号。

ASU
B1500A/E5270Bに有効。ASUタブ画面は、ASU（アト・センス／スイッ
チ・ユニット）の接続状態にかかわらず、校正時、ASUに接続されていた
SMUが装着されている場合に表示されます。ASUの情報を表示します。

Slot スロット番号。

Module Type モジュール タイプ。

Name モジュール名。

ASU Serial 
Number

使用可能な ASUのシリアル番号。ASU 非接続時にも表示されます。異な

る ASUが接続されている場合は、シリアル番号のかわりにエラー・メッ

セージが表示されます。また ASUを使うことのできない SMUに ASUが
接続されている場合にも、エラー・メッセージが表示されます。

ASU I/O Path

Table 1-3 ASU のスイッチ切替動作。SMU または AUX。

SMU<N>:UHV UHVU

SMU<N>:B290X B2901A/B2902A/B2901B/B2902B/B2901BL 
SMU

SMU<N>:B291X B2911A/B2912A/B2911B/B2912B/B2910BL 
SMU

モジュール名 測定リソース

設定値 入出力の接続と説明

SMU 常に ASU Force入力から ASU出力へのパスが作られます。

AUX テスト内容による自動切替が行われます。通常時は AUX In入
力から ASU出力へのパスが作られ、SMUを使用するテストで
は SMU入力から ASU出力へのパスが作られます。
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Switching Matrix
B1505A/B1506A/B1507Aには無効。Switching Matrixタブ画面では、
Keysight B2200A/B2201A/E5250Aスイッチング・マトリクスとの GPIB接続
の確認、およびスイッチング・マトリクス入力ポートと測定モジュールと
の接続条件の設定を行います。

Switching Matrix 
Type

接続されているスイッチング・マトリクスのタイプ（下記）を表示します。

• B2200A Femto Leakage Switch Mainframe

• B2201A 14ch Low Leakage Switch Mainframe

• E5250A Low Leakage Switch Mainframe

• No Switching Matrix（接続されていない場合）

GPIB Address スイッチング・マトリクスの GPIBアドレスを設定します。1から 30。

Poll スイッチング・マトリクスとの GPIB接続の確認を行うには、このボタン

をクリックします。

Start Self Test スイッチング・マトリクスのセルフテストを開始するには、このボタンを

クリックします。

SWM IN SWM INnはスイッチング・マトリクスの入力ポート nに対応します。ここ

で nは、1から 10の整数 (E5250Aの場合 )または 1から 14の整数

(B2200A/B2201Aの場合 )です。

右横のフィールドには、入力ポートに接続されるモジュールを識別するた

めの文字列を入力します。プルダウンメニューからモジュール名を選択す

ることも可能です。設定する文字列に：（コロン）は無効です。

Kelvinチェックボックスをチェックすると、対となる偶数ポートがグレー
アウトされます。

CMUチェックボックスをチェックすると、SWM IN10 (E5250Aの場合 )ま
たは SWM IN14 (B2200A/B2201Aの場合 )がグレーアウトされます。

Kelvin ケルビン接続を行う場合、このチェックボックスをチェックします。SMU
とスイッチング・マトリクスの接続は次のようにします。

• E5250Aの場合：（mは 1から 3の整数）

SMU INPUT 2m-1と SMUの Force端子

SMU INPUT 2mと SMUの Sense端子
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• B2200A/B2201Aの場合：（mは 1から 6の整数）

Input 2m-1と SMUの Force端子

Input 2mと SMUの Sense端子

CMU CMUを接続する場合、このチェックボックスをチェックします。CMUと
スイッチング・マトリクスの接続は次のようにします。

• E5250Aの場合：

AUX INPUT CV1と CMUの Hpot/Hcur端子

AUX INPUT CV2と CMUの Lpot/Lcur端子

• B2200A/B2201Aの場合：

Input 13と CMUの Hpot/Hcur端子

Input 14と CMUの Lpot/Lcur端子

精度の良い容量測定を行うには、容量補正を行う必要があります。詳細は

使用する計測器のユーザ・ガイドを参照してください。

SMU/PG Selector
B1500A/4155/4156に有効。SMU/PG Selectorタブ画面は Keysight 16440A 
SMU/PGUセレクタ (B1500A-A04)の入力接続とチャネル接続状態を設定し
ます。セレクタは Keysight 16445Aセレクタ・アダプタと Digital I/Oコネク
タを介して B1500Aから制御されます。

2台のセレクタを使用することができます。1台目のセレクタは 16445Aを
介して Digital I/Oコネクタに接続します。2台目のセレクタを使用するに

は、1台目のセレクタの Control Outputコネクタに追加のセレクタを接続し

ます。「SMU/PGセレクタ (p. 4-51)」を参照してください。

Enable SMU/PG 
Selector

セレクタを使用する場合は、B1500Aにセレクタを接続し、このチェック・
ボックスをチェックします。

Selector CH1/CH2 CH1と CH2はそれぞれ 1台目のセレクタのチャネル 1と 2を示します。

Selector CH3/CH4 CH3と CH4はそれぞれ 2台目のセレクタのチャネル 1と 2を示します。

SMU Assignment セレクタの CH1、CH2、CH3、CH4の SMU入力に接続されている SMUを
設定します。
Keysight EasyEXPERT ユーザ・ガイド Vol. 1、第 5版 1-103



メイン GUI
Configuration
Input/Output Path

Table 1-4 セレクタ CH1、CH2、CH3、CH4 のスイッチ切替動作。

CH1と CH3には PGU Openの状態もあります。PGU Openに設定するには
Measurement Setupの Advancedウインドウを使用します。

Module Selector
B1505Aに有効。このタブ画面はモジュール・セレクタの入力接続と通常

時の入出力パス接続状態を指定します。セレクタは Digital I/Oコネクタを
介して B1505Aから制御されます。

Enable Module 
Selector

モジュール・セレクタを有効・無効にします。チェックしておくことでモ

ジュール・セレクタを使用することができます。

Input モジュール・セレクタの HVSMU、HCSMU、HPSMU入力ポートに接続さ
れているモジュールを特定します。モジュールが接続されていない場合は、

そのフィールドをブランクにします。

Enable Series Resistor (100 kohm) for HVSMU

HVSMU接続パス上の内蔵直列抵抗（100 k）を有効・無効にします。
チェックしておくことで直列抵抗が接続されます。

Output 通常時の接続状態を設定します。Defaultフィールドに設定されているモ
ジュールからセレクタ出力へのパスが作られます。

測定実行時には、テスト内容による自動切替が行われます。テストに使用

するモジュールからセレクタ出力へのパスが自動的に作られます。接続状

態はモジュール・セレクタ本体の Statusインジケータによって示されます。
Table 1-5 (p. 1-105)を参照してください。

Status 次のステータスを表示します。

Not Detected セレクタが検出されていません。

設定値 入出力の接続と説明

Always SMU 常に Input SMUから Outputへのパスが作られます。

Normally PGU 
(AUX)

テスト内容による自動切替が行われます。通常時は

Input PGUから Outputへのパスが作られ、Input SMU
ポートに接続されている SMUを使用するテストでは
Input SMUから Outputへのパスが作られます。
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Communication Established 正常状態。セレクタを使用できます。

Communication Lost 一度はセレクタが検出されましたが、現在

は通信が途絶えています。

Auto Detection モジュール・セレクタの自動検出を有効・無効にします。チェックしてお

くことで、モジュール・セレクタの自動検出が EasyEXPERT 起動時に実行

されます。

Diagnosis Start Diagnosisボタンはモジュール・セレクタの診断を開始します。Status
は診断結果を表示します。

Apply 設定を適用します。

Table 1-5 モジュール・セレクタの Status インジケータと入出力接続状態

CAUTION デュアル HCSMU（DHCSMU）をモジュール・セレクタと一緒に使用する

場合、モジュール・セレクタの性能劣化・故障を防ぐため、最大電流 ± 30 
Aで使用してください。

テストに使用する

モジュール

Status 
インジ

ケータ

出力端子の入出力接続状態a

a. 通常時には、Defaultフィールドに設定されているモジュールからセレクタ出力へのパ
スが作られます。測定実行時には、テスト内容による自動切替が行われます。テスト

に使用するモジュールからセレクタ出力へのパスが自動的に作られます。

High Sense High Force Low Sense Low Force

HPSMU
またはMPSMU

HPSMU HP/MPSMU
Sense

HP/MPSMU 
Force

HCSMU 
Low Sense

+ 
GNDU Force 

+ 
GNDU Sense

HCSMU 
Low Force

HCSMU
または DHCSMU

HCSMU HCSMU
High Sense

HCSMU 
High Force

HVSMU
HVSMU

HVSMU Force
オープン HVSMU

内部直列抵抗

接続時

HVSMU Force 
+ 直列抵抗

b

b. 全 Inputフィールド（HVSMU、HCSMU、HPSMU）がブランクの場合。 

Open オープン オープン
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Dual HCSMU Combination
B1505Aが HCSMU 2モジュールを装着している場合に有効。このタブ画面

では、デュアル HCSMU（Dual HCSMU）の動作条件を設定します。

Enable デュアル HCSMU動作を有効・無効にします。チェックしておくことで
デュアル HCSMU動作が有効となり、HCSMU 2モジュールは最大電流
± 40 A （パルス）、± 2 A (DC)の SMUとして動作します。

Primary HCSMU デュアル HCSMU動作のプライマリ・チャネルとして使用する HCSMU
（16493S-020/021デュアル HCSMUアダプタの Primaryポートに接続される

HCSMU）を設定します。

Secondary 
HCSMU

デュアル HCSMU動作のセカンダリ・チャネルとして使用する HCSMU
（16493S-020/021デュアル HCSMUアダプタの Secondaryポートに接続され
る HCSMU）を設定します。

Apply デュアル HCSMU動作の設定条件を適用します。設定条件の変更を伴う場

合は、あらかじめ B1505Aをアイドル状態、かつ Standby出力を OFFにし
ておく必要があります。

UHC Expander / Fixture
B1505A/B1506A に有効。このタブ画面では、N1265A 超大電流エクスパン
ダ／フィクスチャ（B1505Aを使用する場合）または B1506Aのテスト・
フィクスチャの設定を行います。フィクスチャは Digital I/O コネクタを介

して B1505A/B1506A から制御されます。

Enable Ultra High 
Current Unit

超大電流ユニット（UHCU）を有効・無効にします。チェックしておくこ
とで UHCUを使用することができます。この機能は、B1506A-H20/H21に
はありません。

Control UHCUの制御に使用するモジュールを特定します。モジュールが接続され

ていない場合は、入力フィールドをブランクにします。

Voltage Control 
SMU フィクスチャの V Controlポートに接続されたモジュー

ル（MCSMUまたは HCSMU）を特定します。この

フィールドに設定された SMUチャネルは、UHCUとし
てアサインされ、UHCUの指定に使用されます。

Current Control 
SMU フィクスチャの I Controlポートに接続されたモジュール

（MCSMUまたは HCSMU）を特定します。
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Self Test Enable Ultra High Current Unitボックスがチェックされている場合に有効。
Startボタンをクリックすると、フィクスチャのセルフ・テストを開始しま

す。実行時には、測定端子を開放しておく必要があります。

Statusはセルフ・テスト実行結果を表示します。

Self Calibration Enable Ultra High Current Unitボックスがチェックされている場合に有効。
Startボタンをクリックすると、フィクスチャのセルフ・キャリブレーショ

ンを開始します。実行時には、測定端子を開放しておく必要があります。

Statusはセルフ・キャリブレーション実行結果を表示します。

Enable Selector フィクスチャのセレクタを有効・無効にします。チェックしておくことで

セレクタを使用することができます。

Input UHCU UHCUにアサインされた SMUチャネルを表示します。
HVSMU フィクスチャの HVSMUポートに直接、あるいは

N1266Aを介して接続された HVSMUを特定します。

SMU フィクスチャの SMUポートに接続されたモジュール
（MPSMUまたは HPSMU）を特定します。

モジュールが接続されていない場合は、入力フィールドをブランクにしま

す。

Output Enable Series Resistor (100 kohm) for HVSMU

HVSMUダイレクト・パス上の内蔵直列抵抗（100 k）を有効・無効にし
ます。チェックしておくことで直列抵抗が接続されます。

Default 通常時のセレクタ接続状態（UHCU、HVSMU、SMU、
GNDU、またはブランク）を設定します。Defaultフィー
ルドに設定された測定リソースからセレクタ出力へのパ

スが作られます。ブランクの場合、出力は開放状態とな

ります。

測定実行時には、テスト内容による自動切替が行われま

す。テストに使用する測定リソースからセレクタ出力へ

のパスが自動的に作られます。

N1265A本体の Status インジケータは、N1265A内部の接
続状態を示します。Table 1-6を参照してください。

Enable Gate 
Control

フィクスチャの Gateパスを有効・無効にします。チェックしておくことで
Gateパスを使用することができます。
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Table 1-6 N1265A の Status インジケータとセレクタ接続パス

Gate Control SMU フィクスチャの Gateポートに接続されたモジュール
（MCSMUまたは HCSMU）を特定します。モジュールが

接続されていない場合は、このフィールドをブランクに

します。Gateパスには内蔵直列抵抗を接続することがで

きます。抵抗を接続するには Resistorフィールドを使用
します。

Resistor Gateパスの内蔵直列抵抗の抵抗値を特定します。直列抵

抗を接続しない場合は、0 ohmに設定します。

Thermometer Channel 1 温度計チャネル 1を有効・無効にします。
Channel 2 温度計チャネル 2を有効・無効にします。
Interval 温度測定の時間間隔を特定します。クラシック・テスト

実行中は、この設定に関わらず温度測定は行われません。

Format 温度データの記録書式を設定します。データは Device ID
文字列の最後に付加される形で記録されます。書式の指

定には、変数 {0}（チャネル 1による測定温度）、{1}
（チャネル 2による測定温度）、{2}（{0}と {1}の差）を

使用します。

書式の初期値：T1={0}, T2={1}, T1-T2={2} deg C

Status
インジ

ケータ

Selector Output 端子a

a. 通常時には、Defaultフィールドで設定された測定リソースから Selector Output端子への
パスが作られます。測定実行時には、テスト内容による自動切替が行われます。テス

トに使用する測定リソースから Selector Output端子へのパスが自動的に作られます。

Low Sense Low Force High Sense High Force

（オフ） 開放 開放 開放 開放

GNDU Sense GNDU Force 開放 開放

SMU GNDU Sense GNDU Force SMU Sense SMU Force

UHC UHCU Low Sense UHCU Low Force UHCU High Sense UHCU High Force

HVSMU GNDU Sense GNDU Force HVSMU Force 開放

GNDU Sense GNDU Force HVSMU Force
+ 直列抵抗

開放
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測定された温度データを繰り返し測定の条件として使用することもできま

す。「Repeat Measurement Setup (p. 1-81)」を参照してください。

Auto Detection フィクスチャの自動検出を有効・無効にします。チェックしておくことで、

フィクスチャの自動検出が EasyEXPERT 起動時に実行されます。

Status 次のステータスを表示します。

Not Detected フィクスチャが検出されていません。

Communication Established 正常状態。フィクスチャを使用できます。

Communication Lost 一度はフィクスチャが検出されましたが、

現在は通信が途絶えています。

Diagnosis Enable Ultra High Current Unitボックス、Enable Selectorボックス、Enable 
Gate Controlボックスの全て、またはどれかがチェックされている場合に有

効。Startボタンをクリックすると、フィクスチャの診断を開始します。実

行中には、ケーブル接続の変更を促すダイアログ ボックスが表示さ れま
す。

Statusは診断結果を表示します。

Apply 設定を適用します。

NOTE 診断を開始する前に

N1266Aエクスパンダが HVSMUと N1265Aの間に接続されている場合は、
N1266Aを取り外してください。そして、HVSMU Force端子と N1265A 
Selector Input HVSMU端子をケーブルで接続します。

HVSMU Current Expander
B1505A に有効。このタブ画面では、N1266A HVSMU電流エクスパンダの
設定を行います。N1266Aは Digital I/O コネクタを介して B1505A から制御
されます。

Enable High 
Voltage Medium 
Current Unit

高電圧中電流ユニット（HVMCU）を有効・無効にします。チェックして
おくことで HVMCUを使用することができます。

Input/Control HVMCUの制御に使用するモジュール、および HVSMUを特定します。モ

ジュールが接続されていない場合は、入力フィールドをブランクにします。

HVSMU N1266Aの HVSMU入力ポートに接続された HVSMUを
特定します。
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Voltage Control 
SMU N1266Aの V Controlポートに接続されたモジュール

（MCSMUまたは HCSMU）を特定します。このフィール

ドに設定された SMUチャネルは、HVMCUとしてアサ
インされ、HVMCUの指定に使用されます。

Current Control 
SMU N1266Aの I Controlポートに接続されたモジュール

（MCSMUまたは HCSMU）を特定します。

Self Test Enable High Voltage Medium Current Unitボックスがチェックされている場合
に有効。Startボタンをクリックすると、N1266Aのセルフ・テストを開始

します。実行時には、測定端子を開放しておく必要があります。

Statusはセルフ・テスト実行結果を表示します。

Output Enable Series Resistor (100 kohm) for HVSMU

HVSMUダイレクト・パス上の内蔵直列抵抗（100 k）を有効・無効にし
ます。チェックしておくことで直列抵抗が接続されます。

Default 通常時の接続状態（HVSMU、HVMCU、またはブラン
ク）を選択します。Defaultフィールドに設定されている
測定リソースから出力へのパスが作られます。ブランク

の場合、High出力は開放状態となります。

測定実行時には、テスト内容による自動切替が行われま

す。テストに使用する測定リソースから出力へのパスが

自動的に作られます。

接続状態は N1266A本体の Status インジケータによって
示されます。Table 1-7を参照してください。

Auto Detection N1266Aの自動検出を有効・無効にします。チェックしておくことで、

N1266Aの自動検出が EasyEXPERT 起動時に実行されます。

Status 次のステータスを表示します。

Not Detected N1266Aが検出されていません。

Communication Established 正常状態。N1266Aを使用できます。
Communication Lost 一度は N1266Aが検出されましたが、現在

は通信が途絶えています。

Apply 設定を適用します。
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Table 1-7 N1266A の Status インジケータと入出力接続状態

UHV Expander
B1505A に有効。このタブ画面では、N1268A 超高電圧エクスパンダの設定
を行います。N1268Aは Digital I/O コネクタを介して B1505A から制御され
ます。

Enable Ultra High 
Voltage Unit

超高電圧ユニット（UHVU）を有効・無効にします。チェックしておくこ
とで UHVUを使用することができます。

Control UHVUの制御に使用するモジュールを特定します。モジュールが接続され

ていない場合は、入力フィールドをブランクにします。

Voltage Control 
SMU N1268Aの V Controlポートに接続されたモジュール

（MCSMUまたは HCSMU）を特定します。このフィール

ドに設定された SMUチャネルは、UHVUとしてアサイ
ンされ、UHVUの指定に使用されます。

Current Control 
SMU N1268Aの I Controlポートに接続されたモジュール

（MCSMU）を特定します。

Auto Detection N1268Aの自動検出を有効・無効にします。チェックしておくことで、

N1268Aの自動検出が EasyEXPERT 起動時に実行されます。

Status 次のステータスを表示します。

Status 
インジケータ

出力端子の入出力接続状態a

a. 通常時には、Defaultフィールドで設定された測定リソースから
N1266A出力へのパスが作られます。測定実行時には、テスト内
容による自動切替が行われます。テストに使用する測定リソー

スから N1266A出力へのパスが自動的に作られます。

Low High

（オフ） GNDU Force、 Sense 開放

HVMCU HVMCU High

HVSMU HVSMU Force

HVSMU Force + 直列抵抗
Keysight EasyEXPERT ユーザ・ガイド Vol. 1、第 5版 1-111



メイン GUI
Configuration
Not Detected N1268Aが検出されていません。

Communication Established 正常状態。N1268Aを使用できます。
Communication Lost 一度は N1268Aが検出されましたが、現在

は通信が途絶えています。

Diagnosis Enable Ultra High Voltage Unitボックスがチェックされている場合に有効。
Startボタンをクリックすると、N1268Aの診断を開始します。実行中には、

ケーブル接続の変更を促すダイアログ ボックスが表示されます。

Statusは診断結果を表示します。

Apply 設定を適用します。

Device Capacitance Selector
B1505A/B1506A/B1507Aに有効。このタブ画面はデバイス・キャパシタン

ス・セレクタの設定を行います。セレクタは Digital I/Oコネクタを介して

B1505A/B1506A/B1507Aから制御されます。

Enable Device 
Capacitance 
Selector

デバイス・キャパシタンス・セレクタを有効・無効にします。チェックし

ておくことでセレクタを使用することができます。

Input MFCMU セレクタに接続されているMFCMUを特定します。

B1506A-H20/H50/H70の場合無効です。
HVSMU セレクタに接続されている HVSMUを特定します。 
SMU セレクタに接続されているMPSMUを特定します。 

Default Path N1272A/B1507Aに有効。アイドル状態でのパスを指定します。

Open オープン。

N1265Aと N1272Aを共に含む構成で、N1265Aを使用す
る際には Openを指定します。

IV IV測定パス。
Classic Test、Tracer Testを用いた N1272Aの IV測定パス
を経由した IV測定が行えます。

Keep 直前のパスを維持します。

Calibration 全容量測定パスの補正と補正データの選択を行います。

File Path 適用される補正データファイルのパスを示します。
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Select Calibration 
Data... 適用される補正データファイルを選択します。

Select Factory 
Default 既定の補正データを選択し適用します。

Start 
Calibration... 全容量測定パスの補正データ取得を行う Device 

Capacitance Calibrationダイアログ ボックスを開きます。

Capacitance Calibrationダイアログ ボックスでは、以下の
操作が行えます。

Start オープン補正データとショート補正

データの取得を開始します。

オープン補正データとショート補正

データの取得はそれぞれスキップする

ことができます。取得をスキップした

補正データについては既にロードして

いる補正データが適用されます。

Save and Apply 取得した補正データをファイル名を指

定して保存し、補正データを適用しま

す。

Close ダイアログ ボックスを閉じます。

Auto Detection デバイス・キャパシタンス・セレクタの自動検出を有効・無効にします。

チェックしておくことで、デバイス・キャパシタンス・セレクタの自動検

出がワークスペースのロード時に実行されます。

Status 次のステータスを表示します。

Not Detected セレクタが検出されていません。

Communication Established 正常状態。セレクタを使用できます。

Communication Lost 一度はセレクタが検出されましたが、現在

は通信が途絶えています。

Diagnosis Enable Device Capacitance Selectorボックスがチェックされている場合に有
効。Startボタンをクリックすると、セレクタの診断を開始します。実行中

には、ケーブル接続の変更を促すダイアログ ボックスが表示されます。

Statusは診断結果を表示します。

Apply 設定を適用します。
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Gate Charge Adapter
B1505A/B1506A に有効。このタブ画面はゲートチャージ測定に関する設定

を行います。

Adapter 使用するアダプタを選択します。

• N1259A Opt014

• N1265A Opt014

• N1274A

• N1275A

• B1506A OptF14

Input ゲートチャージ測定に使用する測定ユニットを指定します。

Gate DUTのゲート駆動に使用するMCSMUを指定します。

HVSMU 高電圧ゲートチャージ測定に使用する HVSMUを指定し

ます。

UHCU/HCSMU 大電流ゲートチャージ測定に使用する UHCU/HCSMUを
指定します。

Current Load 
Control 大電流ゲートチャージ測定に使用する定電流負荷のゲー

トを駆動するMCSMUを指定します。

Default Path N1274Aの場合に有効。アイドル状態での N1274Aのパスを指定します。

Open オープン。

N1274Aの出力はオープン状態となります。
IV IV測定パス。

Classic Test、Tracer Testを用いた N1274Aの IV測定パス
を鶏油した IV測定が行えます。

Calibration 選択したアダプタのオープン／ショート補正と補正データの選択を行いま

す。

File Path 適用される補正データファイルのパスを示します。

Select Calibration 
Data... 適用される補正データファイルを選択します。
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Select Factory 
Default 既定の補正データを選択して適用します。

Start 
Calibration... アダプタの補正データ取得を行う Gate Charge Calibration

ダイアログ ボックスを開きます。

Gate Charge Calibrationダイアログ ボックスでは、以下の
操作が行えます。

Start オープン補正データとショート補正

データの取得を開始します。

オープン補正データとショート補正

データの取得はそれぞれスキップする

ことができます。

取得をスキップした補正データについ

ては既にロードしている補正データが

適用されます。

Save and Apply 取得した補正データをファイル名を指

定して保存し、補正データを適用しま

す。

Close ダイアログ ボックスを閉じます。

Residual 
Resistance ショート補正に適用される DUT ゲート駆動パスの残留

抵抗値を表示します。

N1265A Opt014/B1506A OptF14 の場合は DUT ゲート駆動
パスの直列抵抗選択ごとの抵抗値を表示します。

Parasitic 
Capacitance オープン補正に適用される寄生容量値を表示します。

寄生容量値は DUT ゲート駆動MCSMU の各電流レンジ
ごとに表示します。

Apply 設定を適用します。
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SMU Output Setting Limits
B1505A/B1506A/B1507Aに有効。このタブ画面では、SMU出力値およびコ
ンプライアンス値の上限値を設定します。

Voltage Setting 
Limit

電圧出力値およびコンプライアンス値の上限値を設定します。

有効値：200 V ～ 10 kV、100 Vステップ。

Current Setting 
Limit

電流出力値およびコンプライアンス値の上限値を設定します。

有効値：1 A ～ 1500 A、1 Aステップ。

Apply 設定を適用します。

Event Log
このタブ画面は、イベント ログを表示します。

Date/Time イベントの日付と時刻を表示します。

Message イベント メッセージ。

ID イベントのプロセス ID。

Process プロセス名。

User ユーザ名。 Windowsログイン名。

Host Keysight B1500のホスト名。

Refresh イベント ログをリフレッシュします。
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Extended Configuration
B1505A/B1506A/B1507Aには無効。このダイアログ ボックスは
Configurationウインドウの Switching Matrixタブ画面で Extended 
Configurationボタンをクリックすることによって現れます。

Close Extended Configurationダイアログ ボックスを閉じます。

Save as Hardware 
Profile

スイッチング・マトリクスのハードウェア構成をハードウェア プロファイ
ルに保存可能です。

Save 現在のハードウェア プロファイルを保存します。

ワークスペース毎に異なるハードウェア プロファイルを持つことができま

す。

CMU 
Compensation

スイッチング・マトリクスを用いる容量測定の補正モードを設定します。

No Compensation、Select、User Compensation Data Fileのどれかを選択しま

す。補正については、使用する計測器のユーザ・ガイドを参照してくださ
い。

• No Compensation

容量補正を行わない場合に選択します。補正が行われていない生データ

が表示、保存されます。

• B2200A/B2201A（標準）

B2200A/B2201Aのハードウェア プロファイルが有効な場合は、以下の
設定が可能です。

• Select

B2200A/B2201Aの入力ポートから Keysight 16495F/Gコネクタ・プ
レートまたは Keysight B2220Aプローブカード・インタフェースま

での補正を行うことができます。補正後のデータが表示、保存され
ます。

DUT I/F 使用するパスのモデル番号、16495F/Gまたは
B2220Aを特定します。

Cable B2200A/B2201A出力から DUT I/Fまでを接続する
ケーブルのモデル番号、16494A/B/C-001 (1.5 m) / 002 
(3 m) / 005 (4 m)を特定します。

コネクタ・プレートからポジショナ／マニピュレータまでのケーブ

ル配線やプローブカードによる影響を補正することはできません。
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• User Compensation Data File

補正データ ファイルを特定することによって、B2200A/B2201Aの入
力ポートからポジショナ／マニピュレータ／プローブカード先端ま

での配線による影響を補正することができます。詳細は、使用する

計測器のユーザ・ガイドを参照してください。補正後のデータが表

示、保存されます。

• E5250A（オプション）

E5250Aのハードウェア プロファイルが有効な場合は、以下の設定が可
能です。

• User Compensation Data File

補正データ ファイルを特定することによって、E5250Aの入力ポー
トからポジショナ／マニピュレータ／プローブカード先端までの配

線による影響を補正することができます。詳細は、使用する計測器

のユーザ・ガイドを参照してください。補正後のデータが表示、保

存されます。

Clear User Compensation Data Fileフィールドをクリアし
ます。

Triaxial 
Cable E5250A出力とコネクタ・プレートの間に接続さ

れている 16494Aトライアキシャル・ケーブルの

長さを入力します。

User 
Triaxial 
Cable コネクタ・プレートと DUTの間に使われている

トライアキシャル・ケーブルの長さを入力します。

トライアキシャル・ケーブルが使われていない場
合は 0を入力します。

User 
Coaxial 
Cable コネクタ・プレートと DUTの間に使われている

同軸ケーブルの長さを入力します。同軸ケーブル
が使われていない場合は 0を入力します。
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Switching Matrix Operation Panel
B1505A/B1506A/B1507Aには無効。Switching Matrix Operation Panelは
Switching Matrixボタンをクリックすることで開かれ、Keysight 
B2200A/B2201A/E5250Aスイッチング・マトリクスのスイッチ セットアッ
プの作成、スイッチング・マトリクスへのセットアップの送信などに使用
されます。作成したセットアップは、スイッチ セットアップ専用のプリ

セット グループに保存可能です。このグループは、テスト セットアップ用
のプリセット グループとは別のグループです。

Switch Setup スイッチ セットアップを作成します。Input-to-Outputクロス ポイントをク
リックすることでセットアップを作成します。セットアップをスイッチン
グ・マトリクスに送るには Apply Switch Setupボタンをクリックします。

Setup Name スイッチ セットアップの名前

Clear All 全クロス ポイントの設定をオープンに設定します。

Input スイッチング・マトリクスの入力ポート名と、入力ポー

トに接続されている測定リソース名を表示します。入力

ポートと測定リソースの関連付けは Configurationウイン
ドウの Switching Matrixタブ画面で行います。

Label 測定リソースに設定されているラベルを表示します。こ

のラベルはアプリケーション・テスト定義またはクラ
シック・テスト セットアップで設定されます。

ALL このチェックボックスをチェックすると、この行すべて

をクローズに設定します。チェックを外すと、この行す
べてをオープンに設定します。

この行にクローズの設定がある場合、このチェックボッ

クスはグレーになりチェックを表示します。

Output 出力チャネル 1から 12、24、36、または 48。チャネル数
はスイッチング・マトリクスに装着されているマトリク

ス・カードの数に依存します。チャネル番号下のフィー
ルドにラベルを入力することができます。

クロス ポイントの色 スイッチ セットアップ

グリーン クローズ

グレー オープン
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Export to Current 
My Favorite Group

スイッチ セットアップをクラシック・テスト上のスイッチング・マトリク
ス設定データ フォーマットに変換し、現在開かれているMy Favorite Setup
グループに保存します。

Apply Switch 
Setup

スイッチング・マトリクスにスイッチ セットアップを送ります。

Read Switch Setup スイッチング・マトリクスからスイッチ セットアップを読み取ります。

Open All スイッチング・マトリクスの全リレーをオープンします。

Preset List 作成したスイッチ セットアップを再利用するためには、プリセット グルー
プに保存しておきます。

Preset Listボタンは、次の機能を有するメニューを表示します。プリセット 
グループを選択するにはボタン下のフィールドを使用します。スイッチ 
セットアップを選択するにはフィールド下のエリアを使用します。

Cancel このメニューを閉じます。

Preset Group 次の 5つの機能を提供します。

New... Add Preset Groupダイアログ ボックスを開きま

す。新しいプリセット グループを指定した名前

で作成します。

Rename... Rename Preset Groupダイアログ ボックスを開き

ます。選択されたプリセット グループの名前を

変更することができます。

Delete 選択されたプリセット グループを削除すること

ができます。

Duplicate... Duplicate Preset Groupダイアログ ボックスを開き

ます。開いているプリセット グループのコピー

を指定した名前で作成します。

Organize... Organize Preset Groupダイアログ ボックスを開き

ます。プリセット グループの整理に使用します。

｢Organize Preset Group (p. 1-90)｣を参照してくださ
い。

Rename 選択されたスイッチ セットアップの名前を変更

することができます。

Duplicate 選択されたスイッチ セットアップのコピーを作

成します。
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Delete 選択されたスイッチ セットアップを削除します。

Delete All 現在のプリセット グループのすべてのスイッチ 
セットアップを削除します。

Save 現在のスイッチ セットアップを、現在のプリセット グループに、新しいス
イッチ セットアップとして保存します。

Recall 選択されたスイッチ セットアップをリコールします。これによって、選択

されたスイッチ セットアップの設定内容が表示されます。
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Standby Channel Definition
Standby Channel Definitionウインドウは Standbyボタンをクリックすること
で開き、スタンバイ・チャネルの定義とスタンバイ・モードの設定に用い

られます。「スタンバイ機能 (p. 4-40)」を参照してください。
スタンバイ・チャネルは、スタンバイ・モード ONかつ非測定状態におい

て、指定された出力を続けるチャネルです。このときスタンバイ・チャネ
ルはスタンバイ状態、その他のチャネルはアイドル状態（0 V出力、100 
Aコンプライアンス）にあります。スタンバイ・モード OFFかつ非測定状

態では、全チャネルはアイドル状態にあります。

Standby Channel 
Control

このエリアには次のボタンがあります。

Standby ON/OFF スタンバイ・モード ONまたは OFFに設定します。

Standby Channel 
Definition

このエリアではスタンバイ・チャネルを定義します。スタンバイ・チャネ

ルは順番に出力を開始します。その順番は、このエリアの設定で上から下
の順番となります。出力停止の順番はその逆となります。

Standby スタンバイ・チャネルを指定するにはチェック・ボック

スをチェックします。

ラジオ・ボタンは、Up/Downボタンに有効なチャネル・
セットアップを選択します。

Unit スタンバイ出力に使用する SMUまたは UHVU

セレクタ（N1258A、N1259A-300、N1265A）または
N1266Aエクスパンダに接続された測定リソースを指定

する場合は、そのチャネルが Configurationウインドウで
Default出力に設定されている必要があります。

AUXポートへのパスを形成している ASU（アト・セン
ス／スイッチ・ユニット）に接続された SMUをスタン
バイ・チャネルに設定することはできません。

Mode 出力モード V（電圧）または I（電流）

Source スタンバイ・チャネル出力値、Vまたは A

Compliance コンプライアンス値。 電圧源の電流制限値、または電流

源の電圧制限値を入力します。

Up または Down Standbyラジオ・ボタンで選択されているチャネル・
セットアップを上・下に移動します。
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Data Display
Data Displayウインドウは Data Displayボタンをクリックすることで開き、

測定データの表示と解析に用いられます。

• Data Displayウインドウの GUI
• Display Setup

• Analysis Setup

• Graph Preference

• List Display Preference

• ツールバー

• データ ステータス

• セットアップ・サマリ

• 操作上の補助機能
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NOTE 表示モードについて

Data Displayウインドウは 2つの表示モード Overwriteと Appendを提供し

ます。

Overwriteモードでは、Display Data (p. 1-35)ファンクションは新規に Data 
Displayウインドウを開いて、データを表示します。

Appendモードでは、Display Data (p. 1-35)ファンクションは現在の Data 
Displayウインドウの上に、データを表示します。

NOTE データの再計算

クラシック・テスト実行結果を表示している場合、ユーザ関数、アナリシ

ス関数、自動解析機能の再計算を行うことが可能です。それには Applyボ
タンを使用します。｢ Function Setup (p. 2-47) ｣を参照してください。

NOTE 重ね書き測定

重ね書き測定を実行すると、ツールバーとグラフ表示領域の間にタブが現

れます。このタブを用いて、データ表示・解析操作を行う表示層を選択し

ます。Data Displayウインドウは最大 50（システムメモリ総量が 1 GB以下
の場合は 20）の表示層を持つことができます。

NOTE Multi Display機能について

Multi Display OFF状態では、テスト セットアップが変更されたとしてもテ
スト結果データは常に同じ Data Displayウインドウに表示されます。Multi 
Display ON状態では、同じ名前のテスト セットアップによるテスト結果
データは共通の Data Displayウインドウに、異なる名前のセットアップに

よるデータは新しい Data Displayウインドウに表示されます。

NOTE Data Displayウインドウ、X-Y Graph上の X 軸・Y 軸には、Display Setupの設
定が適用されます。そして、X 軸には 1つの Xデータ、Y 軸には最大 8つ
の Yデータを割り当てることが可能です。

Multi Channel I/V Sweep測定結果を X-Y Graphにプロットする場合は、X 軸

の設定に注意が必要です。それは、複数の VAR1チャネルによる測定デー
タが存在する場合に、複数の Xデータが X 軸の選択肢となり得るからで

す。

グラフ上で注目しているプロットの Xデータと X 軸のデータに不一致が生

じないように、Display Setupで適切な設定を行ってください。
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Data Display ウインドウの GUI

Setup Name このテスト レコードの入手に使用されたテスト セットアップの名前が表示

されます。

X-Y Graph Plot このエリアには、測定結果グラフ、トレース、マーカ、カーソル、ライン

が表示されます。

Preference このメニューは、次の機能を提供します。

Edit... Graph Preference (p. 1-138)を開きます。

Import... Graph Plotエリアの設定ファイルを指

定してインポートするためのダイアロ

グ ボックスを開きます。

Export... 現在の設定を指定したファイルにエク

スポートするためのダイアログ ボック
スを開きます。

Save as Default 現在の設定をデフォルト設定として

セーブします。

Reset to 現在の設定を破棄して、セーブされて

いるデフォルト設定（Default）または
工場出荷時の設定（Factory Default）に
します。

Parameters このエリアには、ユーザ定義出力パラメータのリストが表示されます（パ

ラメータが設定されている場合）。

List Display このエリアには、測定結果データのリストが表示されます。

Preference このメニューは、次の機能を提供します。

Edit... List Display Preference (p. 1-141)を開き

ます。

Save as Default 現在の設定をデフォルト設定として

セーブします。

ピン Data Display ウインドウは最大 50（システムメモリ総量が 1 GB以下の場合
は 20）の表示層を持つことができ、これを超える表示層は古い順に自動消
去されます。このボタンは 2 個以上の表示層が存在する場合に現れます。

ボタン内のピンが縦向きである場合、この表示層は保持されます。横向き

である場合、この表示層は自動消去の対象となります。表示層選択タブを
ダブルクリックすることによって、このボタンと同じ動作が得られます。
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X このボタンは選択された表示層を閉じます。

File メニュー 次の機能を提供します。

Close 選択された表示層を閉じます。

Close All すべての表示層を閉じます。

Update スケールや解析ツールの状態を保存します。

Delete 現在の表示データまたは選択された表示層を削除し

ます。

Save Image... Save Image As...ダイアログ ボックス（Figure 1-10）
を開きます。保存するグラフイメージのファイル名
を設定します。BMP、EMF、GIF、または PNG 形式

で保存できます。

Page Setup... Page Setupダイアログ ボックスを開きます。印刷

ページの設定に使用します。

Print Preview Print Previewダイアログ ボックスを開きます (Figure 
1-11)。表示するグラフイメージの Print Range/Data to 
print/Scalingの設定に使用します。Previewボタンをク
リックすると Print previewウインドウが開きます。

• Print Range（範囲）はWhole Data Display（ウイ
ンドウ全体）または Graph Only（グラフだけ）を
設定します。

• Data to print（データ）は Current Data Display（現

在アクティブな Data Displayウインドウだけ）ま
たは All opened Data Display（開かれている Data 
Displayウインドウすべて）を設定します。

• Scaling（大きさ）は Adjust To X % Normal Size
（規定大に対する比率を指定）または Fit To Page
（ページに合わせた自動調整）を設定します。

Print... Printダイアログ ボックスを開きます（Figure 1-10）。
印刷するグラフイメージの Print Range/Data to print/ 
Scaling（Print Preview参照）の設定に使用します。
Nextボタンをクリックすると、別の Printダイアロ
グ ボックスが開きます。プリンタ、印刷範囲、コ

ピー数の設定および、印刷の開始に使用します。
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Export to Excel グラフイメージ、リスト データ、パラメータ データ
をMicrosoft Excelに直接エクスポートします。

Microsoft Excel 2003、 2007、または 2010をサポート
します。エクスポートするテスト レコードのスタイ
ルの定義は Excel Data Export settings (p. 1-161)で行い
ます。

Exit Data Displayウインドウを閉じます。

Figure 1-10 Save Image... と Print...

bmp, emf, gif, or png format
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Figure 1-11 Print Preview 使用例

Edit メニュー 次の機能を提供します。

Copy Image グラフのイメージを BMPおよび EMFでクリップ
ボードにコピーします。

Copy List リスト データを CSVでコピーします。

Copy Parameters パラメータ データを CSVでコピーします。

Setup > Display... Display Setup (p. 1-135)を開きます。

Setup > Analysis... Analysis Setup (p. 1-136)を開きます。

Preference > Graph... Graph Preference (p. 1-138)を開きます。

Preference > List... List Display Preference (p. 1-141)を開きます。

Figure 1-12にグラフのコピー＆ペーストの例を示します。Edit > Copy Image
メニューを選択し、WordPadに Paste（貼り付け）すると、このような結果
を得ることができます。
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Figure 1-12 グラフのコピーと貼り付け

Figure 1-13はリストのコピー＆ペーストの例です。Edit > Copy Listメ
ニューを選択し、Notepadに Paste（貼り付け）すると、このような結果を
得ることができます。Notepad上の各データはカンマで区切られています

（CSVデータ）。Notepad上のデータをテキスト ファイルで保存し、スプ
レッドシート ソフトウェアで読み取ると、そのファイルは、全データがセ

ルの中に収まった状態でオープンされます。

Figure 1-13 リストのコピーと貼り付け

View メニュー 次の機能を提供します。

Graph X-Y Graph Plotの表示／非表示を切り替えます。

List List Displayの表示／非表示を切り替えます。

Copy to Clipboard

Paste to WordPad

Copy to Clipboard

Paste to Notepad
Keysight EasyEXPERT ユーザ・ガイド Vol. 1、第 5版 1-129



メイン GUI
Data Display
Parameters Parametersの表示／非表示を切り替えます。

Legend グラフ凡例（プロット下）の表示／非表示を切り替

えます。

Line Information ライン情報（X 切片、Y 切片、傾き。プロット エリ

ア内）の表示／非表示を切り替えます。

Secondary Sweep 
Labels 二次掃引のラベルの表示方法を選択します。

Preview Preview (p. 1-153)と Preview Settings (p. 1-155)を開き

ます。

Append Appendモードの有効／無効を切り替えます。

Icon ツールバー上の各機能ボタンの表示／非表示を切り

替えます。

Zoom メニュー 次の機能を提供します。

Target Axis Data Display画面に複数の表示層が開かれている場合

に、スケールの変更がすべての表示層に対して行わ

れるか選択されている表示層のみに行われるか選択
します。

Auto Scale > All Y 
Axes トレースがグラフに収まるようにグラフのスケール

を自動変更します。 Data Display画面に複数の表示層

が開かれている場合は、すべての表示層に対して実
行されます。

Auto Scale > Active Y 
Axis トレースがグラフに収まるようにグラフのスケール

を自動変更します。 Data Display画面に複数の表示層

が開かれている場合は、選択されている表示層にの
み実行されます。

Run Time Auto Scale ランタイム・オートスケールを有効または無効にし
ます。Y 軸、X 軸個別に設定できます。この機能が

有効であれば、測定実行中のトレースがグラフに収
まるようにグラフのスケールが自動変更されます。

Cancel Scaling 直前のスケーリング操作を無効にします。

Cancel All Scaling すべてのスケーリング操作を無効にします。
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Undo Scaling このメニューはグラフがズームされている場合に有

効です。このメニューを選択すると、直前のスケー

リング操作を無効にします。グラフをズームするに

はポイント・アンド・ドラッグ操作を行います。

Redo Scaling このメニューは Undo Scaling操作が行われた場合に

有効です。このメニューを選択すると、直前の Undo 
Scaling操作を無効にします。

Axis メニュー 次の機能を提供します。

Active Y Axis マーカの制御とオートスケールに有効な Y 軸を選択

します。

X Axis X 軸の表示フォーマットを切り替えます。

Direction 増または減方向を切り替えます。

Scale Type リニアかログかを切り替えます。

Polarity 正負の極性を切り替えます。

Y Axis Y 軸の表示フォーマットを切り替えます。

Direction 増または減方向を切り替えます。

Scale Type リニアかログかを切り替えます。

Polarity 正負の極性を切り替えます。

Marker メニュー マーカは測定曲線上を移動できます。次の 6つの機能を提供します。

Enable マーカをオンします。

Interpolation 測定データ補間機能をオンします。2つの実測デー
タ間の補間データを読むことができます。

Skip 複数の測定曲線がある場合、曲線間のマーカ移動に

使用します。

Go To Maximum 最大測定値にマーカを移動します。

Go To Minimum 最小測定値にマーカを移動します。

Go To... マーカ移動先（座標値）のを指定に使用する Direct 
Marker/Cursorダイアログ ボックスを開きます。

Cursor メニュー カーソルはグラフ上、任意の場所に移動できます。次の 3つの機能を提供

します。

Enable カーソルをオンします。
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Go to Marker カーソルをマーカ位置に移動します。

Go to... カーソル移動先（座標値）のを指定に使用する

Direct Marker/Cursorダイアログ ボックスを開きます。

Line メニュー 次の 5つの機能を提供します。 ラインをオンにすると、傾き、X 切片、Y
切片がグラフに表示されます。Figure 1-14を参照してください。

Enable 1 ライン 1をオンします。

Enable 2 ライン 2をオンします。

Mode Normal、Gradient、Tangent、Regression、または Fix。
Adjust Gradient Gradientラインに有効です。この機能をチェックす

ると、ロータリ・ノブ／マウス・ホイールを使って、
ラインの傾きを増減できます。

この機能のチェックを外すか、ロータリ・ノブ／マ

ウス・ホイールを押すとこの機能はオフになります。

Gradient... Gradientラインの傾きの値を設定する Gradient Value
ダイアログ ボックスを開きます。

Figure 1-14 ライン モード

各ラインの描画は、次のように行います。

1. ライン 1またはライン 2をオンします。

2. ライン モードを選択します。

Normal ラインと 2つのカーソルが現れます。カーソルを移動

して 2つのカーソルを通るラインを描画します。

2 cursors
1 cursor
gradient

marker
data curve

2 cursors
measured data

Regression lineTangent lineGradient lineNormal line
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Gradient ラインと 1つのカーソルが現れます。カーソルを移動

してラインが通る点を特定します。Adjust Gradientファ
ンクションを有効にしてから、ロータリ ノブ／マウス 
ホイールを使って、ラインの傾きを変更します。

Tangent ラインが現れます。マーカをオンすると、マーカの位

置に接線が現れます。

Regression ラインと 2つのカーソルが現れます。2つのカーソルを

移動して回帰計算に使用する測定データを特定します。
回帰計算は 2つの十字カーソル線の延長線が描く四角

内に含まれる測定データを用いて行われます。バイア

ス同期掃引測定データの解析では、マーカを用いるこ
とで対象のカーブを特定します。

Fix ラインを固定します。

Text メニュー 20 個までのテキストを、グラフ上に追加できます。次の機能を提供しま

す。

New 新しいテキストを追加するテキスト・エディタを開

きます。

Hide All すべてのテキストを非表示にします。

Delete All すべてのテキストを削除します。

テキストをクリックすると、選択状態になります。キーボードの Shift キー
を押しながらテキストをクリックすると、複数のテキストが選択状態にな
ります。

以下の機能は、選択状態のテキストに有効であり、Textメニュー、Textア
イコン、またはコンテキスト・メニューによって提供されます。コンテキ

スト・メニューは、テキストの上でマウスの右ボタンをクリックすること
で現れます。

Edit Mode 選択状態のテキストを編集します。

Size 選択状態のテキストの文字サイズを設定します。設

定値には Largest、Large、Medium、Small、Smallest、
Fixed Point（6、7、8、9、10、11、12、14、16、18、
20ポイントのいずれか）が有効です。Fixed Point以
外の設定では、グラフの大きさに応じた文字サイズ
が自動選択されます。Fixed Pointに設定した場合は、
グラフの大きさに関係なく、設定された文字サイズ
が適用されます。

Font 選択状態のテキストのフォントを設定します。
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Text Color 選択状態のテキストの文字色を設定します。

Customizeを選択するとカラー・パレットが開きま

す。

Background Color 選択状態のテキストの背景色を設定します。

Customizeを選択するとカラー・パレットが開きま

す。

Hide Frame 選択状態のテキストの枠を非表示にします。

Delete 選択状態のテキストを削除します。

Pointer メニュー 30 個までのポインタを、グラフ上に追加できます。次の機能を提供しま

す。

New Marker ON時に有効です。新しいポインタをマーカ

位置に追加します。

Hide All すべてのポインタを非表示にします。

Delete All すべてのポインタを削除します。

ポインタをクリックすると、選択状態になります。キーボードの Shift キー
を押しながらポインタをクリックすると、複数のポインタが選択状態にな
ります。

以下の機能は、選択状態のポインタに有効であり、Pointerメニュー、
Pointerアイコン、またはコンテキスト・メニューによって提供されます。

コンテキスト・メニューは、ポインタの上でマウスの右ボタンをクリック
することで現れます。

Shape 選択状態のポインタの形状を設定します。

Description > Hide 
Description 選択状態のポインタの情報を非表示にします。

Description > Show All すべてのポインタ情報 (ポインタ IDと X-Y 座標

値）を表示します。

Description > Hide All すべてのポインタ情報を非表示にします。

Delete 選択状態のポインタを削除します。

Window メニュー 次の 3つの機能を提供します。

Tiling すべての Data Displayウインドウを画面上に並べて

表示します。
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Stacking すべての Data Displayウインドウを画面上に重ねて

表示します。

Overlaying すべての Data Displayウインドウを画面上に重ね合

わせて表示します。 いちばん手前の Data Displayウ
インドウの位置、サイズ、表示 /非表示が、画面上
のすべてのData Displayウインドウに適用されます。 

いちばん奥のウインドウを除いて、X-Y Graphエリ
アの背景はクリアされます。

Help メニュー Contents... EasyEXPERT ヘルプ ウインドウを開きます。

コンテキスト・

メニュー

各エリアで右クリックすると、以下のメニューを表示します。

Undo Scaling 直前のスケーリング操作をキャンセルします。

Redo Scaling 直前の Undo Scaling 操作をキャンセルします。

Save Image... Save Image As... ダイアログ ボックスを開きます。

Export to Excel グラフイメージ、リストデータ、パラメータデータを

Microsoft Excel に直接エクスポートします。

Display Setup
このダイアログ ボックスは Edit > Setup > Display...を選択することによって

開き、表示データの選択に用いられます。

X-Y Graph X-Y Graph Plotエリアへの表示データを選択します。 X 軸と Y1 ～ Y8 軸を

設定できます。

Name 軸のパラメータを指定します。

Sharing Y 軸スケールの共有を行うグループを指定します。

Group 1、Group 2、Group 3、Group 4、None（共有しな

い）のいずれか。

Scale、Min、Maxの設定値は、同じグループに設定され

た複数の Y 軸によって共有されます。また、Run Time 
Auto Scale、Auto Scale、Zoom in、 Zoom outによって変更
されるスケールも共有されます。

グルーピングされた Y 軸パラメータと対応する X 軸パラ

メータの両方と同じ名称の X-Yトレースが、同一ウイン

ドウ上、他の表示層に存在する場合、その X-Yトレース
にもスケールの設定・変更が共有されます。
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Scale 軸のスケール。 リニアまたはログ。

Min 軸の最小値。

Max 軸の最大値。

Auto 実行時にオート スケールを自動的に実行します。

Add パラメータ（または軸）を追加します。

Delete 選択したパラメータを削除します。 パラメータを選択す

るには、左側のラジオ ボタンを使用します。

Up/Down 選択したパラメータを上、または下に移動します。

List Display, 
Parameters

List DisplayエリアあるいはParametersエリアへの表示データを選択します。 

各エリアに対して最大 20のパラメータを設定できます。

Add パラメータの行を追加します。

Delete 選択したパラメータを削除します。 パラメータを選択す

るには、左側のチェック ボックスを使用します。

Up/Down 選択したパラメータを上、または下に移動します。

Analysis Setup
Data Displayウインドウで Edit > Setup > Analysisをクリックすることによっ
て表示され、自動解析機能の設定に用いられます。自動解析機能は、測定
が終了すると、ライン、マーカ、またはその両方を Data Displayウインド
ウの X-Y Graph上に自動的に描画します。

この画面では、自動解析機能による制御が可能な 2つのラインと 1つの
マーカを設定します。Line 1および Line 2エリアでは描画するラインを、
Markerエリアではマーカを設定します。

Interpolation Mode このボックスをチェックすると、補間モードが有効になります。 測定点間
にマーカを配置することができます。 

Line 1, Line 2 測定終了後、指定位置に自動表示されるライン 1または 2を設定します。

Enable  ラインを有効にするにはこのボックスをチェックします。

Type 下記 4 種類のライン タイプから 1つを選択します。

Axis ラインに対して有効な軸。 Y1 ～ Y8の中から指定しま

す。

First Point 選択したラインに対応する記述を参照してください。
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Second Point 選択したラインに対応する記述を参照してください。

ライン タイプ：

• Normal: 指定された 2点を通るライン。

• Gradient: 指定された 1点を通り、指定された傾きを持つライン。

• Tangent: 指定された測定点における接線。

• Regression: 指定領域に含まれる測定データを用いた回帰直線。

Marker 測定終了後、指定位置に自動表示されるマーカを設定します。

Enable  マーカを有効にするにはこのボックスをチェックします。

Condition マーカを表示する場所を決定する変数名と条件式を入力

します。

After 追加条件を有効にするには、このボックスをチェックし

ます。

2 番目の変数と条件式を入力します。 これは、指定した

ポイントの検索開始条件を設定します。

例えば、2 番目の条件が満たされた後で最初の条件を満たす測定点を検索

するには、次の式を指定します。

Condition:[DGM]=[MAX(DGM)*0.01] [x]After [DGM]=[MAX(DGM)]

Normal line First Pointエリアと Second Pointエリアで、ラインが通過するポイントを指

定します。 次の 2つの方法でポイントを指定できます。

• X-Y Coordinate

目的の X-Y 座標値または式を Xおよび Yフィールドに入力します。

• Data Condition

ポイントを指定する変数名と条件式を入力します。 これはMarkerポイ
ントを指定するのと同じ方法です。

Gradient line First Pointエリアで、ラインが通過するポイントを指定します。 次の 2つの
方法でポイントを指定できます。

• X-Y Coordinate

目的の X-Y 座標値または式を Xおよび Yフィールドに入力します。

• Data Condition
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ポイントを指定する変数名と条件式を入力します。 これはMarkerポイ
ントを指定するのと同じ方法です。

Gradientフィールドに、傾きの値または式を入力します。

Tangent line First Pointエリアで、接線が通過する測定点を指定します。

ポイントを指定する変数名と条件式を入力します。 これはMarkerポイント
を指定するのと同じ方法です。

Regression line First Pointエリアと Second Pointエリアで、回帰計算に使用される測定デー

タの範囲を指定します。 次の 2つの方法でポイントを指定できます。

• X-Y Coordinate

目的の X-Y 座標値または式を Xおよび Yフィールドに入力します。

• Data Condition

ポイントを指定する変数名と条件式を入力します。 これはMarkerポイ
ントを指定するのと同じ方法です。

Graph Preference
このダイアログ ボックスは Edit > Preference > Graph...または X-Y Graph Plot
エリアの Preference > Editを選択することによって開き、X-Y Graph Plotエ
リアの設定に用いられます。OKボタンをクリックするとセットアップが
適用され、このダイアログ ボックスが閉じます。

Use Present Graph 
Colors

プリセットされた設定またはカスタマイズ設定を選択します。

Standard Standardプリセット設定
Tracer Test Tracer Testプリセット設定
Grayscale Grayscaleプリセット設定
Customized 独自の設定を行う場合に選択します。またはプリセット

設定に変更を行うと自動的に Customizedになります。

Color and Style タ

ブ

色と表現方法を選択します。
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Graph Trace Color
タブ

グラフにプロットされるデータ トレース Y1から Y8の表示／非表示、色、

プロットのスタイル、線の太さ設定します。

Visible データ トレースの表示／非表示の選択。表示す

る場合はチェックボックスをチェックします。

Color Style

Background: 背景色の設定 n.a.

Text: テキストの色の設定 n.a.

Grid: グラフ罫線の色の設定 グラフ罫線の実線／破線の設定

Line/Cursor: グラフの線／カーソル

の色の設定

グラフの線／カーソルの実線／

破線の設定

VAR2 Label: VAR2ラベルの色の設

定

VAR2ラベルの位置の設定

Adjacent 対象ラインの近傍に

表示されます。

Adjacent, 
Pointing 
Line

対象ラインの近傍に

表示され指示線も同

時に表示されます。

Adjacent, 
Merge

各対象ラインの近傍

の表示され位置が近

いラベルはまとめて

表示されます。

Adjacent, 
Pointing 
Line, 
Merge

各対象ラインの近傍

の表示され位置が近

いラベルはまとめて

表示されます。同時

に指示線も表示され

ます。

Line Up, 
Pointing 
Line

各ラベルは一列に表

示され指示線も同時

に表示されます。
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Color データ トレースの表示色。カラーパターンをを

クリックするとカラーパレットが開き、表示色

の変更ができます。

Style データ トレースの表現スタイル。線またはプ

ロットの形を選択します。

Thickness データ トレースの線の太さ。

Change Line Color with 
Append Measurement: Enableをチェックすると Append測定時に線の

表示色がカラー パターンの色に変わります。カ

ラーパターンををクリックするとカラーパレッ

トが開き、表示色の変更ができます。

Format タブ Maximum decades to 
show minor ticks ログ軸上の細かい目盛の表示を可能とするディ

ケード数の最大値を設定します。

Grid Rule (Linear): リニア軸の目盛の本数設定。

Auto 自動設定。

10 Line Fixed 10本固定。

Analytic Values’ Display 
Format: Cursor（カーソル）、Marker（マーカ）、Intercept

（交点）の値の表示桁数、フォーマットを設定しま

す。

Format Engineering（工学表記）または

Scientific（指数表記）。

No. of Digits 表示桁数。

Text Size タブ グラフ上の文字サイズを設定します。設定値には Largest、Large、Medium、
Small、Smallest、Fixed が有効です。Fixed以外の設定では、グラフの大き
さに応じた文字サイズが自動選択されます。Fixedに設定した場合は、文字
サイズ入力フィールドが有効となり、グラフの大きさに関係なく、入力さ
れた文字サイズが適用されます。

X/Y Axis Title 軸タイトルの文字サイズを設定します。

Scale X 座標値、Y 座標値の文字サイズを設定します。

Legend グラフ凡例の文字サイズを設定します。

Options タブ Data Display上の以下の項目の表示／非表示を設定します。
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Setup Name テスト セットアップ名のウインドウ左上への表

示／非表示。

Keysight Logo グラフ・エリア左上への Keysightロゴの表示／

非表示。

Grid グラフのグリッドの表示／非表示。

Marker Guide Line マーカを選択するためのガイド ラインの表示／
非表示。

Active Side Indicator 有効サイドを示すラインの表示／非表示。

All Subscale Values 全てのサブスケール値を表示するかどうか。

Unit Symbols スケール値への単位シンボルの表示／非表示。

Secondary Sweep Labels 二次掃引のラベルの表示／非表示。

Device ID Device IDの表示／非表示。

Setup Summary I/V SweepとMulti Channel I/V Sweepクラシッ
ク・テストに有効。グラフ・エリア下部にチャ

ネル設定の簡易情報の表示／非表示。「セット

アップ・サマリ (p. 1-145)」を参照してくださ
い。

Parameters Parametersエリアの有効／無効。
Always on Top Data Displayウインドウを常に一番上に表示す

る。

List Display Preference
このダイアログ ボックスは Edit > Preference > List...または List Displayエリ
アの Preference > Editを選択することによって開き、List Displayにおける
データ表示の書式設定に用いられます。OKボタンをクリックするとセッ
トアップが適用され、このダイアログ ボックスが閉じます。

Display 次のチェックボックスをチェックすることで、表示データにステータス 
コードや単位を追加します。チェックを外すと、それらは省かれます。

Data Status データの前にステータス コードをつけます。

Physical Unit データの後に単位をつけます。

Number Format データ表示の書式を次から選択します。

• Engineering Format（例：-1.2345 mA）
小数点、SIプレフィックス (接頭辞）、単位を伴うデータ表示。
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• Scientific Notation（例：-1.23456789012345E-003 A）
小数点、指数部（E、+/-、3 桁の数字）、単位を伴うデータ表示。

Position List Displayの位置を次から選択します。

Bottom Data Displayウインドウ下部
Right Data Displayウインドウ右部

ツールバー

Data Displayウインドウのツールバーには 29 個のアイコンがあります。ウ

インドウの左から右にかけて、次のアイコンが配置されています。

Switch Display 
Mode

このアイコンは、表示モードを切り替えます。

Overwriteモードでは、Display Data (p. 1-35)ファンクションは新規に Data 
Displayウインドウを開いて、データを表示します。

Appendモードでは、Display Data (p. 1-35)ファンクションは現在の Data 
Displayウインドウの上に、データを表示します。

Close All Displays このアイコンは、すべての表示層を閉じます。

Show X-Y Graph このアイコンは、X-Y Graph Plotエリアの表示／非表示を切り替えます。

Show List Display このアイコンは、List Displayエリアの表示／非表示を切り替えます。

Show Parameters このアイコンは、Parametersエリアの表示／非表示を切り替えます。

Choose Active 
Y-axis

このアイコンは、マーカの制御とオートスケールに有効な Y 軸を選択しま

す。

Show Graph 
Legend

このアイコンは、グラフ凡例をプロットの下に表示、または隠します。

Show Line 
Information

このアイコンは、ライン情報（X 切片、Y 切片、傾き）をプロット エリア

の中に表示、または隠します。

Change Zoom 
Target Axis

ズーム操作の対象が選択している表示層のみかすべての表示層かを切り替

えます。

Auto Scale このアイコンは、トレースがグラフに収まるようにグラフのスケールを変

更します。
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右側の矢印ボタンは、ランタイム・オートスケールを有効または無効にし

ます。Y 軸、X 軸個別に設定できます。この機能が有効であれば、測定実

行中のトレースがグラフに収まるようにグラフのスケールが自動変更され
ます。

Data Display画面に複数の表示層が開かれている場合には、スケールの変更

はすべての表示層に対して行われます。つまり X-Yグラフのスケールは、
すべての表示層で共有されています。この時、オートスケールは以下のよ
うに実行されます。

1. グラフのスケールは、選択された表示層（一番上の表示層）のデータに

対して最適化されます。

2. このグラフのスケールは、すべての表示層のグラフに適用されます。

オートスケールは、左の Y 軸と右の Y 軸に対して個別に実行されます。

グラフのスケールを元に戻すには、View > Cancel Scaling > This Displayまた
は All Displaysをクリックします。This Displayは、選択された表示層だけ

を元のスケールに戻します。All Displaysは、すべての表示層を元のスケー

ルに戻します。

Undo Scaling このアイコンは、グラフがズームされている場合に有効です。このボタン

をクリックすると、直前のスケーリング操作を無効にします。グラフを

ズームするにはポイント・アンド・ドラッグ操作を行います。

Redo Scaling このアイコンは、Undo Scaling操作が行われた場合に有効です。このボタ

ンをクリックすると、直前の Undo Scaling操作を無効にします。

Marker ON/OFF このアイコンは、マーカをオン／オフします。

Interpolation 
ON/OFF

このアイコンは、測定データ補間機能をオン／オフします。2つの実測
データ間の補間データを読むことができます。

Marker Skip 複数の測定カーブがある場合、測定カーブ間のマーカ移動に使用します。

Marker Maximum このアイコンは、最大測定値にマーカを移動します。

Marker Minimum このアイコンは、最小測定値にマーカを移動します。

Marker Search... このアイコンは、マーカ移動先（座標値）の指定に使用する Direct 
Marker/Cursorダイアログ ボックスを開きます。

Line 1 State このアイコンは、ライン 1をオン／オフし、その機能を Disabled、Normal、
Gradient、Tangent、Regression、または Fixの中から選択します。
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Line 2 State このアイコンは、ライン 2をオン／オフし、その機能を Disabled、Normal、
Gradient、Tangent、Regression、または Fixの中から選択します。

Cursor to Marker このアイコンは、カーソルをマーカ位置に移動します。

Adjust Gradient Gradientラインに有効です。このアイコンをクリックすると、ロータリ ノ
ブ／マウス ホイールを使って、ラインの傾きを増減できます。

このアイコンを再度クリックするか、ロータリ ノブまたはマウス ホイール
を押すと、この機能はオフになります。

Display Setup... このアイコンは、Display Setup (p. 1-135)を開きます。

Reverse Y Axes 
Direction

このアイコンは、Y 軸の方向を切り替えます。

Switch Y Axes 
Scale

このアイコンは、Y 軸のリニア／ログを切り替えます。

Switch Y Axes 
Polarity

このアイコンは、Y 軸の極性を切り替えます。

Reverse X Axis 
Direction

このアイコンは、X 軸の方向を切り替えます。

Switch X Axis 
Scale

このアイコンは、X 軸のリニア／ログを切り替えます。

Switch X Axis 
Polarity

このアイコンは、X 軸の極性を切り替えます。

データ ステータス

測定中に、測定モジュールが何かのステータスを検出した場合、ステータ

ス コードが測定データに記録されます。ステータス コードは下記の例のよ
うに Data Displayウインドウに現れます。

表示例 • X-Y Graph Plotエリア

MARKER( 5.9000000   C 1.82520000  XV 3.33249E-3 )
この行はマーカが ONになっているときにプロット エリアの上に現れ

ます。マーカは、示す点の測定データを読むために用いられます。

• List Displayエリア
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Index V1 V2  I2
123 5.9 V C 1.8252 V XV 3.33249 mA

ステータス コード ステータス コードとその意味をリストします。

SMUステータス コード：

• C：このチャネルがコンプライアンスに達しています。

• T：他のチャネルがコンプライアンスに達しています。

• X：1つ以上のチャネルが発振しています。

• V：測定範囲を超えています。

MFCMUステータス コード：

• U：NULLループ・アンバランス状態です。

• D：IVアンプ飽和状態です。

• V：測定範囲を超えています。

セットアップ・サマリ

この機能は I/V SweepおよびMulti Channel I/V Sweepクラシック・テストで
使用できます。Graph Preferenceダイアログ ボックスまたは Preferenceダイ
アログ ボックスで、Setup Summary ONに設定すると、チャネル設定の簡易

情報がグラフ領域下部に表示されます。

以下のように、1チャネルの設定内容は一行に表示されます。ここで、{}
内は設定値を示しています。

VAR1 チャネル 電圧出力の場合 :
{V Name}: [{Start}, {Stop}] V / {No. of Steps}; {I Name}: {Compliance} A; {Pwr Comp} 
W

電流出力の場合 :
{I Name}: [{Start}, {Stop}] A / {No. of Steps}; {V Name}: {Compliance} V; {Pwr Comp} 
W

例：VDS: [0, 10] V / 101; ID: 1 A; 1 W

VAR2 チャネル 電圧出力の場合 :
{V Name}: [{Start}, {Stop}] V / {Step} V; {I Name}: {Compliance} A; {Pwr Comp} W

電流出力の場合 :
{I Name}: [{Start}, {Stop}] A / {Step} A; {V Name}: {Compliance} V; {Pwr Comp} W
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例：VGS: [0, 5] V / 1 V; ID: 1 mA; 1 mW

Constant チャネル 電圧出力の場合 :
{V Name}: {Source} V; {I Name}: {Compliance} A

電流出力の場合 :
{I Name}: {Source} A; {V Name}: {Compliance} V

コモンの場合 :
{V Name}: COMMON

例：VSUB: -1 V; ISUB: 1 mA
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操作上の補助機能

次のユーザ・インタフェースは、Data Displayウインドウの操作において
様々な補助機能を提供します。

• マウス／タッチパネル

• ロータリーノブ

• ソフトキー

• キーボード

マウス／タッチパネル

Data Displayウインドウにフォーカスがある状態では、Table 1-13 (p. 1-151)
に見られるマウス／タッチパネル操作が可能です。

ロータリーノブ

ロータリーノブを使用する、次の操作が可能です。

• マーカ移動 VAR1方向

グラフにマーカが表示されている状態で、Data Displayウインドウに
フォーカスがある場合は、マーカの移動にロータリーノブを使用できま
す。ノブを早回しすることによって、マーカの移動が加速します。

• マーカ移動 VAR2方向

ロータリーノブをクリックすることによって、マーカを VAR2方向に移

動させることができます。

• Gradientラインの傾き調整

Gradientラインの傾き調整モード（Line > Adjust Gradient）では、傾きの
調整にロータリーノブを使用できます。ノブをクリックすることによっ
て、このモードから抜けます。

• ポインタ移動 VAR1方向

選択されているポインタの移動にロータリーノブを使用できます。ポイ
ンタは VAR2方向へは移動できません。
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ソフトキー

Display Setup (p. 1-135)ウインドウ上のフィールド（下記）の設定にソフト
キーを使用できます。

• Name（パラメータ名）

• Scale（スケール、Linearまたは Log）

キーボード

Data Displayウインドウにフォーカスがある状態では、Table 1-8に見られる
キー操作が可能です。

Table 1-8 Data Display ウインドウにおける補助的なキー操作

また、X-Y Graph（グラフ表示エリア）にフォーカスがある状態では、次表

に見られるキー操作が可能です。

• Table 1-9, "グラフの制御 "

• Table 1-10, "マーカの制御 "

• Table 1-11, " カーソルの制御 "

• Table 1-12, "ラインの制御 "

キー操作 説明

F1 オンラインヘルプの表示

F2 View > X-Y Graphのショートカット

F3 View > List Displayのショートカット

F4 View > Parametersのショートカット

F12 表示モードを変更　Append  Overwrite  Append

Ctrl+W File > Close This Displayのショートカット

Ctrl+Shift+W File > Close All Displaysのショートカット

Ctrl+S File > Save Image As...のショートカット

Ctrl+P File > Print...のショートカット

Ctrl+C Edit > Copyのショートカット
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Table 1-9 グラフの制御

Table 1-10 マーカの制御

キー操作 説明

S View > Auto Scaleのショートカット

Z View > Zoom Inのショートカット

Shift+Z View > Zoom Outのショートカット

Ctrl+Z View > Cancel Scalingのショートカット

Y アクティブなデータを変更　Y1  Y2  ...  Y8  Y1

R グラフ右側の Y 軸をアクティブにし、その軸にセット

されるデータを変更　Y2  Y3  ...  Y8  Y2

W View > Graph Legend ON/OFFのショートカット

K View > Line Information ON/OFFのショートカット

キー操作 説明

M Marker > Marker ON/OFFのショートカット

I Marker > Interpolation ON/OFFのショートカット

F VAR1方向に +1 移動 a

a. Interpolation ON時の移動距離は 1/10

Shift+F VAR1方向に +10 移動 a

B VAR1方向に -1 移動 a

Shift+B VAR1方向に -10 移動 a

P VAR2方向に +1 移動

Shift+P VAR2方向に -1 移動

J Marker > Go To...のショートカット

X Marker > Go To Maximumのショートカット

N Marker > Go To Minimumのショートカット
Keysight EasyEXPERT ユーザ・ガイド Vol. 1、第 5版 1-149



メイン GUI
Data Display
Table 1-11 カーソルの制御

Table 1-12 ラインの制御

キー操作 説明

C Cursor > Cursor ON/OFFのショートカット

T Cursor > Go To Markerのショートカット

 Y 軸方向に +1/1000 移動

Shift+  Y 軸方向に +1/100 移動

 X 軸方向に +1/1000 移動

Shift+  X 軸方向に +1/100 移動

 Y 軸方向に -1/1000 移動

Shift+  Y 軸方向に -1/100 移動

 X 軸方向に -1/1000 移動

Shift+  X 軸方向に -1/100 移動

キー操作 説明

1 a

a. テンキーの 1と 2は使えません。

Line > Line 1 ON/OFFのショートカット

2 a Line > Line 2 ON/OFFのショートカット

V アクティブなラインを変更　Line 1  Line 2  Line 1 
(Line 1と Line 2が ONの時に有効 )

L アクティブなラインのモードを変更
Normal  Gradient  Tangent   Regression   Normal

G Line > Adjust Gradientのショートカット
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Table 1-13 Data Display ウインドウにおけるマウス／タッチパネル操作

対象 操作 説明

X-Y Graph グラフ左側の

Y 軸をクリック

Y1データをアクティブに設定

グラフ右側の

Y 軸をクリック

グラフ右側の Y 軸にセットされているデータをアクティ

ブに設定、あるいは、既にアクティブであれば、アク

ティブなデータを変更

プロットを

クリック

マーカが表示されていれば、マウスポインタの位置に

マーカを移動

カーソルを

クリック

複数のカーソルが表示されていれば、アクティブなカー

ソルを選択

カーソルを

ドラッグ

カーソルを移動

ラインを

クリック

複数のラインが表示されていれば、アクティブなライン

を選択

テキストを

クリック

テキストを選択状態に設定

キーボードの Shift キーを押しながらクリックすると、
複数のテキストを選択状態に設定

テキストを

ドラッグ

テキストを移動

ポインタを

クリック

ポインタを選択状態に設定

キーボードの Shift キーを押しながらクリックすると、
複数のポインタを選択状態に設定

ポインタ情報を

クリック

ポインタ情報を選択状態に設定

キーボードの Shift キーを押しながらクリックすると、
複数のポインタ情報を選択状態に設定

ポインタ情報を

ドラッグ

ポインタ情報を移動
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X-Y Graph マウスホイール

を回転

マーカが表示されていれば、マーカを移動

ポインタが選択状態であれば、ポインタを移動

Gradientラインの傾き調整モード（Line > Adjust Gradient）
では、Gradientラインの傾きを調整

マウスホイール

をクリック

ロータリーノブのクリックと同じ動作（マウスの設定で、

ホイールのクリックを中央ボタンに割り当てている場合

に有効）

List Display カラムヘッダを

ドラッグ

カラムを移動

カラムの境界線

をドラッグ

カラム幅を変更

テーブル上の行

をクリック

該当位置へマーカを移動

スクロールバー

を移動

List Displayに表示されるデータを変更、縦方向と横方向
にスクロール可能

マウスホイール

を回転

List Displayに表示されるデータを変更

その他 ツールバー下の

タブaをクリック

データ表示・解析操作を行う表示層を選択

ツールバー下の

タブ aをダブル
クリック

表示層につけられるピンの向き（縦・横）を変更

縦：データ保持対象の表示層

横：データ自動消去対象の表示層

表示エリア間の

境界をドラッグ

ウインドウの大きさを変更しないで、データ表示エリア

（X-Y Graph、List Display、Parameters）の大きさを調整

ウインドウの枠

をドラッグ

データ表示エリア（X-Y Graph、List Display、Parameters）
の大きさを調整しながら、ウインドウの大きさを変更

a. タブは、Data Displayウインドウの表示モードが Appendであり、テスト結果レコードに
重ね書き測定データが含まれている場合に現れます。

対象 操作 説明
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Previewウインドウと Preview Settingsダイアログ ボックスは、Data Display
ウインドウの View > Previewを選択することによって開きます。Preview 
Settingsダイアログ ボックスは、グラフ、X 軸、Y 軸のタイトルとライ

ン・スタイルの設定に用いられます。Previewウインドウは、新しいプロッ
トを表示します。また、そのプロットを指定プリンタへ出力することが可
能です。

Data Displayウインドウは、上記パラメータの設定、および新しいプロット
の表示を行うことができません。

• Previewウインドウの GUI
• Preview Settings

Preview ウインドウの GUI
Previewウインドウは次の GUIを提供します。

Setup Name このテスト レコードの入手に使用されたテスト セットアップの名前が表示

されます。

X-Y Graph Plot このエリアには、測定結果グラフ、トレース、マーカ、カーソル、ライン

が表示されます。

Parameters このエリアには、ユーザ定義出力パラメータのリストが表示されます（パ

ラメータが設定されている場合）。

List Display このエリアには、測定結果データのリストが表示されます。
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File メニュー 次の機能を提供します。

Page Setup... 印刷ページを設定するためのダイアログ ボックスを
開きます。

Print Preview プレビューを行うグラフの指定に使用するダイアロ

グ ボックスを開きます。グラフの特定後、プレ

ビューは Print previewウインドウに表示されます。
Figure 1-11を参照してください。

Print... 印刷対象の指定に使用するダイアログ ボックス
（Figure 1-10）を開きます。 対象を選択すると、Print
ダイアログ ボックスが開きます。 ダイアログ ボック
スから印刷を開始できます。

Exit Previewウインドウを閉じます。

Edit メニュー 次の機能を提供します。

Copy X-Y Graph Plotエリアがアクティブな時には、グラ
フのイメージを BMPおよび EMFでクリップボード
にコピーします。

List Displayエリアのラインカーソルがアクティブな

時には、リスト データを CSVでコピーします。

Parametersエリアがアクティブな時には、パラメー
タ データを CSVでコピーします。

Copy Image グラフのイメージを BMPおよび EMFでクリップ
ボードにコピーします。

Copy List リスト データを CSVでコピーします。

Copy Parameters パラメータ データを CSVでコピーします。

View メニュー 次の機能を提供します。

X-Y Graph X-Y Graph Plotの表示／非表示を切り替えます。

List Displays List Displayの表示／非表示を切り替えます。

Parameters Parametersの表示／非表示を切り替えます。

Settings... Preview Settings (p. 1-155)を開きます。

Help メニュー Contents... EasyEXPERT ヘルプ ウインドウを開きます。
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Preview Settingsダイアログ ボックスは次の GUIを提供します。

General グラフ タイトルを Graph Titleフィールドに設定します。タイトルはプロッ
ト エリアの下に現れます。

X/Y Axis Title X 軸のタイトルを Xフィールドに、Y 軸のタイトルを Yフィールド（Y1
から Y8）に設定します。タイトルは軸の近くに現れます。

Line Style ライン 1、ライン 2、トレース Y1から Y8のライン・スタイルを選択しま

す。

Color and 
Thickness...

Color and Thicknessダイアログ ボックスを開きます。このダイアログ ボッ
クスは Graph Preference (p. 1-138)と同じ GUIを提供します。

OK 設定を Previewウインドウに適用し、ダイアログ ボックスを閉じます。

Cancel 設定をキャンセルし、ダイアログ ボックスを閉じます。

Apply 設定を Previewウインドウに適用します。

Reset ダイアログ ボックス上の設定をクリアして、既定値に戻します。
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Text File Export settings
このダイアログ ボックスは Results > Export Options > Text File Export（また
は Test Results Data Folder Exportダイアログ ボックスあるいは Test Results 
Data Auto Exportダイアログ ボックスの Settings...ボタン）をクリックする
ことによって開きます。Export As Text Fileでエクスポートされるテスト レ
コードのスタイルを定義するために使用します。

Reset すべての設定項目に初期値を適用します。

OK 現在の設定を定義・記憶し、ダイアログ ボックスを閉じます。

Cancel 設定変更をキャンセルし、ダイアログ ボックスを閉じます。

Measurement Data
タブ

測定データに関する記録項目。測定パラメータ名、単位、データサイズを

含めることができます。記録項目の詳細については Table 1-14を参照して
ください。チェックボックスにチェックが残されている項目がテスト レ
コードに記録されます。

測定データに関係するタグデータとして、Dimension1、Dimension2、Data 
Name、Data Unit、Data Valueの文字列があります。これら文字列は、テス
ト レコード内で同じ列（Orientation=By Rowの場合は横方向、By Column
の場合は縦方向）に置かれるデータの種類を示します。タグデータは Tag 
informationボックスにチェックがある場合に記録されます。

Table 1-15は Orientation=By Rowのエクスポート例を示しています。ある測
定パラメータに関連するすべてのデータは同じ縦列に置かれます。そして

第 1縦列（例：A列）にタグデータが記録されます。Table 1-16は
Orientation=By Columnのエクスポート例を示しています。ある測定パラ
メータに関連するすべてのデータは同じ横列に置かれます。そして第 1横
列（例：1列）にタグデータが記録されます。Tag informationボックスに
チェックがない場合（初期値）、タグデータは記録されません。測定データ

が前列にシフトされます。
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Table 1-14 Measurement Data 記録項目（ON: チェックあり、OFF: チェックなし）

Table 1-15 Orientation=By Row によるエクスポート例

項目 説明 初期値

Tag information タグ情報 OFF

Data names 測定パラメータ名。 ON

Data units 測定データの単位。 OFF

Size 測定データの Dimension1（VAR1サイズ）と Dimension2（VAR2サ
イズ）。

OFF

Data values 記録項目。下記セグメント毎に設定できます。

セグメント 初期値

Data assigned to X-Y Graph（X-Y Graph Plotのデータ） ON

Data assigned to List Display（List Displayのデータ） ON

Data assigned to Parameter Display （Parametersのデータ） ON

User function defined but not displayed （表示されていないユーザ関
数）

OFF

Analysis function defined but not displayed 
（表示されていないアナリシス関数）

OFF

Any data referred to by the user function but not directly displayed 
（ユーザ関数が参照している表示されていないデータ）

OFF

Any data referred to by the analysis function but not directly displayed 
（アナリシス関数が参照している表示されていないデータ）

OFF

Data is displayed by two dimensional array
（二次元配列で表示されているデータ）

OFF

A B C D E F

1 Dimension1 101 101 101 1

2 Dimension2 1 1 1 1

3 Data Name Vg Id Gm Vth
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Table 1-16 Orientation=By Column によるエクスポート例

Identification タブ Identification section 
Save Typeラジオボタンは、Identification sectionの項目の

記録動作を特定します。記録動作については Table 1-17
を参照してください。

テスト レコードを識別するための記録項目。テスト名、

テストタイプ、メタデータの一部など。記録項目の詳細

については Table 1-18を参照してください。チェック
ボックスにチェックが残されている項目がテスト レコー
ドに記録されます。初期設定では、全項目がチェックさ

れます。

Table 1-17 Identification、Setup Data の記録動作

4 Data Unit V A S V

5 Data Value 0 4.55E-09 1.24E-10 1.23

6 Data Value 0.02 8.59E-09 5.25E-10

A B C D E F

1 Dimension1 Dimension2 Data Name Data Unit Data Value Data Value

2 101 1 Vg V 0 0.02

3 101 1 Id A 4.55E-09 8.59E-09

4 101 1 Gm S 1.24E-10 5.25E-10

5 1 1 Vth V 1.23

6

A B C D E F

動作 説明

Save with measurement data チェックされた項目が測定データと一緒に

テスト レコードに記録されます。初期設定。

Do not save チェックされた項目があっても、何も記録

されません。

Save as separate file チェックされた項目がテスト レコードとは
別のファイルに記録されます。ファイル名

には -sがつけられます（拡張子の前）。
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Table 1-18 Identification 記録項目

Setup data section テスト セットアップ データに関する記録項目。テスト 
パラメータ、DUTパラメータ、アナリシス パラメータ。
記録項目の詳細については Table 1-19を参照してくださ
い。チェックボックスにチェックが残されている項目が

テスト レコードに記録されます。

セットアップ データに関係するタグデータとして、

TestParameter、DutParameter、AnalysisSetupの文字列があ
ります。これら文字列は、テスト レコード内で同じ横列

に置かれるデータの種類を示します。タグデータは Tag 
informationボックスにチェックがない場合（初期値）は
記録されません。この場合、Channel.Unitのような設定
パラメータ名がテスト レコードの第 1縦列に記録され、
第 2縦列以降にパラメータ値が記録されます。Tag 
informationボックスにチェックがある場合には、テスト 
レコードの第 1縦列にタグデータが記録され、設定パラ
メータ名とパラメータ値は第 2縦列以降に記録されます。

プルダウン メニューは、Setup data sectionの項目の記録

動作を特定します。記録動作については Table 1-17を参
照してください。

項目 説明

Setup title テスト セットアップ名

Classic test 
name

クラシック・テスト名。I/V Sweep、Multi Channel I/V Sweep、I/V-t 
Sampling、C-V Sweep、SPGU Control、Switching Matrix Control、また
は Direct Controlのいずれか。この項目は Application test nameと排他
的関係にあります。

Application 
test name

アプリケーション・テスト名。この項目は Classic test nameと排他的

関係にあります。

Test date テスト実行日。メタデータ RecordTimeの日付に相当。

Test time テスト実行時間。メタデータ RecordTimeの時間に相当。

Device ID デバイス ID。メタデータ TestTargetに相当。

Count テスト カウント。メタデータ IterationIndexに相当。

Flags テスト データの Flagsの設定値。メタデータ Flagに相当。 
Remarks テスト データの Remarksの設定値。メタデータ Remarksに相当。 
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Table 1-19 Setup Data 記録項目（ON: チェックあり、OFF: チェックなし）

Miscellaneousタブ Miscellaneous settings, Save As 
データ区切り文字とファイル拡張子を指定します。CSV
（カンマ、.csv、初期値）、Text（タブ、.txt）または

Formatted Text（スペース、.prn）。
Miscellaneous settings, Quotation 

ストリング値に付ける引用符を指定します。Single（‘’）、
Double（“”）、または None（引用符なし、初期値）。None
に設定されたとしても、区切り文字や改行文字を含むス

トリングは “”（二重引用符）で囲まれます。

項目 説明 初期値

Test parameters クラシック・テストまたはアプリケーション・テストに定義さ

れるテスト パラメータ。
ON

DUT parameters アプリケーション・テストに定義される DUTパラメータ。 ON

Analysis setup 測定中あるいは測定後の Data Display設定状態。グラフ フォー

マット、テキスト、マーカ、カーソル、ライン、ポインタ、リ

ストなど。

OFF
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Excel Data Export settings
このダイアログ ボックスは Results > Export Options > Excel Exportをクリッ
クすることによって開きます。Data Displayの File > Export to Excelでのエ
クスポートまたは測定後のMicrosoft Excelへの自動エクスポートの際の、
エクスポートされる項目をを定義するために使用します。

Reset すべての設定項目に初期値を適用します。

OK 現在の設定を定義・記憶し、ダイアログ ボックスを閉じます。

Cancel 設定変更をキャンセルし、ダイアログ ボックスを閉じます。

Measurement Data
タブ

測定データに関する記録項目。測定パラメータ名、単位、データサイズを

含めることができます。記録項目の詳細については Table 1-20を参照して
ください。チェックボックスにチェックが残されている項目がテスト レ
コードに記録されます。

測定データに関係するタグデータとして、Dimension1、Dimension2、Data 
Name、Data Unit、Data Valueの文字列があります。これら文字列は、テス
ト レコード内で同じ列（Orientation=By Rowの場合は横方向、By Column
の場合は縦方向）に置かれるデータの種類を示します。タグデータは Tag 
informationボックスにチェックがある場合に記録されます。

Table 1-21は Orientation=By Rowのエクスポート例を示しています。ある測
定パラメータに関連するすべてのデータは同じ縦列に置かれます。そして

第 1縦列（例：A列）にタグデータが記録されます。Table 1-22は
Orientation=By Columnのエクスポート例を示しています。ある測定パラ
メータに関連するすべてのデータは同じ横列に置かれます。そして第 1横
列（例：1列）にタグデータが記録されます。Tag informationボックスに
チェックがない場合（初期値）、タグデータは記録されません。測定データ

が前列にシフトされます。

Table 1-20 Measurement Data 記録項目（ON: チェックあり、OFF: チェックなし）

項目 説明 初期値

Tag information タグ情報 OFF

Data names 測定パラメータ名。 ON

Data units 測定データの単位。 OFF
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Table 1-21 Orientation=By Row によるエクスポート例

Size 測定データの Dimension1（VAR1サイズ）と Dimension2（VAR2サ
イズ）。

OFF

Data values 記録項目。下記セグメント毎に設定できます。

セグメント 初期値

Data assigned to X-Y Graph（X-Y Graph Plotのデータ） ON

Data assigned to List Display（List Displayのデータ） ON

Data assigned to Parameter Display （Parametersのデータ） ON

User function defined but not displayed （表示されていないユーザ関
数）

OFF

Analysis function defined but not displayed 
（表示されていないアナリシス関数）

OFF

Any data referred to by the user function but not directly displayed 
（ユーザ関数が参照している表示されていないデータ）

OFF

Any data referred to by the analysis function but not directly displayed 
（アナリシス関数が参照している表示されていないデータ）

OFF

Data is displayed by two dimensional array
（二次元配列で表示されているデータ）

OFF

A B C D E F

1 Dimension1 101 101 101 1

2 Dimension2 1 1 1 1

3 Data Name Vg Id Gm Vth

4 Data Unit V A S V

5 Data Value 0 4.55E-09 1.24E-10 1.23

6 Data Value 0.02 8.59E-09 5.25E-10

項目 説明 初期値
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Table 1-22 Orientation=By Column によるエクスポート例

Identification タブ Identification section 
Save Typeラジオボタンは、Identification sectionの項目の

記録動作を特定します。記録動作については Table 1-23
を参照してください。

テスト レコードを識別するための記録項目。テスト名、

テストタイプ、メタデータの一部など。記録項目の詳細

については Table 1-24を参照してください。チェック
ボックスにチェックが残されている項目がテスト レコー
ドに記録されます。初期設定では、全項目がチェックさ

れます。

Table 1-23 Identification、Setup Data の記録動作

A B C D E F

1 Dimension1 Dimension2 Data Name Data Unit Data Value Data Value

2 101 1 Vg V 0 0.02

3 101 1 Id A 4.55E-09 8.59E-09

4 101 1 Gm S 1.24E-10 5.25E-10

5 1 1 Vth V 1.23

6

動作 説明

Export チェックされた項目が測定データと一緒に

エクスポートされます。初期設定。

Do not export チェックされた項目があっても、何もエク

スポートされません。
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Table 1-24 Identification 記録項目

Setup data section Save Typeラジオボタンは、Setup data sectionの項目の記

録動作を特定します。記録動作については Table 1-23を
参照してください。

テスト セットアップ データに関する記録項目。テスト 
パラメータ、DUTパラメータ、アナリシス パラメータ。
記録項目の詳細については Table 1-25を参照してくださ
い。チェックボックスにチェックが残されている項目が

テスト レコードに記録されます。

セットアップ データに関係するタグデータとして、

TestParameter、DutParameter、AnalysisSetupの文字列があ
ります。これら文字列は、テスト レコード内で同じ横列

に置かれるデータの種類を示します。タグデータは Tag 
informationボックスにチェックがない場合（初期値）は
記録されません。この場合、Channel.Unitのような設定
パラメータ名がテスト レコードの第 1縦列に記録され、
第 2縦列以降にパラメータ値が記録されます。Tag 
informationボックスにチェックがある場合には、テスト 
レコードの第 1縦列にタグデータが記録され、設定パラ
メータ名とパラメータ値は第 2縦列以降に記録されます。

項目 説明

Setup title テスト セットアップ名

Classic test 
name

クラシック・テスト名。I/V Sweep、Multi Channel I/V Sweep、I/V-t 
Sampling、C-V Sweep、SPGU Control、Switching Matrix Control、ま
たは Direct Controlのいずれか。この項目は Application test nameと
排他的関係にあります。

Application 
test name

アプリケーション・テスト名。この項目は Classic test nameと排他
的関係にあります。

Test date テスト実行日。メタデータ RecordTimeの日付に相当。

Test time テスト実行時間。メタデータ RecordTimeの時間に相当。

Device ID デバイス ID。メタデータ TestTargetに相当。

Count テスト カウント。メタデータ IterationIndexに相当。

Flags テスト データの Flagsの設定値。メタデータ Flagに相当。 
Remarks テスト データの Remarksの設定値。メタデータ Remarksに相当。 
1-164 Keysight EasyEXPERT ユーザ・ガイド Vol. 1、第 5版



メイン GUI
Excel Data Export settings
Table 1-25 Setup Data 記録項目（ON: チェックあり、OFF: チェックなし）

Worksheet タブ Target Sheet, Auto Export on Measurement 
測定後のMicrosoft Excelへの自動エクスポート時の出力
設定をします。

List 測定データがMicrosoft Excelの List
ワークシートにエクスポートされま

す。

Customized List Measurement Dataタブ、Identification
タブで選択した項目がMicrosoft Excel
の Setupワークシートにエクスポート
されます。

Target Sheet, Manual Export on Data Display 
Data Displayで File > Export to Excelを選択して測定レ

コードをMicrosoft Excelへエクスポートする時の出力設
定をします。

List 測定データがMicrosoft Excelの List
ワークシートにエクスポートされま

す。

Graph グラフがMicrosoft Excelの Graphワー
クシートにエクスポートされます。

Customized List Measurement Dataタブ、Identification
タブで選択した項目がMicrosoft Excel
の Setupワークシートにエクスポート
されます。

Sheet Name 
チェックした項目がエクスポート先のワークシート名が

が追加された物になります。

項目 説明 初期値

Test parameters クラシック・テストまたはアプリケーション・テストに定義さ

れるテスト パラメータ。
ON

DUT parameters アプリケーション・テストに定義される DUTパラメータ。 ON

Analysis setup 測定中あるいは測定後の Data Display設定状態。グラフ フォー

マット、テキスト、マーカ、カーソル、ライン、ポインタ、リ

ストなど。

OFF
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クラシック・テストの定義
Keysight EasyEXPERTソフトウェアのクラシック・テスト設定用 GUIのリ
ファレンス情報を記しています。

• I/V Sweep

• Multi Channel I/V Sweep

• I/V List Sweep

• I/V-t Sampling

• C-V Sweep

• SPGU Control

• Switching Matrix Control

• Direct Control

• Function Setup

• Auto Analysis Setup

• Display Setup

• SMU Range Setupウインドウ

• A/D Converter & Integration Time Setupウインドウ

• Pulse Setupウインドウ

• Advanced Setupウインドウ

• Range Setupウインドウ

• Advanced Setupウインドウ（C-V Sweep）

• SPGU Pulse Setupウインドウ

• Load Z Setupウインドウ

• Pulse Switch Setupウインドウ

• SPGU ALWG Setupウインドウ

• Define ALWG Waveformウインドウ
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測定を実行するには「メイン画面 (p. 1-17)」を参照してください。

測定データの表示、解析を行うには「Data Display (p. 1-123)」を参照してく
ださい。

セルフテストや診断を実施するには「Configuration (p. 1-98)」を参照してく
ださい。

セルフキャリブレーションを実施するには「Calibration (p. 1-92)」を参照し
てください。

NOTE GNDU（グランド・ユニット）を使用する
グランド・ユニットを使用する場合は以下の条件に従う必要があります。

1. Modeを COMMONに設定する

2. Functionを CONSTに設定する

3. グランド・ユニットに設定された I Nameを使用しない

どれか一つでも守られなかった場合は実行時エラーを生じます。.
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I/V Sweep
I/V Sweep
EasyEXPERTメイン画面で Classic Testタブをクリックし、I/V Sweepアイ
コンを選択します。 メイン画面に I/V Sweepテスト セットアップ画面が表
示されます。 測定モードについては｢ I/V Sweep測定 (p. 4-3) ｣を参照してく
ださい。

Setup Name テスト セットアップの名前を設定します。この名前でMy Favoriteグルー
プ（プリセット グループ）に保存されるテスト セットアップが識別されま

す。 他のセットアップと区別できる一意の名前を入力してください。

この名前はテスト結果データに記録され、テスト レコードのリスト エリア
でデータを区別するために用いられます。

Channel タブ Channel Setup画面を表示します。｢ Channel Setup (p. 2-5) ｣を参照してくださ
い。

Measurement タブ Measurement Setup画面を表示します。｢ Measurement Setup (p. 2-6) ｣を参照し
てください。

Function タブ Function Setup画面を表示します。｢ Function Setup (p. 2-47) ｣を参照してくだ
さい。

Auto Analysis タブ Auto Analysis Setup画面を表示します。｢ Auto Analysis Setup (p. 2-48) ｣を参照
してください。

Display タブ Display Setup画面を表示します。｢ Display Setup (p. 2-51) ｣を参照してくださ
い。 
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I/V Sweep
Channel Setup
チャネル・セットアップおよび、チャネル出力データ、測定データ、タイ

ム・スタンプ・データ、インデックス・データの変数定義を行います。

Channel Definition チャネル・セットアップおよび、チャネル出力／測定データの変数定義を

行います。

Unit 出力または測定に使用される測定リソース。

V Name 電圧出力または測定データの変数名。

I Name 電流出力または測定データの変数名。

Mode 出力モード。SMUの場合、V（電圧）、I（電流）、
VPULSE（電圧パルス）、IPULSE（電流パルス）、または
COMMON（グランド）。ただし B2900の場合、
COMMON（グランド）は選択できません。SPGUの場
合、VPULSE（電圧パルス）または ALWG（任意直線波

電圧）。

Function 出力機能。VAR1（一次掃引）、VAR2（二次掃引）、

VAR1’（同期掃引）、または CONST（一定）。B2900の場
合、VAR1’は選択できません。

Add SMU SMU用チャネル・セットアップの行を追加します。

Add SPGU SPGU用チャネル・セットアップの行を追加します。

Delete チャネル・セットアップを削除します。 セットアップを

選択するには、左側のラジオ ボタンを使用します。

Up 選択したチャネル・セットアップを上に移動します。

Down 選択したチャネル・セットアップを下に移動します。

複数の出力チャネルが設定されている場合、Channel Definition設定の上か
ら下の順番でチャネル出力が開始されます。出力停止の順番はその逆とな

ります。

Miscellaneous 
Variables

タイム・スタンプ・データとインデックス・データの変数を定義します。

Time Stamp Name タイム・スタンプの変数名。 タイム・スタンプ・デー

タには、各測定点の測定開始時刻が返ります。

Index Name データ・インデックスの変数名。 1以上の整数が返り

ます。
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I/V Sweep
Measurement Setup
ソース・チャネル出力、レンジング・モード、掃引中止条件、測定チャネ

ル A/Dコンバータ、直列抵抗、フィルタ、出力 /測定ウエイト時間の設定

を行います。

VAR1 一次掃引源 (VAR1)出力を定義します。

Unit VAR1出力に使用される SMU。

Name VAR1出力データの変数名。

Direction 掃引方向、シングル（スタート→ストップ）またはダブ

ル（スタート→ストップ→スタート）。

Linear/Log 掃引出力、LINEAR、LOG10、LOG25、または LOG50。
B2900の場合、LINEARまたは LOG10。ここで LOGの
後の数字は 1ディケードあたりの掃引点数を表していま
す。

Start 掃引スタート値。

Stop 掃引ストップ値。

Step 掃引出力のステップ変化量。

No. of Steps ステップ数。 この値は、Start値、Stop値、Step値から自
動的に計算されます。

Compliance コンプライアンス値。 電圧源の電流制限値、または電流

源の電圧制限値を入力します。

Pwr Comp パワー・コンプライアンス値 (W)、または OFF。B2900
では無効です。

VAR2 二次掃引源 (VAR2)出力を定義します。

Unit VAR2出力に使用される SMU。

Name VAR2出力データの変数名。

Start 掃引スタート値。

Stop 掃引ストップ値。 この値は、Start値、Step値、No. of 
Steps値から自動的に計算されます。

Step 掃引出力のステップ変化量。

No. of Steps 掃引ステップ数。
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I/V Sweep
Compliance コンプライアンス値。 電圧源の電流制限値、または電流

源の電圧制限値を入力します。

Pwr Comp パワー・コンプライアンス値 (W)、または OFF。B2900
では無効です。

VAR1’ 同期掃引源 (VAR1’)を定義します。VAR1’出力は次の式で与えられます。

VAR1’出力 = Offset + Ratio  VAR1出力

Unit VAR1’出力に使用される SMU。

Name VAR1’出力データの変数名。

Offset オフセット値。

Ratio 係数。

Compliance コンプライアンス値。 電圧源の電流制限値、または電流

源の電圧制限値を入力します。

Pwr Comp パワー・コンプライアンス値 (W)、または OFF。

Timing ホールド時間とディレイ時間を定義します。｢ソース印加時間の設定 (p. 
4-71) ｣を参照してください。

Hold ホールド時間。出力開始からディレイ時間開始までの時

間。 0 ～ 655.35 s、10 ms分解能。

SMU:B290X/B291X: 0 ～ 100000 s。
Delay ディレイ時間。ホールド時間終了から測定開始までの時

間。ディレイ時間の後で、測定チャネルはただちに測定
を開始します。 0 ～ 65.535 s、0.1 ms分解能。

SMU:B290X/B291X: 0 ～ 100000 s。

Constants 定電圧源／定電流源を定義します。

Unit 定電圧源／定電流源に使用される SMU。

V Name 電圧出力または測定データの変数名。

I Name 電流出力または測定データの変数名。

Mode 出力モード、V（電圧）、I（電流）、VPULSE（電圧パル
ス）、IPULSE（電流パルス）のいずれか。

Source 出力値。
Keysight EasyEXPERT ユーザ・ガイド Vol. 1、第 5版 2-7



クラシック・テストの定義

I/V Sweep
Compliance コンプライアンス値。 電圧源の電流制限値、または電流

源の電圧制限値を入力します。

SMU Pulse SMUパルス設定パラメータを定義します。｢ SMUパルス (p. 4-65) ｣を参照し
てください。

Unit パルス出力に使用する SMU。

Period パルス周期。AUTOと入力すると、最適値が自動設定さ

れます。

Width パルス幅。

Base パルス・ベース値。

Sweep status 掃引停止条件を設定します。｢ Sweep停止機能 (p. 4-39) ｣を参照してくださ
い。

Range... このボタンは、測定レンジ変更動作の設定に使用するウインドウを開きま

す。｢ SMU Range Setupウインドウ (p. 2-53) ｣を参照してください。

ADC/Integ... このボタンは、測定チャネルの A/Dコンバータの設定に使用するウインド
ウを開きます。｢ A/D Converter & Integration Time Setupウインドウ (p. 2-55) ｣
を参照してください。 

Advanced... このボタンは、測定チャネルのその他の機能の設定に使用するウインドウ

を開きます。 ｢ Advanced Setupウインドウ (p. 2-57) ｣を参照してください。 

SPGU Pulse... このボタンは、SPGU出力の設定に使用するウインドウを開きます。 

｢SPGU Pulse Setupウインドウ (p. 2-63) ｣または｢SPGU ALWG Setupウインド
ウ (p. 2-67) ｣を参照してください。 
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Multi Channel I/V Sweep
Multi Channel I/V Sweep
EasyEXPERTメイン画面で Classic Testタブをクリックし、Multi Channel I/V 
Sweepアイコンを選択します。 メイン画面にMulti Channel I/V Sweepテスト 
セットアップ画面が表示されます。 測定モードについては｢ Multi Channel 
I/V Sweep測定 (p. 4-13) ｣を参照してください。

Setup Name テスト セットアップの名前を設定します。この名前でMy Favoriteグルー
プ（プリセット グループ）に保存されるテスト セットアップが識別されま

す。 他のセットアップと区別できる一意の名前を入力してください。

この名前はテスト結果データに記録され、テスト レコードのリスト エリア
でデータを区別するために用いられます。

Channel タブ Channel Setup画面を表示します。｢ Channel Setup (p. 2-10) ｣を参照してくだ
さい。

Measurement タブ Measurement Setup画面を表示します。｢ Measurement Setup (p. 2-11) ｣を参照
してください。

Function タブ Function Setup画面を表示します。｢ Function Setup (p. 2-47) ｣を参照してくだ
さい。

Auto Analysis タブ Auto Analysis Setup画面を表示します。｢ Auto Analysis Setup (p. 2-48) ｣を参照
してください。

Display タブ Display Setup画面を表示します。｢ Display Setup (p. 2-51) ｣を参照してくださ
い。 

NOTE Data Displayウインドウ、X-Y Graph上の X 軸・Y 軸には、Display Setupの設
定が適用されます。そして、X 軸には 1つの Xデータ、Y 軸には最大 8つ
の Yデータを割り当てることが可能です。

Multi Channel I/V Sweep測定結果を X-Y Graphにプロットする場合は、X 軸

の設定に注意が必要です。それは、複数の VAR1チャネルによる測定デー
タが存在する場合に、複数の Xデータが X 軸の選択肢となり得るからで

す。

グラフ上で注目しているプロットの Xデータと X 軸のデータに不一致が生

じないように、Display Setupで適切な設定を行ってください。
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Multi Channel I/V Sweep
Channel Setup
チャネル・セットアップおよび、チャネル出力データ、測定データ、タイ

ム・スタンプ・データ、インデックス・データの変数定義を行います。

Channel Definition チャネル・セットアップおよび、チャネル出力／測定データの変数定義を

行います。

Unit 出力または測定に使用される測定リソース。

V Name 電圧出力または測定データの変数名。

I Name 電流出力または測定データの変数名。

Mode 出力モード。SMUの場合、V（電圧）、I（電流）、
VPULSE（電圧パルス）、IPULSE（電流パルス）、または
COMMON（グランド）。ただし B2900の場合、
COMMON（グランド）は選択できません。SPGUの場
合、VPULSE（電圧パルス）または ALWG（任意直線波

電圧）。

Function 出力機能、VAR1（一次掃引）、VAR2（二次掃引）、また

は CONST（一定）。

Add SMU SMU用チャネル・セットアップの行を追加します。

Add SPGU SPGU用チャネル・セットアップの行を追加します。

Delete チャネル・セットアップを削除します。 チャネルを選択

するには、左側のラジオ ボタンを使用します。

Up 選択したチャネル・セットアップを上に移動します。

Down 選択したチャネル・セットアップを下に移動します。

複数の出力チャネルが設定されている場合、Channel Definition設定の上か
ら下の順番でチャネル出力が開始されます。出力停止の順番はその逆とな

ります。

Miscellaneous 
Variables

タイム・スタンプ・データとインデックス・データの変数を定義します。

Time Stamp Name タイム・スタンプの変数名。 タイム・スタンプ・デー

タには、各測定点の測定開始時刻が返ります。

Index Name データ・インデックスの変数名。 1以上の整数が返り

ます。
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Multi Channel I/V Sweep
Measurement Setup
ソース・チャネル出力、レンジング・モード、掃引中止条件、測定チャネ

ル A/Dコンバータ、直列抵抗、フィルタ、出力 /測定ウエイト時間の設定

を行います。

VAR1 一次掃引源 (VAR1)出力を定義します。

Direction 掃引方向、シングル（スタート→ストップ）またはダブ

ル（スタート→ストップ→スタート）。

Linear/Log 掃引出力、LINEAR、LOG10、LOG25、LOG50のいずれ
か。B2900の場合、LINEARまたは LOG10。ここで LOG
の後の数字は 1ディケードあたりの掃引点数を表してい
ます。

No. of Steps 掃引ステップ数。 

Unit VAR1出力に使用される SMU。

Name VAR1出力データの変数名。

Start 掃引スタート値。

Stop 掃引ストップ値。

Compliance コンプライアンス値。 電圧源の電流制限値、または電流

源の電圧制限値を入力します。

Pwr Comp パワー・コンプライアンス値 (W)、または OFF。B2900
では無効です。

Constant 定電圧源／定電流源を定義します。

Unit 定電圧源／定電流源に使用される SMU。

V Name 電圧出力または測定データの変数名。

I Name 電流出力または測定データの変数名。

Mode 出力モード、V（電圧）または I（電流）。

Source 出力値。

Compliance コンプライアンス値。 電圧源の電流制限値、または電流

源の電圧制限値を入力します。

VAR2 二次掃引源 (VAR2)出力を定義します。

Unit VAR2出力に使用される SMU。
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Multi Channel I/V Sweep
Name VAR2出力データの変数名。

Start 掃引スタート値。

Stop 掃引ストップ値。 この値は、Start値、Step値、No. of 
Steps値から自動的に計算されます。

Step 掃引出力のステップ変化量。

No. of Steps 掃引ステップ数。

Compliance コンプライアンス値。 電圧源の電流制限値、または電流

源の電圧制限値を入力します。

Pwr Comp パワー・コンプライアンス値 (W)、または OFF。B2900
では無効です。

Timing ホールド時間とディレイ時間を定義します。｢ソース印加時間の設定 (p. 
4-71) ｣を参照してください。

Hold ホールド時間。出力開始からディレイ時間開始までの時

間。 0 ～ 655.35 s、10 ms分解能。

SMU:B290X/B291X: 0 ～ 100000 s。
Delay ディレイ時間。ホールド時間終了から測定開始までの時

間。ディレイ時間の後で、測定チャネルはただちに測定
を開始します。 0 ～ 65.535 s、0.1 ms分解能。

SMU:B290X/B291X: 0 ～ 100000 s。

Sweep status 掃引停止条件を設定します。｢ Sweep停止機能 (p. 4-39) ｣を参照してくださ
い。

Range... このボタンは、測定レンジ変更動作の設定に使用するウインドウを開きま

す。｢ SMU Range Setupウインドウ (p. 2-53) ｣を参照してください。

ADC/Integ... このボタンは、測定チャネルの A/Dコンバータの設定に使用するウインド
ウを開きます。｢ A/D Converter & Integration Time Setupウインドウ (p. 2-55) ｣
を参照してください。 

Pulse... このボタンは、SMUパルス出力の設定に使用するウインドウを開きます。 
｢ Pulse Setupウインドウ (p. 2-56) ｣を参照してください。 

Advanced... このボタンは、測定チャネルのその他の機能の設定に使用するウインドウ

を開きます。 ｢ Advanced Setupウインドウ (p. 2-57) ｣を参照してください。 
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Multi Channel I/V Sweep
SPGU Pulse... このボタンは、SPGU出力の設定に使用するウインドウを開きます。 

｢SPGU Pulse Setupウインドウ (p. 2-63) ｣または｢SPGU ALWG Setupウインド
ウ (p. 2-67) ｣を参照してください。 
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I/V List Sweep
I/V List Sweep
EasyEXPERTメイン画面で Classic Testタブをクリックし、I/V List Sweepア
イコンを選択します。 メイン画面に I/V List Sweepテストセットアップ画面
が表示されます。

I/V List Sweep測定は、I/V Sweep測定と同様の測定を行いますが、次の違

いがあります。I/V Sweepについては、「I/V Sweep測定 (p. 4-3)」を参照し
てください。

• VAR1および VAR2のステップ出力値を、任意のベクター・データで設

定します。スプレッドシート ソフトウェアのベクター・データ、タブ
区切りデータ、またはカンマ区切りデータを Define vector dataダイアロ
グ ボックスにコピーして使うことができます。詳細は、「Define vector 
data (p. 2-19)」を参照してください。

• 装着されている全 SMUを、VAR1に設定できます。

• VAR1’はサポートされません。

Setup Name テストセットアップの名前を設定します。この名前でMy Favoriteグループ
（プリセット・グループ）に保存されるテストセットアップが識別されま
す。 他のセットアップと区別できる一意の名前を入力してください。

この名前はテスト結果データに記録され、テスト・レコードのリスト・エ

リアでデータを区別するために用いられます。

Channel タブ Channel Setup画面を表示します。｢ Channel Setup (p. 2-5) ｣を参照してくださ
い。

Measurement タブ Measurement Setup画面を表示します。｢ Measurement Setup (p. 2-6) ｣を参照し
てください。

Function タブ Function Setup画面を表示します。｢ Function Setup (p. 2-47) ｣を参照してくだ
さい。

Auto Analysis タブ Auto Analysis Setup画面を表示します。｢ Auto Analysis Setup (p. 2-48) ｣を参照
してください。

Display タブ Display Setup画面を表示します。｢ Display Setup (p. 2-51) ｣を参照してくださ
い。 
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I/V List Sweep
Channel Setup
チャネル・セットアップおよび、チャネル出力データ、測定データ、タイ

ム・スタンプ・データ、インデックス・データの変数定義を行います。

Channel Definition チャネル・セットアップおよび、チャネル出力／測定データの変数定義を

行います。

Unit 出力または測定に使用される測定リソース。

V Name 電圧出力または測定データの変数名。

I Name 電流出力または測定データの変数名。

Mode 出力モード。SMUの場合、V（電圧）、I（電流）、
VPULSE（電圧パルス）、IPULSE（電流パルス）、または
COMMON（グランド）。ただし B2900の場合、
COMMON（グランド）は選択できません。SPGUの場
合、VPULSE（電圧パルス）または ALWG（任意直線波

電圧）。

Function 出力機能、VAR1（一次掃引）、VAR2（二次掃引）、また

は CONST（一定）。

Mode=VPULSEまたは IPULSEの SMUが存在する場合：

• VAR1に設定できる SMUは最大 2チャネルです。

• 一方の VAR1がMode=VPULSEである場合、もう一

方の VAR1をMode=Vに設定します。

• 一方の VAR1がMode=IPULSEである場合、もう一方

の VAR1をMode=Iに設定します。

Add SMU SMU用チャネル・セットアップの行を追加します。

Add SPGU SPGU用チャネル・セットアップの行を追加します。

Delete チャネル・セットアップを削除します。 セットアップを

選択するには、左側のラジオ・ボタンを使用します。

Up 選択したチャネル・セットアップを上に移動します。

Down 選択したチャネル・セットアップを下に移動します。

複数の出力チャネルが設定されている場合、Channel Definition設定の上か
ら下の順番でチャネル出力が開始されます。出力停止の順番はその逆とな

ります。
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I/V List Sweep
Miscellaneous 
Variables

タイム・スタンプ・データとインデックス・データの変数を定義します。

Time Stamp Name タイム・スタンプの変数名。 タイム・スタンプ・デー

タには、各測定点の測定開始時刻が返ります。

Index Name データ・インデックスの変数名。 1以上の整数が返り

ます。

Measurement Setup
ソース・チャネル出力、レンジング・モード、掃引中止条件、測定チャネ

ル A/Dコンバータ、直列抵抗、フィルタ、出力 /測定ウエイト時間の設定

を行います。

VAR1 一次掃引源 (VAR1)出力を定義します。

Unit VAR1出力に使用される SMU。

Source VAR1出力値をベクター・データで設定します。「Define 
vector data (p. 2-19)」を参照してください。

Compliance コンプライアンス値。 電圧源の電流制限値、または電流

源の電圧制限値を入力します。

Pwr Comp パワー・コンプライアンス値 (W)、または OFF。B2900
では無効です。

NOTE VAR1/VAR2ステップ出力を定義する
これらのパラメータを設定するには、Define vector data ダイアログ ボック

スを用いてベクター・データを作成します。このダイアログ ボックスは、
ベクター・データ入力フィールドのグリッド・ボタン（Figure 2-1参照）を
クリックすることによって開きます。

ベクター・データに有効な配列サイズは、次のとおりです（列 行）。

• VAR1のステップ出力値：N1 = 最大 1 1001（初期値：1 1）

• VAR2のステップ出力値：N2 = 最大 1 1001（初期値：1 1）

• ディレイ時間：N3 = 最大 1 1001（初期値：1 1）

ただし、次式を満たす必要があります。

1 N1 N2  128128
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クラシック・テストの定義

I/V List Sweep
VAR2 二次掃引源 (VAR2)出力を定義します。

Unit VAR2出力に使用される SMU。

Name VAR2出力データの変数名。

Source VAR2出力値をベクター・データで設定します。「Define 
vector data (p. 2-19)」を参照してください。

Compliance コンプライアンス値。 電圧源の電流制限値、または電流

源の電圧制限値を入力します。

Pwr Comp パワー・コンプライアンス値 (W)、または OFF。B2900
では無効です。

SMU Pulse SMUパルス設定パラメータを定義します。｢ SMUパルス (p. 4-65) ｣を参照し
てください。

Unit パルス出力に使用する SMU。

Period パルス周期。設定できません。SMUはディレイ時間後、
直ちにパルスを出力します。

Width パルス幅。

Base パルス・ベース値。

Timing ホールド時間とディレイ時間を定義します。｢ソース印加時間の設定 (p. 
4-71) ｣を参照してください。

Hold ホールド時間。出力開始からディレイ時間開始までの時

間。 0 ～ 655.35 s、10 ms分解能。

SMU:B290X/B291X: 0 ～ 100000 s。
Delay ディレイ時間をベクター・データで設定します。「Define 

vector data (p. 2-19)」を参照してください。

ディレイ時間は 1ステップ変化した後から測定開始まで

の時間。最初のステップでは、ホールド時間終了から測

定開始までの時間。ディレイ時間後、測定チャネルは直

ちに測定を開始します。 

0 ～ 65.535 s（SMU:B290X/B291X: 0 ～ 100000 s）、0.1 ms
分解能。
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I/V List Sweep
Constants 定電圧源／定電流源を定義します。

Unit 定電圧源／定電流源に使用される SMU。

V Name 電圧出力または測定データの変数名。

I Name 電流出力または測定データの変数名。

Mode 出力モード、V（電圧）、I（電流）、VPULSE（電圧パル
ス）、IPULSE（電流パルス）のいずれか。

Source 出力値。

Compliance コンプライアンス値。 電圧源の電流制限値、または電流

源の電圧制限値を入力します。

Sweep status 掃引停止条件を設定します。｢ Sweep停止機能 (p. 4-39) ｣を参照してくださ
い。

Range... このボタンは、測定レンジ変更動作の設定に使用するウインドウを開きま

す。｢ SMU Range Setupウインドウ (p. 2-53) ｣を参照してください。

ADC/Integ... このボタンは、測定チャネルの A/Dコンバータの設定に使用するウインド
ウを開きます。｢ A/D Converter & Integration Time Setupウインドウ (p. 2-55) ｣
を参照してください。 

Advanced... このボタンは、測定チャネルのその他の機能の設定に使用するウインドウ

を開きます。 ｢ Advanced Setupウインドウ (p. 2-57) ｣を参照してください。 

SPGU Pulse... このボタンは、SPGU出力の設定に使用するウインドウを開きます。 

｢SPGU Pulse Setupウインドウ (p. 2-63) ｣または｢SPGU ALWG Setupウインド
ウ (p. 2-67) ｣を参照してください。 
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I/V List Sweep
Define vector data
ベクター・データ入力フィールドのグリッド・ボタン（Figure 2-1参照）を
クリックすることによって開かれます。ベクター・データ入力フィールド
は以下の画面に表示されます。

• Vectorタイプ・テスト・パラメータを含むアプリケーション・テストの

設定画面（EasyEXPERTメイン画面または Test Definitionウインドウ）

• Vectorタイプ・テスト・パラメータの定義を含む Test Specification設定
画面（Test Definitionウインドウ）

• Vectorタイプ・テスト・パラメータのシンボル設定に使用する Define 
symbolsダイアログ ボックス

Define vector dataダイアログ ボックスは Define dimensionsダイアログ ボッ

クスを用いて定義された配列を表示します。Define dimensionsダイアログ 

ボックスは Test Specification設定画面から開きます。Figure 2-1の例では
Dim1Min=1、Dim1Max=11、Dim2Min=1、Dim2Max=3の設定で作成された
配列が表示されています。ここで Dim1は配列の垂直方向（行）、Dim2は
水平方向（列）に対応します。配列の第 1インデックスは、常に 1です。

Figure 2-1 Vector Data Entry Field

NOTE 選択されたセルの数値を変更するのにマウスホイール、ロータリーノブを

使用できます。
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クラシック・テストの定義

I/V List Sweep
行、列を削除するには、選択してから Delete キーを押します。

Define vector dataダイアログ ボックスには次の GUIがあります。

OK ボタン 表示されているベクター・データを保存してからダイアログ ボックスを閉

じます。

Cancel ボタン 終了確認メッセージを表示し、ダイアログ ボックスを閉じます。ベク

ター・データは保存されません。

File メニュー 次の機能があります。

Exit 終了確認メッセージを表示し、ダイアログ ボックスを閉

じます。ベクター・データは保存されません。

Edit メニュー 次の 4つの機能があります。

Copy 選択された項目をクリップボードにコピーします。

Paste クリップボード内のデータを指定場所に貼り付けます。

Delete 選択された項目を削除します。

Select All 配列内の全データを選択します。全セルが選択されます。

マウス・メニュー 1 セルにフォーカスがある状態でマウスの右ボタンをクリックすると、次の

メニューが現れます。

Cut 選択された文字をクリップボードに移動します。

Copy 選択された文字をクリップボードにコピーします。

Paste クリップボード内のデータを指定場所に貼り付けます。

マウス・メニュー 2 データ表示領域でマウスの右ボタンをクリックすると、次のメニューが現

れます。

Copy 選択された項目をクリップボードにコピーします。

Paste クリップボード内のデータを指定場所に貼り付けます。

Insert 選択された行の前に 1行追加します。このメニューは、

行ヘッダの下に *ボタンがあり、行ヘッダの 1つが選択

されている状態で有効です。

Delete 選択された行、列を削除します。

Select All 配列内の全データを選択します。全セルが選択されます。
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I/V List Sweep
ベクター・データを

インポートする

Define vector dataダイアログ ボックスは、カンマ区切りデータ（各データ

がカンマで区切られ、各行の最後に CR/LFまたは LFがあること）または、
タブ区切りデータ（各データがタブで区切られ、各行の最後に CR/LFまた
は LFがあること）をインポートできます。

次の手順は、ベクター・データをインポートします。

1. ベクター・データをノートパッドで開きます。

2. ノートパッド上で、インポートするデータをコピーします。

3. Define vector dataダイアログ ボックス上のセルをクリックします。

このセルは、インポートされるベクター・データの一番上、左端のセル
となります。

4. 列ヘッダと行ヘッダが交差するセルの上で、マウスの右ボタンをクリッ

クし、メニュー上の Pasteを選択します。

このようにして、スプレッドシート ソフトウェアで作成されたベクター・
データを読み取ることができます。

ベクター・データを

エクスポートする

Define vector dataダイアログ ボックスは、タブ区切り形式のベクター・

データをエクスポートできます。

次の手順は、ベクター・データをエクスポートします。

1. Define vector dataダイアログ ボックス上で、ベクター・データを選択し

ます。

2. Editメニューまたはマウス・メニュー 2の Copyを選択します。

3. ノートパッド上で、データを貼り付けます。

4. データを保存します。

保存したデータをスプレッドシート ソフトウェアで開くことによって、エ

クスポートされたベクター・データを読み取ることができます。
Keysight EasyEXPERT ユーザ・ガイド Vol. 1、第 5版 2-21



クラシック・テストの定義

I/V-t Sampling
I/V-t Sampling
EasyEXPERTメイン画面で Classic Testタブをクリックし、I/V-t Samplingア
イコンを選択します。 メイン画面に I/V-t Samplingテスト セットアップ画面
が表示されます。測定モードの詳細については｢ I/V-t Sampling測定 (p. 
4-14) ｣を参照してください。

Setup Name テスト セットアップの名前を設定します。この名前で、My Favoriteグルー
プ（プリセット グループ）に保存されるテスト セットアップが識別されま

す。 他のセットアップと区別できる一意の名前を入力してください。

この名前はテスト結果データに記録され、テスト レコードのリスト エリア
でデータを区別するために用いられます。

Channel タブ Channel Setup画面を表示します。｢ Channel Setup (p. 2-23) ｣を参照してくだ
さい。

Measurement タブ Measurement Setup画面を表示します。｢ Measurement Setup (p. 2-24) ｣を参照
してください。

Function タブ Function Setup画面を表示します。｢ Function Setup (p. 2-47) ｣を参照してくだ
さい。

Auto Analysis タブ Auto Analysis Setup画面を表示します。｢ Auto Analysis Setup (p. 2-48) ｣を参照
してください。

Display タブ Display Setup画面を表示します。｢ Display Setup (p. 2-51) ｣を参照してくださ
い。
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I/V-t Sampling
Channel Setup
チャネル・セットアップおよび、チャネル出力データ、測定データ、タイ

ム・スタンプ・データ、インデックス・データの変数定義を行います。

Channel Definition チャネル・セットアップおよび、チャネル出力／測定データの変数定義を

行います。

NOTE UHCU、HVMCUを使用することはできません。

Unit 出力または測定に使用される測定リソース。

V Name 電圧出力または測定データの変数名。

I Name 電流出力または測定データの変数名。

Mode 出力モード。SMUの場合、V（電圧）、I（電流）、または
COMMON（グランド）。ただし B2900の場合、
COMMON（グランド）は選択できません。SPGUの場
合、VPULSE（電圧パルス）または ALWG（任意直線波

電圧）。

Add SMU SMU用チャネル・セットアップの行を追加します。

Add SPGU SPGU用チャネル・セットアップの行を追加します。

Delete チャネル・セットアップを削除します。 セットアップを

選択するには、左側のラジオ ボタンを使用します。

Up 選択したチャネル・セットアップを上に移動します。

Down 選択したチャネル・セットアップを下に移動します。

複数の出力チャネルが設定されている場合、Channel Definition設定の上か
ら下の順番でチャネル出力が開始されます。出力停止の順番はその逆とな

ります。もし Output Sequenceが SIMULTANEOUSに設定されている場合
は、出力チャネルは同時に出力を開始し、同時に停止します。

Miscellaneous 
Variables

タイム・スタンプ・データとインデックス・データの変数を定義します。

Time Stamp Name タイム・スタンプの変数名。 タイム・スタンプ・デー

タには、各測定点の測定開始時刻が返ります。

Index Name データ・インデックスの変数名。 1以上の整数が返り

ます。
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Measurement Setup
サンプリング・タイミング・パラメータや定電圧源／定電流源などの設定

を行います。

NOTE Interval値を 2 msより短く設定する場合
サンプリング・モードがリニアであること。ログ・サンプリング測定では、

この設定はできません。また SPGUを使用することはできません。

下記条件が全測定チャネルに自動設定され、全チャネルは同時に測定を開

始します。測定終了後は自動的に元の設定に戻されます。

• 高速 A/Dコンバータ

• コンプライアンス値を含む最小測定レンジ（固定）

測定時間が Intervalよりも長くなる場合、アベレージング数 (ADCの設定 )
が自動的に調整され、サンプリング間隔が保たれます。測定終了後は自動
的に元の設定に戻されます。

Sampling 
Parameter

サンプリング・タイミング・パラメータを定義します。

Linear/Log サンプリング測定モード。リニア (LINEAR)または
ログ (LOG10、LOG25、LOG50、LOG100、LOG250、ま
たは LOG500)。B2900の場合は、LINEARまたは
LOG10。
ログの場合、LOGに続く数字は 1ディケード当りの測定

データ数を示します。例えば LOG10は 1ディケード当

り 10 個のデータを取得します。

Interval サンプリングの間隔、秒。2 ms ～ 65.535 s、設定分解能
1 ms。
次の条件を満たすことによって Interval < 2 ms（設定分解
能 0.01 ms）のリニア・サンプリングも可能です。上記
NOTEを参照してください。

Interval  0.1 + 0.02 （測定チャネル数 -1）ms

B2900の場合は、10 s ～ 100000 s。ただし SMU:B290X
が存在する場合は 20 s以上でなければならない。

No. of Samples サンプリング測定データ数。整数。1 ～下記最大値。

リニアでの最大値： 100001 / 測定チャネル数

ログでの最大値： 11ディケード分のデータ数 + 1
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Total Sampling 
Time 総サンプリング時間が表示されます。

第 1点目の測定開始から I/V-t Sampling測定終了までの時
間。 ホールド時間は含まれません。

Total Sampling Time = Interval  No of Samples

Output Sequence ソース出力ルール。同期出力 (SIMULTANEOUS)または
設定順出力 (SEQUENCE)。｢出力順序と時間原点 (p. 
4-19) ｣を参照してください。

Hold Time Source値出力開始から第 1サンプリング点までの時間、

秒。0 ～ 655.35 s、設定分解能 10 ms。
B2900の場合は、0 ～ 100000 s。
Interval < 2 msの場合、次の値も有効です。|Hold Time|は
サンプリング開始から Source値出力開始までの時間を示

します。

-90 ms ～ -0.1 ms、設定分解能： 0.1 ms。

Base Hold Time Base値出力を保持する時間（Source値出力開始まで）、

秒。0 ～ 655.35 s、設定分解能 10 ms。

Stop Condition サンプリング測定のストップ・コンディションを設定します。この機能に

ついては「ストップ・コンディション (p. 4-19)」を参照してください。
Enable/ Disable ストップ・コンディションを有効または無効にします。 

設定範囲 : ENABLE(有効 )、または DISABLE(無効 )
Enable Delay サンプリング測定を開始した時間からストップ・コン

ディションを有効にするまでのディレイ時間。 
Name サンプリング測定の終了を判断する変数の名前。測定パ

ラメータ名あるいはユーザ関数の変数名を定義します。

Eventに現れる Valを意味します。

次の組み込み関数を使用しているユーザ関数を使用する

ことはできません。

at, avg, cond, dim1Size, dim2Size, integ, mavg, max, min, 
storeAt

Threshold サンプリング測定の終了を判断する変数の目標値。

Eventに現れる Thを意味します。
Event サンプリング測定の終了を判断する条件式。 
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Val > Th Nameに設定した変数の値が Threshold
の設定値よりも大きい場合に真。

Val < Th Nameに設定した変数の値が Threshold
の設定値よりも小さい場合に真。

|Val| > |Th| Nameに設定した変数の絶対値が
Thresholdの絶対値よりも大きい場合に
真。

|Val| < |Th| Nameに設定した変数の絶対値が
Thresholdの絶対値よりも小さい場合に

真。

No. of Events サンプリング測定の終了を判断するための Eventの発生

回数。

Constants 定電圧源／定電流源を定義します。

Unit 定電圧源／定電流源に使用される SMU。

V Name 電圧出力または測定データの変数名。

I Name 電流出力または測定データの変数名。

Mode 出力モード、V（電圧）、I（電流）のいずれか。

Base、Source ベース値、ソース値（Vまたは A）。

Base値は、Output Sequenceが SIMULTANEOUSの場合は
全出力チャネルに、SEQUENTIALの場合は最後に出力を
開始するチャネルだけに設定可能です。

Compliance コンプライアンス (Aまたは V)。

Range... このボタンは、測定レンジ変更動作の設定に使用するウインドウを開きま

す。｢ SMU Range Setupウインドウ (p. 2-53) ｣を参照してください。

ADC/Integ... このボタンは、測定チャネルの A/Dコンバータの設定に使用するウインド
ウを開きます。｢ A/D Converter & Integration Time Setupウインドウ (p. 2-55) ｣
を参照してください。 

Advanced... このボタンは、測定チャネルのその他の機能の設定に使用するウインドウ

を開きます。 ｢ Advanced Setupウインドウ (p. 2-57) ｣を参照してください。 

SPGU Pulse... このボタンは、SPGU出力の設定に使用するウインドウを開きます。 

｢SPGU Pulse Setupウインドウ (p. 2-63) ｣または｢SPGU ALWG Setupウインド
ウ (p. 2-67) ｣を参照してください。 
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Interval < 2ミリ秒のサンプリング測定に SPGUを使用することはできませ

ん。
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C-V Sweep
EasyEXPERTメイン画面で Classic Testタブをクリックし、C-V Sweepアイ
コンを選択します。 メイン画面に C-V Sweepテスト セットアップ画面が表
示されます。 測定モードの詳細については｢C-V Sweep測定 (p. 4-20)｣を参照
してください。

Setup Name テスト セットアップの名前を設定します。この名前で、My Favoriteグルー
プ（プリセット グループ）に保存されるテスト セットアップが識別されま

す。 他のセットアップと区別できる一意の名前を入力してください。

この名前はテスト結果データに記録され、テスト レコードのリスト エリア
でデータを区別するために用いられます。

Channel タブ Channel Setup画面を表示します。｢ Channel Setup (p. 2-29) ｣を参照してくだ
さい。

Measurement タブ Measurement Setup画面を表示します。｢ Measurement Setup (p. 2-30) ｣を参照
してください。

Function タブ Function Setup画面を表示します。｢ Function Setup (p. 2-47) ｣を参照してくだ
さい。

Auto Analysis タブ Auto Analysis Setup画面を表示します。｢ Auto Analysis Setup (p. 2-48) ｣を参照
してください。

Display タブ Display Setup画面を表示します。｢ Display Setup (p. 2-51) ｣を参照してくださ
い。

NOTE Error Correction
測定を開始する前に、誤差補正を実行する必要があります。 誤差補正用

GUIについては｢CMU Calibration (p. 1-94) ｣を参照してください。 4つの方法

があります。 簡単な方法としては、位相補償とオープン補正だけを実行し
ます。
2-28 Keysight EasyEXPERT ユーザ・ガイド Vol. 1、第 5版



クラシック・テストの定義

C-V Sweep
Channel Setup
チャネル・セットアップおよび、チャネル出力データ、タイム・スタン

プ・データ、インデックス・データの変数定義を行います。

Channel Definition チャネル・セットアップおよび、チャネル出力データの変数定義を行いま

す。

NOTE UHCU、HVMCUを使用することはできません。

Unit 出力または測定に使用される測定リソース。

V Name 電圧出力または測定データの変数名。

I Name 電流出力または測定データの変数名。

Mode SMU出力モード、V（電圧）、I（電流）、または
COMMON（グランド）。

Function 出力機能、VAR1（一次掃引）、または CONST（一定）。

Add SMU チャネル・セットアップの行を追加します。

Delete チャネル・セットアップを削除します。 セットアップを

選択するには、左側のラジオ ボタンを使用します。

Up 選択したチャネル・セットアップを上に移動します。

Down 選択したチャネル・セットアップを下に移動します。

複数の出力チャネルが設定されている場合、Channel Definition設定の上か
ら下の順番でチャネル出力が開始されます。ただし、MFCMUは最後に出
力を開始します。出力停止の順番はその逆となります。

Miscellaneous 
Variables

タイム・スタンプ・データとインデックス・データの変数を定義します。

Time Stamp Name タイム・スタンプの変数名。 タイム・スタンプ・デー

タには、各測定点の測定開始時刻が返ります。

Index Name データ・インデックスの変数名。 1以上の整数が返り

ます。
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Measurement Setup
MFCMU測定モード、チャネル出力、掃引中止条件、MFCMU A/Dコン
バータの設定を行います。

C-V (VAR1) MFCMU測定モードと DCバイアス出力を定義します。

V Name DCバイアス出力データの変数名。

Model MFCMU測定モード。 第 1および第 2測定パラメータ。
Table 4-2 (p. 4-22)を参照してください。 プルダウンメ
ニューから 1つを選択します。

para1 Name 第 1測定パラメータの変数名。

para2 Name 第 2測定パラメータの変数名。

Direction 掃引方向、シングル（スタート→ストップ）またはダブ

ル（スタート→ストップ→スタート）。

Linear/Log 掃引出力、LINEAR、LOG10、LOG25、LOG50のいずれ
か。ここで LOGの後の数字は 1ディケードあたりの掃
引点数を表しています。

Start 掃引スタート値。

Stop 掃引ストップ値。

Step 掃引出力のステップ変化量。

Compliance SMUに有効。コンプライアンス値。 電圧源の電流制限

値、または電流源の電圧制限値を入力します。

No. of Steps ステップ数。 この値は、Start値、Stop値、Step値から自
動的に計算されます。

Signal Source 測定信号を定義します。

Frequency List 測定信号の周波数。

F Name 周波数データの変数名。

AC Level 測定信号のオシレータ・レベル（OSCレベル）。10 mV
～ 250 mV、1 mV分解能。

Add 測定周波数を追加します。

Delete 選択した周波数を削除します。 周波数を選択するには、

左側のラジオ ボタンを使用します。

Up 選択した周波数を上に移動します。
2-30 Keysight EasyEXPERT ユーザ・ガイド Vol. 1、第 5版



クラシック・テストの定義

C-V Sweep
Down 選択した周波数を下に移動します。

Integration Time MFCMUの A/Dコンバータを設定します。

Mode A/Dコンバータ動作モード、AUTOまたは PLC。

Factor 既定値に対する係数。｢ Mode、Factor (p. 4-21) ｣を参照し
てください。

Timing ホールド時間とディレイ時間を定義します。｢ソース印加時間の設定 (p. 
4-71) ｣を参照してください。

Hold ホールド時間。出力開始からディレイ時間開始までの時

間。0 ～ 655.35 s、10 ms分解能。

Delay ディレイ時間。ホールド時間終了から測定開始までの時

間。ディレイ時間の後で、MFCMUはただちに測定を開

始します。0 ～ 655.35 s、0.1 ms分解能。

Constants 定電圧出力源／定電流出力源を定義します。

Unit 定電圧出力源／定電流出力源に使用される SMU。

V Name 電圧出力または測定データの変数名。

I Name 電流出力または測定データの変数名。

Mode 出力モード、V（電圧）、I（電流）、COMMON（グラン
ド）のいずれか。

Source 出力値。

Compliance コンプライアンス値。 電圧源の電流制限値、または電流

源の電圧制限値を入力します。

Sweep status 掃引停止条件を設定します。｢ Sweep停止機能 (p. 4-39) ｣を参照してくださ
い。

Range... このボタンは、測定レンジ変更動作の設定に使用するウインドウを開きま

す。｢ Range Setupウインドウ (p. 2-59) ｣を参照してください。

ADC/Integ... このボタンは、SMU測定チャネルの A/Dコンバータの設定に使用するウ
インドウを開きます。｢ A/D Converter & Integration Time Setupウインドウ (p. 
2-55) ｣を参照してください。 

Advanced... このボタンは、測定チャネルのその他の機能の設定に使用するウインドウ

を開きます。 「Advanced Setupウインドウ（C-V Sweep） (p. 2-61)」を参照し
てください。
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SPGU Control
EasyEXPERTメイン画面で Classic Testタブをクリックし、SPGU Controlア
イコンを選択します。メイン画面に SPGU Controlセットアップ画面が表示
されます。SPGUの機能については「SPGUモジュール (p. 4-28)」を参照し
てください。

Setup Name SPGU Controlセットアップの名前を設定します。この名前でMy Favoriteグ
ループ（プリセット グループ）に保存されるテスト セットアップが識別さ

れます。他のセットアップと区別できる一意の名前を入力してください。

この名前はテスト結果データに記録され、テスト レコードのリスト エリア
でデータを区別するために用いられます。

Channel Definition SPGUチャネル設定を定義します。
Unit 電圧パルス出力または任意直線波形電圧出力に使用され

る SPGU（半導体パルス・ジェネレータ・ユニット）
VName 電圧出力データの変数名

Mode 出力モード、VPULSE（電圧パルス出力）または ALWG
（任意直線波形電圧出力）

全 SPGUチャネルが同じ出力モードに設定される必要が

あります。

Add チャネル・セットアップの行を追加します。

Delete チャネル・セットアップを削除します。セットアップを

選択するには、左側のラジオ ボタンを使用します。

Up 選択したチャネル・セットアップを上に移動します。

Down 選択したチャネル・セットアップを下に移動します。

SPGU Setup 次のボタンは、設定ウインドウを開きます。

Pulse/ALWG... Mode=VPULSEの場合、SPGU Pulse Setupウインドウ (p. 
2-63)を開きます。

Mode=ALWGの場合、SPGU ALWG Setupウインドウ (p. 
2-67)を開きます。

Advanced... Advanced Setupウインドウ（SPGU Control） (p. 2-33)を開

きます。
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Progress Monitor 次のチェック ボックスは、SPGUチャネル出力印加中に表示される Data 
Displayウインドウの設定を行います。
Graph: % of 
Progress 進行状況（Percent of Progress vs. Time）をグラフ表示させ

るにはチェックを付けます。

List: Time Data Timeデータをリスト表示させるにはチェックを付けま

す。

SPGU出力時間が短すぎる場合は Data Displayウインドウにデータは表示さ
れません。Progress Monitorは、出力時間が長い場合（例えば 30秒以上）
の進行状況確認に使用します。

Advanced Setup ウインドウ（SPGU Control）
SPGU Control画面の Advanced...ボタンをクリックすることによって開か

れ、次の機能の設定に用いられます。

After Measurement 
Setting

バイアス保持機能を設定します。SPGU出力終了後のチャネル出力を指定

します。

Bias Hold after 
Measurement バイアス保持機能 ONまたは OFF

バイアス保持機能 OFFの場合、SPGU出力終了後、直ちにチャネル出力を

停止します。

バイアス保持機能 ONの場合、SPGU出力終了から繰り返し実行またはク

イック・テストにおける次の動作の開始までの間、チャネル出力が継続し

ます。VPULSEモードの場合はベース電圧、ALWGモードの場合は初期電
圧を出力します。チャネルの初期化は次の動作の開始時に行われます。

Semiconductor 
Relays (16440A 
SMU/PG Selector)

Keysight 16440A SMU/PGUセレクタ (B1500A-A04)のチャネル CH1/CH3の
状態（DEFAULTまたは PGU OPEN）を設定します。この機能を使用する
場合は SPGU出力を開始する前に DEFAULTを Always SMUまたは Normally 
PGU (AUX)に設定します。設定は Configurationウインドウの SMU/PG 
Selectorタブ画面で行います。
CH1 CH1の状態、DEFAULTまたは PGU OPEN。
CH3 CH3の状態、DEFAULTまたは PGU OPEN。

CH1は第 1セレクタのチャネル 1を、CH3は第 2セレクタのチャネル 1を
表しています。セレクタの詳細については「SMU/PGセレクタ (p. 4-51)」
を参照してください。

セレクタの接続には Keysight 16445Aアダプタが必要です。
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Switching Matrix Control
EasyEXPERTメイン画面で Classic Testタブをクリックし、Switching Matrix 
Controlアイコンを選択します。メイン画面に Switching Matrix Controlセッ
トアップ画面が表示されます。この画面では Keysight B2200A/B2201A/ 
E5250Aスイッチング・マトリクスのリレー制御用セットアップを作成しま
す。

セットアップを適用するには Singleボタンをクリックします。それには予

め、Configurationウインドウの Switching Matrixタブ画面を用いてスイッチ
ング・マトリクスとの GPIB接続を確立しておく必要があります。

｢ Switching Matrix (p. 1-102) ｣を参照してください。

Setup Name リレー制御用セットアップの名前を設定します。この名前で、My Favorite
グループ（プリセット グループ）に保存されるセットアップが識別されま

す。 他のセットアップと区別できる一意の名前を入力してください。

この名前はテスト結果データに記録され、テスト レコードのリスト エリア
でデータを区別するために用いられます。

Connection スイッチング・マトリクスのリレー制御用セットアップを作成します。

Add リレー接続セットアップの行を追加します。

Delete 選択されたセットアップ行を削除します。セットアップ

行を選択するには、左側のラジオ ボタンを使用します。

Up 選択されたセットアップ行を上に移動します。

Down 選択されたセットアップ行を下に移動します。

セットアップ行には次の入力フィールドがあります。

Operation リレー制御のタイプ

Open All、Switch Setup、Close Range、Open Output、
Open Range、Open Input。Table 2-1を参照してください。

Input スイッチング・マトリクスの入力ポート番号またはラベ

ル

Switch Setup、Close Range、Open Inputに有効。 
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Outputs スイッチング・マトリクスの出力チャネル番号またはラ

ベル

Switch Setupと Open Outputには出力チャネルを指定する

ために、4つの入力フィールドがあります。

Close Rangeと Open Rangeには出力チャネルの範囲を指

定するために、2つの入力フィールドがあります。

Rule リレー接続ルール

BBM: 指定チャネルの現在の接続をオープンにしてから

新しい接続を行います。

MBBR: 指定チャネルの新しい接続を行ってから、以前の

接続をオープンします。

Table 2-1 リレー接続のタイプ

Operation 説明

Open All 全リレーをオープンします。

Switch Setup 指定された入力ポートから指定された出力チャネルまで

を接続します。出力チャネルを 4つまで同時指定可能で

す。

Close Range 指定された入力ポートから指定された出力チャネルまで

を接続します。対象は 2つの Outputsフィールドが示す範

囲内の出力チャネルです。

Open Output 指定された出力チャネルに接続されているリレーをオー

プンします。出力チャネルを 4つまで同時指定可能です。

Open Range 指定された出力チャネルに接続されているリレーをオー

プンします。対象は 2つの Outputsフィールドが示す範囲

内の出力チャネルです。

Open Input 指定された入力ポートに接続されているリレーをオープ

ンします。
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Direct Control
EasyEXPERTメイン画面で Classic Testタブをクリックし、Direct Controlア
イコンを選択します。 メイン画面に Direct Controlテスト セットアップ画面
が表示されます。 

Direct Controlテスト・モードは SMUや CMUを直接コントロールすること

で測定を実行します。コントロールには GPIBコマンドを用います。GPIB
コマンドについては、「Keysight B1500プログラミング・ガイド」を参照し
てください。

Direct Controlテストで使用可能な GPIBコマンドはMeasurement Setup画面
の Commandプルダウン・メニューにリストされます。それ以外のコマン

ドを使用することはできません。

Setup Name テスト セットアップの名前を設定します。この名前でMy Favoriteグルー
プ（プリセット グループ）に保存されるテスト セットアップが識別されま

す。 他のセットアップと区別できる一意の名前を入力してください。

この名前はテスト結果データに記録され、テスト レコードのリスト エリア
でデータを区別するために用いられます。

Channel タブ Channel Setup画面を表示します。｢ Channel Setup (p. 2-37) ｣を参照してくだ
さい。

Measurement タブ Measurement Setup画面を表示します。｢ Measurement Setup (p. 2-38) ｣を参照
してください。

Function タブ Function Setup画面を表示します。｢ Function Setup (p. 2-47) ｣を参照してくだ
さい。

Keysight B2200A/B2201A/E5250Aスイッチング・マトリクスを使用した場
合、CMU測定データの補正が必要です。それには compenReZファンク
ションと compenImZファンクション、または compenReYファンクション
と compenImYファンクションを用いたユーザ関数を定義します。

Auto Analysis タブ Auto Analysis Setup画面を表示します。｢ Auto Analysis Setup (p. 2-48) ｣を参照
してください。

Display タブ Display Setup画面を表示します。｢ Display Setup (p. 2-51) ｣を参照してくださ
い。 
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Channel Setup
チャネル・セットアップおよび、チャネル出力データ、測定データ、タイ

ム・スタンプ・データ、インデックス・データの変数定義を行います。

Channel Definition チャネル・セットアップおよび、チャネル出力／測定データの変数定義を

行います。

Unit 出力または測定に使用される測定リソース。

V Name DC電圧出力または測定データの変数名。

I Name DC電流出力または測定データの変数名。

Add CMU CMU用チャネル・セットアップの行を追加します。

Add SMU SMU用チャネル・セットアップの行を追加します。

Add SPGU SPGU用チャネル・セットアップの行を追加します。

Delete チャネル・セットアップを削除します。 チャネルを選択

するには、左側のラジオ ボタンを使用します。

Up 選択したチャネル・セットアップを上に移動します。

Down 選択したチャネル・セットアップを下に移動します。

Additional Data 
Variables

測定データの変数定義を行います。Channel Definitionで定義される DC電
圧と DC電流以外のデータに対する変数定義を行います。

Unit 測定に使用されるユニット（SMUまたは CMU）。

Type 測定データのタイプ。Table 2-2を参照してください。

Name 測定データの変数名。

Add 測定変数の行を追加します。

Delete 測定変数を削除します。 変数を選択するには、左側のラ

ジオ ボタンを使用します。

Miscellaneous 
Variables

タイム・スタンプ・データとインデックス・データの変数を定義します。

Time Stamp Name タイム・スタンプの変数名。 タイム・スタンプ・デー

タには、各測定点の測定開始時刻が返ります。

Index Name データ・インデックスの変数名。 1以上の整数が返り

ます。
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Table 2-2 Measurement Data Variables の Type に有効な値

Measurement Setup
SMUや CMUのコントロールに使用するコマンド群の定義と、SMU 直列

抵抗、フィルタ、バイアス保持機能の設定を行います。

Advanced... SMU 直列抵抗、SMUフィルタ、バイアス保持機能の設定を行うウインド

ウを開きます。「Advanced Setup (p. 2-39)」 を参照してください。

Command Setup SMUや CMUの直接コントロールに使用するコマンド群を定義します。

Command コマンドまたは関数をプルダウン・メニューから選択し

ます。「Command Setup (p. 2-41)」 を参照してください。

Arguments コマンド・パラメータを入力します。複数のパラメータ

を入力する場合は、パラメータをカンマ（,）でつなぎま
す。カンマの前後に複数のスペースを挿入可能です。

有効なコマンド・パラメータ全てを入力することをお勧

めします。省略可能なパラメータを省略した場合、初期

値が使われる、直前の設定が使われる、何も設定されな

い等、実行コマンドに依存する動作が行われます。各コ
マンドの説明は「Keysight B1500プログラミング・ガイ
ド」を参照してください。

Type 説明

SMU Quasi-Static C SMU容量測定値 (F)

CMU Re(Z) CMUレジスタンス測定値 ()

CMU Im(Z) CMUリアクタンス測定値 ()

CMU Re(Y) CMUコンダクタンス測定値 (S)

CMU Im(Y) CMUサセプタンス測定値 (S)

CMU Frequency CMU出力信号周波数 (Hz)

CMU AC Level Output Data CMU OSCレベル 出力値 (Vac)

CMU DC Bias Monitor Data CMU DCバイアス モニタ値 (Vdc)

CMU AC Level Monitor Data CMU OSCレベル モニタ値 (Vac)
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パラメータに数値変数を使用可能です。また、四則演算

子を用いた数式の形で設定することも可能です。

アプリケーション・テスト定義内では、Numeric 型の

Test Parameters、Device Parameters、Symbolを使用するこ
とも可能です。

内部変数を使用する場合は、内部変数を文字列として扱

う必要があります。例えば、 次のように入力します。

“%I1”, “%R1”, “%R2”

Ignore 実行しないコマンド行をコメント・アウトするには、

チェックボックスにチェックを入れます。

Add コマンド・セットアップ行を追加します。

Delete コマンドを削除します。 コマンドを選択するには、左側

のラジオ ボタンを使用します。

Up 選択したコマンドを上に移動します。

Down 選択したコマンドを下に移動します。

Advanced Setup
Direct ControlのMeasurement Setup画面で Advancedボタンをクリックする
ことによって開かれ、SMU 直列抵抗、SMUフィルタ、バイアス保持機能

の設定に用いられます。

Options 次の設定が可能です。

Primary Setup プライマリ・セットアップ ONまたは OFF。

ONの場合、Direct Controlテスト開始時にプライマリ・セットアップの設

定が行われます。設定状態については「プライマリ・セットアップ (p. 
2-40)」を参照してください。

OFFの場合は、プライマリ・セットアップの設定が省かれます。現在の設

定状態がわかっていて、そのままテストを開始しても問題のないことがわ
かっている場合には OFFに設定します。OFFにすることで、テストの実行
時間を短縮することができます。

Channel Settings 直列抵抗とフィルタを設定します。

Unit 測定に使用される SMU。

VName 電圧出力または測定データの変数名。

IName 電流出力または測定データの変数名。
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Series R 直列抵抗の NONEまたは 1MOHM。｢ SMU 直列抵抗 (p. 
4-75) ｣を参照してください。

SMU Filter SMUフィルタの ONまたは OFF。｢ SMUフィルタ (p. 
4-74) ｣を参照してください。

V Compliance UHCU, UHVU, または HVMCUのみ有効。
測定リソースの出力電圧は自動的に測定されこの V 
Compliance値と比較されます。測定値が V Compliance値
を越えていた場合は、測定ステータスがコンプライアン

スになり掃引はMeasurement Setup (p. 2-11)の Sweep 
Statusの設定にしたがい中止します。

After Measurement 
Setting

測定実行後のソース出力を保持する機能です。この機能を有効にすると、

繰り返し測定またはクイック・テスト実行中に行われる測定と次の測定と

の間に、出力源がバイアス出力を行います。｢バイアス保持機能 (p. 4-43) ｣
を参照してください。

Bias Hold after Measurement バイアス保持機能 ONまたは OFF

Semiconductor 
Relays (16440A 
SMU/PG Selector)

SPGUまたは PGUを装着している計測器に有効です。また Keysight 
16440A SMU/PGUセレクタ (B1500A-A04)の接続にはKeysight 16445Aアダプ
タが必要です。

セレクタのチャネル CH1/CH3の状態（DEFAULTまたは PGU OPEN）を設
定します。この機能を使用する場合は SPGU出力を開始する前に DEFAULT
を Always SMUまたは Normally PGU (AUX)に設定します。設定は
Configurationウインドウの SMU/PG Selectorタブ画面で行います。
CH1 CH1の状態、DEFAULTまたは PGU OPEN。
CH3 CH3の状態、DEFAULTまたは PGU OPEN。

CH1は第 1セレクタのチャネル 1を、CH3は第 2セレクタのチャネル 1を
表しています。セレクタの詳細については「SMU/PGセレクタ (p. 4-51)」
を参照してください。

プライマリ・セットアップ

プライマリ・セットアップは Direct Controlテスト開始時の初期設定です。

この設定は、デバイス・クリアや *RSTコマンドによる初期設定とは異な
ります。相違点を以下にリストします。

• データ出力フォーマット

FMT 13, 0の状態に設定されます。

• プログラム・メモリ
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設定されません。テスト開始前の状態が残ります。

• 内部変数

設定されません。テスト開始前の状態が残ります。

• 測定条件設定コマンド

次のコマンドの設定は変更されません。コマンド・パラメータには、テ

スト開始前の設定値が設定されています。

MM

WV, WI, WSV, WSI, WNX

PV, PI, PWV, PWI

BDV

QSV, QSO 

LGI, LGV, LSI, LSV, LSSI, LSSV

BGI, BGV, BSI, BSV, BSSI, BSSV

FC, WDCV

PDCV, PWDCV

WFC

WACV

MDCV

Command Setup
Command Setupを定義するには、Commandにコマンドまたは関数を設定
し、Argumentsにコマンド・パラメータを入力します。また、次の注意が

必要です。

• FMTコマンドの第一パラメータに有効な値は 13だけです。

• チャネルの指定には Channel Setupの Unit値を使用します。

• データの読み取りを行うには ReadDataBuffer関数を使用します。

• プログラム・メモリ番号に有効な値は 1から 1000です。

• SCRコマンドのパラメータは省略できません。

• VARコマンドの第二パラメータに有効な値は 1から 40です。従って、

内部変数%I1から%I40と %R1から %R40を使用可能です。
Keysight EasyEXPERT ユーザ・ガイド Vol. 1、第 5版 2-41



クラシック・テストの定義

Direct Control
Command Setupの設定例を Table 2-3に記します。この例は、SMU1を用い
て電圧出力と、電流スポット測定を行います。

Table 2-3 Command Setup 設定例

ReadDataBuffer
このファンクションは測定データを読み取ります。一度に読み取るデー

タ・ブロック数を countパラメータに設定します。countが省略された場

合、このファンクションは 1データ・ブロックを読み取ります。

シンタックス ReadDataBuffer [count]

パラメータ count 一度に読み取るデータ・ブロック数、またはターミネー

タの数。

データ・ブロックとは、ターミネータを読み取るまでの

データのことです。データ出力フォーマットについては
「Keysight B1500プログラミング・ガイド」 を参照してく
ださい。

Command Arguments 説明

FMT 13, 0 データ出力フォーマットを設定します。

MM 1, SMU1:HP 測定モードを設定します。

TSC 1 時間データ出力を有効にします。

AV 10, 1 アベレージング数を設定します。

DV SMU1:HP, 0, 1.5, 0.1 DC電圧を出力します。

CMM SMU1:HP, 0 測定動作モードを設定します。

RI SMU1:HP, 0 電流測定レンジを設定します。

TSR タイマーをリセットします。

XE 測定を開始します。

ReadDataBuffer 1 測定データを読み取ります。
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設定例 以下の例では、高速スポット測定を 3 回行って測定データを読み取ります。

NOTE データ出力バッファは、Direct Controlテストの開始時にクリアされます。

NOTE SMUがフォース側測定動作を行い、かつソース・データ出力が有効な場

合、その SMUのソース・データは削除され、かわりにその SMUの測定
データが保管されます。ここで SMUのフォース側測定動作とは、電圧出

力・電圧測定動作または電流出力・電流測定動作をいいます。ソース・

データ出力を設定するには FMTコマンドを使用します。

compenReZ
この組み込み関数は指定されたインピーダンス・データの補正を行い、補

正結果の実数データを返します。

この関数は、スイッチング・マトリクスによる測定端子延長時の CMU測
定データ補正に有効です。compenReZと compenImZをユーザ・ファンク
ションとして Function Setup画面に定義することで、Direct Controlテスト実
行中に補正が行われます。また、測定パラメータ計算式の入力も必要です。

補正関数の入力例を Figure 2-2に示します。計算式については「インピー

ダンス測定について (p. 4-23)」を参照してください。

シンタックス compenReZ(frequency,Real,Imaginary)

パラメータ frequency 測定周波数 Hz。数値型スカラまたはベクター・データ。

C-f測定データの場合は、複数の周波数設定値を保管し

ているベクター変数を frequencyに定義します。

Real CMU Re(Z)測定データ、。数値型ベクター・データ。

Command Arguments 説明

TI 1, 0 測定チャネル 1で高速スポット測定を

行います。

TI 2, 0 測定チャネル 2で高速スポット測定を

行います。

TI 3, 0 測定チャネル 3で高速スポット測定を

行います。

ReadDataBuffer 3 3 個の測定データを読み取ります。
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補正前のインピーダンス実数データを保管しているベク

ター変数を Realに定義します。

Imaginary CMU Im(Z)測定データ、。数値型ベクター・データ。

補正前のインピーダンス虚数データを保管しているベク

ター変数を Imaginaryに定義します。

設定例 Name  Rcompen
Definition  compenReZ(Freq,ReZ,ImZ)
Rcompenには、補正されたインピーダンスの実数データが返ります。

compenImZ
この組み込み関数は指定されたインピーダンス・データの補正を行い、補

正結果の虚数データを返します。

この関数は、スイッチング・マトリクスによる測定端子延長時の CMU測
定データ補正に有効です。compenReZと compenImZをユーザ・ファンク
ションとして Function Setup画面に定義することで、Direct Controlテスト実
行中に補正が行われます。また、測定パラメータ計算式の入力も必要です。

補正関数の入力例を Figure 2-2に示します。計算式については「インピー

ダンス測定について (p. 4-23)」を参照してください。

シンタックス compenImZ(frequency,Real,Imaginary)

パラメータ frequency 測定周波数 Hz。数値型スカラまたはベクター・データ。

C-f測定データの場合は、複数の周波数設定値を保管し

ているベクター変数を frequencyに定義します。

Real CMU Re(Z)測定データ、。数値型ベクター・データ。

補正前のインピーダンス実数データを保管しているベク

ター変数を Realに定義します。

Imaginary CMU Im(Z)測定データ、。数値型ベクター・データ。

補正前のインピーダンス虚数データを保管しているベク

ター変数を Imaginaryに定義します。

設定例 Name  Xcompen
Definition  compenImZ(Freq,ReZ,ImZ)
Xcompenには、補正されたインピーダンスの虚数データが返ります。
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compenReY
この組み込み関数は指定されたアドミタンス・データの補正を行い、補正

結果の実数データを返します。

この関数は、スイッチング・マトリクスによる測定端子延長時の CMU測
定データ補正に有効です。Figure 2-2のように、compenReYと compenImY
をユーザ・ファンクションとして Function Setup画面に定義することで、
Direct Controlテスト実行中に補正が行われます。また、測定パラメータ計

算式の入力も必要です。計算式については「インピーダンス測定について 
(p. 4-23)」を参照してください。Figure 2-2では、キャパシタンスの計算に

次式が定義されています。

C=ImY/(2PIFreq)

シンタックス compenReY(frequency,Real,Imaginary)

パラメータ frequency 測定周波数 Hz。数値型スカラまたはベクター・データ。

C-f測定データの場合は、複数の周波数設定値を保管し

ているベクター変数を frequencyに定義します。

Real CMU Re(Y)測定データ、S。数値型ベクター・データ。

補正前のアドミタンス実数データを保管しているベク

ター変数を Realに定義します。

Imaginary CMU Im(Y)測定データ、S。数値型ベクター・データ。

補正前のアドミタンス虚数データを保管しているベク

ター変数を Imaginaryに定義します。

設定例 Name  Gcompen
Definition  compenReY(Freq,ReY,ImY)
Gcompenには、補正されたアドミタンスの実数データが返ります。

Figure 2-2 Function Setup 設定例
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compenImY
この組み込み関数は指定されたアドミタンス・データの補正を行い、補正

結果の虚数データを返します。

この関数は、スイッチング・マトリクスによる測定端子延長時の CMU測
定データ補正に有効です。Figure 2-2のように、compenReYと compenImY
をユーザ・ファンクションとして Function Setup画面に定義することで、
Direct Controlテスト実行中に補正が行われます。また、測定パラメータ計

算式の入力も必要です。計算式については「インピーダンス測定について 
(p. 4-23)」を参照してください。Figure 2-2では、キャパシタンスの計算に

次式が定義されています。

C=ImY/(2PIFreq)

シンタックス compenImY(frequency,Real,Imaginary)

パラメータ frequency 測定周波数 Hz。数値型スカラまたはベクター・データ。

C-f測定データの場合は、複数の周波数設定値を保管し

ているベクター変数を frequencyに定義します。

Real CMU Re(Y)測定データ、S。数値型ベクター・データ。

補正前のアドミタンス実数データを保管しているベク

ター変数を Realに定義します。

Imaginary CMU Im(Y)測定データ、S。数値型ベクター・データ。

補正前のアドミタンス虚数データを保管しているベク

ター変数を Imaginaryに定義します。

設定例 Name  Bcompen
Definition  compenImY(Freq,ReY,ImY)
Bcompenには、補正されたアドミタンスの虚数データが返ります。
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Function Setup
I/V Sweep／Multi Channel I/V Sweep／ I/V List Sweep／ I/V-t Sampling／
C-V Sweep／ Direct Controlテスト セットアップ画面の Function Setupタブ
をクリックすることによって表示され、ユーザ関数とアナリシス関数の設
定に用いられます。

関数の計算は測定終了後、自動的に行われます。Display Setupに設定され
ている関数は Data Displayウインドウに表示されます。ユーザ関数は Graph 
Plot、List Display、Parametersに、アナリシス関数は Parametersに有効です。

User Function, 
Analysis Function

User/Analysis Functionエリアは、テストに対して有効なユーザ／アナリシ
ス関数を設定します。 最大 20 個の関数を設定できます。 ユーザ関数の結果

は、それ以降の行で定義された他のユーザ関数から参照することができま

す。 また、アナリシス関数の結果は、それ以降の行で定義された他のアナ
リシス関数から参照することができます。

Name 関数名。

Unit 関数の単位。

Definition 関数の定義。 次の識別子を使用することができます。

• このテストで使用される測定／出力データの変数。

• 以前のプログラム行で定義された関数。

• コンポーネントとしてこのテストをコールするアプリ

ケーション・テストから渡されたローカル変数。

• 組み込み関数とグローバル変数。

• リードアウト関数（ユーザ関数では使用できません）

｢プログラミング・ツール (p. 5-1) ｣を参照してください。
Add, Delete 関数を追加または削除します。 関数を選択するには、関数名

左側のラジオ ボタンを使用します。

Up, Down 選択した関数を上または下に移動します。
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Auto Analysis Setup
Auto Analysis Setup
I/V Sweep／Multi Channel I/V Sweep／ I/V List Sweep／ I/V-t Sampling／
C-V Sweep／ Direct Controlテスト セットアップ画面の Auto Analysis Setup
タブをクリックすることによって表示され、自動解析機能の設定に用いら

れます。自動解析機能は、測定が終了すると、ライン、マーカ、またはそ
の両方を Data Displayウインドウの X-Y Graph上に自動的に描画します。

この画面では、自動解析機能による制御が可能な 2つのラインと 1つの
マーカを設定します。Line 1および Line 2エリアでは描画するラインを、
Markerエリアではマーカを設定します。

VAR2 (Secondary) 
Step

自動解析対象のカーブを特定するには、このフィールドに VAR2（二次掃

引）ステップ番号（インデックス）を入力します。

Interpolation Mode このボックスをチェックすると、補間モードが有効になります。 測定点間
にマーカを配置することができます。 

Line 1, Line 2 測定終了後、指定位置に自動表示されるライン 1または 2を設定します。

Enable  ラインを有効にするにはこのボックスをチェックします。

Type 下記 4 種類のライン タイプから 1つを選択します。

Axis ラインに対して有効な軸。 Y1 ～ Y8の中から指定しま

す。

First Point 選択したラインに対応する記述を参照してください。

Second Point 選択したラインに対応する記述を参照してください。

ライン タイプ：

• Normal: 指定された 2点を通るライン。

• Gradient: 指定された 1点を通り、指定された傾きを持つライン。

• Tangent: 指定された測定点における接線。

• Regression: 指定領域に含まれる測定データを用いた回帰直線。

Marker 測定終了後、指定位置に自動表示されるマーカを設定します。

Enable  マーカを有効にするにはこのボックスをチェックします。

Condition マーカを表示する場所を決定する変数名と条件式を入力

します。
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After 追加条件を有効にするには、このボックスをチェックし

ます。

2 番目の変数と条件式を入力します。 これは、指定した

ポイントの検索開始条件を設定します。

例えば、2 番目の条件が満たされた後で最初の条件を満たす測定点を検索

するには、次の式を指定します。

Condition:[DGM]=[MAX(DGM)*0.01] [x]After [DGM]=[MAX(DGM)]

Normal line First Pointエリアと Second Pointエリアで、ラインが通過するポイントを指

定します。 次の 2つの方法でポイントを指定できます。

• X-Y Coordinate

目的の X-Y 座標値または式を Xフィールドと Yフィールドに入力しま
す。

• Data Condition

ポイントを指定する変数名と条件式を入力します。 これはMarkerポイ
ントを指定するのと同じ方法です。

Gradient line First Pointエリアで、ラインが通過するポイントを指定します。 次の 2つの
方法でポイントを指定できます。

• X-Y Coordinate

目的の X-Y 座標値または式を Xフィールドと Yフィールドに入力しま
す。

• Data Condition

ポイントを指定する変数名と条件式を入力します。 これはMarkerポイ
ントを指定するのと同じ方法です。

Gradientフィールドに、傾きの値または式を入力します。

Tangent line First Pointエリアで、接線が通過する測定点を指定します。

ポイントを指定する変数名と条件式を入力します。 これはMarkerポイント
を指定するのと同じ方法です。

Regression line First Pointエリアと Second Pointエリアで、回帰計算に使用される測定デー

タの範囲を指定します。 次の 2つの方法でポイントを指定できます。

• X-Y Coordinate
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Auto Analysis Setup
目的の X-Y 座標値または式を Xフィールドと Yフィールドに入力しま
す。

• Data Condition

ポイントを指定する変数名と条件式を入力します。 これはMarkerポイ
ントを指定するのと同じ方法です。
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Display Setup
Display Setup
I/V Sweep／Multi Channel I/V Sweep／ I/V List Sweep／ I/V-t Sampling／
C-V Sweep／ Direct Controlテスト セットアップ画面の Display Setupタブを
クリックするか、Test Definitionウインドウの Define own Output Parameters
ボックスをチェックすることによって表示され、テスト結果出力の設定に
用いられます。

X-Y Graph X-Y Graph Plotエリアへの表示データを選択します。 X 軸と Y1 ～ Y8 軸を

設定できます。チェックボックスで有効／無効を指定します。

Name 軸のパラメータを指定します。

Sharing Y 軸スケールの共有を行うグループを指定します。

Group 1、Group 2、Group 3、Group 4、None（共有しな

い）のいずれか。

Scale、Min、Maxの設定値は、同じグループに設定され

た複数の Y 軸によって共有されます。また、Run Time 
Auto Scale、Auto Scale、Zoom in、 Zoom outによって変更
されるスケールも共有されます。

グルーピングされた Y 軸パラメータと対応する X 軸パラ

メータの両方と同じ名称の X-Yトレースが、同一ウイン

ドウ上、他の表示層に存在する場合、その X-Yトレース
にもスケールの設定・変更が共有されます。

Scale 軸のスケール。 リニアまたはログ。

Min 軸の最小値。

Max 軸の最大値。

Add パラメータ（または軸）を追加します。

Delete 選択したパラメータを削除します。 パラメータを選択す

るには、左側のラジオ ボタンを使用します。

Up 選択したパラメータを上に移動します。

Down 選択したパラメータを下に移動します。
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List Display, 
Parameters

Data Displayウインドウの List Displayエリアまたは Parametersエリアへの
表示データを選択します。チェックボックスで有効／無効を指定します。
各エリアに対して最大 20のパラメータを設定できます。

Add パラメータの行を追加します。

Delete 選択したパラメータを削除します。 パラメータを選択す

るには、左側のラジオ ボタンを使用します。

Up 選択したパラメータを上に移動します。

Down 選択したパラメータを下に移動します。
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SMU Range Setupウインドウ
SMU Range Setup ウインドウ

I/V Sweep／Multi Channel I/V Sweep／ I/V List Sweep／ I/V-t Samplingの
Measurement Setup画面で Rangeボタンをクリックすることによって開か

れ、測定レンジ変更動作の設定に用いられます。

測定レンジングの詳細については、｢ SMUレンジング・モード (p. 4-57) ｣を
参照してください。

Unit 測定に使用される SMU。

Name 測定データの変数名。

Mode レンジ変更モード。オート (AUTO)、リミテッド・オー
ト (LIMITED)、固定 (FIXED)のいずれか。

Range レンジ値。 オートレンジの場合、このフィールドは無視

してください。 リミテッド・オートの場合、測定チャネ
ルは指定されたレンジより小さいレンジを使用しません。

NOTE 1 pAレンジを使用するには（B1500A/E5270Bに有効）
ASU（アト・センス／スイッチ・ユニット）を装着している測定チャネル

は 1 pAレンジをサポートします。1 pAレンジを使用するには、1 pA 固定

レンジまたは 1 pAリミテッド・オート・レンジングに設定します。

B1500A/E5270Bは 1 pAレンジによる測定データの補正を自動実行し、補
正後のデータを返します。データ補正は、あらかじめ保存されているオフ

セット・データ、または測定したオフセット・データを使用して実行され
ます。

オフセット・データを測定するには、実デバイスの測定を開始する前にセ

ルフキャリブレーションを実行します。このオフセット・データは
B1500A/E5270Bの電源がオフされるまで一時的に記憶されます。

Up 選択した測定チャネル・セットアップを上に移動します。

Down 選択した測定チャネル・セットアップを下に移動します。

複数の測定チャネルが設定されている場合、SMU Range Setup設定の上か
ら下の順番で、チャネルが測定を開始します。例外および詳細について

「測定チャネルが複数ある場合 (p. 4-73)」を参照してください。
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Range Change 
Rule and Rate 電圧測定または固定レンジでは使用できません。｢電流測

定オート・レンジング拡張機能 (p. 4-60) ｣を参照してくだ
さい。

有効な Range Change Ruleの値は BY FULL RANGE、GO 
UP AHEAD、または UP AND DOWN AHEAD。

BY FULL RANGEは、通常のオートレンジ動作を実行し

ます。

GO UP AHEADおよび UP AND DOWN AHEADは、レン
ジの境界を決定する Rate値を 11 ～ 100の範囲内で設定

します。測定データが下記の境界値を超えると、レンジ
変更が発生します。

レンジ・アップ境界 = 現在の測定レンジ  Rate/100

レンジ・ダウン境界 = 現在の測定レンジ  Rate/1000

ここで、レンジ・ダウン境界を使用できるのは、UP 
AND DOWN AHEADルールの場合だけです。
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A/D Converter & Integration Time Setupウインドウ
A/D Converter & Integration Time Setup ウイン

ドウ

I/V Sweep／Multi Channel I/V Sweep／ I/V List Sweep／ I/V-t Sampling／
C-V SweepのMeasurement Setup画面で ADC/Integボタンをクリックするこ
とによって開かれ、SMU測定チャネルの A/Dコンバータ (ADC)の設定に
用いられます。

A/D Converter ADCタイプの選択および、オート・ゼロ機能の設定を行います。｢積分時

間 (p. 4-68) ｣を参照してください。
Unit 測定に使用される SMU。

Name 測定データの変数名。

ADC ADCタイプ、HR ADC（高分解能 ADC）または HS ADC
（高速 ADC）。HR ADCはMCSMU、HCSMU、HVSMU、

SMU:B290X、SMU:B291Xには無効です。また SMUパ
ルスを使用する測定にも無効です。

Measurement Compliance Side（コンプライアンス側測定）、または

Force and Compliance Sides（フォース側測定とコンプライ

アンス測定の両方）。Force and Compliance Sidesは
HRSMU、MPSMU、HPSMUには無効です。

Integration Time 各 ADCタイプに対する ADCモードとその係数を設定します。

Mode ADC動作モード

高分解能 ADC：AUTO、MANUAL、または PLC。

高速 ADC：AUTO、MANUAL、PLC、または TIME。

SMUパルスを使用する測定：TIMEまたは PLC。
Factor 係数値。 「積分時間 (p. 4-68)」の Factor値。

Auto Zero オート・ゼロ機能の ONまたは OFF。 高分解能 ADCに有
効。「ADCゼロ機能 (p. 4-69)」を参照してください。

Pulse Averaging 
Count

パルス測定のアベレージングを設定します。HRSMU、MPSMU、HPSMU
には無効です。Count値は、SMUパルス出力チャネルを複数使用する場合
の Pulse Setupウインドウ上の Count値と同じ値に自動設定されます。

Count 1測定データの取得（平均計算）に必要な測定の回数。
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Pulse Setup ウインドウ

Multi Channel I/V SweepのMeasurement Setup画面で Pulseボタンをクリック
することによって開かれ、SMUパルス出力の設定に用いられます。SMU
パルス設定パラメータについては「SMUパルス (p. 4-65)」を参照してくだ
さい。

次のパラメータを設定します。

Common 全パルス出力チャネルに共通のパラメータを設定します。

Period パルス周期。AUTOと入力すると、最適値が自動設定さ

れます。

Measurement 
Delay Time パルス周期の開始から測定開始までの時間。AUTOに設

定すると、最初に立ち下がるパルスのピーク出力が終了

する時点で測定が完了するように自動設定されます。

Integration Time 下記入力フィールドは高速 ADCの設定を行います。高分解能 ADCを使用
することはできません。

Mode ADC動作モード、TIMEまたは PLC。
Factor 係数値。「積分時間 (p. 4-68)」の Factor値。

Pulse Averaging 
Count

パルス測定のアベレージングを設定します。Count値は、ADC and 
Integration Time Setupウインドウの Count値と同じ値に自動設定されます。

Count値は、HRSMU、MPSMU、HPSMUには無効です。
Count 1測定データの取得（平均計算）に必要な測定の回数。

Pulse Channels パルス出力チャネルに個別のパラメータを設定します。

Unit パルス出力に使用する SMU。

Name パルス電圧またはパルス電流出力データの変数名。

Pulse Delay Time パルス周期の開始から遷移（ベースからピーク）開始ま

での時間。HRSMU、MPSMU、HPSMUには 0を設定す
します。

Width パルス幅。HRSMU、MPSMU、HPSMUには同じ値を設

定する必要があります。

Base パルス・ベース値。
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Advanced Setup ウインドウ

I/V Sweep／Multi Channel I/V Sweep／ I/V List Sweep／ I/V-t Samplingの
Measurement Setup画面で Advancedボタンをクリックすることによって開

かれ、次の機能の設定に用いられます。

Channel Settings 直列抵抗とフィルタを設定します。

Unit 測定に使用される SMU。

VName 電圧出力または測定データの変数名。

IName 電流出力または測定データの変数名。

Series R 直列抵抗の NONEまたは 1MOHM。｢ SMU 直列抵抗 (p. 
4-75) ｣を参照してください。

SMU 直列抵抗はMCSMU、HCSMU、HVSMU、
SMU:B290X、SMU:B291Xにはありません。

SMU Filter SMUフィルタの ONまたは OFF。｢ SMUフィルタ (p. 
4-74) ｣を参照してください。

V Compliance UHCU、UHVU、HVMCUに有効。電圧掃引出力のリ
ミット値。これら測定リソースの出力電圧は自動的に測

定され、その測定値はリミット値と比較されます。そし

て、測定値がリミット値を越えると、測定ステータスが

コンプライアンス・ステータスにセットされ、掃引測定

は掃引停止動作（Measurement Setup画面の Sweep [xxxx] 
statusフィールドで設定します）を行います。電圧範囲、

設定分解能は、使用する測定リソースに準じます。

Low Terminal SMU:B290X、SMU:B291Xに有効。Low端子の設定。
GROUNDEDまたは FLOATING。

High Cap. SMU:B290X、SMU:B291Xに有効。高静電容量モード。
ONまたは OFF。静電容量の大きい負荷の測定を行う場

合は ONに設定します。

Wait Time Control 出力待ち時間と測定待ち時間を設定します。｢ウエイト時間 (p. 4-72) ｣を参
照してください。Output Waitは、出力待ち時間を設定します。 Measurement 
Waitは、測定待ち時間を設定します。

State SMU:B290X、SMU:B291Xに有効。待ち時間。ONまた
は OFF。
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Factor 係数値。 0 ～ 10（SMU:B290X、SMU:B291Xでは 0 ～

100）、0.1分解能。 これは｢ウエイト時間 (p. 4-72) ｣に記さ
れる Nの値です。

After Measurement 
Settings

測定実行後のソース出力を保持する機能です。この機能を有効にすると、

繰り返し測定またはクイック・テスト実行中に行われる測定と次の測定と

の間に、出力源がバイアス出力を行います。｢バイアス保持機能 (p. 4-43) ｣
を参照してください。

Bias Hold after 
Measurement 出力保持機能 ONまたは OFF

Output Value after 
Measurement 測定後出力値。

START（掃引スタート値）、STOP(掃引ストップ値）、
SOURCE（サンプリング出力ソース値）、または BASE
（サンプリング出力ベース値）。SMU:B290X、

SMU:B291Xでは、STARTまたは STOP。

Semiconductor 
Relays (16440A 
SMU/PG Selector)

SPGUまたは PGUを装着している計測器に有効です。また Keysight 
16440A SMU/PGUセレクタ (B1500A-A04)の接続にはKeysight 16445Aアダプ
タが必要です。

セレクタのチャネル CH1/CH3の状態（DEFAULTまたは PGU OPEN）を設
定します。この機能を使用する場合は SPGU出力を開始する前に DEFAULT
を Always SMUまたは Normally PGU (AUX)に設定します。設定は
Configurationウインドウの SMU/PG Selectorタブ画面で行います。
CH1 CH1の状態、DEFAULTまたは PGU OPEN。
CH3 CH3の状態、DEFAULTまたは PGU OPEN。

CH1は第 1セレクタのチャネル 1を、CH3は第 2セレクタのチャネル 1を
表しています。セレクタの詳細については「SMU/PGセレクタ (p. 4-51)」
を参照してください。
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Range Setupウインドウ
Range Setup ウインドウ

C-V SweepのMeasurement Setup画面で Rangeボタンをクリックすることに
よって開かれ、測定レンジ変更動作の設定に用いられます。

CMU Measurement 
Range

CMUの測定レンジ変更動作を設定します。
Unit 測定に使用される CMU。

Mode レンジ変更モード。オート (AUTO)または固定 (FIXED)。
Mode=AUTOの場合、MFCMUは最高測定分解能を提供

するレンジを自動的に選択し、測定を実行します。 
Mode=FIXEDの場合、MFCMUは Rangeフィールドに設
定されたレンジを用いて、測定を実行します。

Range 測定レンジ。このフィールドはMode=FIXEDの場合に有
効です。有効な測定レンジは測定周波数に依存します。
Table 2-4を参照してください。

Table 2-4 有効な測定レンジ 

SMU Measurement 
Range

SMUの測定レンジ変更動作を設定します。

測定レンジングの詳細については、｢ SMUレンジング・モード (p. 4-57) ｣を
参照してください。

Unit 測定に使用される SMU。

Name 測定データの変数名。

Mode レンジ変更モード。オート (AUTO)、リミテッド・オー
ト (LIMITED)、固定 (FIXED)のいずれか。

Range レンジ値。 オートレンジの場合、このフィールドは無視

してください。 リミテッド・オートの場合、測定チャネ
ルは指定されたレンジより小さいレンジを使用しません。

周波数 測定レンジ

 200 kHz 50 , 100 , 300 , 1 k, 3 k, 10 k, 30 k, 100 k, 300 k

 2 MHz 50 , 100 , 300 , 1 k, 3 k, 10 k, 30 k

 5 MHz 50 , 100 , 300 , 1 k, 3 k
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Range Change 
Rule and Rate 電圧測定または固定レンジでは使用できません。｢電流測

定オート・レンジング拡張機能 (p. 4-60) ｣を参照してくだ
さい。

有効な Range Change Ruleの値は BY FULL RANGE、GO 
UP AHEAD、または UP AND DOWN AHEAD。

BY FULL RANGEは、通常のオートレンジ動作を実行し

ます。

GO UP AHEADおよび UP AND DOWN AHEADは、レン
ジの境界を決定する Rate値を 11 ～ 100の範囲内で設定

します。測定データが下記の境界値を超えると、レンジ
変更が発生します。

レンジ・アップ境界 = 現在の測定レンジ  Rate/100

レンジ・ダウン境界 = 現在の測定レンジ  Rate/1000

ここで、レンジ・ダウン境界を使用できるのは、UP 
AND DOWN AHEADルールの場合だけです。

Up 選択した測定チャネル・セットアップを上に移動します。

Down 選択した測定チャネル・セットアップを下に移動します。

複数の測定チャネルが設定されている場合、SMU Measurement Range設定
の上から下の順番で、チャネルが測定を開始します。例外および詳細につ

いて「測定チャネルが複数ある場合 (p. 4-73)」を参照してください。

NOTE 1 pAレンジを使用するには (B1500A/E5270B)
ASU（アト・センス／スイッチ・ユニット）を装着している測定チャネル

は 1 pAレンジをサポートします。1 pAレンジを使用するには、1 pA 固定

レンジまたは 1 pAリミテッド・オート・レンジングに設定します。

B1500A/E5270Bは 1 pAレンジによる測定データの補正を自動実行し、補
正後のデータを返します。データ補正は、あらかじめ保存されているオフ

セット・データ、または測定したオフセット・データを使用して実行され
ます。

オフセット・データを測定するには、実デバイスの測定を開始する前にセ

ルフキャリブレーションを実行します。このオフセット・データは
B1500A/E5270Bの電源がオフされるまで一時的に記憶されます。
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Advanced Setup ウインドウ（C-V Sweep）
C-V SweepのMeasurement Setup画面で Advancedボタンをクリックするこ
とによって開かれ、次の機能の設定に用いられます。

AC Level/DC Bias 
Monitor Settings

容量測定実行中に CMUがモニタする ACレベルと DCバイアスのデータを
格納する変数を定義します。

Unit 測定に使用される CMU。

AC Level Monitor 
Name ACレベルのモニタ・データを格納する変数名。

DC Bias Monitor 
Name DCバイアスのモニタ・データを格納する変数名。

Channel Settings SMU 直列抵抗と SMUフィルタを設定します。
Unit 測定に使用される SMU。

VName 電圧出力または測定データの変数名。

IName 電流出力または測定データの変数名。

Series R 直列抵抗の NONEまたは 1MOHM。｢ SMU 直列抵抗 (p. 
4-75) ｣を参照してください。

SMU 直列抵抗はMCSMU、HCSMU、HVSMUにはあり
ません。

SMU Filter SMUフィルタの ONまたは OFF。｢ SMUフィルタ (p. 
4-74) ｣を参照してください。

V Compliance UHCU、UHVU、HVMCUに有効。電圧掃引出力のリ
ミット値。これら測定リソースの出力電圧は自動的に測

定され、その測定値はリミット値と比較されます。そし

て、測定値がリミット値を越えると、測定ステータスが

コンプライアンス・ステータスにセットされ、掃引測定

は掃引停止動作（Measurement Setup画面の Sweep [xxxx] 
statusフィールドで設定します）を行います。電圧範囲、

設定分解能は、使用する測定リソースに準じます。

Wait Time Control SMUの出力待ち時間と測定待ち時間を設定します。｢ウエイト時間 (p. 
4-72) ｣を参照してください。Output Waitは、出力待ち時間を設定します。 

Measurement Waitは、測定待ち時間を設定します。
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Factor 係数値。 0 ～ 10、0.1分解能。 これは｢ウエイト時間 (p. 
4-72) ｣に記される Nの値です。

After Measurement 
Settings

測定実行後のソース出力を保持する機能です。この機能を有効にすると、

繰り返し測定またはクイック・テスト実行中に行われる測定と次の測定と

の間に、出力源がバイアス出力を行います。｢バイアス保持機能 (p. 4-43) ｣
を参照してください。

Bias Hold after 
Measurement 出力保持機能 ONまたは OFF

Output Value after 
Measurement 測定後出力値。

START（掃引スタート値）または STOP(掃引ストップ
値）。

Semiconductor 
Relays (16440A 
SMU/PG Selector)

SPGUまたは PGUを装着している計測器に有効です。また Keysight 
16440A SMU/PGUセレクタ (B1500A-A04)の接続にはKeysight 16445Aアダプ
タが必要です。

セレクタのチャネル CH1/CH3の状態（DEFAULTまたは PGU OPEN）を設
定します。この機能を使用する場合は SPGU出力を開始する前に DEFAULT
を Always SMUまたは Normally PGU (AUX)に設定します。設定は
Configurationウインドウの SMU/PG Selectorタブ画面で行います。
CH1 CH1の状態、DEFAULTまたは PGU OPEN。
CH3 CH3の状態、DEFAULTまたは PGU OPEN。

CH1は第 1セレクタのチャネル 1を、CH3は第 2セレクタのチャネル 1を
表しています。セレクタの詳細については「SMU/PGセレクタ (p. 4-51)」
を参照してください。
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SPGU Pulse Setup ウインドウ

I/V Sweep／Multi Channel I/V Sweep／ I/V List Sweep／ I/V-t Samplingの
Measurement Setup画面で SPGU Pulse...ボタンをクリックする、あるいは
Mode=VPULSEの状態で SPGU Control画面の Pulse/ALWGボタンをクリッ
クすることによって開かれ、SPGUパルス出力の設定に用いられます。設
定パラメータについては、Figure 2-3を参照してください。

Global Settings 次の入力フィールドがあります。設定は全チャネルに適応されます。

Period パルス周期。 20 ns ～ 10 s、分解能 10 ns。

Operation SPGUチャネル出力の動作モード（Free Run、PULSE COUNT、または
Duration）を設定するためのラジオ ボタンがあります。設定は全チャネル

に適応されます。

Free Run 測定が完了または停止するまでパルス出力が継続されま

す。このモードは SPGU Controlクラシック・テストには
対応していません。

PULSE COUNT 指定数のパルスが出力されます。パルス数を 1 ～

1000000の範囲で指定します。 
Duration 指定時間が経過するまでパルス出力が継続されます。出

力時間を 1 s ～ 31556926 s（1年）の範囲で指定します。

Pulse Settings Unit 電圧パルス出力に使用される半導体パルス・ジェネレー

タ・ユニット（SPGU）
VName 電圧出力データの変数名

Type 2-Level Pulse（2値パルス）または 3-Level Pulse（3値パ
ルス）。3-Level Pulseを選択した場合、Additional Pulse
フィールドが有効になります。

Base、Peak パルスのベース電圧およびピーク電圧。 
0 ～  40 V、分解能：1 mV。

Delay ディレイ時間。0 ～ Period-20 ns、分解能：2.5 nsまたは
10 ns（パルス遷移時間 > 8 s）。

Width パルス幅。10 ns ～ Period-10 ns、分解能：2.5 nsまたは
10 ns（パルス遷移時間 > 8 s）。

Leading, Trailing パルス遷移時間。8 ns ～ 400 ms、分解能：2 nsまたは
8 ns（パルス遷移時間 > 8 s）。
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SPGU setup view 
order

Up 選択したチャネル・セットアップを上に移動します。

Down 選択したチャネル・セットアップを下に移動します。

このボタンで行った変更は SPGU Pulse Setupウインドウ上の表示だけに有
効です。Channel Setupの設定には変更はありません。

Load Z Load Z Setupウインドウ (p. 2-65)を開きます。このウインドウで、DUT
（被測定デバイス）の負荷インピーダンスを設定します。この値は出力電圧

の自動調整に使用されます。SPGUは Baseまたは Peakの指定値に近い電

圧を出力します。

Pulse Switch Pulse Switch Setupウインドウ (p. 2-66)を開きます。 このウインドウで、パル
ス・スイッチを有効にします。パルス・スイッチは SPGU出力に内蔵され
ている半導体リレーであり、SPGUチャネル出力を開放するために使用し

ます。このリレーはメカニカル・リレーよりも耐久性に優れ、スイッチン

グ回数の多いアプリケーションに有効です。

Figure 2-3 SPGU パルス設定パラメータ
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Load Z Setup ウインドウ

SPGU Pulse Setupウインドウまたは SPGU ALWG Setupウインドウの Load 
Z...ボタンをクリックすることによって開かれ、SPGUチャネルに接続され
た DUT（被測定デバイス）の負荷インピーダンスの設定に用いられます。

正しいインピーダンス値を設定してください。SPGUは、この値を用いて
出力電圧を自動調整し、指定されたパルス・ベース値およびパルス・ピー

ク値に近い電圧を出力します。

Load Z Unit 電圧パルス出力または任意直線波形電圧出力に使用され

る半導体パルス・ジェネレータ・ユニット（SPGU）
VName 電圧出力データの変数名

Load Z このチャネルに接続される DUT（被測定デバイス）の負

荷インピーダンス。単位：。
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Pulse Switch Setup ウインドウ

SPGU Pulse Setupウインドウの Pulse Switch...ボタンをクリックすることに
よって開かれ、パルス・スイッチの設定に用いられます。パルス・スイッ

チは SPGU出力に内蔵されている半導体リレーであり、SPGUチャネル出
力を開放するために使用します。このリレーはメカニカル・リレーよりも

耐久性に優れ、スイッチング回数の多いアプリケーションに有効です。

Pulse Switch Unit 電圧パルス出力に使用される半導体パルス・ジェネレー

タ・ユニット（SPGU）
VName 電圧出力データの変数名

SW Sync ENABLE（パルス・スイッチ有効）または DISABLE（パ
ルス・スイッチ無効）。 

パルス・スイッチの状態切替（接続／開放）は自動的に

制御され、Figure 2-3に見られるように出力パルスに同期
します。

Delay パルス出力開始からパルス・スイッチ状態切替までの時

間。0 ～ Period-100 ns、分解能 10 ns。
Width パルス・スイッチの切替状態を維持する時間。

100 ns ～ Period-Delay ns、分解能 10 ns。
Normal パルス・スイッチ通常時の状態。CLOSE（接続）または

OPEN（開放）。パルス・スイッチの状態は、Delay-sw時
間経過すると切り替わり、Width-sw時間経過するまで維

持されます（Figure 2-3参照）。この動作はパルス周期ご
とに繰り返されます。
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SPGU ALWG Setup ウインドウ

I/V Sweep／Multi Channel I/V Sweep／ I/V List Sweep／ I/V-t Samplingの
Measurement Setup画面で SPGU ALWG...ボタンをクリックする、あるいは
Mode=ALWGの状態で SPGU Control画面の Pulse/ALWGボタンをクリック
することによって開かれ、任意直線波形（arbitrary linear waveform）電圧出
力の設定に用いられます。

Operation SPGUチャネル出力の動作モード（Free Run、SEQUENCE COUNT、または
Duration）を設定するためのラジオ ボタンがあります。設定は全チャネル

に適応されます。

Free Run 測定が完了または停止するまで任意直線波形シーケンス

出力が継続されます。このモードは SPGU Controlクラ
シック・テストには対応していません。

SEQUENCE 
COUNT 指定数のシーケンスが出力されます。シーケンス数を 1

～ 1000000の範囲で指定します。 
Duration 指定時間が経過するまで出力が継続されます。出力時間

を 1 s ～ 31556926 s（1年）の範囲で指定します。

ALWG Setting 次のフィールドがあります。

ALWG Source 開始ボタン（start button）をクリックすると、Define 
ALWG Waveformウインドウ (p. 2-68)が開きます。この

ウインドウは、任意直線波形およびその出力シーケンス

の定義に用いられます。

Load Z Load Z Setupウインドウ (p. 2-65)を開きます。このウインドウで、DUT
（被測定デバイス）の負荷インピーダンスを設定します。この値は出力電圧

の自動調整に使用されます。SPGUは Baseまたは Peakの指定値に近い電

圧を出力します。

Figure 2-4 SPGU ALWG Setup ウインドウ

start button
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Define ALWG Waveform ウインドウ

波形データ入力フィールドまたは SPGU ALWG Setupウインドウ上 ALWG 
Sourceフィールドの開始ボタン（start button）をクリックすることによって
開かれ、任意直線波形データの作成に用いられます。波形データは、パ

ターン・データとシーケンス・データによって定義されます。

File メニュー 次の 5つの機能があります。
Export ALWaveform... 波形データをエクスポートします。

Import ALWaveform... 波形データをインポートします。

Export Pattern... 選択したパターン・データをエクスポートします。

Import Patterns... パターン・データをインポートします。

Open Pattern Library... パターン・データ・フォルダを開きます。

Close Define ALWG Waveformウインドウを閉じます。

Pattern メニュー 次の 6つの機能があります。
New パターンを新規作成する場合に選択します。New Pattern

ダイアログ ボックスが開き、新規パターン名を入力する

と、Waveform Pattern Editor (p. 2-71)が開きます。 
Edit 選択したパターンをWaveform Pattern Editorで開きます。

Cut 選択したパターンをクリップボードに移動します。

Copy 選択したパターンをクリップボードにコピーします。

Paste クリップボード内のパターンを貼り付けます。

Rename 選択したパターンの名前を変更します。

Column メニュー 次の 5つの機能があります。
Edit 選択した列データをWaveform Pattern Editorで開きます。

Insert 列を追加します。

Delete 選択した列を削除します。

Move 選択した列を左方向または右方向に移動します。

Repeat Count Repeat Countダイアログ ボックスを開きます。繰り返し

回数を設定することができます。
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Sequence Editor 出力チャネル、出力パターン、パターン出力の繰り返し回数、出力順を設

定します。これによって任意直線波形データが定義されます。

Column No. 出力順を特定する番号。パターンはこの番号の順番で出

力されます。

Repeat Count パターン出力の繰り返し回数。channelフィールド（例：

ラベル “SPGU1:HV”の右側のフィールド）によって特定

されるパターンの出力回数を入力します。

channel
(e.g SPGU1:HV) 出力チャネルと出力パターン。出力チャネルは、この行

のヘッダ（例：SPGU1:HV）によって特定されます。右

側の入力フィールドを用いてパターンを特定します。

ドロップダウン・メニューからパターンを選択すること

ができます。

右側のボタンはWaveform Pattern Editorを開きます。

このエリアには次のボタンがあります。

Insert Column 列を追加します。

Delete Column 選択した列を削除します。

To Left 選択した列を左方向に移動します。

To Right 選択した列を右方向に移動します。

また、マウス右クリックのメニューには次の機能があります。

Cancel メニューを閉じます。

Insert Column 列を追加します。

Delete Column 選択した列を削除します。

Move Column 選択した列を左方向または右方向に移動します。

Repeat Count Repeat Countダイアログ ボックスを開きます。繰り返し

回数を設定することができます。

Edit 選択したパターン・データ（Pattern）または列データ
（Column）をWaveform Pattern Editorで開きます。

Repeat Countフィールドでのマウス右クリック・メニューには次の機能が

あります。

Cut 選択された値をクリップボードに移動します。

Copy 選択された値をクリップボードにコピーします。
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Paste クリップボード内の値を指定された場所に貼り付けます。

列が選択された状態（薄青色）でのマウス右クリック・メニューには次の

機能があります。

Cancel メニューを閉じます。

Edit Column  列データをWaveform Pattern Editorで開きます。

channelフィールドが選択された状態（薄青色）でのマウス右クリック・メ

ニューには次の機能があります。

Cancel メニューを閉じます。

Edit Pattern  パターン・データをWaveform Pattern Editorで開きます。

Patterns あらかじめ定義されている波形パターンのアイコンを表示します。マウス

右クリックのメニューには次の機能があります。

Cancel メニューを閉じます。

New Pattern パターンを新規作成する場合に選択します。New Pattern
ダイアログ ボックスが開き、新規パターン名を入力する

と、Waveform Pattern Editor (p. 2-71)が開きます。 
Edit 選択したパターンをWaveform Pattern Editorで開きます。

Cut 選択したパターンをクリップボードに移動します。

Copy 選択したパターンをクリップボードにコピーします。

Paste クリップボード内のパターンを貼り付けます。

Rename 選択したパターンの名前を変更します。

Export Pattern... 選択したパターン・データをエクスポートします。

Import Pattern... パターン・データをインポートします。

パターンのアイコンをダブルクリックすると、そのパターンが Pattern 
Editorで開かれます。
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Waveform Pattern Editor
Patternメニューから Newを選択するなど、いくつかの方法で開かれ、

パターン・データの作成および編集に用いられます。

File メニュー 次の 3つの機能があります。
Save パターン・データを保存します。

Save As... 名前を指定してパターン・データを保存する
ためのダイアログ ボックスを開きます。

Close データを保存せずにWaveform Pattern Editorを
閉じます。

Edit メニュー 次の 7つの機能があります。
Undo 直前の操作を取り消します。

Redo Undoによる取り消し操作を取り消します。

Add a New Point 節点 1つを追加します。

Delete a Point 選択した節点を削除します。

Same Level As Left Point 選択した節点のレベルを左側の節点に合わせ

ます。

Copy Pattern to Clipboard 選択したパターン・データを、タブ区切りス

プレッドシート形式でクリップボードにコ

ピーします。

Paste Pattern from Clipboard クリップボード内のタブ区切りスプレッド

シート形式データを貼り付けます。

Display メニュー 次の機能があります。

Channel Display Channelsダイアログ ボックスを開きま

す。Pattern Editorに表示される SPGUチャネ
ルの選択を行います。この機能は、Waveform 
Pattern Editorで列データを開いている場合に

有効となります。
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Define ALWG Waveformウインドウ
Pattern Editor パターン・データを定義します。グラフィック・モードとテーブル・モー

ドの 2つの方法でパターン・データを定義することができます。 

グラフィック・モードでは、ウインドウ左側のグラフ上でマウス・ポイン

タと GUIを用いてパターン・データを定義します。

テーブル・モードでは、ウインドウ右側の表に Time（秒）、Level（V）、
Switch（パルス・スイッチの状態、0：オープンまたは 1：クローズ）の値
を入力することによってパターン・データを定義します。

Delta Timeチェック ボックスおよび Delta Levelチェック ボックスは、テー
ブル内のデータ表記を切り替えます。チェックがない場合は絶対値表記、

チェックがある場合は直前の節点からの差分表記となります。

このエリアには次のボタンがあります。

Undo 直前の操作を取り消します。

Redo Undoによる取り消し操作を取り消します。

Add a New Point 節点 1つを追加します。

Delete a Point 選択した節点を削除します。

また、マウス右クリックのメニューには次の機能があります。

Cancel メニューを閉じます。

Save パターン・データを保存します。

Save As... パターン・データを指定した名前で保存します。

Edit Editメニューを表示します。
Display Displayメニューを表示します。

Pattern Editorが列データを開いている時には、次の GUIがあります。
Ref Ch. 基準点を含むチャネルまたはパターンを指定します。

Ref Pt. 基準点をインデックス番号（テーブルの No.列）で指定

します。

Delta T 基準点からの差を表示します。Timeデータ用。
Delta V 基準点からの差を表示します。Levelデータ用。
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アプリケーション・テストの定義
Keysight EasyEXPERTソフトウェアのアプリケーション・テスト定義作成
用 GUIのリファレンス情報を記しています。

• Test Definitionウインドウ
• Specification

• Output

• Contents

• Local Variable Definition

• Program Component

• Auto Analysis

• Data Display Control

• Display Data Setup

• GPIB I/O

• Message

• Data Store Control

• Command Execution

• Command Executionを使用する
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Test Definitionウインドウ
Test Definition ウインドウ

Test Definitionウインドウは、Libraryメニューの Define New Test...または
Open Definition of This Test...を選択することによって開かれ、アプリケー

ション・テスト・モードで使用されるテスト定義の作成に使用されます。 

テスト定義は Figure 3-1に示されるエレメントで構成されます。Test 
Definitionウインドウでは、次の 3つのタブ画面を設定することでテスト定
義を作成します。

• Specification

Specificationにはテスト名、概要、デバイス・パラメータ、テスト・パ

ラメータを設定します。パラメータとは、Test Contents内のテスト実行
フローまたはテスト セットアップにテスト条件を渡す変数です。

• Contents

Contentsはテスト定義のコアであり、ローカル変数、テスト実行フ

ロー、テスト セットアップを定義します。テスト セットアップを定義
するには、アプリケーション・テスト、クラシック・テスト、または
My Favoriteセットアップを選択し、テスト条件を設定します。

• Output

Outputの設定はオプションです。テスト定義によるテスト結果出力（テ
スト結果表示とテスト レコード）が必要な場合に、変数（アナリシス・

パラメータ）と表示条件を設定します。

Figure 3-1 Test Definition

Test Specification Test Output

Test Contents

•Test name
•Test description
•Variables

•Entry fields

•Variables

•Test result display

•Local variables
•Test execution flow
•Test setup

•Device parameters
•Test parameters

•X-Y graph
•Data list
•Parameter display

•Classic test
•Application test
•My Favorite setup

•Analysis parameters
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Test Definitionウインドウ
Test Definitionウインドウには次のメニューがあります。

File メニュー 次の 2つの機能を提供します。

Save テスト定義を保存します。 EasyEXPERTに付属するサン

プル・アプリケーション・テストや、他のユーザが作成
したアプリケーション・テストを保存するには、Test 
Nameの値を変更する必要があります。 Test Nameは一意

の名前でなくてはなりません。

Close テスト定義を保存するかしないかを尋ねるダイアログ 
ボックスを開きます。Yesを選択するとテスト定義を保

存して Test Definitionウインドウを閉じます。Noを選択

するとテスト定義を保存しないで Test Definitionウインド
ウを閉じます。

Edit メニュー クリップボードを使用したカット &ペースト、項目の選択等の編集能を提

供します。

Debug メニュー テストフローのデバッグ機能を提供します。｢ Test Contentsのデバッグ (p. 
3-23) ｣を参照してください。

Help メニュー Contents... EasyEXPERT ヘルプ ウインドウを開きます。
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Specification
Specification
この画面は、テスト定義情報と、テスト定義の入力パラメータを定義する

ために用いられます。

Test Information テスト情報を定義します。

Category テスト定義のカテゴリを表示します。 

このボタンは、カテゴリを設定するためのダイアログ 
ボックスを開きます。カテゴリ名の長さは 1 ～ 30文字。 
1つのテスト定義に複数のカテゴリを設定できます。

Test Name テスト定義名を指定します。 名前の長さは 1 ～ 30文字。

Icon メイン画面の Libraryエリアに表示されるテスト定義アイ
コン用ビットマップ ファイルを指定します。

Browse...：ファイル選択ダイアログ ボックスを開きま

す。

Clear：初期設定に戻します。

Description テスト定義の説明を入力します。

Device Parameters 
Definition

デバイス・パラメータを定義します。デバイス・パラメータのタイプ（型）

は Numeric（数値）です。

Name デバイス・パラメータ名。

Default パラメータの初期設定値。

Description パラメータの説明。

Add デバイス・パラメータの行を追加します。

Delete 選択したデバイス・パラメータを削除します。 パラメー

タを選択するには、左側のラジオ ボタンを使用します。

Up 選択したデバイス・パラメータを上に移動します。

Down 選択したデバイス・パラメータを下に移動します。

Copy 選択したデバイス・パラメータをクリップボードにコ

ピーします。

Paste クリップボード内のデバイス・パラメータを選択されて

いるデバイス・パラメータ行の下に追加します。
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Specification
Test Parameters 
Definition

テスト・パラメータを定義します。

Background メイン画面の Test Parametersエリアの背景用ビットマッ

プ ファイルを指定します。

Browse...：ファイル選択ダイアログ ボックスを開きま

す。

Clear：初期設定に戻します。

Name テスト・パラメータ名。

Type テスト・パラメータのタイプ（型）。 Numeric（数値）、
Module（モジュール）、String（文字列）、Vector（配列）、

または ALWaveform（SPGU ALWG出力データ）。

Default パラメータの初期設定値。

Numeric、Vector、ALWaveformパラメータ用フィールド
の右には Numeric KeyPadを開くボタンがあります。

Vectorパラメータ用フィールドの左にはDefine vector data 
(p. 2-19)ダイアログ ボックスを開くボタンがあります。

ALWaveformパラメータ用フィールドの左には Define 
ALWG Waveformウインドウ (p. 2-68)を開くボタンがあ
ります。

Description パラメータの説明。

Align メイン画面の Test Parametersエリアに表示される入力
フィールドの X原点を指定します。このボックスを

チェックすると、X原点は入力フィールドの左端に設定

されます。このボックスのチェックを外すと、X原点は
入力フィールドの左側に置かれるパラメータ名の左端に
設定されます。

X, Y 入力フィールドの位置を指定します。(X, Y)=(0, 0)は、
メイン画面の Test Parametersエリアの左上隅を指定しま

す。 下と右が正の方向です。「Layout...」を参照してくだ
さい。

Width 入力フィールドの幅を指定します。

Ext 通常はチェックしません。この行のパラメータに対応す

る入力フィールドはメイン画面に配置されます。

設定値の変更頻度が低いと判断されるパラメータについ

ては、Extボックスをチェックします。
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Specification
このパラメータに対応する入力フィールドは、メイン画

面の Extended Setupボタンをクリックすることによって
表示されるダイアログ ボックスに配置されます。

Layout... Define Layout (p. 3-10)ダイアログ ボックスを開きます。

Add テスト・パラメータの行を追加します。

Delete 選択したテスト・パラメータを削除します。 パラメータ

を選択するには、左側のラジオ ボタンを使用します。

Up 選択したテスト・パラメータを上に移動します。

Down 選択したテスト・パラメータを下に移動します。

Copy 選択したテスト・パラメータをクリップボードにコピー

します。

Paste クリップボード内のテスト・パラメータを貼り付けしま

す。

Properties 選択されたデバイス・パラメータまたはテスト・パラメータに対する次の

値を定義するために使用します。

パラメータの選択には、パラメータ名の左側にあるラジオ ボタンを使用し
ます。

Min Numeric、Vectorパラメータに有効。許容可能な最小値。

Max Numeric、Vectorパラメータに有効。許容可能な最大値。

Digits Numeric、Vectorパラメータに有効。有効桁数。

Resolution Numeric、Vectorパラメータに有効。許容される設定分解
能。

Unit Numeric、Vectorパラメータに有効。パラメータの単位。

Typical Values... Numeric、Stringパラメータに有効。

Define typical valuesダイアログ ボックスを開きます。パ

ラメータの選択肢（代表的な設定値）を設定できます。

設定された値は、アプリケーション・テスト・モードの

メイン画面に表示されるパラメータ入力フィールドの選

択肢となります。アクティブな入力フィールドの選択肢

はソフトキーに表示され、ソフトキーを用いて設定する

ことが可能です。また、入力フィールドの右クリックで
現れる Selectサブメニューを用いて設定することも可能
です。選択肢は、指定されたパラメータだけに有効です。
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Specification
Resource Type Moduleパラメータに有効。Define Resource Typesダイア
ログ ボックスを開きます。測定リソースのタイプを特定

します。複数設定可能。SMU、HPSMU、HCSMU、
DHCSMU (デュアル HCSMU)、HVSMU、HRSMU、
MPSMU、MCSMU、HRSMU/ASU、GNDU、SPGU、
HVSPGU、WGFMU、RSWGFMU、MFCMU、
MFCMU/SCUU、SWM IN、SWM AUX IN、SWM SMU 
IN、UHCU500、UHCU1500、UHVU、HVMCU、または
NONE。

NONEは、ダミーの SMU NONx:NC (x=1, 2, ...)を測定リ
ソースの選択肢に追加します。NONx:NCを選択した場

合、そのチャネルは測定実行時に無視されます。VAR1
に NONx:NCを選択している場合には、実行エラーが発

生します。

Dimension... Vectorパラメータに有効。

Define dimensionsダイアログ ボックスを開きます。ベク

ター・データの配列サイズを設定します。

Dim1Minと Dim1Maxを用いて一次元側のサイズを指定

します。一次元側は主掃引データの格納に使用できます。

Dim2Minと Dim2Maxを用いて二次元側のサイズを指定

します。二次元側は二次掃引データの格納に使用できま
す。

設定値は、次の条件を満たす必要があります。

• 1  Dim1Min  Dim1Max (例 Dim1Min=1, 
Dim1Max=11)

• 1  Dim2Min  Dim2Max (例 Dim2Min=1, 
Dim2Max=3)

Assign Output 
Channels... ALWaveformパラメータに有効。

このボタンは Assign ALWaveform Output Channelsダイア
ログ ボックスを開きます。SPGUチャネルの識別に変数

を使用する場合、その変数をこのダイアログ ボックスに
指定します。変数にはModuleタイプのテスト・パラ
メータを使用します。

例えば、次のようにパラメータを定義した場合、WAVE1
パラメータの Assign ALWaveform Output Channelsダイア
ログ ボックスには PG1を指定します。
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Specification
PG1: SPGUチャネル識別用のModuleパラメータ

WAVE1: PG1への設定データ用 ALWaveformパラメータ

SPGU ALWG設定データの作成には Define ALWG 
Waveformウインドウ (p. 2-68)を使用します。上記のよう
に設定した場合、WAVE1用データ作成時のチャネル識

別子には PG1が使用されます。
Symbols... Numeric、Vectorパラメータに有効。

Define symbolsダイアログ ボックスを開きます。指定さ

れた数値パラメータの値をシンボル（文字列）に割り当
てることができます。

シンボルの割り当てを設定すると、アプリケーション・

テスト・モードのメイン画面に表示されるパラメータ入

力フィールドには、数値ではなく、割り当てられたシン
ボルが入ります。

テスト定義の内部では、パラメータは数値で扱われます。

ところが、パラメータの文字列変換結果は、文字列化さ
れた数字ではなく、割り当てられたシンボルとなります。

例えば、パラメータ Param1の Value=1に Symbol=ONを
割り当てた場合、Param1入力フィールドに数値 1を入力
すると Param1入力フィールドには文字列 ONが設定され
ます。 また、Param1入力フィールドに文字列 ONが設定
されている間、Param1値は内部的に数値 1となります。
そして、Param1の数値が 1である時の Param1の文字列
変換結果は文字列 1ではなく、文字列 ONになります。

数値－シンボルの割り当ては、指定されたパラメータだ

けに有効です。

Value値と Symbol値は 1対 1に対応する必要がありま

す。 

ValueはMin、Max、Digits、Resolutionの各設定を満たす
必要があります。

Symbolには 1 ～ 30文字が有効です。
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Specification
NOTE Symbols... 数値－シンボルの割り当て
数値－シンボルの割り当てが行われたパラメータの文字列変換結果は、割

り当てられたシンボルです。数式を文字列に変換する string組み込み関数
を使用する場合には、注意が必要です。次の設定例におけるMode=0時の
string(Mode) 関数実行結果は、文字列 OFFであり、文字列 0ではありま
せん。

Name=Mode, Value=0, Symbol=OFF

Define Layout
このダイアログ ボックスは、Test Definitionウインドウの Specification画面
上の Layout...ボタンをクリックすることによって開き、アプリケーショ

ン・テスト設定画面上に表示するテスト・パラメータの入力フィールドの
レイアウトの定義に用いられます。Figure 3-2を参照してください。

入力フィールドのレイアウトを定義するには、以下の手順で行ってくださ

い。

1. 移動する入力フィールドを選択します。その方法については、「入力

フィールドを選択するには (p. 3-13)」を参照してください。

2. 選択された入力フィールドを移動します。その方法については、「入力

フィールドを移動するには (p. 3-14)」を参照してください。

Figure 3-2 Define Layout ダイアログ ボックス

Primary Entry Field
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Specification
Define Layout GUI
ここでは、Define Layoutダイアログ ボックスのグラフィカル・ユーザ・イ

ンタフェースを説明します。

Define Layoutダイアログ ボックスには、次のボタンがあります。

OK 設定したレイアウトを保存してから、Define Layoutダイ
アログ ボックスを閉じます。

Cancel 設定したレイアウトを保存しないで、Define Layoutダイ
アログ ボックスを閉じます。

Define Layoutダイアログ ボックスには、次のメニューがあります。

File メニュー Exit 設定したレイアウトを保存しないで、Define Layoutダイ
アログ ボックスを閉じます。

Edit メニュー Undo 操作を取り消します。10 回前までさかのぼることができ

ます。

Redo 取り消した操作を再度実行します。

Select All すべての入力フィールドを選択します。

View メニュー Property... Properties (p. 3-12)ウインドウを開きます。

Align メニュー Left プライマリ入力フィールド（Primary Entry Field）の左端

に、その他の選択された入力フィールドの左端を合わせ
ます。

Center プライマリ入力フィールドの水平方向の中心に、その他

の選択された入力フィールドの水平方向の中心を合わせ
ます。

Right プライマリ入力フィールドの右端に、その他の選択され

た入力フィールドの右端を合わせます。

Top プライマリ入力フィールドの上端に、その他の選択され

た入力フィールドの上端を合わせます。

Middle プライマリ入力フィールドの垂直方向の中心に、その他

の選択された入力フィールドの垂直方向の中心を合わせ
ます。

Bottom プライマリ入力フィールドの下端に、その他の選択され

た入力フィールドの下端を合わせます。
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Specification
To Grid 選択された入力フィールドの左上端を最寄のグリッドに

合わせます。

Distribute メニュー Horizontally 選択された入力フィールド（3 個以上）を、左端の入力

フィールドを基点に水平方向に間隔が均一になるように

配置します。

Vertically 選択された入力フィールド（3 個以上）を、上端の入力

フィールドを基点に垂直方向に間隔が均一になるように

配置します。

Centralize メニュー Horizontally 選択された入力フィールド全体の水平方向の中心を、入

力フィールド・エリアの水平方向の中心に移動します。

Vertically 選択された入力フィールド全体の垂直方向の中心を、入

力フィールド・エリアの垂直方向の中心に移動します。

Tab Order メニュー Top to Bottom 左上の入力フィールドから Xが小さい順 (Xが同じ場合

は Yが小さい順）に、TabIndexが割り振られます。X/Y
については、「Properties (p. 3-12)」を参照してください。

Left to Right 左上の入力フィールドから Yが小さい順 (Yが同じ場合

は Xが小さい順）に、TabIndexが割り振られます。X/Y
については、「Properties (p. 3-12)」を参照してください。

Properties
このウインドウは、Define Layoutダイアログ ボックスの Viewメニューで、
Property...をクリックすることによって開き、入力フィールド・エリアや入

力フィールドの特性を設定します。

入力フィールド・エリアを選択すると、以下の特性を設定できます。

Design DrawGrid グリッドの表示／非表示を切り替えます。

GridSize グリッドの幅と高さを設定します。

SnapToGrid グリッドに合わせるかどうかを切り替えます。

Layout Size 入力フィールド・エリアの幅と高さを設定します。

入力フィールドを選択すると、以下の特性を設定できます。

Behavior TabIndex アプリケーション・テストで、テスト・パラメータの入

力フィールドをタブで移動させる順序を設定します。
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Layout Align 入力フィールドの X原点を指定します。

True:入力フィールドの左端。

False: 入力フィールドの左側に置かれるパラメータ名の

左端。

Width 入力フィールドの幅を指定します。

X, Y 入力フィールドの位置を指定します。Y原点は入力
フィールドの上端です。(X, Y)=(0, 0)は、入力フィール
ド・エリアの左上隅を指定します。 下と右が正方向です。

入力フィールドを選択するには

入力フィールドを選択するには、以下の方法があります。

• 入力フィールドをクリックします。キーボードの Ctrl キーを押しながら
入力フィールドをクリックすると、複数の入力フィールドを選択できま
す。

• マウスをドラッグして作った矩形で複数の入力フィールドを囲います。

• EDITメニューの Select Allをクリックして、すべての入力フィールドを

選択します。

選択された入力フィールドは、青い矩形で囲われます。配置操作の基準に

なるプライマリ入力フィールド（Primary Entry Field）は、Figure 3-2に記さ
れているように強調された青の矩形で囲われます。プライマリ入力フィー

ルドは、ひとつだけ設定することができます。プライマリ入力フィールド

を変更するには、選択状態にある入力フィールドをクリックします。最後

にクリックされた入力フィールドが、プライマリ入力フィールドになりま
す。

選択されている入力フィールドを解除するには、以下の方法があります。

• キーボードの Shift キーを押しながら、選択されている入力フィールド

をクリックします。

• 選択されている入力フィールド以外の場所をクリックすると、すべての

入力フィールドの選択が解除されます。
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入力フィールドを移動するには

選択されている入力フィールドを移動するには、以下の方法があります。

• マウスによるドラッグ＆ドロップにより、単一または複数の入力フィー

ルドを移動することができます。

• プロパティ・ウインドウの Xと Yの値を変更して、単一または複数の

入力フィールドを移動することができます。

• キーボードの矢印キーを使って、単一または複数の入力フィールドを移

動することができます。

• Alignメニューの機能を使って、プライマリ入力フィールドを基準とし

て、単一または複数の入力フィールドを移動することができます。

• Distributeメニューの機能を使って、選択された複数の入力フィールド

を、水平方向または垂直方向に間隔が均一になるように配置することが
できます。

• Centralizeメニューの機能を使って、選択された複数の入力フィールド

の水平方向または垂直方向の中心を、入力フィールド・エリアの水平方
向または垂直方向の中心に移動することができます。
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Output
この画面は、テスト定義によるテスト結果出力（テスト結果表示とテスト 
レコード）の設定に用いられます。

Outputのセットアップはオプションです。下記動作を実現するにはアナリ

シス・パラメータと表示パラメータの定義が必要です。

• 後に続くテストへのデータ転送

• テスト結果に基づくプログラム分岐

• テスト定義内でのテスト結果データの計算

• このアプリケーション・テストのテスト結果表示とテスト レコード

テスト定義内で使用されるアプリケーション・テストのアナリシス・パラ

メータを読み取るには、External Variable Setup (p. 3-25)ダイアログ ボック

スを使用します。

Define Own Output 
Parameters

テスト定義によるテスト結果出力の設定を行うには、このチェック ボック
スをチェックします。このボックスがチェックされていると、X-Y Graph、
List Display、Parametersの各エリアが有効になります。 テスト結果出力はテ
スト定義の実行毎に行われます。

Allocate Data 
Display for each 
test

Multi Display機能を Enable、Disable、または Comply with above levelに設定
します。

Enableに設定すると、同じ名前のテストセットアップによるテスト結果

データは共通の Data Displayウインドウに、異なる名前のテストセット

アップによるデータは新しい Data Displayウインドウに表示されます。
Disableに設定すると、異なる名前のテストセットアップによるデータで

あっても、常に同じ Data Displayウインドウに表示されます。

Comply with above levelに設定すると、Multi Display ON/OFFステータスあ
るいはこのアプリケーション・テストを使用する上位アプリケーション・

テストの設定に従います。

Define Analysis 
Parameters...

Analysis Parameter Definition (p. 3-16)ウインドウを開きます。このウインド

ウでは、テスト結果に出力されるベクター データまたはスカラ データの定
義を行います。ここで定義する変数をアナリシス・パラメータと呼びます。

X-Y Graph, 
List Display, 
Parameters

テスト定義によるテスト結果出力（テスト レコードと結果表示）を設定す
るために用いられます。｢ Display Setup (p. 2-51) ｣を参照してください。
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Analysis Parameter Definition
このウインドウは Define Analysis Parametersボタンをクリックすることで
開かれ、テスト結果に出力されるベクター データまたはスカラ データの定
義に用いられます。ここで定義する変数をアナリシス・パラメータと呼び
ます。このウインドウを閉じるには Closeボタンを使用します。

NOTE アナリシス・パラメータは、このアプリケーション・テストを使用するテ
スト定義から参照可能です。それには、「External Variable Setup (p. 3-25)」
ダイアログ ボックスを用いて、アナリシス・パラメータとテスト定義内変

数（ローカル変数、デバイス・パラメータ、テスト・パラメータ、または
アナリシス・パラメータ）との関連付けを行います。

Vector Parameters ベクター データをストアするアナリシス・パラメータを設定します。ベク
ター データとは、1つ以上の数値を含む配列データです。

Name アナリシス・パラメータの名前。

Unit アナリシス・パラメータの単位。

Description アナリシス・パラメータの説明。

Add アナリシス・パラメータの行を追加します。

Delete 選択したパラメータを削除します。パラメータを選択す

るには、左側のラジオ ボタンを使用します。

Up 選択したパラメータを上に移動します。

Down 選択したパラメータを下に移動します。

Scalar Parameters スカラ データをストアするアナリシス・パラメータを設定します。スカラ 
データとは、1つの数値データです。

Name アナリシス・パラメータの名前。

Unit アナリシス・パラメータの単位。

Description アナリシス・パラメータの説明。

Add アナリシス・パラメータの行を追加します。

Delete 選択したパラメータを削除します。 パラメータを選択す

るには、左側のラジオ ボタンを使用します。

Up 選択したパラメータを上に移動します。

Down 選択したパラメータを下に移動します。
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Contents
Test Contentsはテスト定義のコアであり、ローカル変数、テスト セット
アップ、テスト実行フロー（プログラム フロー）から構成されます。Test 
Contentsには、次のエレメントを定義可能です。Figure 3-3を参照してくだ
さい。

• ローカル変数（Local Variables）

• プログラム・コンポーネント（Program Component）

• アプリケーション・テスト（Application Test）

• クラシック・テスト（Classic Test）

• My Favoriteセットアップ（My Favorite Setup）

• アナリシス・コンポーネント（Analysis）

• その他のコンポーネント（Miscellaneous）

• デバイス・パラメータ（Test Specificationで定義）

• テスト・パラメータ（Test Specificationで定義）

• アナリシス・パラメータ（Test Outputで定義）

デバイス・パラメータ、テスト・パラメータ、アナリシス・パラメータを 
Contents内で用いる場合、ローカル変数に定義する必要はありません。

使用可能なコンポーネントについては、Figure 3-4を参照してください。

Figure 3-3 Contents のエレメント

Variables
•Device parameters
•Test parameters

Variables
•Analysis parameters

Local variables

Program Component

Application Test
Classic Test

Analysis

Miscellaneous

Test OutputTest Specification

My Favorite setup
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Contents の定義・編集

Contents画面は、テスト定義のコアとなるテスト実行フローを作成するた
めに使用されます。 テスト実行フローを作成するには、ウインドウの中央
にある Program Listエリアを使用し、次を実行します。Figure 3-5も参照し
てください。

1. Local Variables Definitionを用いてローカル変数を定義します。

2. コンポーネント選択エリアからコンポーネントを選択します。使用可能

なコンポーネントについては、Figure 3-4を参照してください。

3. 選択したコンポーネントを、BLOCKステートメントと END BLOCKス
テートメントの間に追加します。

4. テスト実行フローが完成するまで、これを繰り返します。

Figure 3-4 使用可能なコンポーネント

Program Component

Application Test

Analysis

Classic Test

M iscellaneous

M y Favorite
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Program 
Component

このメニューは、テスト フローで使用可能なプログラム コンポーネントを
表示します。｢ Program Component (p. 3-28) ｣を参照してください。

Application Test このメニューは、使用可能なアプリケーション・テスト定義を表示します。 

テスト フローにアプリケーション・テスト・コンポーネントを Insertする
と｢ Application Test (p. 1-56) ｣と同様なテスト条件設定画面が現れます。この

画面でテスト条件を設定します。

テスト条件の入力に変数を使用することができます。Numeric変数または
Module変数を使用するには、変数名をそのまま入力します。String変数を
使用するには、変数名の前にイコール =をつけて入力します（例：

=VAR）。

Assign to external variables...ボタンをクリックすると｢ External Variable Setup 
(p. 3-25) ｣ダイアログ ボックスを開きます。

Analysis このメニューは、テスト フローで使用可能な解析機能を表示します。 次の
コンポーネントが提供されています。

• Auto Analysis (p. 3-29)

• Display Data Setup (p. 3-33)

• Data Display Control (p. 3-32)

Classic Test このメニューは、クラシック・テスト項目 I/V Sweep、Multi Channel I/V 
Sweep、I/V List Sweep、I/V-t Sampling、C-V Sweep、SPGU Control、
Switching Matrix Control、Direct Controlを表示します。

テスト フローにクラシック・テスト・コンポーネントを Insertすると、
｢ I/V Sweep (p. 2-4) ｣、｢ Multi Channel I/V Sweep (p. 2-9)」、「I/V List Sweep (p. 
2-14)」、「I/V-t Sampling (p. 2-22) ｣、｢ C-V Sweep (p. 2-28) ｣、｢ SPGU Control (p. 
2-32) ｣、｢ Switching Matrix Control (p. 2-34) ｣、または「Direct Control (p. 
2-36)」と同様なテスト条件設定画面が現れます。この画面でテスト条件の

設定を行います。

テスト条件設定画面の Display Setupタブ画面において、Assign to external 
variables...ボタンをクリックすると、｢ External Variable Setup (p. 3-25) ｣ダイ
アログ ボックスをオープンします。
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My Favorite Setup このメニューはテスト フローに InsertするMy Favoriteセットアップの選択

に使用します。Preset Groupを特定してから、セットアップを選択します。

トレーサ・テスト セットアップを選択する場合、Multi Channel I/V Sweep
テスト セットアップに変換されて Insertされます。この変換処理では、

VAR1の両方向掃引（Dual Polarity）の設定は無視されます。正方向掃引 ス
タート→ストップの設定は変換されますが、負方向掃引 -1（スタート→

ストップ）の設定は変換されません。

Miscellaneous このメニューは、テスト フローで使用可能なその他の機能を表示します。

次のコンポーネントが提供されています。

• GPIB I/O (p. 3-35)

• Message (p. 3-40)

• Command Execution (p. 3-43)

• Data Store Control (p. 3-42)

コンポーネントをテスト フローに追加するには、コンポーネントを配置す

る行を選択し、コンポーネント選択エリアからテスト実行フロー エリアに
コンポーネントをドラッグします。または、行とコンポーネントを選択し、
Insertボタンをクリックします。コンポーネントは選択された行の次の行に

配置され、それ以降の行は下に移動します。

テスト フローにコンポーネントを追加したら、新しい行を選択することに

よって、エディタ（ウインドウ中央から右）が表示される場合があります。

エディタはセットアップの定義に使用されます。エディタが表示されるか
どうかはコンポーネントに依存します。例えば、Local Variables Definition
は、ローカル変数設定用のエディタを表示します。｢ Local Variable 
Definition (p. 3-26) ｣を参照してください。

テスト フローを編集するには、Block Selection/Line Selection、Insert、
Delete、Copy、Cut、Pasteの各ボタンを使用します。また、テスト フロー
をデバッグするには、Run/Pause、Abort、Step、Break、Inspectの各ボタン
または Debugメニューを使用します。｢ Test Contentsのデバッグ (p. 3-23) ｣を
参照してください。
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Edit / Debug ボタン Contents上部には、編集用の Block Selection/Line Selection、Insert、Delete、
Copy、Cut、そして Pasteボタンと、デバッグ用の Run、Abort、Step、
Break、そして Inspectボタンが表示されます。リスト エリアで選択された

行に対して有効なボタンだけが使用可能です。

Line Selectionボタンは、リスト エリアの選択モードを行選択モードに変更

します。 Block Selectionボタンは、選択モードをブロック選択に変更しま

す。

行選択モードでは、行カーソルは行を選択します。

ブロック選択モードでは、行カーソルはブロックを選択します。 たとえば、

IFステートメントから END IFステートメントまでの行は 1つのブロック
です。

Insert このボタンは、選択されたコンポーネントを選択された行の次の行に配置

します。 それ以降の行は下に移動します。

Delete このボタンは、選択された行を削除します。 それ以降の行は上に移動しま

す。

Copy このボタンは、選択された行をクリップボードにコピーします。Test 
Definitionウィンドウ間でのコピー＆ペーストも可能です。

Cut このボタンは、選択された行をクリップボードに移動します。 それ以降の

行は上に移動します。

Paste このボタンは、クリップボード内のコンポーネントを選択された行の次の

行に配置します。それ以降の行は下に移動します。Test Definitionウィンド
ウ間でのコピー＆ペーストも可能です。

COMMENT このボタンは、選択された行をコメントアウトします。COMMENTコン
ポーネントを用いて作られた行、および END BLOCK行には無効です。

UNCOMMENT このボタンは、選択されたコメント行をもとに戻します。COMMENTコン
ポーネントを用いて作られた行、および END BLOCK行には無効です。
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Figure 3-5 Test Contents 設定画面
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Test Contents のデバッグ

Contentsタブ画面では、次のデバッグ用のボタンが表示されます。これら

は Test Contentsのデバッグに有効です。

ブレークポイントを設定したら、Runボタンをクリックします。そして、

Test Contentsの動作のチェック、Variable Inspectorを用いた変数値のチェッ
クなどを行いましょう。

Figure 3-6 Test Contents のデバッグ

Run/Pause デバッグを開始（テスト フローを実行）します。 実行中は、ラベルが
Pauseに変わります。Pauseをクリックすると実行が休止し、ラベルが
Runに変わります。Runはデバッグ（実行）を継続します。

Abort デバッグ（実行）を中止します。

Step テスト フローの選択された行を実行します。 ボタンを繰り返しクリックす

ると、実行が 1行ずつ継続されます。

Break ブレーク ポイントを設定／解除します。ブレーク ポイントでこのボタンを
クリックすると、この行のブレーク ポイントの設定は解除されます。プロ

グラム実行はブレーク ポイントで自動的にブレークします。

Inspect デバッグ（実行）が休止またはブレークしているときに使用できます。 こ

のボタンは Variable Inspectorを開きます。｢ Variable Inspector (p. 3-24) ｣を参
照してください。

Break point

Paused point
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Variable Inspector
Variable Inspectorは、Test Contents画面の Inspectボタンをクリックすること
によって表示され、ローカル変数、デバイス・パラメータ、テスト・パラ

メータ、アナリシス・パラメータの値をモニタ・変更するために用いられ
ます（ベクター変数の場合はモニタのみ可能）。次のボタンがあります。

Add Numeric 数値変数モニタ エリアを追加します。

Add Vector ベクター変数モニタ エリアを追加します。

Add String ストリング変数モニタ エリアを追加します。

Add Module モジュール変数モニタ エリアを追加します。

変数モニタ エリアのバナーをクリックすると、次の機能を提供するメ

ニューが表示されます。

Up 変数モニタ エリアを上に移動します。

Down 変数モニタ エリアを下に移動します。

Remove 変数モニタ エリアを削除します。

Numeric Variable 次の情報をモニタ・変更できます。

Variable 数値変数名。

Value 変数の値。

Vector Variable 次の情報をモニタできます。

Name ベクター変数名。

Index1 2 次元配列の第 1インデックス。

Index2 2 次元配列の第 2インデックス。

Value 変数の値。

String Variable 次の情報をモニタ・変更できます。

Variable 文字列変数名。

Value 変数の値。

Module Variable 次の情報をモニタ・変更できます。

Variable モジュール変数名。

Value 変数の値。
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External Variable Setup
このダイアログ ボックスはアプリケーション・テスト セットアップ画面ま
たはクラシック・テスト セットアップ画面の Assign to external variable...ボ
タンをクリックすることによって表示され、テスト セットアップ内部の変
数とテスト定義内変数（ローカル変数、デバイス・パラメータ、テスト・

パラメータ、またはアナリシス・パラメータ）との関連付けを行います。
これにより内部変数の値をプログラム フローで読み取ることができます。

このダイアログには次のボタンがあります。

Add 変数入力フィールドを追加します。

Delete ラジオ ボタンで選択した変数入力フィールドを削除します。

Up 選択した変数入力フィールドを上に移動します。

Down 選択した変数入力フィールドを下に移動します。

このダイアログ ボックスには次の入力フィールドがあります。

External variable Measurement dataフィールドに設定される内部変数と対となるテスト定義内
変数（ローカル変数、デバイス・パラメータ、テスト・パラメータ、また
はアナリシス・パラメータ）の名前を設定します。

Measurement data 値の読み取りを行うテストセットアップ内部変数の名前を設定します。ア

プリケーション・テストの場合、アナリシス・パラメータだけが有効です。

使用例 テスト セットアップ内部のベクター変数 Vdataの値をローカル変数

VDATAで読み取るには、次のようにします。

1. Local Variables Definitionステートメントを用いて、VDATAをローカル

変数として定義します。

2. アプリケーション・テストまたはクラシック・テスト セットアップ画
面の Assign to external variable...ボタンをクリックします。

3. External Variable Setupダイアログ ボックスの Addボタンをクリックし
ます。

4. External Variableに VDATAを設定します。

5. Measurement dataに Vdataを設定します。

6. Closeボタンをクリックします。
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Local Variable Definition
このセットアップ エディタは、テスト フロー リスト エリアで Local 
Variables Definitionが選択されているときに表示され、テスト定義で使用さ

れる変数を定義します。 セットアップ エディタには、次のボタンがありま

す。

Add Numeric 数値変数を追加します。

Add Vector ベクター変数を追加します。

Add String ストリング変数を追加します。

Add Module モジュール変数を追加します。

変数エリアのバナーをクリックすると、次の機能を提供するメニューが表

示されます。

Up このボタンは、変数エリアを上に移動します。

Down このボタンは、変数エリアを下に移動します。

Remove このボタンは、変数を削除します。

Numeric Variable このエリアには、次の入力フィールドがあります。

Name 数値変数名。

Value 変数の初期設定値。

Description 変数に関する追加情報。
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Vector Variable このエリアには、次の入力フィールドがあります。

Name ベクター変数名。

Count 要素数、または配列サイズ。

Description 変数に関する追加情報。

このエリアには、配列データの初期値自動設定方法を指定する次のラジオ 
ボタンがあります。

• Assign Linear Values FROM [最初の要素の値 ] TO [最後の要素の値 ]

Count=1の場合、最初の値（=最後の値）が要素に設定されます。

Count>1の場合、N 番目の要素には次の値が設定されます。

最初の値 + (N-1) （最後の値 -最初の値）/ (Count-1)

• Assign Linear Values FROM [最初の要素の値 ] STEP [ステップ値 ]

N 番目の要素には、最初の値 + (N-1) ステップが設定されます。

String Variable このエリアには、次の入力フィールドがあります。

Name 文字列変数名。

Value 変数の初期設定値。

Description 変数に関する追加情報。

Module Variable このエリアには、次の入力フィールドがあります。

Name モジュール変数名。

Description 変数に関する追加情報。
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Program Component
この選択メニューは、｢プログラム・ステートメント (p. 5-23) ｣に記される
コンポーネントを提供します。特に、次のコンポーネントはセットアップ 
エディタを提供します。

• ASSIGN

• COMMENT

• IF

• ELSE IF

• FOR

ASSIGN このコンポーネントは、変数値の定義に使用されるセットアップ エディタ
を提供します。次の入力フィールドが提供されます。

Variable 変数名。

Expression 変数の定義。

COMMENT このコンポーネントは、プログラム ラインにコメントを入力するための
セットアップ エディタを提供します。

IF このコンポーネントは、IFステートメントの条件を入力するためのセット

アップ エディタを提供します。

ELSE IF このコンポーネントは、ELSE IFステートメントの条件を入力するための

セットアップ エディタを提供します。

FOR このコンポーネントは、FOR NEXTループの条件を定義するためセット

アップ エディタを提供します。次の入力フィールドが提供されます。

Variable 変数名。

Initial Value FOR NEXTループを開始するカウント。

Terminate Value FOR NEXTループを終了するカウント。

Step Value ループ カウントの増分ステップ値。
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Auto Analysis
このコンポーネントは、自動解析機能を設定するためのセットアップ エ
ディタを提供します。 自動解析機能は、測定が終了すると、ライン、マー
カ、またはその両方を Data Displayウインドウの X-Y Graph上に自動的に

描画します。

セットアップ エディタでは、自動解析機能による制御が可能な 2つのライ
ンと 1つのマーカを設定します。 

Line 1および Line 2エリアでは、描画するラインを設定します。 

Markerエリアでは、マーカを設定します。

Interpolation Mode このボックスをチェックすると、補間モードが有効になります。 測定点間
にマーカを配置することができます。 

Line 1, Line 2 このエリアでは、測定の後で、指定位置に自動表示されるライン 1または
ライン 2を設定します。

Enable  ラインを有効にするにはこのボックスをチェックします。

Fix  自動解析機能実行後のラインをグラフ上に固定するには

このボックスをチェックします。移動可能にするには

チェックを外します。

Type 下記 4 種類のライン タイプから 1つを選択します。

Axis ラインに対して有効な軸。 Y1 ～ Y8の中から指定しま

す。

First Point 選択したラインに対応する記述を参照してください。

Second Point 選択したラインに対応する記述を参照してください。

ライン タイプ：

• Normal: 指定された 2点を通るライン。

• Gradient: 指定された 1点を通り、指定された傾きを持つライン。

• Tangent: 指定された測定点における接線。

• Regression: 指定領域に含まれる測定データを用いた回帰直線。
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Marker このエリアでは、測定の後で、指定位置に自動表示されるマーカを設定し

ます。

Enable  マーカを有効にするにはこのボックスをチェックします。

Condition マーカを表示する場所を決定する変数名と条件式を入力

します。

After 追加条件を有効にするには、このボックスをチェックし

ます。

2 番目の変数と条件式を入力します。 これは、指定した

ポイントの検索開始条件を設定します。

例えば、2 番目の条件が満たされた後で最初の条件を満たす測定点を検索

するには、次の式を指定します。

Condition:[DGM]=[MAX(DGM)*0.01] [x]After [DGM]=[MAX(DGM)]

Normal line First Pointエリアと Second Pointエリアは、ラインが通過するポイントを指

定するために用いられます。 次の 2つの方法でポイントを指定できます。

• X-Y Coordinate

目的の X-Y 座標値または式を Xフィールドと Yフィールドに入力しま
す。

• Data Condition

ポイントを指定する変数名と条件式を入力します。 これはMarkerポイ
ントを指定するのと同じ方法です。

Gradient line First Pointエリアは、ラインが通過するポイントを指定するために用いられ

ます。 次の 2つの方法でポイントを指定できます。

• X-Y Coordinate

目的の X-Y 座標値または式を Xフィールドと Yフィールドに入力しま
す。

• Data Condition

ポイントを指定する変数名と条件式を入力します。 これはMarkerポイ
ントを指定するのと同じ方法です。

Gradientフィールドに、傾きの値または式を入力します。
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Tangent line First Pointエリアは、接線が通過する測定点を指定するために用いられま

す。

ポイントを指定する変数名と条件式を入力します。 これはMarkerポイント
を指定するのと同じ方法です。

Regression line First Pointエリアと Second Pointエリアは、回帰計算に使用される測定デー

タの範囲を指定するために用いられます。 次の 2つの方法でポイントを指

定できます。

• X-Y Coordinate

目的の X-Y 座標値または式を Xフィールドと Yフィールドに入力しま
す。

• Data Condition

ポイントを指定する変数名と条件式を入力します。 これはMarkerポイ
ントを指定するのと同じ方法です。
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Data Display Control
このコンポーネントは、テスト定義内で使用されるアプリケーション・テ

ストまたはクラシック・テストのテスト結果表示を制御します。

Enable Data Display このボックスをチェックすると表示を有効にします。

このコンポーネントを使用しない場合、表示は有効です。

このコンポーネントはテスト定義によるテスト結果表示を制御しません。

テスト定義によるテスト結果表示は常に有効です。テスト定義が行うテス
ト結果出力については｢ Output (p. 3-15) ｣を参照してください。
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Display Data Setup
このコンポーネントは、テスト実行フローに設定されたローカル変数の

データ出力を設定します。ローカル変数のデータを Data Displayウインド
ウに表示できます。

X-Y Graph X-Y Graph Plotエリアへの表示データを選択します。 X 軸と Y1 ～ Y8 軸を

設定できます。

Name 軸のパラメータを指定します。

Sharing Y 軸スケールの共有を行うグループを指定します。

Group 1、Group 2、Group 3、Group 4、None（共有しな

い）のいずれか。

Scale、Min、Maxの設定値は、同じグループに設定され

た複数の Y 軸によって共有されます。また、Run Time 
Auto Scale、Auto Scale、Zoom in、 Zoom outによって変更
されるスケールも共有されます。

グルーピングされた Y 軸パラメータと対応する X 軸パラ

メータの両方と同じ名称の X-Yトレースが、同一ウイン

ドウ上、他の表示層に存在する場合、その X-Yトレース
にもスケールの設定・変更が共有されます。

Scale 軸のスケール。 リニアまたはログ。

Min 軸の最小値。

Max 軸の最大値。

Add パラメータ（または軸）を追加します。

Delete 選択したパラメータを削除します。 パラメータを選択す

るには、左側のラジオ ボタンを使用します。

Up 選択したパラメータを上に移動します。

Down 選択したパラメータを下に移動します。
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List Display, 
Parameters

List Displayエリアでは、Data Displayウインドウの List Displayエリアの出
力を設定します。 Parametersエリアでは、Data Displayウインドウの
Parametersエリアの出力を設定します。 各エリアに対して最大 20のパラ
メータを設定できます。

parmeter データ出力を行うパラメータを指定します。

Add パラメータの行を追加します。

Delete 選択したパラメータを削除します。 パラメータを選択す

るには、左側のラジオ ボタンを使用します。

Up 選択したパラメータを上に移動します。

Down 選択したパラメータを下に移動します。
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GPIB I/O
このコンポーネントは、次の入力フィールドを含むセットアップ エディタ
を提供します。 このコンポーネントは GPIBインタフェースの制御に用い
られます。 変数名を入力するフィールドには、テスト定義に定義されてい
る変数名だけを入力できます。

CAUTION このコンポーネントのAddressパラメータにEasyEXPERTが制御対象として

いる装置の GPIBアドレスを設定してはいけません。設定した場合、装置
の動作は保障されません。

Write String 指定した文字列データを指定した GPIBデバイスに送信します。

Address ターゲット デバイスの GPIBアドレス。

String 送信する文字列値。

Terminator ターミネータ、DEFAULT、EOI、CR/LF+EOI、LF+EOI、
CR/LF、LF、NONE（指定なし）のいずれか。

Write Value 指定した数値データを文字列データに変換し、指定した GPIBデバイスに
送信します。

Address ターゲット デバイスの GPIBアドレス。

Format Write Valueのフォーマット。 Keysight T&M Programmers 
Toolkitに従います。

Value0 送信する数値または文字列。

Value1 送信する数値または文字列。

Value2 送信する数値または文字列。

Value3 送信する数値または文字列。

Terminator ターミネータ、DEFAULT、EOI、CR/LF+EOI、LF+EOI、
CR/LF、LF、NONE（指定なし）のいずれか。
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Read String 指定した GPIBデバイスから文字列値を読み取ります。

Address ターゲット デバイスの GPIBアドレス。

String 文字列変数名。 返された値を格納します。

Length To Read 読み取る文字列値のバイト長。

Length Actually 
Read 数値変数名。 返された値のバイト長を格納します。 

Length To Readが十分大きく、返された文字列値ととも

にターミネータが送信されている場合は、この数値変数
の値は指定された Length To Readよりも小さくなります。

Terminator ターミネータ、DEFAULT、EOI、CR/LF+EOI、LF+EOI、
CR/LF、LF、NONE（指定なし）のいずれか。

Terminated 数値変数名。 実行結果を格納します。 ターミネータに

よって読み取りが完了した場合、1が格納されます。 そ

れ以外の場合、0が格納されます。

Timeout タイムアウト。 231 sより小さい値（分解能 1 ms）が有効
です。 0を入力すると、タイムアウトは設定されません。 

Read Value 指定した GPIBデバイスから数値を読み取ります。

Address ターゲット デバイスの GPIBアドレス。

Value 数値変数名。 返された値を格納します。

Preamble 文字列変数名。 返された値のプリアンブルを格納します。 

プリアンブルとは、数値と見なされない部分です。 この

フィールドが設定されていない場合は、プリアンブルは
削除されます。

Postamble 文字列変数名。 返された値のポストアンブルを格納しま

す。 ポストアンブルとは、数値と見なされない部分です。 

このフィールドが設定されていない場合は、ポストアン
ブルは削除されます。

Success 数値変数名。 実行結果を格納します。 成功した場合、1
が格納されます。 それ以外の場合、0が格納されます。

Terminator ターミネータ、DEFAULT、EOI、CR/LF+EOI、LF+EOI、
CR/LF、LF、NONE（指定なし）のいずれか。

Timeout タイムアウト。 231 sより小さい値（分解能 1 ms）が有効
です。 0を入力すると、タイムアウトは設定されません。 
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Read List 指定した GPIBデバイスからベクター データを読み取ります。

Address ターゲット デバイスの GPIBアドレス。

Values ベクター変数名。 返された値を格納します。

Delimiter 区切り記号。 1文字。 0 ～ 9、E、e、+、-、.(小数点）は
指定できません。

Length Actually 
Read 数値変数名。 ベクター変数に格納されるデータの数を格

納します。

Terminator ターミネータ、DEFAULT、EOI、CR/LF+EOI、LF+EOI、
CR/LF、LF、NONE（指定なし）のいずれか。

Timeout タイムアウト。 231 sより小さい値（分解能 1 ms）が有効
です。 0を入力すると、タイムアウトは設定されません。 

Read STB 指定した GPIBデバイスのステータス バイトを読み取ります。

Address ターゲット デバイスの GPIBアドレス。

Status Byte 数値変数名。 ステータス バイトを格納します。

Timeout タイムアウト。 231 sより小さい値（分解能 1 ms）が有効
です。 0を入力すると、タイムアウトは設定されません。 

GP-IB Control 実行する GPIBステートメントを次から選びます。

• Group Execution Trigger

指定した GPIBデバイスにトリガを送信します。

Address ターゲット デバイスの GPIBアドレス。

Timeout タイムアウト。 231 sより小さい値（分解能 1 ms）が有効
です。 0を入力すると、タイムアウトは設定されません。 

• Device Clear

指定した GPIBデバイスにデバイス クリアを送信します。

Address ターゲット デバイスの GPIBアドレス。

Timeout タイムアウト。 231 sより小さい値（分解能 1 ms）が有効
です。 0を入力すると、タイムアウトは設定されません。 
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• Go To Local

指定した GPIBデバイスをローカル状態に戻します。

Address ターゲット デバイスの GPIBアドレス。

Timeout タイムアウト。 231 sより小さい値（分解能 1 ms）が有効
です。 0を入力すると、タイムアウトは設定されません。 

• Local LockOut

指定した GPIBデバイスをロックします。

Address ターゲット デバイスの GPIBアドレス。

Timeout タイムアウト。 231 sより小さい値（分解能 1 ms）が有効
です。 0を入力すると、タイムアウトは設定されません。 

コマンド入力例 1 Keysight B2200Aスイッチング・マトリクス（GPIBアドレス 22）に次のコ

マンドを入力するには、Write Valueを使用し、次のように入力します。

:ROUT:SYMB:CHAN 0, 1, “Gate”

このコマンドは、オート構成モードの B2200Aの出力 1に Gateという文字
列をアサインします。

• Write Value:

Address 22

Format :ROUT:SYMB:CHAN {0}, {1}, “{2}”

Value0 0

Value1 1

Value2 Gate

Value3 空欄

Terminator LF+EOI

ここで、{0}、{1}、{2}、{3}は Formatフィールド内で使用できる変数であ
り、それぞれ Value0、Value1、Value2、Value3に対応します。
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コマンド入力例 2 コマンド入力例 1を実行した後に、次のクエリ コマンドを実行し、そのレ

スポンスを読むには、Write Stringと Read Stringを使用し、次のように入力

します。Write Stringでコマンドを送ってから、Read Stringでレスポンスを
読み取ります。

:ROUT:SYMB:CHAN? 0, 1

このコマンドは、オート構成モードの B2200Aの出力 1にアサインされた
文字列を読み取ります。

• Write String:

Address 22

String :ROUT:SYMB:CHAN? 0, 1

Terminator LF+EOI

• Read String:

Address 22

String ReturnedValue

Length To Read 10

Length Actually Read Length1

Terminator LF+EOI

Terminated Term

Timeout 1.00 s

ここで、ReturnedValueは :ROUT:SYMB:CHAN? 0, 1コマンドの実行による
レスポンスを格納する文字列変数、Length1は ReturnedValue値のバイト長
を格納する数値変数、Termは実行結果を格納する数値変数であり、これら

の変数は Local Variables Definitionステートメントに定義されているものと
します。
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このコンポーネントは、次の入力フィールドを含むセットアップ エディタ
を提供します。このコンポーネントは、プログラム実行を休止し、ユーザ
の応答を待つために表示されるメッセージ ボックスを設定します。

Message メッセージ ボックスに表示されるメッセージを入力します。 

User Response このエリアは Button 1から Button 4のエリアに分かれています。

Button 1 このエリアには、次の入力フィールドがあります。

Label 左端のボタンのラベルまたは名前。

Selected テスト定義で使用された変数名。 この変数は、ユーザの応答

を格納します。 このボタンのクリックによってメッセージ 
ボックスが閉じられた場合、返される値は 1です。 それ以外
の場合、返される値は 0です。

Button 2 このエリアには、次の入力フィールドがあります。

Label 左から 2 番目のボタンのラベルまたは名前。

Selected テスト定義で使用された変数名。 この変数は、ユーザの応答

を格納します。 このボタンのクリックによってメッセージ 
ボックスが閉じられた場合、返される値は 1です。 それ以外
の場合、返される値は 0です。

Button 3 このエリアには、次の入力フィールドがあります。

Label 右から 2 番目のボタンのラベルまたは名前。

Selected テスト定義で使用された変数名。 この変数は、ユーザの応答

を格納します。 このボタンのクリックによってメッセージ 
ボックスが閉じられた場合、返される値は 1です。 それ以外
の場合、返される値は 0です。

Button 4 このエリアには、次の入力フィールドがあります。

Label 右端のボタンのラベルまたは名前。
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Selected テスト定義で使用された変数名。 この変数は、ユーザの応答

を格納します。 このボタンのクリックによってメッセージ 
ボックスが閉じられた場合、返される値は 1です。 それ以外
の場合、返される値は 0です。
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Data Store Control
このコンポーネントは、テスト定義内で使用されるアプリケーション・テ

ストまたはクラシック・テストのテスト レコードの保存を制御します。

Enable Creating Test Result Record 
このボックスをチェックすると、保存を有効にします。

このコンポーネントを使用しない場合、保存は有効です。

このコンポーネントはテスト定義によるテスト レコードの保存を制御しま
せん。テスト定義によるテスト レコードの保存は常に有効です。テスト定

義が行うテスト結果出力については｢ Output (p. 3-15) ｣を参照してください。
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Command Execution
このコンポーネントは、次の入力フィールドを含むセットアップ エディタ
を提供します。 このコンポーネントは、指定された実行ファイル（EXE
ファイル）を実行し、その実行結果を取得するために用いられます。 変数

名を入力するフィールドには、テスト定義内に定義されている変数名だけ

を入力できます。「Command Executionを使用する (p. 3-45)」を参照してく
ださい。

Command 
Filename

実行するWindows実行ファイル（EXEファイル）の名前。

Argument コマンドに渡す引数またはパラメータ。

Write Type 書き込むデータの型。 String（文字列）または List（ベクター データ）。

• String

Write Stringエリアが表示されます。書き込む文字列データを定義しま

す。最大 20 個の文字列データを定義可能です。

• List

Write Listエリアが表示されます。次の入力フィールドがあります。

Values EXEファイルに渡す Listデータの変数名。

Format このフィールドの入力を省略すると、Listデータが渡
されます。Listデータ内の 1データを渡す場合は、
そのエレメントを特定するキーワードを入力します。

「Formatフィールドを設定する (p. 3-48)」を参照して
ください。
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Read Type 読み取るデータの型。 String（文字列）、Value（数値）、List（ベクター デー
タ）、None（レスポンスなし）のいずれか。

• String

Read Stringエリアが表示されます。次の入力フィールドがあります。

Result 数値変数名。実行結果コードを格納します。

String 文字列変数名。 返される値を格納します。

Length Actually Read 数値変数名。 Stringに格納された文字列のバ

イト長を格納します。

• Value

Read Valueエリアが表示されます。次の入力フィールドがあります。

Result 数値変数名。 実行結果コードを格納します。

Value 数値変数名。 返される値を格納します。

• List

Read Listエリアが表示されます。次の入力フィールドがあります。

Result 数値変数名。 実行結果コードを格納します。

Values ベクター変数名。 返される値を格納します。

• None

読み出す値がない場合に選択します。
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Command Execution を使用する

Windows実行ファイル（EXEファイル）を実行するには Command 
Executionコンポーネントを使用します。ほとんどの実行ファイルには、実

行に必要な入力パラメータ、または実行後に返される出力パラメータがあ
ります。パラメータには Test Contentsタブ画面の Local Variable Definitionコ
ンポーネント、または Test Specificationタブ画面で定義される変数を使用
します。

ここではWindows実行ファイルの入力方法を説明します。

• コマンド・パラメータ

• 数値またはベクター入力パラメータを定義する

• 複数の文字列または数値入力パラメータを定義する

• 数値出力パラメータを定義する

• ベクター出力パラメータを定義する

• 文字列出力パラメータを定義する

• Formatフィールドを設定する

コマンド・パラメータ

Command Executionコンポーネントでは、入力変数 1つと出力変数 1つを
使用可能です。複数の文字列入力パラメータ、数値入力パラメータに対応

するには、次のように変数を設定します。複数のベクター入力パラメータ、
複数の出力パラメータには対応できません。

• 複数の文字列入力パラメータを用いるには、文字列変数を使用します。

Command ExecutionコンポーネントでWrite Typeを Stringに設定すると、
文字列データを 20 個まで定義することが可能です。

• 複数の数値入力パラメータを用いるには、数値変数を使用し、Write 
Typeを Stringに設定します。数値変数名を入力する場合は、string組み
込み関数を使用します。たとえば、Rz数値変数を設定するには
string(Rz)と入力します。

• 数値入力パラメータと文字列入力パラメータが必要な場合は、それぞれ

数値変数、文字列変数を使用し、Write Typeを Stringに設定します。
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NOTE コマンド実行前には、ASSIGNステートメントを用いて、変数に値を入力
しておく必要があります。

NOTE string組み込み関数

string組み込み関数は、数式を文字列に変換する関数です。関数の引数に注

意してください。数値－シンボル割り当ての行われた数値変数が引数であ

る場合、string 関数の実行結果は割り当てられたシンボルです。文字列変換

された数字ではありません。数値－シンボルの割り当ては Specification (p. 
3-5)で定義されます。

次の数値－シンボル割り当て設定例におけるMode=0時の string(Mode) 
関数実行結果は、文字列 OFFであり、文字列 0ではありません。

パラメータ Mode、Value=0、Symbol=OFF

数値またはベクター入力パラメータを定義する

1. Test Contentsタブ画面の Local Variable Definitionコンポーネント、また
は Test Specificationタブ画面でベクター変数を定義します。

2. Command ExecutionコンポーネントでWrite Typeを Listに設定します。

3. Write Listエリアの Valuesフィールドに変数名を入力します。

数値パラメータの場合、ベクター変数の 1つの要素が数値データ格納用

として使用されます。データを特定するには Formatフィールドを使用
します。例えば、ベクター変数の第 1 要素を特定するには {0}と入力
します。「Formatフィールドを設定する (p. 3-48)」を参照してください。
ベクター パラメータの場合、Formatフィールドを使用しません。

複数の文字列または数値入力パラメータを定義する

1. Test Contentsタブ画面の Local Variable Definitionコンポーネント、また
は Test Specificationタブ画面で複数の文字列または数値変数を定義しま
す。

2. Command ExecutionコンポーネントでWrite Typeを Stringに設定します。

3. Write Stringエリアに 1行追加します。

4. 第 1行目に第 1入力パラメータの変数名を入力します。

複数の入力パラメータがある場合は、行を追加し、その行に変数名を入

力します。このとき、入力パラメータの順番を厳守してください。
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数値変数名を入力するには、string組み込み関数を使用します。たとえ
ば、Rz数値変数を設定するには string(Rz)と入力します。

数値出力パラメータを定義する

1. Test Contentsタブ画面の Local Variable Definitionコンポーネント、また
は Test Specificationタブ画面で数値変数を定義します。

2. Command Executionコンポーネントで Read Typeを Valueに設定します。

3. Read Valueエリアの Valueフィールドに変数名を入力します。

Resultフィールドはブランクにするか、Local Variable Definitionまたは Test 
Specificationに定義されている別の数値変数名を入力します。変数はコマン

ド実行結果を受け取るために使用されます。

ベクター出力パラメータを定義する

1. Test Contentsタブ画面の Local Variable Definitionコンポーネント、また
は Test Specificationタブ画面でベクター変数を定義します。

2. Command Executionコンポーネントで Read Typeを Listに設定します。

3. Read Listエリアの Valuesフィールドに変数名を入力します。

Resultフィールドはブランクにするか、Local Variable Definitionまたは Test 
Specificationに定義されている数値変数名を入力します。変数はコマンド実

行結果を受け取るために使用されます。

文字列出力パラメータを定義する

1. Test Contentsタブ画面の Local Variable Definitionコンポーネント、また
は Test Specificationタブ画面で文字列変数を定義します。

2. Command Executionコンポーネントで Read Typeを Stringに設定します。

3. Read Stringエリアの Stringフィールドに変数名を入力します。

Resultフィールドと Length Actually Readフィールドはブランクにするか、
Local Variable Definitionまたは Test Specificationに定義されている数値変数
名を入力します。変数はコマンド実行結果あるいは戻された文字列データ
の長さを受け取るために使用されます。
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Format フィールドを設定する

キーワードは {I,A:F}のように入力します。I、A、Fは次の意味を持ちま

す。

I エレメントを特定するインデックス。整数。0または正数。0は
1 番目のエレメントを特定します。省略できません。

A データの文字の長さ。整数。正数は右揃いの文字、負数は左揃

いの文字を示します。省略すると、文字の長さは制限されませ
ん。

F スタイル。Table 3-1を参照してください。省略すると Gが選択

されます。

次に入力例を記します。

• {0,5:E}　1 番目のエレメント、5文字分、指数表現

• {1,10}　2 番目のエレメント、10文字分、一般表現

• {2:x}　3 番目のエレメント、文字数制限なし、16進数表現

• {3}　4 番目のエレメント、文字数制限なし、一般表現

Table 3-1 F に有効な値

F 意味 F 意味

C または c 通貨 N または n 数値

D または d 10進数 P または p パーセント

E または e 指数 R または r ラウンドトリップ

F または f 固定小数点 X または x 16進数

G または g 一般
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設定例

次の設定例は 2つの数値入力と 4つの数値出力を持つ PlsdivMeasureIdコマ
ンドを実行します。

入力パラメータには rangingと id_rangeの数値変数、出力パラメータには
read_dataベクター変数、コマンド実行結果の格納には PassFail数値変数を
用います。これらの変数は Test Contentsタブ画面の Local Variable Definition
コンポーネント、または Test Specificationタブ画面で定義します。 入力用の
変数にはコマンド実行前に値を入力しておく必要があります。4つの出力
データは read_dataの要素に順に格納されます。

Figure 3-7 Command Execution 設定例
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機能の説明
本章では Keysight B1500/EasyEXPERTによる測定機能と、 EasyEXPERTの便
利な機能について説明します。

• I/V Sweep測定

• Multi Channel I/V Sweep測定

• I/V-t Sampling測定

• C-V Sweep測定

• SPGUモジュール

• Sweep停止機能

• スタンバイ機能

• バイアス保持機能

• 電流オフセット除去機能

• SMU CMUユニファイ・ユニット（SCUU）

• アト・センス／スイッチ・ユニット（ASU）

• SMU/PGセレクタ

• モジュール・セレクタ

• 超大電流エクスパンダ／フィクスチャ

• HVSMU電流エクスパンダ

• 超高電圧エクスパンダ

• SMUレンジング・モード

• SMUコンプライアンス

• SMUパルス

• SMU測定時間

• SMUフィルタ

• SMU 直列抵抗

• インターロック機能

• 自動パワー・オフ機能
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I/V Sweep 測定

I/V Sweep測定では、出力チャネル（SMU）が電圧または電流の掃引出力
を行い、測定チャネル（SMU）が各掃引ステップ毎に電流または電圧の測

定を行います。使用する出力ファンクションに応じて次の測定を行うこと

ができます。SMUの出力ファンクションについては Figure 4-1を参照して
ください。

• 基本掃引測定（VAR1を使用）

• バイアス同期掃引測定（VAR1と VAR2を使用）

• 同期掃引測定（VAR1と VAR1’を使用、VAR2も使用可能）

• パルス掃引測定（SMUの 1チャネルがパルス出力を行う基本掃引測定、
バイアス同期掃引測定、または同期掃引測定）

Figure 4-1 SMU の出力ファンクションと掃引出力

使用可能な測定リソース

SMU（ソース／モニタ・ユニット）と SPGU（パルス・ジェネレータ・ユ
ニット）を使用することができます。SMUは定電圧、定電流、電圧パル
ス、または電流パルスの出力を行いながら測定を行うことができます。

SPGUは電圧パルスの出力を行います。SPGUを使用するには｢ SPGUモ
ジュール (p. 4-28) ｣を参照してください。
複数の測定チャネルを使用する場合、各チャネルは順番に測定を実行しま

す。｢測定チャネルが複数ある場合 (p. 4-73) ｣を参照してください。

VAR1

VAR2

VAR1’
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出力レンジ

掃引源の出力レンジは、出力のタイプによって次のレンジに自動設定され

ます。

• リニア掃引：掃引出力値すべてをカバーする最小出力レンジ。

• 電圧ログ掃引：掃引出力値すべてをカバーする最小出力レンジ。

• 電流ログ掃引：掃引出力値の変更毎にその値に最適な出力レンジ。

基本掃引測定

掃引出力には、一次掃引源 (VAR1)を使用します。掃引出力設定の組み合
わせ (Directionと Linear/Log）によって Figure 4-2のような階段波出力が可

能です。

• Direction

Single: 片道掃引。スタート値からストップ値まで出力を掃引します。

Double: 往復掃引。スタート値からストップ値まで掃引し、さらにス

タート値まで掃引します。

• Linear/Log

Linear: リニア階段波掃引

Log: ログ階段波掃引

Figure 4-2 基本掃引測定に有効な階段波出力
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基本掃引測定を行うには次の設定を行います。GUIについては｢ I/V Sweep 
(p. 2-4) ｣を参照してください。

1. Channel Setup画面で次の設定を行います。

• 一次掃引源に設定する SMUの Functionを VAR1に設定します。

• 電流測定 SMUのMode（出力モード）を V、VPULSE、または
COMMON（B2900では選択不可）に、電圧測定 SMUのModeを I
または IPULSEに設定します。パルスは SMU 1モジュールだけに有
効です。

2. Measurement Setup画面で、VAR1の次のパラメータを設定します。

Direction 片道掃引 (SINGLE)または往復掃引 (DOUBLE)。

Linear/Log リニア (LINEAR)またはログ (LOG)掃引。ログ掃引
における 1ディケードあたりの掃引ステップ数は 10 、
25、または 50です（B2900の場合、10のみ）。

Start 掃引スタート値。有効な設定値は掃引源の出力範囲に

依存します。ログ掃引ではゼロは無効です。

Stop 片道掃引終了点、または往復掃引折り返し点の出力

値。有効な設定値は掃引源の出力範囲に依存します。
ログ掃引では Startと同じ極性の値が有効であり、ゼ

ロは無効です。

Step, 
No. of Steps リニア掃引の場合、Stepは掃引のステップ変化量。

No. of Stepsは掃引ステップ数であり、Start、Stop、
Stepから自動的に計算されます。

ログ掃引の場合、Stepは無効です。No. of Stepsは掃
引ステップ数であり、Start、Stop、および 1ディケー
ドあたりのステップ数から自動的に計算されます。

No. of Stepsは 1から 10,001（B2900の場合、2500）
でなければいけません。

Compliance 掃引源のコンプライアンス値。 有効な設定値は掃引源

のコンプライアンス・レンジに依存します。

Pwr Comp (設定省略可 )掃引源のパワー・コンプライアンス値。 
有効な設定値は掃引源のパワー・コンプライアンス・

レンジに依存します。B2900では、無効です。
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Hold ホールド時間。Start値出力開始からディレイ時間の

開始までの時間。ディレイ時間が 0 sの時は、測定開

始までの時間。 
設定範囲：0 ～ 655.35 s、分解能：10 ms

SMU:B290X/B291Xの設定範囲は、0 ～ 100000 s。
Delay ディレイ時間。ホールド時間の終了から測定開始まで

の時間。または出力値をステップ・アップしたタイミ

ングから測定開始までの時間。 
設定範囲：0 ～ 65.535 s、分解能：100 s

SMU:B290X/B291Xの設定範囲は、0 ～ 100000 s。

Figure 4-3 基本掃引測定 

バイアス同期掃引測定 
バイアス同期掃引測定では、一次掃引源 (VAR1)と二次掃引源 (VAR2)を使
用します。VAR2が Start値を出力している間に、VAR1が Start値から Stop
値までの階段波掃引を行います。次に VAR2出力を Step値だけ変化させて

一次掃引を行います。これを VAR2出力が Stop値に達するまで繰り返しま

す。
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VAR2にはリニア片道掃引が有効です。

GUIについては｢ I/V Sweep (p. 2-4) ｣を参照してください。

バイアス同期掃引測定を行うには次の設定を行います。

1. Channel Setup画面で次の設定を行います。

• 一次掃引源に設定する SMUの Functionを VAR1に設定します。

• 二次掃引源に設定する SMUの Functionを VAR2に設定します。

• 電流測定 SMUのMode（出力モード）を V、VPULSE、または
COMMON（B2900では選択不可）に、電圧測定 SMUのModeを I
または IPULSEに設定します。パルスは SMU 1モジュールだけに有
効です。

2. ｢基本掃引測定｣を参照し、VAR1を設定します。
3. Measurement Setup画面で、VAR2の次のパラメータを設定します。

Start 二次掃引源の出力スタート値。有効な設定値は二次掃

引源の出力範囲に依存します。

Stop 二次掃引源の出力ストップ値。Start、Step、No. 
of Stepsから自動的に計算されます。有効な設定値

は二次掃引源の出力範囲に依存します。

Step 二次掃引源のステップ変化量。

No. of Steps 二次掃引源のステップ数（N2）。 設定範囲：1 ～ 1001

ただし、次式を満たす必要があります。

1 N1 N2  128128（N1：一次掃引源のステップ数）

Compliance 二次掃引源のコンプライアンス値。 有効な設定値は
SMUのコンプライアンス・レンジに依存します。

Pwr Comp (設定省略可 ) 二次掃引源のパワー・コンプライアン

ス値。 有効な設定値は SMUのパワー・コンプライア
ンス・レンジに依存します。B2900では無効です。
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Figure 4-4 バイアス同期掃引測定 

同期掃引測定 
同期掃引測定では、一次掃引源 (VAR1)と同期掃引源 (VAR1’)を使用しま
す。B2900では無効です。

同期掃引源の出力は、次式に見られるように、一次掃引源の出力に対して

係数とオフセットを持っています。

同期掃引出力 = 一次掃引出力  Ratio + Offset

Ratioおよび Offsetは設定パラメータです。これらを設定する場合、同
期掃引出力が SMUの出力範囲を越えないように、ご注意ください。

一次掃引源の次のパラメータの設定は、同期掃引源にも共通です。

• Direction (Singleまたは Double)

• Linear/Log

同期掃引測定を行うには次の設定を行います。GUIについては｢ I/V Sweep 
(p. 2-4) ｣を参照してください。

1. Channel Setup画面で次の設定を行います。

• 一次掃引源に設定する SMUの Functionを VAR1に設定します。

• 同期掃引源に設定する SMUの Functionを VAR1’に設定します。

• 電流測定 SMUのMode（出力モード）を V、VPULSE、または
COMMONに、電圧測定 SMUのModeを Iまたは IPULSEに設定し
ます。パルスは SMU 1モジュールだけに有効です。
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機能の説明

I/V Sweep測定
VAR1と VAR1’を同じモード（電圧または電流）に設定してくださ

い。

2. ｢基本掃引測定｣を参照し、VAR1を設定します。
3. Measurement Setup画面で、VAR1’の次のパラメータを設定します。

Offset 一次掃引源と同期掃引源の出力間のオフセット値。

Ratio 一次掃引源と同期掃引源の出力の比率。

Compliance 同期掃引源のコンプライアンス値。有効な設定値はコ

ンプライアンス・レンジに依存します。

Pwr Comp (設定省略可 )同期掃引源のパワー・コンプライアン

ス。有効な設定値はパワー・コンプライアンス・レン
ジに依存します。

Figure 4-5 同期掃引測定 

パルス掃引測定 
掃引源または定電源として設定されている SMUからパルスを出力するこ
とによって、パルス掃引測定を行うことが可能です。 ただしパルス源に設

定できる SMUは 1つです。
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機能の説明

I/V Sweep測定
Figure 4-6は SMUパルス出力とその他の出力の関係を示しています。 SMU
のパルス出力は一次掃引源の各ステップと同期します。測定は、SMUがパ
ルスのピーク値を出力している間に行われます。またディレイ時間を設定
することはできません。

パルス掃引測定を行うには、次の設定を行います。パルス設定パラメータ

の定義を Figure 4-7に示します。 GUIについては｢ I/V Sweep (p. 2-4) ｣を参照
してください。

1. Channel Setup画面で次の設定を行います。

• 一次掃引源に設定する SMUの Functionを VAR1に設定します。

• 電流測定 SMUのMode（出力モード）を V、VPULSE、または
COMMONに、電圧測定 SMUのModeを Iまたは IPULSEに設定し
ます。パルス出力に設定できる SMUは 1モジュールだけです。

2. ｢基本掃引測定｣を参照し、VAR1を設定します。
3. Measurement Setup画面で、SMU Pulseの次のパラメータを設定します。

Period パルス周期。

Width パルス幅。パルス出力の開始（パルス・ベース値から

パルス・ピーク値 に向かって出力を開始した時）か

らパルスの終了（パルス・ピーク値からパルス・ ベー
ス値に向かって出力を開始した時）までの時間。

Base パルス・ベース値。

パルス・ピーク値 パルス・ピーク値の設定は、パルス出力に使用する SMUの出力ファンク
ション (Function)の設定によって異なります。Table 4-1を参照してくださ
い。

Table 4-1 パルス・ピーク値と Function の設定

Function の設定 パルス・ピーク値 

CONST Constantsエリアの Source値

VAR1 VAR1の Start、Stop、Stepから決まります。

VAR2 VAR2の Start、Step、No. of Stepsから決まります。

VAR1’ VAR1の Start、Stop、Stepと VAR1’の Offset、Ratio
から決まります。
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機能の説明

I/V Sweep測定
測定チャネル 使用できる測定チャネルは 1つです。

測定チャネルは常にコンプライアンス・レンジを用いて測定を行います。

コンプライアンス・レンジとは、設定されたコンプライアンス値を含む最
小レンジのことです。Measurement Setup画面の Rangeボタンは無効です。

Figure 4-6 SMU パルス出力とその他の出力 
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機能の説明

I/V Sweep測定
Figure 4-7 SMU パルス 
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機能の説明

Multi Channel I/V Sweep測定
Multi Channel I/V Sweep 測定

Multi Channel I/V Sweep測定は、I/V Sweepと同様の掃引測定を行いますが、
次の違いがあります。

• 全 SMUを VAR1掃引出力源に設定可能（最大 10チャネル）

• 全 SMUをパルス出力源に設定可能（最大 10チャネル）
• VAR1出力モード（電圧または電流）の選択に制限はありません

• VAR1’掃引モードがありません

掃引出力と測定のタイミングを Figure 4-8に記します。DC出力チャネルは
Channel Setup画面にリストされた順に出力を開始します。複数の測定チャ

ネルを使用する場合、各チャネルは順番に測定を実行します。｢測定チャネ

ルが複数ある場合 (p. 4-73) ｣を参照してください。

複数のパルス出力チャネルを使用する場合、DC出力チャネルが Channel 
Setup画面にリストされた順に出力を開始し、最後にパルス出力チャネルが

同時に出力を開始します。全ての測定チャネルは同時に測定を開始します。

Figure 4-8 Multi Channel I/V Sweep 測定（高分解能 AD コンバータ使用時）
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機能の説明

I/V-t Sampling測定
I/V-t Sampling 測定

I/V-t Sampling（サンプリング）測定では、出力チャネル（SMU）が定電圧
または定電流を出力し、測定チャネル（SMU）が指定された時間間隔

(Interval)で被測定デバイス (DUT)に生じる電流／電圧変化を測定します。

使用可能な測定リソース

SMU（ソース／モニタ・ユニット）と SPGU（パルス・ジェネレータ・ユ
ニット）を使用できます。SMUは定電圧または定電流の出力を行いながら
測定を行うことができます。SPGUは電圧パルスの出力を行います。SPGU
を使用するには｢ SPGUモジュール (p. 4-28) ｣を参照してください。

NOTE SPGUを使用するにはサンプリング・インターバルを  2 msに設定します。

サンプリング動作

I/V-t Sampling測定の動作を説明します。Figure 4-9を参照してください。こ
の例では Output Sequenceを SEQUENTIALに設定しています。また、バイ
アス保持機能で測定終了後出力を Base値に設定しています。

下図内 Time値計算式中の aおよび bは、1点測定の開始から A/Dコンバー
タによる積分開始までの時間を表しています。

Figure 4-9 サンプリング動作 
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機能の説明

I/V-t Sampling測定
1. Output Sequenceの設定が SEQUENTIALの場合、出力チャネルが順番に

Source値出力を開始し、最後の出力チャネルは Base値出力を開始します

(Starts sampling)。｢出力順序と時間原点 (p. 4-19) ｣を参照してください。
Output Sequenceの設定が SIMULTANEOUSの場合、出力チャネルが同
時に Base値出力を開始します (Starts sampling)。

Base値は、SIMULTANEOUSの場合は全出力チャネルに、

SEQUENTIALの場合は最後に出力を開始するチャネルだけに設定可能

です。

2. ベース・ホールド時間 (Base Hold Time)の経過後、出力チャネルは出力
値を Source値に変更します。出力チャネルはその出力値をサンプリン

グ測定終了まで維持します。

3. ホールド時間 (Hold Time)の後、測定チャネルは直ちに第 1サンプリン

グ点で測定を開始します。複数の測定チャネルを使用する場合、各チャ

ネルは順番に測定を実行します。｢測定チャネルが複数ある場合 (p. 
4-73) ｣を参照してください。

4. その後、測定チャネルは指定されたサンプリング間隔 (Interval)で、次

の動作を繰り返します。この動作は、測定データ数が No of Samplesに
達するまで繰り返されます。

• 測定可能な状態であれば測定を開始します。

• ビジー状態であれば測定を行いません。

ログ・サンプリングでは、ログ軸上、等間隔となる点に最も近いデータ

だけが残ります。このデータだけが測定データ数にカウントされます。

Interval < 2 msのリニア・サンプリングにおいて、総測定時間が
Interval  No of Samplesを超えてしまう場合は、測定データ数が
No of Samplesに達していなくてもサンプリング測定を終了します。

5. 出力チャネルが出力を停止し、I/V-t Sampling測定が終了します。

バイアス保持機能が有効である場合、出力チャネルは Base値または
Source値の出力を行います。

NOTE 時間データとインデックス

ログ・サンプリングの場合、ログ軸上、等間隔となる点に最も近いデータ

だけが残ります（記録されます）。測定データには、そのデータが記録され
た順番に 1から +1ステップでインデックスがつけられます。

リニア・サンプリングについては、｢時間データとインデックス (p. 4-18) ｣
を参照してください。
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機能の説明

I/V-t Sampling測定
設定パラメータ

I/V-t Sampling測定を実行するには次の設定を行います。GUIについては
｢ I/V-t Sampling (p. 2-22) ｣を参照してください。

NOTE Interval値を 2ミリ秒より短く設定する場合

サンプリング・モードがリニアであること。ログ・サンプリング測定では、

この設定はできません。また SPGUを使用することはできません。

全測定チャネルが高速 A/Dコンバータを使用していること。高分解能 ADC
を使用する測定チャネルがある場合、この設定はできません。

測定チャネルが複数ある場合、全チャネルは並列に測定を実行します。

測定レンジングの設定が固定モードでない場合は、各チャネルに設定され

ているコンプライアンス値を含む最小レンジが自動的に選択されます。

測定時間が Intervalよりも長くなる場合、アベレージング数 (ADCの設定 )
が自動的に調整され、サンプリング間隔が保たれます。

1. Channel Setup画面で次の設定を行います。

• 定電源に使用する SMUを選択します。

• 電流測定 SMUのMode（出力モード）を Vまたは COMMON、電圧
測定 SMUのModeを Iに設定します。

2. Measurement Setup画面の Sampling Parameterエリアで、SMUの次のパ

ラメータを設定します。

Linear/Log サンプリング測定モード。リニア (LINEAR)または
ログ (LOG10、LOG25、LOG50、LOG100、LOG250、
または LOG500)。

ログの場合、LOGに続く数字は 1ディケード当りの

測定データ数を示します。例えば LOG10は 1ディ
ケード当り 10 個のデータを取得します。

Interval サンプリングの間隔、秒。2ミリ秒～ 65.535秒、設定
分解能 1ミリ秒。

リニア・サンプリングでは、Interval < 2ミリ秒（設定
分解能 0.01ミリ秒）も有効です。ただし、次の条件

を満たす必要があります。上記 NOTEも参照してく
ださい。

Interval  0.1 + 0.02 （測定チャネル数 -1）ミリ秒
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I/V-t Sampling測定
No of Samples サンプリング測定データ数。整数。1 ～下記最大値。

リニアでの最大値： 100001 / 測定チャネル数

ログでの最大値： 11ディケード分のデータ数 + 1

Total Sampling 
Time 総サンプリング時間が表示されます。

第 1点目の測定開始から I/V-t Sampling測定終了まで
の時間。 ホールド時間は含まれません。

Total Sampling Time = Interval  No of Samples

Output 
Sequence ソース出力ルール。同期出力 (SIMULTANEOUS)また

は設定順出力 (SEQUENCE)。｢出力順序と時間原点 (p. 
4-19) ｣を参照してください。

Hold Time Source値出力開始から第 1サンプリング点までの時

間、秒。0 ～ 655.35秒、設定分解能 10ミリ秒。

Interval < 2ミリ秒の場合、次の値も有効です。

|Hold Time|はサンプリング開始から Source値出力開

始までの時間を示します。

-90ミリ秒～ -0.1ミリ秒、設定分解能： 0.1ミリ秒。

Base Hold 
Time Base値出力を保持する時間（Source値出力開始ま

で）、秒。0 ～ 655.35秒、設定分解能 10ミリ秒。

3. Measurement Setup画面の Constantsエリアで、SMUの次のパラメータを

設定します。

Base、Source ベース値、ソース値（Vまたは A）。

Base値は、Output Sequenceが SIMULTANEOUSの場
合は全出力チャネルに、SEQUENTIALの場合は最後
に出力を開始するチャネルだけに設定可能です。

Compliance コンプライアンス (Aまたは V)。
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I/V-t Sampling測定
時間データとインデックス

時間データを取得するには、Channel Setup画面の Time Stamp Nameフィー
ルドに変数名（例：Time）を設定します。リニア・サンプリング測定実行
後に得られる時間データを式で表わすと、次のようになります。

Time = Hold Time + Interval  [(Index  1) + N] + 

Time Channel Setup画面の Time Stamp Nameに入力する変数
名。時間データが返ります。

Index Channel Setup画面の Index Nameに入力する変数名。デー

タ・インデックスが返ります。最大値 2147483647。
Interval サンプリング間隔。Measurement Setup画面で設定。
Hold Time ホールド時間。Measurement Setup画面で設定。
N 1点測定実行中に行われたサンプリング回数。この変数

は Intervalよりも測定時間が長い場合に存在します。
 1点測定の開始から A/Dコンバータによる積分開始まで

の時間を表しています。

Intervalが測定時間よりも長い場合、測定チャネルは Intervalの間隔で測定
を繰り返します。逆に、測定時間の方が長い場合、Intervalの整数倍の間隔

で測定を繰り返します。Figure 4-10は、ホールド時間 10 ms、サンプリング
間隔 5 msの条件における I/V-t Sampling測定タイミングの例です。この例
では N=3となります。

• Time (Index=1の時 ) = 10 ms = 10 + 5  [(1-1) + 0] ms

• Time (Index=2の時 ) = 30 ms = 10 + 5  [(2-1) + 3] ms

Figure 4-10 サンプリングと測定タイミング
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I/V-t Sampling測定
出力順序と時間原点

Output Sequenceが SEQUENTIALに設定されている場合、出力チャネルは
順番に出力を開始します。その順番は、Channel Setup画面の設定で上から
下の順番となります。出力停止の順番はその逆となります。

Output Sequenceが SIMULTANEOUSに設定されている場合、出力チャネル
は同時に出力を開始します。出力停止も同時に行われます。

チャネル出力が Base値から Source値に変更されるタイミングを時間原点
(origin)と定義します。

サンプリング測定の終了 

I/V-t Sampling測定は、下記条件のどれかが生じることで終了します。

• ストップ・コンディションに設定されたイベントが起こった時。

「ストップ・コンディション (p. 4-19)」を参照してください。
• 測定データの数が No of Samplesに設定された数を超えた時。

• Interval < 2 msのリニア・サンプリング測定の場合、総測定時間が
Interval  No of Samplesを超えた時。

• Stopボタンをクリックした時。

• Keysight B1500に緊急事態が起こった時。

• 高電圧印加時にインターロック端子を開放した時。

ストップ・コンディション

ストップ・コンディションはMeasurement Setup画面の Stop Condition
フィールドで定義されます。この機能は次のように測定を終了します。

1. Nameに設定したパラメータの値と Thresholdの設定値を比較します。 

2. Eventに設定したイベントの発生回数をカウントします。

3. Eventに設定したイベントが No. of Eventsに設定した回数だけ発生した

ならば、ただちにサンプリング測定を終了します。

ストップ・コンディションの設定パラメータについては、｢ I/V-t Sampling 
(p. 2-22) ｣を参照してください。
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C-V Sweep測定
C-V Sweep 測定

C-V Sweep測定では、マルチ周波数容量測定ユニット (MFCMU)を用いて
AC信号を出力しながら DCバイアスの掃引出力を行い、各掃引ステップに
おいてインピーダンスを測定します。

使用可能な測定リソース

C-V Sweep測定にはマルチ周波数容量測定ユニット (MFCMU)を使用しま
す。 25 Vを超える DCバイアスを必要とする場合は SMU CMUユニファ
イ・ユニット (SCUU)とソース／モニタ・ユニット (SMU)を使用しま
す。 100 Vまでの DCバイアス出力が可能です。または高電圧バイアス T
と HVSMUを使用すると  3000 Vまでの DCバイアス出力が可能です。

設定パラメータ

C-V Sweep測定を実行するには次の設定を行います。GUIについては｢ C-V 
Sweep (p. 2-28) ｣を参照してください。

1. Channel Setup画面で次の設定を行います。

• CMUの V Nameを設定します。

• 定電流源または定電圧源を使用するには、SMUのMode (I、Vまた
は、COMMON)と V Nameまたは I Nameを設定します。

2. Measurement Setup画面で、CMUの次のパラメータを設定します。

Model, xName 測定パラメータ。Table 4-2を参照してください。

Direction 片道掃引 (SINGLE)または往復掃引 (DOUBLE)。

Linear/Log リニア (LINEAR)またはログ (LOG)掃引。ログ掃引
における 1ディケードあたりの掃引ステップ数は 10 、
25、または 50です。

Start, Stop Startは DCバイアス掃引スタート値。Stopは片道掃
引終了点あるいは往復掃引折り返し点の出力値。

CMUは  25 Vの出力が可能です。

SCUU（SMU CMUユニファイ・ユニット）を使用す
る場合は、 100 Vの出力が可能です。

高電圧バイアス Tと HVSMUを使用する場合
は、 3000 Vの出力が可能です。
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C-V Sweep測定
Step, 
No. of Steps Stepは DCバイアス掃引のステップ変化量。No. of 

Stepsは掃引ステップ数であり、Start、Stop、Stepか
ら自動的に計算されます。No. of Steps値は 2から
1001となる必要があります。

Frequency List 
出力周波数のリスト。1 kHz ～ 5 MHz。分解能 6 桁。

F Name 出力周波数リストの変数名。

AC Level AC信号レベル。10 mV ～ 250 mV、分解能：1 mV。

Mode、Factor 次のどちらかの方法を用いて測定時間を設定します。

Mode=AUTOでは、測定データの平均化に用いるサン

プル数を設定します。初期サンプル数（既定値）に対
する倍数を Factorに設定します。Factorには 1 ～

1023の整数が有効です。

Mode=PLCでは、A/Dコンバータの積分時間を設定し

ます。1電源サイクル（50 Hzで 20 ms、60 Hzで 16.7 
ms）に対する倍数を Factorに設定します。Factorに
は 1 ～ 100の整数が有効です。

Hold ホールド時間。Start値出力開始からディレイ時間の

開始までの時間。ディレイ時間が 0 sの時は、測定開

始までの時間。 
設定範囲：0 ～ 655.35 s、分解能：10 ms

Delay ディレイ時間。ホールド時間の終了から測定開始まで
の時間。または DCバイアス出力値をステップ アッ
プしたタイミングから測定開始までの時間。 
設定範囲：0 ～ 65.535 s、分解能：100 s

NOTE 精度の高い容量測定を行うには、測定を開始する前に、測定周波数と同じ

周波数で補正データ測定を実行する必要があります。

測定周波数が下記デフォルト周波数に含まれていない場合は、Advanced 
Options...ボタンをクリックし、Advanced Options for CMU Calibrationウイン
ドウの Frequencyに全測定周波数を設定してください。

デフォルト周波数：

1 k、2 k、5 k、10 k、20 k、50 k、100 k、200 k、500 k、1 M、1.2 M、1.5 M、
2 M、2.5 M、2.7 M、3 M、3.2 M、3.5 M、3.7 M、4 M、4.2 M、4.5 M、
5 MHz
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Table 4-2 MFCMU 測定パラメータ

第 1 測定パラメータ 第 2 測定パラメータ

R（レジスタンス、） X（リアクタンス、）

G（コンダクタンス、S） B（サセプタンス、S）

Z（インピーダンス、） （位相角、ラジアン）

Z（インピーダンス、） （位相角、度）

Y（アドミタンス、S） （位相角、ラジアン）

Y（アドミタンス、S） （位相角、度）

Cp（並列容量、F） G（コンダクタンス、S）

Cp（並列容量、F） D（損失係数）

Cp（並列容量、F） Q（損失係数の逆数）

Cp（並列容量、F） Rp（並列抵抗、）

Cs（直列容量、F） Rs（直列抵抗、）

Cs（直列容量、F） D（損失係数）

Cs（直列容量、F） Q（損失係数の逆数）

Lp（並列インダクタンス、H） G（コンダクタンス、S）

Lp（並列インダクタンス、H） D（損失係数）

Lp（並列インダクタンス、H） Q（損失係数の逆数）

Lp（並列インダクタンス、H） Rp（並列抵抗、）

Ls（直列インダクタンス、H） Rs（直列抵抗、）

Ls（直列インダクタンス、H） D（損失係数）

Ls（直列インダクタンス、H） Q（損失係数の逆数）
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C-V Sweep測定
測定パラメータ

MFCMUはインピーダンス測定を実行して、Table 4-2のパラメータを計算

し、出力します。これらの組合せから 1つを選択します。例えば選択の目

安として、低容量測定 (インピーダンスで 100 以上 )には並列測定

(Cp-G、Cp-D)、高容量測定 (100 以下 )には直列測定 (Cs-Rs)が有効です。
これは、低容量測定では並列抵抗の影響が大きくなるからです。

インピーダンス測定について

抵抗、コンデンサ、インダクタなどすべての回路部品には寄生成分が含ま

れています。例えば、コンデンサ中の不要な抵抗、インダクタ中の不要な

抵抗、および抵抗中の不要なインダクタンスなどです。そのため、このよ
うな回路部品は複素インピーダンスでモデル化する必要があります。

インピーダンスの定義、ベクトル表示を Figure 4-11に記します。インピー

ダンス Zとは、一定の周波数の交流に対して回路や素子が持つ全抵抗で

す。Zには実数部 (real part)と虚数部 (imaginary part)があり、直交座標形式

では抵抗 Rとリアクタンス Xとして表され、また極座標形式ではインピー

ダンスの絶対値 |Z|と位相角 として表されます。

これらのパラメータのほかに、素子の品質を表す quality factor (Q)と損失係

数 Dがあります。

Figure 4-11 インピーダンスとパラメータの計算

|Z|=   (R +X )

=tan   (      )-1

R
|X|

R=Rs

Z= I
V

Z

I

V

X= 2  f L

Q=       =D
1

R
|X|

Z:    impedance ( )
R:    resistance ( )
X:    reactance ( )
q:    phase (degree or radian)
Rs:  series resistance ( )
f:     frequency (Hz)
L:    inductance (H)
Q:   quality factor
D:   dissipation factor

Real part

Imaginary part

|Z|
jX

R

I:    current (A)
V:   voltage (V)

2         2
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出力パラメータ選択の目安として、高インダクタンス測定 (インピーダン

スで 100 以上 )には並列測定 (Lp-G、Lp-Dなど )、低インダクタンス測定
(100 以下 )には直列測定 (Ls-Rsなど )が有効です。これは、高インダク
タンス測定では並列抵抗の影響が大きくなるからです。

Figure 4-12 アドミタンスとパラメータの計算

部品の特性に応じて、アドミタンス Y（インピーダンスの逆数）を使う場

合があります。アドミタンスのベクトル表示を Figure 4-12に記します。Z
と同様に、Yは実数と虚数成分を持ち、直交座標形式ではコンダクタンス

Gとサセプタンス Bとして表され、極座標形式ではアドミタンスの絶対値

|Y|と位相角 として表されます。

|Y|=  (G  +B  )2 2

=tan   (      ) = --1

G
|B|

Y= Z
1

B= 2  f C

Q=       =D
1

G
|B|

Y:    admitance (S)
G:    conductance (S)
B:    susceptance (S)

:   phase (degree or radian)
f:     frequency (Hz)
C:    capacitance (F)
Q:    quality factor
D:    dissipation factor
Rp:  parallel resistance ( )

Real part

Imaginary part

|Y|

jB

G

G= Rp
1

4-24 Keysight EasyEXPERT ユーザ・ガイド Vol. 1、第 5版



機能の説明
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4 端子対構造と DUT 接続について

一般的に、通常の端子構造による接続では、相互インダクタンス、測定信

号の干渉、および不要な残留成分が、測定（特に高周波測定において）に

影響します。MFCMUは 4端子対 (four-terminal pair, 4TP)構造の測定端子を
採用しているので、こうした要因による測定の制限を少なくし、簡単で安

定した、正確な測定を行うことができます。4端子対測定の原理を Figure 
4-13に記します。測定端子は次の 4つの同軸コネクタで構成されます。

• Hcur: 電流 high端子

• Hpot: 電圧 high端子

• Lpot: 電圧 low端子

• Lcur: 電流 low端子

Figure 4-13 4 端子対測定法の原理

4端子対測定法は、特に高インピーダンス、低インピーダンス測定で効果

を発揮します。外部シールド導体は、中心導体を流れる測定信号の帰還路

となっています（グランドではありません）。従って、中心導体と外部シー

ルド導体には、等しい電流（但し、方向は逆）が流れ、双方の電流から生

じた磁界は打ち消しあうので、導体周囲に磁界は生じないことになります。

つまり、測定信号電流が誘導磁界を発生させないので、測定用リードの自

己インダクタンスまたはリード間の相互インダクタンスによって誤差が増

加することがなく、正確な測定を行うことができます。

DUT

Multi frequency CMU

V
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A

+
-
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LpotAuto balance bridge

Virtual ground

System ground

Ix

Ix

VxVx
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4端子対測定法による正確な測定を実現するには、デバイス (DUT)の接続
を次のように行います。Figure 4-13、Figure 4-14を参照してください。

• MFCMUから DUTまでの配線をできる限り短くします。

• できる限り DUTの近くまで 4端子対構造で延長します。

• 4端子対構造で延長したケーブル端において（できる限り DUTに近い

ところで）、すべての端子の外部シールド (outer shield)を互いに接続し

ます。外部シールドが他のものから電気的に絶縁されるように配線して
ください。

アト・センス／スイッチ・ユニット (ASU)やガード・スイッチ・ユ
ニット (GSWU)使用時の CMU returnの接続がこれに当ります。

• 外部シールドから露出されて、中心導体（信号線）だけで延長される配

線をできる限り短くします。

• 配線上可能な場合は、DUT周辺にガード (guard)を施し、ガードを外部
シールドに接続します。これによって浮遊容量やノイズの影響を減少で

きます。ガードが他のものから電気的に絶縁されるように配線してくだ
さい。

• Low (Lcur, Lpot)端子側の信号ラインには、なるべく浮遊容量やガード

容量がつかない配線を施します。ウェーハ・チャックへの接続が必要な
場合は、High (Hcur, Hpot)端子をウェーハ・チャックに接続します。

測定データの補正について

正確なインピーダンス測定を行うために、MFCMUは次の補正機能を装備

しています。補正機能は延長ケーブルや DUTインタフェース（マニピュ

レータ、プローブカードなど）に存在する誤差要因 (error elements)の影響
を減少できます。

• Phase: 位相補償

ケーブル延長による測定系の位相のずれを補正します。

• Open: オープン補正

浮遊アドミタンスを補正します。高インピーダンス測定に有効です。

• Short: ショート補正

残留インピーダンスを補正します。低インピーダンス測定に有効です。

• Load: ロード補正

ワーキング スタンダードを用いて測定系全体の補正を行います。
4-26 Keysight EasyEXPERT ユーザ・ガイド Vol. 1、第 5版



機能の説明

C-V Sweep測定
4端子対構造で延長された部分 (MFCMU 専用ケーブル、アクセサリを使用

している部分）の補正はMFCMUが内部で自動的に実行します。

ワーキング スタンダードの値を基準として DUTの値を評価する場合には
Open、Short、Load補正を実行します。

補正実行後も、測定系に寄生インピーダンスが残ることがあります。寄生

成分の影響を最小限にするには、外部シールド (outer shield)から露出した
部分をできる限り短くすることが重要です。

補正を実行するには、｢ CMU Calibration (p. 1-94) ｣を参照してください。

Figure 4-14 測定系の補正
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SPGUモジュール
SPGU モジュール

B1500Aに有効。SPGUは半導体パラメトリック・テスト用に開発されたパ

ルス・ジェネレータ・モジュールであり、以下の主要機能を備えています。

SPGUの制御には SPGU Controlクラシック・テスト、または I/V Sweep、
Multi Channel I/V Sweep、I/V List Sweep、I/V-t Samplingクラシック・テスト
内の SPGU設定機能を使用します。

• 出力チャネル数： 1モジュールにつき 2チャネル

• 出力インピーダンス： 50 

• 出力レベル： 0 ～40 V（オープン負荷）、  20 V（50 負荷）

• SPGU動作モード（装着されている全チャネルに有効）：PG（パルス・
ジェネレータ）または ALWG（任意直線波形出力）

• チャネル出力動作モード：FREE RUN、DURATION、または PULSE 
COUNT（PGモード）/ SEQUENCE COUNT（ALWGモード）。但し、

FREE RUNモードは SPGU Controlクラシック・テストではサポートさ
れません。

• PG出力モード：各チャネル 2値パルス出力または 3値パルス出力

• パルス・スイッチ：メカニカル・リレーよりも耐久性に優れ、スイッチ

ング回数の多いアプリケーションに有効

• 出力レベル自動調整：DUTの負荷インピーダンスを指定することに

よって出力電圧を自動調整

Figure 4-15 SPGU 簡易回路図

NOTE SPGUを I/V-t Samplingテストに使用する場合、サンプリング間隔を2 ms以上
に設定してください。

50 Pulse switch

ALWG

PG 2-level
or 3-level

Output 2

or

50 Pulse switch

ALWG

PG 2-level
or 3-level

Output 1

or
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PG 動作モード

PG（パルス・ジェネレータ）動作モードでは、SPGUは 2値パルス電圧ま
たは 3値パルス電圧（Figure 4-16）を出力します。

SPGUの各チャネルは、パルス出力を同時に開始し、パルス周期ごとの出

力の繰り返しを同時に行います。パルスの出力は、指定時間の経過、また

は指定数出力の完了まで続けられます。

SPGUパルスの設定については「SPGUパルス設定パラメータ (p. 4-30)」を
参照してください。また、掃引測定およびサンプリング測定におけるチャ

ネル出力の動作概要については、「パルス出力動作 (p. 4-32)」を参照してく
ださい。

Figure 4-16 3 値パルス出力例
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SPGUパルス設定パラメータ
SPGUパルスを出力するには次の設定を行います。GUIについては「SPGU 
Control (p. 2-32)」を参照してください。

1. Channel Setup画面で次の設定を行います。

• SPGUの V Nameを入力します。

• SPGUのモード（Mode）を VPULSEに設定します。 これによって
PGモードに設定されます。ALWGに設定しないでください。

2. SPGU Pulse Setupウインドウで、次のパラメータを設定します。設定パ

ラメータについては Figure 4-17を参照してください。
Period パルス周期。20 ns ～ 10 s、分解能 10 ns。
Operation FREE RUN、PULSE COUNT、または DURATION。

FREE RUNモードの場合、SPGUは測定が完了または

停止するまでパルス出力を継続します。このモードは

SPGU Controlクラシック・テストではサポートされ
ません。

PULSE COUNTモードの場合、1 ～ 1000000の範囲で

パルス数を指定します。SPGUは指定された数のパル

スを出力します。

DURATIONモードの場合、1 s ～ 31556926 s（1年）
の範囲で総出力時間を指定します。SPGUは指定時間

が経過するまで出力を継続します。

Type 2-Level Pulse（2値パルス）または 3-Level Pulse（3値
パルス）。3-Level Pulseを選択した場合、Additional 
Pulseフィールドが有効になります。

Base、Peak パルスのベース電圧およびピーク電圧。0 ～40 V
（オープン負荷）、20 V（50 負荷）、分解能 1 mV。

Delay ディレイ時間。0 ～ Period-20 ns、分解能 2.5 ns。
パルス遷移時間が > 8 sの場合、分解能は 10 nsに設
定されます。

Width パルス幅。10 ns ～ Period-10 ns、分解能 2.5 ns。
パルス遷移時間が > 8 sの場合、分解能は 10 nsに設
定されます。
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Leading、
Trailing パルス遷移時間。8 ns ～ 400 ms、分解能 2 ns。

パルス遷移時間が > 8 sの場合、分解能は 8 nsに設
定されます。

3.（オプション）3値パルスを定義するには Additional Pulseフィールドを
設定します。3値パルスは Primary Pulseと Additional Pulseによって実現

されます。3値パルス出力例を Figure 4-16に記します。

4. Load Z Setupウインドウで、DUT（被測定デバイス）の負荷インピーダ

ンスを設定します。この値は出力電圧の自動調整に使用されます。

SPGUは Baseまたは Peakの指定値に近い電圧を出力します。

5.（オプション）Pulse Switch Setupウインドウで、パルス・スイッチを有
効にします。パルス・スイッチは SPGU出力に内蔵されている半導体リ
レーであり、SPGUチャネル出力を開放するために使用します。このリ

レーはメカニカル・リレーよりも耐久性に優れ、スイッチング回数の多

いアプリケーションに有効です。

SW Sync ENABLE（パルス・スイッチ有効）または DISABLE
（パルス・スイッチ無効）。

パルス・スイッチの状態切替（接続／開放）は自動的

に制御され、Figure 4-17に見られるように出力パルス
に同期します。

SW Sync=ENABLEの場合、Delay、Width、および Normalフィールドが
有効になります。

Delay パルス出力開始からパルス・スイッチ状態切替までの

時間。0 ～ Period-100 ns、分解能 10 ns。
Width パルス・スイッチの切替状態を維持する時間。

100 ns ～ Period-Delay ns、分解能 2.5 ns。
Normal パルス・スイッチ通常時の状態：CLOSE（接続）ま

たは OPEN（開放）。パルス・スイッチの状態は、

Delay-sw時間経過すると切り替わり、Width-sw時間
経過するまで維持されます（Figure 4-17参照）。この
動作はパルス周期ごとに繰り返されます。
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Figure 4-17 パルス設定パラメータ

パルス出力動作

SPGUは I/V Sweep、Multi Channel I/V Sweep、I/V List Sweep、I/V-t Sampling
クラシック・テストでも使用可能であり、パルス出力動作は以下のように

測定モード毎に異なります。サンプリング測定におけるパルス出力例を

Figure 4-18に記します。

• サンプリング測定、同時出力モード（Simultaneous）。 Table 4-3参照。

• サンプリング測定、順次出力モード（Sequential）。 Table 4-4参照。

• 掃引測定モード。 Table 4-5参照。
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Figure 4-18 サンプリング測定、FREE RUN モードでの SPGU パルス出力例
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0 V

End of measurement

Sequencial output:

base hold time

0 V

0 V

0 V

0 V

3

2

4

1
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SPGUモジュール
Table 4-3 I/V-t Sampling、同時出力での出力タイミング

パルス出力

条件

ソース・チャネルの動作

開始時 測定中 測定後 終了時

Duration >
測定時間

SMUと SPGU
が

同時にベース

値出力を開始

します。

SMUが
サンプリング

測定動作を開

始します。

ベース・ホールド時間

経過後、SMUによる
ソース値出力と SPGU
によるパルス出力が同

時に開始されます。

指定時間の経過、また

は指定数パルス出力の

完了まで、

SMUによるソース値出
力と SPGUによるパル
ス出力が継続されます。

その後、SMUは Output 
Value after Measurement
の設定値（ベース値ま

たはソース値）の出力、

SPGUはベース値出力
を開始します。

バイアス

保持機能

が ONの
場合、全

チャネル

が出力を

継続しま

す。

バイアス

保持機能

が OFFの
場合、
Channel 
Setup定義
の逆順で

全ソース

出力が 0 V
に変更さ

れます。

FREE RUN SMUは Output Value 
after Measurementの設定
値（ベース値または

ソース値）を出力し、

SPGUはパルス出力を
継続します。

バイアス保持機能が

OFFの場合、SPGUは
ベース値を出力します。

Duration < 
測定時間

ベース・ホールド時間

経過後、SMUによる
ソース値出力と SPGU
によるパルス出力が同

時に開始されます。

指定時間の経過、また

は指定数パルス出力の

完了によって、SPGU
はベース値出力を開始

します。

SMUは Output Value 
after Measurementの設定
値（ベース値または

ソース値）を出力し、

SPGUはベース値を出
力します。
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SPGUモジュール
Table 4-4 I/V-t Sampling、順次出力での出力タイミング

パルス

出力条件

ソース・チャネルの動作

開始時 測定中 測定後 終了時

Duration > 
測定時間

最終 SMU以
外の SMUが
ソース値出力

を開始しま

す。 そして、
SPGUと最終
SMUがベース
値出力を開始

します。 
出力順序は
Channel Setup
画面の定義順

（上から下）

に従います。

SMUがサンプ
リング測定動

作を開始しま

す。

ベース・ホールド時間

経過後、最終 SMUに
よるソース値出力と

SPGUによるパルス出
力が同時に開始されま

す。

指定時間の経過、また

は指定数パルス出力の

完了まで、

SMUによるソース値出
力と SPGUによるパル
ス出力が継続されます。

その後、最終 SMUが
Output Value after 
Measurementの設定値
（ベース値またはソース

値）を出力し、SPGU
がベース値を出力しま

す。

バイアス

保持機能

が ONの
場合、全

チャネル

が出力を

継続しま

す。

バイアス

保持機能

が OFFの
場合、
Channel 
Setup定義
の逆順で

全ソース

出力が 0 V
に変更さ

れます。

FREE RUN 最終 SMUが Output 
Value after Measurement
の設定値（ベース値ま

たはソース値）を出力

し、SPGUがパルス出
力を継続します。

バイアス保持機能が

OFFの場合、SPGUは
ベース値を出力します。

Duration <
測定時間

ベース・ホールド時間

経過後、最終 SMUに
よるソース値出力と

SPGUによるパルス出
力が同時に開始されま

す。指定時間の経過、

または指定数パルス出

力の完了によって、

SPGUはベース値出力
を開始します。

最終 SMUが Output 
Value after Measurement
の設定値（ベース値ま

たはソース値）を出力

し、SPGUがベース値
を出力します。
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SPGUモジュール
Table 4-5 I/V Sweep、Multi Channel I/V Sweep、I/V List Sweep の出力タイミング

パルス

出力条件

ソース・チャネルの動作 

開始時 測定中 測定後 終了時

Duration > 
測定時間

SMUと SPGU
が出力を開始

します。 
出力順序は
Channel Setup
画面の定義順

（上から下）

に従います。

このとき、掃

引源はスター

ト値、定電源

はソース値、

SPGUはベー
ス値を出力し

ます。

定電源は「終

了時」まで出

力を継続しま

す。

SPGUがパルス出力を
開始し、その出力を継

続します。 

SMUが掃引測定動作
を開始、実行します。

掃引源が Output Value 
after Measurementの設定
値（スタート値または

ストップ値）を出力し

ます。

指定時間の経過、また

は指定数パルス出力の

完了まで、SPGUはパ
ルス出力を継続し、 その
後、ベース値を出力し

ます。

バイアス

保持機能

が ONの
場合、全

チャネル

が出力を

継続しま

す。

バイアス

保持機能

が OFFの
場合、
Channel 
Setup定義
の逆順で

全ソース

出力が 0 V
に変更さ

れます。

FREE RUN 掃引源が Output Value 
after Measurementの設定
値（スタート値または

ストップ値）を出力し

ます。

SPGUはパルス出力を
継続します。

バイアス保持機能が

OFFの場合、SPGUは
ベース値を出力します。

Duration < 
測定時間

SPGUがパルス出力を
開始します。 

SMUが掃引測定動作
を開始、実行します。

指定時間の経過、また

は指定数パルス出力の

完了まで、SPGUはパ
ルス出力を継続し、 そ
の後、ベース値を出力

します。

掃引源が Output Value 
after Measurementの設定
値（スタート値または

ストップ値）を出力し

ます。

SPGUがベース値を出
力します。
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SPGUモジュール
ALWG 動作モード

ALWG（任意直線波形出力）動作モードでは、SPGUは Figure 4-19に見ら
れるような任意直線波形電圧を出力します。出力波形はパターン・データ

とシーケンス・データから特定される電圧パターンであり、データの作成

には Define ALWG Waveformウインドウ (p. 2-68)を使用します。

掃引測定およびサンプリング測定におけるチャネル出力の動作概要につい

ては、「パルス出力動作 (p. 4-32)」を参照してください。1シーケンスの出
力は 1パルスの出力と同様に扱われます。

パターン・データ 1チャネルに設定する電圧パターンすべてを定義します。パターンは複数

のベクター・データで構成され、ベクター・データは出力レベルと時間

データによって定義されます。

• パターン数：1チャネル当たり最大 512

• ベクター・データ数（1チャネル分の全パターンの定義に使用可能なベ

クター・データ数）：最大 1024 - N（N：パターン数）

• 出力レベル：0 ～40 V（オープン負荷、分解能：1 mV）

• 時間データ（追加時間）：10 ns ～ 671.088630 ms（分解能：10 ns）

シーケンス・データ ひとつのシーケンス内で出力される全パターンについて、出力チャネル、

出力パターン、パターン出力の繰り返し回数、出力順を定義します。

• パターンの繰り返し回数：1,048,576

• 1シーケンス内のパターン数：最大 512

Figure 4-19 ALWG 出力例

SPGU1

SPGU2

Start

Pattern2

Pattern2 Pattern1

Pattern1Pattern2

Pattern2 Pattern1

Pattern1
initial value initial value

initial value initial value

1 sequence

Pattern1

setup change (50 ns)

SPGU2 pulse switch
(normally open)

0: Open
1: Close011 111 10 011 111 1 1 110 1 11 11 1 110 1 11 111 110 1 11 11 0

Pattern1
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SPGUモジュール
Figure 4-19の例では SPGU1と SPGU2を使用しています。これらのチャネ
ルは、1 回のシーケンスにつき Pattern2を 2 回、Pattern1を 3 回出力しま

す。ここでは SPGU1の Pattern1と Pattern2には同じパターンが定義されて

います。 

SPGUチャネルは、シーケンス出力を同時に開始します。シーケンスは、

パルス周期と同様に繰り返されます。シーケンス出力は、指定時間が経過

するか、繰り返し回数が指定シーケンス数に達するまで続けられます。

NOTE パターン間の設定遅延時間

異なるインデックスのパターンに切り替える際は、50 nsの設定遅延時間が
必ず発生します。

同じインデックスのパターンに切り替える際は、遅延時間は発生しません。
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Sweep停止機能
Sweep 停止機能

この機能は次の条件のどれかが検出された時に掃引測定を自動停止する機
能です。この機能は出力時間の短縮やデバイス破壊の防止に役立ちます。

• 有効な測定モード：

• I/V Sweep測定

• Multi Channel I/V Sweep測定

• I/V List Sweep測定

• C-V Sweep測定

• 停止条件：

• 電圧コンプライアンスまたは電流コンプライアンスに達した時

• 測定値が測定レンジを越えた時

• SMUが発振した時

• MFCMUにエラーが生じた時

自動停止機能を設定するには Classic Test定義のMeasurement Setup画面の
Sweep [xxxx] statusフィールドを使用します。

• Sweep [CONTINUE AT ANY] status：停止機能をオフします。パワー・コ
ンプライアンスが設定されている場合は設定できません。

• Sweep [STOP AT ANY ABNORMAL] status：停止機能をオンします。

• Sweep [SKIP AT ANY ABNORMAL] status：（B1500本体に有効）停止機
能をオンします。ただしバイアス同期掃引測定の実行中に停止条件が検

出された場合には、VAR1掃引出力を一旦停止し、VAR2出力値を次の

ステップ出力値に変更して掃引測定を継続します。I/V List Sweep測定、
C-V Sweep測定には使用できません。

自動停止後の出力

Sweep停止機能によって測定が停止されると、出力チャネルは次の値を出

力します。ただし B2900の場合は、出力スイッチがオフになります。

• 掃引源：スタート値

• パルス源、パルス掃引源：パルス・ベース値
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スタンバイ機能
スタンバイ機能
スタンバイ機能は、測定を開始する前と実行後に、指定された DCバイア
ス出力（スタンバイ出力）を行う機能です。

スタンバイ・チャネル

スタンバイ出力を行う SMUまたは UHVUをスタンバイ・チャネルといい
ます。スタンバイ・チャネルは、スタンバイ・モード ONかつ非測定状態

において、指定された DCバイアス出力を続けます。
スタンバイ・チャネルに CMU、GNDUを使用することはできません。ま

た、AUXポートへのパスを形成している ASU（アト・センス／スイッチ・
ユニット）に接続された SMUをスタンバイ・チャネルに設定することは
できません。

セレクタ（N1258A、N1259A-300、N1265A）または N1266Aエクスパンダ
に接続された測定リソースを指定する場合は、そのチャネルが

Configurationウインドウで Default出力に設定されている必要があります。

スタンバイ・チャネルの定義、スタンバイ・モードの設定については、

「Standby Channel Definition (p. 1-122)」を参照してください。

スタンバイ状態

測定を開始する前と実行後に、スタンバイ・チャネルだけが DCバイアス
出力を行っている状態をスタンバイ状態と呼びます。このとき、その他の

チャネルはアイドル状態（0 V出力、100 Aコンプライアンス、SMUフィ
ルタ OFF、直列抵抗 OFF）にあります。スタンバイ・モード OFFかつ非測

定状態では、全チャネルはアイドル状態にあります。

B1500がスタンバイ状態にあるとき、測定を開始すると、スタンバイ・

チャネルはスタンバイ出力を停止し、測定チャネルは測定を行います（測

定状態）。そして、測定終了後、このチャネルはスタンバイ出力を開始しま

す（スタンバイ状態）。この一連の動作中に、状態がアイドル状態になるこ
とはありません。

スタンバイ・チャネルにバイアス保持機能が有効になっている場合、測定

終了後、このチャネルはバイアス保持機能による出力を行います。バイア

ス保持期間の後、このチャネルはスタンバイ出力を開始します。この一連
の動作中に、状態がアイドル状態になることはありません。
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スタンバイ機能
スタンバイ出力順序

スタンバイ・チャネルは順番に出力を開始します。その順番は、Standby 
Channel Definitionウインドウ Standby Channel Definitionにリストされたチャ
ネルの上から下の順番となります。出力停止の順番はその逆となります。

Figure 4-20 は、下記チャネル・セットアップ例におけるスタンバイと測定
の動作を表しています。この例は、各チャネルがこの順番で Standby 
Channel Definitionウインドウに設定されていることと、スタンバイ状態に
おける出力値と測定状態における出力値が同じ値に設定されていることを
想定しています。

• SMU1：電圧源、非スタンバイ・チャネル

• SMU2：電圧源、スタンバイ・チャネル

• SMU3：電圧源、スタンバイ・チャネル

Figure 4-20 スタンバイ機能

SMU1

SMU2

SMU3

Standby ON

Standby OFF

force V

force V

force V
V2

Measurement state

Standby state Standby state

Idle state Idle state

Idle state Idle state

V3

V1
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スタンバイ機能
スタンバイ機能を使用する

スタンバイ状態にするには、Standby Channel Definitionウインドウの
Standby ONボタンをクリックします。ただし、スタンバイ・チャネルが定
義されていない場合は、スタンバイ状態にすることはできません。スタン

バイ状態では EasyEXPERTメイン画面下部に Standbby ONインジケータが
現れます。Standby Channel Definitionウインドウはメイン画面の Standbyボ
タンをクリックすることによって開かれます。

スタンバイ状態からアイドル状態に戻るには、Standby Channel Definitionウ
インドウの Standby OFFボタンをクリックします。

スタンバイ状態にあるとき、スタンバイ・チャネルの設定を変更すると、

アイドル状態に変わります。しかし、その他のチャネルの設定を変更して
も状態は変わりません。

SMUフィルタと直列抵抗は OFFに設定されます。

次の機能を実行することはできません。

• セルフテスト、診断

• セルフキャリブレーション（SMU Calibration、CMU Calibration）

• SMUゼロ・オフセット測定

• ASU接続パスの変更

オート・キャリブレーションが ONであっても、セルフキャリブレーショ

ンは実行されません。セルフキャリブレーション実行中にスタンバイ・
モードを ONに設定できません。

ワークスペースを開いたときの状態はアイドル状態です。

スタンバイ・モードが ONのままワークスペースまたは EasyEXPERTを終
了した場合、自動的にスタンバイ・モードが OFFに設定されてから、終了
処理が行われます。

スタンバイ・モードが ONのままWindowsを終了した場合、スタンバイ・
モードが OFFに設定されずに、終了処理が行われます。
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バイアス保持機能
バイアス保持機能

この機能は、測定終了後のモジュール出力を保持する機能です。有効にす

ると、複数のクラシック・テストを定義しているクイック・テストまたは

アプリケーション・テスト、あるいは繰り返し測定を実行中に行われる測

定間に、出力モジュールがバイアス出力を行います。そして、次の測定の

開始と共に出力値の変更または不使用モジュールの切断が行われます。

対象チャネルと

バイアス出力値

バイアス保持機能 OFFの場合、出力チャネルは直ちに出力を停止します。

バイアス保持機能 ONの場合、出力チャネルは次のように出力を継続しま

す。

I/V Sweep測定：

• VAR1／ VAR1’出力チャネル：掃引スタート値またはストップ値

• VAR2出力チャネル：掃引ストップ値

• CONST出力チャネル：出力値

• SMUパルス出力チャネル : ベース値
C-V Sweep測定：

• バイアス掃引出力チャネル：掃引スタート値またはストップ値

• 定電圧／電流出力チャネル：出力値

I/V-t Sampling測定：

• 定電圧／電流出力チャネル：ベース値またはソース値

SPGUの出力：

• Table 4-6のように出力を継続します。

バイアス保持期間 • 測定が終了してからシングル測定終了までの間

• 測定が終了してから次の測定が開始されるまでの間（繰り返し測定、ア

プリケーション・テストまたはクイック・テストの場合）

出力源の初期化 全測定が終了すると、出力モジュールの初期化が行われます。初期化に

よって、SMUは電圧出力 0 V、コンプライアンス 0.1 mAに、MFCMUは
DCバイアス 0 V、信号レベル 0 Vに設定されます。
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バイアス保持機能
設定方法 Advanced Setupウインドウで設定します。

• Bias hold after measurement

ON（保持機能有効）または OFF（無効、既定値）に設定します。

• Output value after measurement

測定後の出力値を START（スタート値、既定値）または STOP（ストッ
プ値）、BASE（ベース値）または SOURCE（ソース値、既定値）に設

定します。VAR2、CONST、C-V Sweepの定電源は対象外。

Table 4-6 バイアス保持機能 ON 時の SPGU 出力

SPGU 出力動作

モード
SPGU の出力

FREE RUN VPULSEモードの場合はパルス出力を、ALWGモー
ドの場合はシーケンス出力を継続します。

同期サンプリング測定の開始時にはSPGU出力トリガ
がリセットされます。

COUNT VPULSEモードの場合はベース値の出力を、ALWG
モードの場合は初期電圧値の出力を継続します。

次の測定の開始時には SPGUの初期化が行われます。

DURATION
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電流オフセット除去機能
電流オフセット除去機能

電流オフセット除去機能は、電流測定値からオフセット電流を減算し、そ

の結果を最終的な測定データとして返す機能です。測定ケーブル、マニ

ピュレータ、プローブ・カードなどの測定系に生じる誤差成分（オフセッ

ト電流）の補正に有効です。

100 nA以上のレンジによる測定ではオフセット除去は行われません。10 
nAレンジによる測定では 1 nAレンジのオフセット電流を使用してオフ
セット除去が行われます。1 nAレンジ以下の測定では、各レンジで測定さ
れたオフセット電流が使用されます。オフセット電流測定を行える測定レ
ンジ、オフセット電流の許容値、対象となるモジュールを Table 4-7 に記し
ます。

オフセットの測定と

除去機能の設定

オフセット電流を測定し、オフセット除去機能を有効にするには、次の手

順に従います。

1. メイン画面上の Calibrationボタンをクリックして、Calibrationウインド
ウを開きます。｢ Calibration (p. 1-92) ｣を参照してください。 

2. Calibrationウインドウの SMU Zero Cancelタブ画面において、オフセッ
ト測定を行うチャネルを選択します。選択するには Nameフィールド左

側のチェック ボックスにチェックをつけます。

3. SMU+ASUの 1 pAレンジのオフセット測定を有効にするには、Full 
Rangeチェック ボックスをチェックします。チャネル毎に設定できま

す。

4. Integration Timeフィールドに、オフセット測定用の積分時間を設定しま

す。1 PLC (power line cycle) ～ 100 PLC、初期値 16 PLC。チャネル毎に

設定できます。

実デバイス測定時にオフセット除去が行われるようにするには、実デバ

イス測定用の積分時間よりも長い積分時間を設定してください。

5. Measure...ボタンをクリックします。ダイアログ ボックスが開きます。

表示されるダイアログ ボックスの指示に従って、オフセット電流の測

定を行います。 測定完了後、オフセット除去機能が自動的に有効となり

ます。

オフセット電流測定実行中は、デバイス側ケーブル端にて測定端子を開

放してください。
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機能の説明

電流オフセット除去機能
NOTE オフセット電流は、高分解能 A/Dコンバータを用いて測定されます
（HVSMUを除く）。

オフセット除去機能を無効にするには、Nameフィールド左側のチェック 
ボックスからチェックを外します。

Table 4-7 測定レンジ、オフセット許容値、対象モジュール

ある測定チャネルの、ある測定レンジにおけるオフセット値が許容値を超

えている場合、この測定チャネルの、このレンジ以下の測定レンジに対す

るオフセット データは無効となります。そして、このチャネルのレンジン

グ設定が、このレンジ以下の測定レンジを含む場合、その測定チャネルに

よる全測定データに対して、オフセット除去は行われません。

測定レンジ オフセット電流の許容値 対象モジュール

1 nA ±10 pA SMU+ASU, HRSMU, 
MPSMU, HPSMU, 
HVSMU

100 pA ±1 pA SMU+ASU, HRSMU

10 pA ±400 fA SMU+ASU, HRSMU

1 pA ±100 fA SMU+ASU
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機能の説明

SMU CMUユニファイ・ユニット（SCUU）
SMU CMU ユニファイ・ユニット（SCUU）

B1500Aに有効。SMU CMUユニファイ・ユニット (SCUU)を使用するには
マルチ周波数容量測定ユニット（MFCMU）を装着した Keysight B1500Aが
必要です。MFCMUは B1500Aのスロット N（3から 10の整数）に、SMU
はスロット N-1と N-2に装着されている必要があります。詳細は

「Keysight B1500Aユーザ・ガイド」を参照してください。SCUUをハイ・

パワー SMU (HPSMU)に接続することはできません。

ガード・スイッチ・ユニット (GSWU)は CMU High/Low端子のガード
(CMU return)間接続をコントロールします。SMU使用時は開放、MFCMU
使用時は接続されます。

SCUUは被測定デバイス（DUT）に接続される測定リソース（MFCMUま
たは SMU）の自動切替を行い、Figure 4-21にみられる 4つの接続 (Setup)
を行うことが可能です。但し、電源投入直後はオープン状態です。SCUU
の入力には 4つの同軸コネクタと 4つのトライアキシャル・コネクタがあ

り、直接または、専用 SCUUケーブルを用いてMFCMU・SMUに接続しま
す。

SCUUに設置されている LEDは、次のように SCUUの状態を示します。

SMU スロット N-1/N-2の SMUを使用可能。

CMU Internal Bias MFCMUを使用可能。内部 DCバイアス源を使用。

CMU SMU Bias MFCMUを使用可能。DCバイアス源に SMUを使用。

SCUUの出力には 4つのトライアキシャル・コネクタがあり、DUTインタ
フェース（マニピュレータ、プローブカードなど）との接続に使用します。
測定リソースが SMUである場合は 2組のケルビン接続コネクタであり、

それぞれ Force1/Sense1、Force2/Sense2に対応します。また測定リソースが

MFCMUである場合は CMU High/Lowがそれぞれ Force1/Force2に接続さ
れ、Sense1/Sense2は使用されません。

さらに正確なインピーダンス測定を実現するには、CMU return端子を
GSWUに接続します。CMU return端子とは DUTインタフェースのできる
限り DUTに近いところで開放された外部シールド導体のことをいいます。

Figure 4-14を参照してください。

GSWUにはコネクタ 1つと端子 2つがあります。コネクタは GSWUケー
ブルを用いて SCUUに接続します。2つの端子はワイヤを用いて CMU 
High/　Lowから延長される DUTインタフェースの CMU return端子に接続
します。
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SMU CMUユニファイ・ユニット（SCUU）
Figure 4-21 SCUU 入出力の接続

NOTE SCUU/GSWU使用上の注意
SCUU/GSWUを接続するには Keysight B1500Aの電源をオフしてください。

Sense1

Force

to GSWU through
DUT interface

Force1

Setup 1:  CMH/Force1/Sense1: SMU (slot N-1)

Sense

CML/Force2/Sense2: Open
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Force Force2

Setup 2:  CMH/Force1/Sense1: Open

Sense

CML/Force2/Sense2: SMU (slot N-2)

SMU in slot N-1

SMU in slot N-2

Sense1

Force Force1

Setup 3:  CMH/Force1/Sense1: SMU (slot N-1)

Sense

CML/Force2/Sense2: SMU (slot N-2)

SMU in slot N-1
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Force Force2

Sense

SMU in slot N-2

Hcur CMUH

Setup 4:  CMH/Force1: CMUH (slot N)

Hpot

CML/Force2: CMUL (slot N)

MFCMU in slot N
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CMU Return

to GSWU through
DUT interface
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アト・センス／スイッチ・ユニット（ASU）
アト・センス／スイッチ・ユニット（ASU）

B1500A/E5270Bに有効。アト・センス／スイッチ・ユニット (ASU)を使用
するには、校正時に接続されていた SMU に接続します。ASUを使用する
ことで 1 pAレンジの使用が可能となります。また AUX入力端子に他計測
器を接続することで、被測定デバイス（DUT）に接続される測定リソース
(SMUまたは他計測器 )の自動切替を行い、Figure 4-22にみられる 2つの接
続 (Setup)を行うことが可能です。電源投入時には Setup 1の状態になりま
す。詳細は、使用する計測器のユーザ・ガイドを参照してください。

ASUの入力にはトライアキシャル・コネクタ 1つと同軸コネクタ 2つがあ
り、それぞれ SMUの Force端子、他計測器の入出力端子との接続に使用し
ます。また制御信号用コネクタは ASUケーブルを用いて SMUに接続しま
す。

Figure 4-22 ASU 入出力の接続

ASUには次のインジケータ (LED)が設置されています。

SMU SMUを使用可能 (Setup 1)。

AUX AUXに接続された計測器を使用可能 (Setup 2)。

D-sub

Sense

CMU-cur/AUX In

CMU-pot

Force

From SMU

CMU/AUX

CMU Return

Circuit common

Force

Setup 1:  AUX Off  ( SMU input to ASU output )

Setup 2:   AUX On ( CMU/AUX input to ASU output )
Circuit common
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機能の説明

アト・センス／スイッチ・ユニット（ASU）
ASUの出力には 2つのトライアキシャル・コネクタがあり、DUTインタ
フェース（マニピュレータ、プローブカードなど）との接続に使用します。

測定リソースが SMUである場合は 1組のケルビン接続コネクタであり、

それぞれ Force/Senseに対応します。また測定リソースが他計測器である場

合は CMU/AUXが Forceに接続され、Senseは使用されません。

他計測器としてMFCMUまたは 4端子対構造の LCRメータを接続するに
は、ASUを 2ユニット必要とします。一方の ASUの CMU-pot/CMU-cur入
力コネクタは計測器の Hpot/Hcurとの接続に、もう一方の ASUの
CMU-pot/CMU-cur入力コネクタは Lpot/Lcurとの接続に使用します。
さらに、4端子対測定法による正確なインピーダンス測定を実現するには、

2つの ASUの CMU Return端子を互いに接続します。｢ 4端子対構造と DUT
接続について (p. 4-25) ｣および Figure 4-14を参照してください。

NOTE 1 pAレンジを使用するには
ASU（アト・センス／スイッチ・ユニット）を装着している測定チャネル

は 1 pAレンジをサポートします。1 pAレンジを使用するには、1 pA 固定

レンジまたは 1 pAリミテッド・オート・レンジングに設定します。

B1500A/E5270Bは 1 pAレンジによる測定データの補正を自動実行し、補
正後のデータを返します。データ補正は、あらかじめ保存されているオフ

セット・データ、または測定したオフセット・データを使用して実行され
ます。

オフセット・データを測定するには、実デバイスの測定を開始する前にセ

ルフキャリブレーションを実行します。このオフセット・データは
B1500A/E5270Bの電源がオフされるまで一時的に記憶されます。

NOTE ASU使用上の注意
ASUの接続は B1500A/E5270Bの電源を投入する前に行ってください。

ASUと SMUの組み合わせは重要です。異なる組み合わせでも使用可能で

すが、性能試験が行われた正しい組み合わせでのみ、仕様は保証されます。
｢ ASU (p. 1-101) ｣を参照して、組み合わせが正しいことを確認してくださ

い。

CMU-potコネクタは、MFCMUまたは 4端子対入力の LCRメータを接続す
る場合に使用します。そうでない場合は、BNCオープンコネクタを接続す
るか、何も接続しないでください。このラインは ASU内部で CMU-cur/ 
AUX-inラインに接続されます。

ASUを接続している場合、SMUの内部直列抵抗を使用することはできま

せん。
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SMU/PGセレクタ
SMU/PG セレクタ

B1500A/4155/4156に有効。Keysight 16440A SMU/PGUセレクタ
(B1500A-A04)は、Outputポートに接続される測定パスの切り替えを行いま

す。セレクタの 簡易回路図を Figure 4-23に記します。セレクタにはチャネ
ル CH 1と CH 2があり、それぞれ下記チャネル状態を提供します。チャネ

ル状態の設定は Configurationウインドウの SMU/PG Selectorタブ画面で行
います。

CH 1 オープン、SMU接続、PGU接続、PGUオープン
CH 2 オープン、SMU接続、PGU接続

PGUオープンは CH 1だけに有効です。PGUパスのメカニカル・リレーを

クローズしたまま、半導体リレーをオープンすることによって実現されま

す。半導体リレーはメカニカル・リレーに比べて耐久性が高いので、ス

イッチング回数の多いアプリケーションに有効です。PGUオープンは
Measurement Setupの Advanced Setupウインドウで設定します。

Figure 4-23 SMU/PG セレクタの簡易回路図と接続図

セレクタ 2台を接続することが可能です。1台目のセレクタの CONTROL 
Outputコネクタと 2台目のセレクタの CONTROL Inputコネクタを専用ケー

ブルで接続します。セレクタを B1500Aに接続するには、Keysight 16445A
セレクタ・アダプタが必要です。

AC power

16440A Selector #2 for DUT terminals 3 and 4

B1500A Digital I/O

DUT terminal 1
SMU #1 Force
PGU #1 or others
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16445A Selector Adapter
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PGU Input
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モジュール・セレクタ
モジュール・セレクタ

B1505Aに有効。被測定デバイス（DUT）に接続される測定リソース
（HCSMUまたは DHCSMU (デュアル HCSMU)、HPSMU、HVSMU）の自
動切替を行うには Keysight N1258Aモジュール・セレクタを使用します。
モジュール・セレクタの Inputポートには HCSMUまたは DHCSMU、
GNDU、HPSMU、HVSMUを接続し、Outputポートには DUTインタ
フェースを接続します。Inputポートには、少なくとも SMU 2モジュール
を接続する必要があります。

パッケージ・デバイスの測定には Keysight N1259Aテスト・フィクスチャ
を使用します。N1259Aはモジュール・セレクタを内蔵することができま
す。

モジュール・セレクタの設定は ConfigurationウインドウのModule Selector
タブ画面で行います。

Figure 4-24 モジュール・セレクタの簡易回路図と接続図

CAUTION デュアル HCSMU (DHCSMU)をモジュール・セレクタと一緒に使用する場

合、モジュール・セレクタの性能劣化・故障を防ぐため、最大電流 ± 30 A
で使用してください。

Front view

DUT high terminal

DUT high
HPSMU

DUT low

Module Selector

Open

High

HVSMU

HCSMU

GNDU

Low AC power

B1505A Digital I/O
HCSMU Force+Sense
HPSMU Force+Sense
GNDU Force+Sense
HVSMU Force

Rear view

DUT low terminal

Open

100 k
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超大電流エクスパンダ／フィクスチャ
超大電流エクスパンダ／フィクスチャ

B1505Aに有効。Keysight N1265Aは、500 Aまたは 1500 A（オプション
N1265A-015）までの出力と測定を可能にする電流エクスパンダと、被測定
デバイス（DUT）に接続される測定リソースの切替用セレクタを内蔵して

いるテスト・フィクスチャです。

電流エクスパンダ機能は、超大電流ユニット（UHCU）を構成するために
使用します。

セレクタ機能は、DUTに接続される測定リソースの切り替えに使用しま

す。測定リソースとして、UHCU、HVSMU/HVMCU、HP/MPSMU、そし

て GNDUを使用することができます。Figure 4-26を参照してください。

セレクタの出力をプローバ・ステーションまで延長するには Keysight 
N1265A-524超大電流プローバ・システム・ケーブルを使用します。この
ケーブルは、500 Aまでの電流に耐えることができます。

N1265Aは、UHVU、Bias-Tを介したMFCMU、および
HP/MP/HC/MC/DHCSMUの接続パスも提供します。

超大電流ユニット 超大電流ユニット（UHCU）は、Figure 4-25にみられるように、N1265Aと
2台のMC/HCSMUを用いて構成されます。UHCUの出力は、内蔵セレク
タを制御することによって、Selector Outputポートに現れます。

超大電流エクスパンダ／フィクスチャの設定は Configuration ウインドウの
UHC Expander / Fixtureタブ画面で行います。

Figure 4-25 UHCU 構成図
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超大電流エクスパンダ／フィクスチャ
Figure 4-26 N1265A 内蔵セレクタの簡易回路図

Low High
Sense Force

S: Sense

F: Force

P.A

GNDU

UHCU

SMU HVSMU
S F

S F
S F

F

P.A: Protection adapter

Sense Force

HVSMU force is 
connected to 
High sense line.

MCSMU MCSMU
I-controlV-control

MCSMU
FS

Low High
Gate

100 k

0 
10 

100 
or 1 k
4-54 Keysight EasyEXPERT ユーザ・ガイド Vol. 1、第 5版



機能の説明

HVSMU電流エクスパンダ
HVSMU 電流エクスパンダ

B1505Aに有効。Keysight N1266Aは、HVSMU用の電流エクスパンダであ
り、高電圧中電流ユニット（HVMCU）を構成するために使用します。

HVMCUは、Figure 4-27にみられるように、N1266Aと 1台の HVSMU そ

して 2台のMC/HCSMUを用いて構成されます。また、HVSMU出力と
HVMCU出力の切り替えを行うセレクタを内蔵しています。

HVSMU電流エクスパンダの設定は Configuration ウインドウの HVSMU 
Current Expanderタブ画面で行います。

Figure 4-27 HVMCU の構成

N1266A HVSMU current expander

HVSMU

GNDU

V-control
I-control

Digital I/O Digital I/O
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HVMCU

*1: N1261A-002/004 protection adapter is required for connecting prober.
     Not requred for connecting N1258A, N1259A, N1259A-300, or N1265A.

N1261A-002
or 004(*1)
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超高電圧エクスパンダ
超高電圧エクスパンダ

B1505Aに有効。Keysight N1268Aは、10 kVまでの出力と測定を可能にす
る電圧エクスパンダであり、超高電圧ユニット（UHVU）を構成するため
に使用します。

UHVUは、Figure 4-28にみられるように、N1268Aと 2台のMC/HCSMU
を用いて構成されます。

超高電圧エクスパンダの設定は Configuration ウインドウの UHV Expander
タブ画面で行います。

Figure 4-28 UHVU の構成
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SMUレンジング・モード
SMU レンジング・モード

ソース／モニタ・ユニット (SMU)の測定レンジまたは出力レンジの動作
モード（レンジング・モード）には次のモードがあります。レンジング・

モードはチャネル毎に設定します。

• オート・レンジング

• リミテッド・オート・レンジング

• 固定レンジ

• コンプライアンス・レンジ

• 電流測定オート・レンジング拡張機能

設定時の注意

レンジング・モードを設定する場合は、以下に注意してください。

測定チャネル

• レンジング・モードを設定しない場合、オート・レンジングが設定され

ます。

• 電圧出力／電圧測定、または電流出力／電流測定を行う場合、測定レン

ジは出力レンジと同じレンジに設定されます。

• パルス出力を行う場合、測定チャネルはコンプライアンス・レンジまた

は指定された固定レンジで測定を行います。オート・レンジングおよび
リミテッド・オート・レンジングの動作を行うことはできません。

• アト・センス／スイッチ・ユニット (ASU)を接続した SMUにおける
オート・レンジング動作の最低レンジは 10 pAです。1 pAレンジを使
用するには、1 pAリミテッド・オート・レンジング・モードまたは
1 pA 固定レンジに設定してください。

出力チャネル

• 出力チャネルのレンジング・モードを選択する場合は、オート・レンジ

ングまたはリミテッド・オート・レンジングを選択してください。

• 電圧出力レンジ、電圧コンプライアンス・レンジの切り替えが起こる

と、チャネル出力値は一時的に 0 Vになります。
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SMUレンジング・モード
オート・レンジング

オート・レンジングでは次の動作を行います。

測定チャネル

最高分解能で測定を実行できるように測定レンジを自動設定します。

• 電流測定の場合、測定値が次の範囲内であれば現在のレンジを使用し、

この範囲を超えるとレンジを切り替えて測定を実行します。

レンジ値の 10 %  測定値  レンジ値の X %

ここで、X %は 115 %、最大レンジでは 100 %。

電流測定オート・レンジング拡張機能 (p. 4-60)も参照してください。

• 電圧測定の場合、測定値が次の範囲内であれば現在のレンジを使用し、

この範囲を超えるとレンジを切り替えて測定を実行します。

1つ下のレンジ値  測定値  レンジ値の X %

ここで、X %は 110 %、最大レンジでは 100 %。

出力チャネル

出力値をカバーする最小レンジを自動設定します。出力チャネルの設定に

よって次のレンジを選択します。

• 階段波掃引出力：

スタート値、ストップ値をカバーする最小レンジ。ただし電流のログ掃

引を行う場合はステップ出力値をカバーする最小レンジを使用します。

また電圧掃引源にパワー・コンプライアンスを設定した場合はステップ

出力値をカバーする最小レンジ（20 Vレンジ以上）を使用します。
• パルス出力：

ベース値、ピーク値をカバーする最小レンジ。

• パルス掃引出力：

ベース値、スタート値、ストップ値をカバーする最小レンジ。

• サーチ出力、疑似パルス出力：

スタート値、ストップ値をカバーする最小レンジ。

各レンジにおける最大出力値を以下に記します。

• 電流出力：レンジ値の 115 %、最大レンジでは 100 %
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• 電圧出力：レンジ値の 100 %

リミテッド・オート・レンジング

オート・レンジングと同様の動作を行いますが、指定したレンジ値以上の

レンジを使用します。

例えば、10 mAリミテッド・オートを選択した場合、1 mA以下のレンジを
使用しません。従って、レンジ変更の回数が減り、オート・レンジングよ

りも短時間で測定、出力を実行します。

固定レンジ

指定されたレンジを使用します。

ただし電流測定チャネルに設定する測定レンジの値がコンプライアンス値

をカバーする最小レンジよりも高い場合、測定チャネルはそのレンジ（コ

ンプライアンス・レンジ）を使用します。

コンプライアンス・レンジ

電圧出力／電流測定または電流出力／電圧測定を行うチャネルに有効です。

出力設定コマンドに指定されたコンプライアンス値をカバーする最小レン

ジを自動的に選択し、そのレンジで測定を行います。

測定チャネルが定電圧または定電流出力を行う場合には、コンプライアン

ス・レンジを設定できます。

測定チャネルが掃引出力を行う場合には、パワー・コンプライアンスを設

定できます。パワー・コンプライアンスを設定した場合、下式で与えられ

る値とコンプライアンス設定値のどちらか小さい値をカバーする最小レン

ジを使用します。

電流コンプライアンス =パワー・コンプライアンス設定値／ステップ電圧

電圧コンプライアンス =パワー・コンプライアンス設定値／ステップ電流

コンプライアンスの詳細については、 「SMUコンプライアンス (p. 4-61)」
を参照してください。

NOTE コンプライアンス・レンジのレンジ設定動作は、測定時ではなく、コンプ

ライアンス設定時に実行されます。
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電流測定オート・レンジング拡張機能

電流測定をオート・レンジングで行う場合、レンジ切り替え動作を拡張す

ることが可能です。この動作拡張にはレンジ変更ルール (Range Changing 
Rule)を設定します。「SMU Range Setupウインドウ (p. 2-53)」を参照してく
ださい。Rate値はレンジ切り替えの境界を決定します。

• Range Changing Rule=BY FULL RANGE：

通常のオート・レンジングと同じ動作を行います。

次の条件の一方が満たされると、測定中に測定レンジを切り替えます。

測定値 >レンジ値の X %

測定値  レンジ値の 10 %

ここで、X %は 115 %または 100 %（最大レンジにおいて）。

• Range Changing Rule=GO UP AHEAD：

次の条件が満たされると、測定後に測定レンジを１つ上に変更します。

測定データ  current1

• Range Changing Rule=UP AND DOWN AHEAD：

次の条件が満たされると、測定中に測定レンジを１つ下に変更します。

測定データ  current2

次の条件が満たされると、測定後に測定レンジを１つ上に変更します。

測定データ  current1

ここで、current1、current2は次の式で与えられます。また、rateに有効な
値は 11から 100です。

current1 =レンジ値  rate /100

current2 =レンジ値  rate /1000

例えば、レンジ値 =10 mA、rate=90であれば、次の値を示します。

current1 = 9 mA

current2 = 0.9 mA
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SMU コンプライアンス

コンプライアンスは、ソース／モニタ・ユニット（SMU)の出力リミッタ
です。過電流、過電圧、または過電力による被測定デバイスの破壊防止に

有効です。電流出力の SMUには電圧コンプライアンス、電圧出力の SMU
には電流コンプライアンスを設定します。

コンプライアンスに達すると、SMUはコンプライアンス到達時の出力を維

持します。すなわち、定電流源または定電圧源として働きます。

コンプライアンスの設定は、SMUの出力値と同じ設定範囲、分解能、確度

で行えます。設定値の詳細は、使用する計測器のユーザ・ガイドを参照し

てください。

極性と出力値

• 電流コンプライアンスの極性

正負両方向に設定されます。ここで、出力電圧と逆極性側のコンプライ

アンス値は、設定値よりもわずかに大きな値となります（コンプライア
ンス値を含む最小レンジ値の 2.5 ～ 12 %程度大きな値に設定されま

す）。Figure 4-29を参照してください。

• 電圧コンプライアンスの極性

出力電流と同じ極性に設定されます。逆極性の出力に電圧コンプライア

ンスは機能しません。

Figure 4-29 コンプライアンスと出力の関係 
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パワー・コンプライアンス

階段波掃引源の設定では、電圧コンプライアンスと電流コンプライアンス

の他にパワー・コンプライアンスがあります。パワー・コンプライアンス

を HVSMUに設定することはできません。

パワー・コンプライアンスを設定すると、SMUは出力電圧または出力電流
を変更する度に電流コンプライアンスまたは電圧コンプライアンスを変更

します。その値は、下式で与えられる値とコンプライアンス設定値のどち

らか小さい値となります。Figure 4-30を参照してください。
電流コンプライアンス =パワー・コンプライアンス設定値／ステップ電圧

電圧コンプライアンス =パワー・コンプライアンス設定値／ステップ電流

Figure 4-30 パワー・コンプライアンス出力領域 

設定範囲

パワー・コンプライアンスの設定範囲は下記のように、SMUのタイプに
よって異なります。

MPSMU/HRSMU 1 mW ～ 2 W

HPSMU 1 mW ～ 20 W

HCSMU 1 mW ～ 40 W（DC）、1 mW ～ 400 W（パルス）
DHCSMU 1 mW ～ 80 W（DC）、1 mW ～ 800 W（パルス）
MCSMU 1 mW ～ 3 W（DC）、1 mW ～ 30 W（パルス）
UHCU 1 mW ～ 7.5 kW（パルス、500 Aレンジ）、1 mW ～

22.5 kW（パルス、1500 Aレンジ）
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Voltage
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UHVU 1 mW ～ 100 W（DC）、1 mW ～ 200 W（パルス）
HVMCU 1 mW ～ 600 W（パルス、2200 Vレンジ）、1 mW ～

900 W（パルス、1500 Vレンジ）

コンプライアンス到達後の状態

コンプライアンスに達すると、階段波掃引源は自動的に掃引を終了し、出

力値をスタート値に戻します。また、コンプライアンスに達した後の測定
データは NaNとなります。

SMUの出力範囲
パワー・コンプライアンスを設定する場合、電圧（または電流）出力レン

ジと電流（または電圧）コンプライアンス・レンジを変更しながら電圧

（または電流）掃引を行います。従って SMUは最大出力の限界で掃引を行

うことができます。Figure 4-31はパワー・コンプライアンスを設定した場
合と設定しない場合のMPSMU出力の違いを示しています。

Figure 4-31 MPSMU で電圧掃引を行う場合の電流範囲

NOTE パワー・コンプライアンスを設定すると、掃引ステップ毎にコンプライア

ンスを調整するので、測定時間が長くなります。
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設定時の注意

コンプライアンスを設定する場合は、以下に注意してください。

• 電流コンプライアンスが小さすぎるとセトリング時間が長くなります。

• 次の条件のために、指定した電流を出力できなかった場合は、SMUの
出力が電圧コンプライアンスに達する可能性があります。

• テスト・デバイスを流れる電流が限界に達した場合

• 他チャネルがコンプライアンスに達した場合

• 他チャネルの電流測定値がレンジの最大測定値に達した場合
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SMU パルス

ソース／モニタ・ユニット（SMU）は電圧パルスまたは電流パルスを出力
することができます。このセクションではパルス設定パラメータについて

記述しています。使用するパルス出力チャネルの数によって設定パラメー

タが異なります。Figure 4-32を参照してください。

パルス出力時の注意

パルス出力を行う場合、以下の事項に注意してください。

• 1 nA以下の出力レンジを使用することはできません。

• Multi Channel I/V Sweep以外のテストでは、複数のパルス出力チャネル
を使用することはできません。

• Multi Channel I/V Sweep以外のテストでは、複数の測定チャネルを使用
することはできません。

• 測定チャネルはコンプライアンス・レンジで測定を行います。オート・

レンジングおよびリミテッド・オート・レンジングの動作を行うことは
できません。

Figure 4-32 SMU パルス設定パラメータ
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パルス設定パラメータ

パルス設定パラメータと有効値を以下に記します。

ホールド時間 0 s ～ 655.35 s、10 ms分解能

パルス周期 5 ms ～ 5 s、100 s分解能

SMU:B290X/B291X: 50 s ～ 100000 s
パルス幅 HR/MP/HPSMU: 500 s ～ 2 s、100 s 分解能

HCSMU/デュアル HCSMU: 50 s ～ 2 s、2 s 分解能。
但し 20 Aレンジまたは 40 Aレンジを使用する場合、
最大 1 ms、デューティ比 1 %以下であること。

MCSMU: 10 sから 2 s、 2 s 分解能。但し 1 Aレンジ
を使用する場合、最大 100 ms、デューティ比 5 %以下
であること。

UHCU: 10 s ～ 1 ms 、 デューティ比 0.4 %以下（500 A
レンジ）。10 s ～ 500 s、デューティ比 0.1 %以下
（1500 Aレンジ）。2 s 分解能。

UHVU: 100 s ～ 2 s、2 s 分解能。但し 100 mAレン
ジを使用する場合、最大 1 ms。

HVSMU: 500 s ～ 2 s、2 s 分解能

HVMCU: 10 s ～ 100 s、2 s 分解能。但し 2200 V / 
110 mAレンジを使用する場合、最大 1 ms。

SMU:B290X/B291X: 50 s ～ 100000 s
パルス・ディレイ時

間 0 s ～パルス周期 - パルス幅、2 s分解能。

HR/MP/HPSMU：0 s

測定ディレイ時間 2 s ～パルス周期 -測定時間 -2 ms、2 s分解能

SMU:B290X/B291Xの場合は、次式で自動的に算出さ

れます。

測定ディレイ =パルス終了時間－積分時間

測定時間 HR/MP/HPSMU: 16 s ～ 20 ms、2 s分解能

HC/MCSMU: 2 s ～ 20 ms、2 s分解能

HVSMU: 6 s ～ 20 ms、2 s分解能

「積分時間 (p. 4-68)」を参照してください。
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設定値は、次式を満足する必要があります。

• パルス周期  パルス・ディレイ時間 + パルス幅 + 2 ms 
（パルス・ディレイ時間 + パルス幅  100 ms）

• パルス周期  パルス・ディレイ時間 + パルス幅 + 10 ms 
（パルス・ディレイ時間 + パルス幅 >100 ms）

• HR/MP/HPSMUのパルス幅が同じ値であること。異なる値が入力された

場合は、最も長い時間が設定されます。

パルス周期に AUTOを設定すると、次の値のうち、最も長い値に自動設定

されます。

• パルス幅とデューティ比から得られる最短周期

• パルス周期 = 5 ms
（パルス・ディレイ時間 + パルス幅  3 msの場合）

• パルス周期 = パルス・ディレイ時間 + パルス幅 + 2 ms 
（3 ms < パルス・ディレイ時間 + パルス幅  100 msの場合）

• パルス周期 = パルス・ディレイ時間 + パルス幅 + 10 ms 
（100 ms < パルス・ディレイ時間 + パルス幅の場合）

測定ディレイ時間に AUTOを設定すると、最初に立ち下がるパルスのピー

ク出力が終了する時点で測定が完了するように自動設定されます。
Keysight EasyEXPERT ユーザ・ガイド Vol. 1、第 5版 4-67



機能の説明

SMU測定時間
SMU 測定時間

ソース／モニタ・ユニット（SMU)の測定時間は、積分時間、測定レンジ

などの測定条件に依存しており、次の式で表現されます。

測定時間 = 積分時間 +オーバーヘッド時間

積分時間は、単に測定に必要な時間であり、測定レンジの変更、測定デー

タの補正などに要する時間はオーバーヘッド時間とみなします。

積分時間

1つの測定データを得るために必要な時間です。積分時間を長くするほど

確度のよい測定結果を得ることができます。積分時間の設定は、測定チャ

ネルが使用する A/Dコンバータ（ADC）毎に行います。

• 高速 ADC (High Speed ADC)

各測定モジュールに搭載されており、高速測定に有効です。モード

(Mode)と Factor値を設定することで、1測定データ当りのアベレージン

グ・サンプル数または実測定時間を設定します。モードには、AUTO、
MANUAL、PLC、および TIMEがあります。SMUパルスを使用する測
定には、PLCと TIMEが有効です。

• 高分解能 ADC (High Resolution ADC)

高精度、高分解能測定に有効です。この ADCはメインフレームに搭載
されており、複数の測定モジュールによって交互に使用されます。モー

ド (Mode)と Factor値を設定することで、1測定データ当りの積分時間

を設定します。SMUパルスを使用する場合、高分解能 ADCを使用する
ことはできません。モードには、AUTO、MANUAL、および PLCがあ
ります。

Table 4-8は測定機器間の ADC設定の違いを示します。詳細については、

各測定器のマニュアルを参照してください。表中のデフォルト積分時間に

ついては、「ユーザ・ガイド Vol. 2」の第 10章「困ったときに見てみましょ
う」内のセクション「4155/4156からの移行時の注意」を参照してくださ

い。また、この表には、設定時に EasyEXPERTから測定器に送られる

FLEXコマンドも表記しています。
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Table 4-8 測定機器間の ADC セッティングの違い

ADCゼロ機能
ADCゼロ機能は高分解能 ADCに有効であり、自動的に ADC内部のオフ
セットを測定して補正を行います。LCDには補正後の測定データが表示さ
れます。高速 ADCにこの機能はありません。

EasyEXPERT ADC セッティング

ADC
タイプ

Auto Manual PLC

4155/4156 
(HP/MP/HR
SMU)

高分解能
ADC

MEDIUM
(=SLI 2)

SHORT
(=SIT 1, 80 s  
Factor)

MEDIUM or LONG
(=SLI 2 or SLI 3, 
Factor/電源周波数 )

B1500/B1505
(HP/MP/HR
SMU)

高分解能
ADC

デフォルト積分時間 
 Factor
(=AIT 1,0,Factor)

80 s  Factor
(=AIT 1,1,Factor)

Factor/電源周波数

(=AIT 1,2,Factor)

高速 ADC デフォルト積分時間 
 Factor
(=AIT 0,0,Factor)

80 s  Factor
(=AIT 0,1,Factor)

Factor/電源周波数

(=AIT 0,2,Factor)

E5270B
(HP/MP/HR
SMU)

高分解能
ADC

デフォルト積分時間 
 Factor
(=AIT 1,0,Factor)

80 s  Factor
(=AIT 1,1,Factor)

Factor/電源周波数

(=AIT 1,2,Factor)

高速 ADC デフォルト積分時間 
 Factor
(=AIT 0,0,Factor)

80 s  Factor
(=AIT 0,1,Factor)

Factor/電源周波数

(=AIT 0,2,Factor)

E5260A/E526
2A/E5263A
(HP/MPSMU)

高速 ADC デフォルト積分時間 
 Factor
(=AIT 0,0,Factor)

80 s  Factor
(=AIT 0,1,Factor)

Factor/電源周波数

(=AIT 0,2,Factor)

B2900 高速 ADC ファームウェア・デ

フォルト設定 
(1 A以上のレンジで
は PLC、100 nA
以下のレンジでは  
PLC)

50 s  Factor Factor/電源周波数
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NOTE 測定精度の仕様を満足させるには、この機能を ONする必要があります。

測定精度よりも測定スピードの方が重要である場合には、この機能を OFF
します。積分時間を約半分に短縮することができます。
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オーバーヘッド時間

オーバーヘッド時間は、測定レンジの変更などに要する時間です。この時

間は測定条件によって変動するもので、意図的に設定することはできませ

ん。オーバーヘッド時間の主な要素を以下に示します。

• 測定中のレンジ変更時間（オートまたはリミテッド・オート・レンジで

測定した場合）

• 測定開始時のレンジ変更時間（コンプライアンス値より低い測定レンジ

が使用された場合）

ソース印加時間の設定

測定時間を意図的に設定することはできません。そのかわりに掃引測定で

は、測定時間を含むソース印加時間を設定することができます。ソース印

加時間を設定するには、ディレイ時間とステップ・ディレイ時間の設定を

行います。ステップ・ディレイ時間は測定開始からソース出力値変更まで

の時間として定義されます。ソース印加時間を一定に保つためには、ス

テップ・ディレイ時間は測定時間以上である必要があります。

EasyEXPERTでは、ステップ・ディレイ時間 (Step delay time)を設定するこ
とはできません。GPIBリモート・モードでのみ設定可能です。

Vstart

Hold time

Measurement time

Delay time (Td)

Step delay time (Tsd)
only for Remote mode

Td Tsd

Td TsdSource output time
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ウエイト時間

ウエイト時間はチャネル出力開始からの待ち時間です。出力ウエイト時間

(Source wait time)、測定ウエイト時間 (Measurement wait time)を別々に設定

することができます。

出力ウエイト時間は出力チャネルが出力を開始してから出力値を変更する

までに必ず待つ時間であり、測定ウエイト時間は出力チャネルが出力を開

始してから測定チャネルが測定を開始するまでに必ず待つ時間です。
Figure 4-33を参照してください。ウエイト時間は次式で与えられます。設

定値はすべてのチャネルに有効です。

ウエイト時間 = N  REF値

REF値は SMUが出力条件、測定条件に応じて自動的に設定する値であり、

変更することのできない値です。Nの有効値は 0 ～ 10（B2900の場合、0
～ 100）、0.1ステップです（初期値：1）。
最適なウエイト時間を設定することは困難です。長すぎると時間の無駄に

なりますが、短すぎるとデバイスの特性が安定する前に測定を実行してし

まうかもしれません。応答の遅いデバイスを測定する場合には初期値では
十分な待ち時間が取れないことがあります。その場合は、N値を 1以上に
設定します。応答の速いデバイスの測定において測定スピードが最重要で
ある場合には、N値を 1以下に設定します。

Figure 4-33 出力／測定ウエイト時間

NOTE GPIBリモート・モードでディレイ時間がウエイト時間よりも長い場合は、
ウエイト時間を無視することができます。

EasyEXPERTでは、ステップ・ディレイ時間 (Step delay time)を設定するこ
とはできません。

Time

Measurement wait time

:  Measurement

Hold time

Delay time

Source wait time

Step delay time
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測定チャネルが複数ある場合

複数の測定チャネルを使用するには、Display Setup画面または Function 
Setup画面で複数の測定パラメータを設定します。この場合、各測定点にお
ける測定実行順、時間データ、測定時間は次のようになります。

• 測定実行の順番

測定チャネルは、下記の順番で測定を実行します。

1. 高速 ADコンバータおよび FIXED測定レンジを使用する測定チャネ
ルが同時に測定を開始します（並列測定）。

2. 並列測定終了後、その他の測定チャネルが順番に測定を実行します。
その順番は、SMU Range Setup画面に定義されたチャネルの上から
下となります。

例外として、複数パルスを用いるマルチ・チャネル掃引測定、および

Interval < 2 msのリニア・サンプリング測定では、全測定チャネルが同

時に測定を開始します。

• 時間データ

一番初めに測定を開始するチャネルの測定開始時間だけが記録されま

す。

• 測定時間

全測定チャネルによる測定時間の総和となります。
Keysight EasyEXPERT ユーザ・ガイド Vol. 1、第 5版 4-73



機能の説明

SMUフィルタ
SMU フィルタ

ソース／モニタ・ユニット（SMU）はフィルタを内蔵しています。ノイ
ズ、スパイク、オーバーシュートのない、きれいな出力を行うためにフィ

ルタを利用することができます。フィルタをオンにすると、出力波形を整

える分、セトリング時間が長くなります。

フィルタを設定するには「Advanced Setupウインドウ (p. 2-57)」を参照して
ください。

NOTE スタンバイ状態にあるスタンバイ・チャネルの SMUフィルタは OFFに設定
されます。
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SMU 直列抵抗

ソース／モニタ・ユニット（HRSMU、HPSMU、MPSMU）には直列抵抗

（約 1 M）が内蔵されています。直列抵抗はデバイスの保護、負性抵抗の

測定などに利用することができます。ただし、その効果はデバイスの特性

や測定環境に依存します。

直列抵抗を使用する場合、設定電圧は直列抵抗を通してデバイスに印加さ

れます。従って、デバイスには分圧された電圧が印加されます。測定器の

設定値はデバイス端における電圧値ではありません。

直列抵抗を設定するには｢Advanced Setupウインドウ (p. 2-57)｣を参照してく
ださい。

直列抵抗はMCSMU、HCSMU、および HVSMUには内蔵されていません。

NOTE 直列抵抗を使用できない条件

アト・センス／スイッチ・ユニット (ASU)を接続している SMUを用いる
測定、および高電力 SMU (HPSMU)の 1 Aレンジを用いる測定には直列抵

抗を使用することはできません。

スタンバイ状態にあるスタンバイ・チャネルの直列抵抗は OFFに設定され
ます。
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インターロック機能
インターロック機能は、作業者が測定端子に触れた場合に起こり得る感電

事故を防ぐための機能です。Interlock端子を開放すると出力電圧は ± 42 V
に制限されます。

± 42 Vを越える高電圧測定を実行するには、テスト・フィクスチャまたは

コネクタ・プレートのインターロック回路を Interlock端子に接続します。
インターロック回路はシールド・ボックスのドア付近に設置された LED 1
つとメカニカル・スイッチ 2つを互いに接続することで完成します。設置

および接続については、使用する計測器のユーザ・ガイドを参照してくだ
さい。

インターロック機能は次の動作を行います。

• インターロック回路が開放されている場合、出力電圧を ± 42 Vに制限

します。

• インターロック回路が閉じている場合、チャネル出力最大値までの出力

を可能にします。

• 高電圧状態でインターロック回路が開放された場合、直ちにすべての出

力を 0 Vに設定します。

CAUTION インターロック機能が動作したにもかかわらず実際の出力が 120 ms以内に
0 Vにならなかった場合、B1500/E5260/E5270は自動的に初期化を行いま

す。B1500/E5260/E5270がこの動作を行った場合、初期化の後でセルフテ

ストを実行してください。モジュールに異常があるかもしれません。

WARNING 測定端子開放時は、SMU が最大出力電圧をフォース、 ガード、センス端子

に出力できないように、インターロック端子を開放してください。
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自動パワー・オフ機能

自動パワー・オフ機能は異常電圧や異常電流による損傷を避けるために自

動的に電源をオフする機能です。

この機能によって電源がオフされた時には、Standbyスイッチの設定はオン
のままになっています。電源を再投入するには次の手順に従ってください。

1. Windowsが起動している場合は、全ての作業を終了し、Windowsを
シャットダウンします。

2. 測定端子をオープンします。

3. Standbyスイッチを押し、スイッチをオフの状態にします。

4. リア・パネルからパワー・ケーブルを抜き取ります。

5. 10秒以上待ちます。

6. リア・パネルにパワー・ケーブルを接続します。

7. Standbyスイッチを押して、スイッチをオンの状態にします。

異常電圧や異常電流が生じる原因としては、テスト・デバイスとの不適切

な接続、過電圧または過電流の入力、装置の不具合、あるいはサイト・パ
ワーの瞬断などが考えられます。

B1500/E5260/E5270に測定ケーブルが接続されておらず、サイト・パワー
が正常であるにもかかわらず、この機能が作動した場合は
B1500/E5260/E5270に問題がある可能性があります。お近くのキーサイト・

テクノロジーにご連絡ください。
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自動パワー・オフ機能
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プログラミング・ツール
この章は Keysight EasyEXPERTに組み込まれているプログラミング・ツー
ルについて説明します。プログラミング・ツールは、Classic Test定義の
ユーザ関数 (user function)やアナリシス関数 (analysis function)を定義する場
合や、Application Test定義のテスト実行フロー (test execution flow)を定義す
る場合に使用します。

この章は次のセクションで構成されています。

• 変数と数式

• 組み込み関数

• リードアウト関数

• プログラム・ステートメント
5-2 Keysight EasyEXPERT ユーザ・ガイド Vol. 1、第 5版



プログラミング・ツール

変数と数式
変数と数式
Keysight EasyEXPERTでは、次の用途に変数 (variable)を使用することがで
きます。変数としてユーザ関数 (user function)、アナリシス関数 (analysis 
function)を使用することもできます。

• 測定条件入力パラメータ値の保持

• 測定結果データや解析データの保持

• Application Test定義のテスト実行フロー (test execution flow)内の変数

• Classic Test定義のユーザ関数

• Classic Test定義のアナリシス関数

変数名に使用可能な文字：

• アルファベット Aから Z、aから z（大文字と小文字は区別されます）

• アンダースコア _ 

• 数字 0から 9（変数名の先頭には使用できません）

• アットマーク@（変数名の先頭には使用できません）

NOTE 変数名の重複について

変数にはユニークな名前を設定する必要があります。例えば Application定
義内で Local変数が下記変数のどれかと同じ名前で定義された場合、Local
変数が有効となって、下記変数が無効となります。

• テスト セットアップ内の変数（組み込み関数 (built-in function)を使用）

• テスト セットアップ内の変数（リードアウト関数 (read out function)を
使用）

• テスト・パラメータ (test parameter)として定義された変数

• デバイス・パラメータ (device parameter)として定義された変数

• アナリシス・パラメータ (analysis parameter)として定義された変数

Local変数は Test Definitionウインドウの Test Contentsセットアップにおい
て Local Variable Definitionステートメントを用いて定義します。テスト・
パラメータとデバイス・パラメータは Test Specificationセットアップで、
アナリシス・パラメータは Test Outputセットアップで定義します。
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数式

変数の定義に有効な数式 (expression)を Figure 5-1に記します。また、構成
要素を説明します。

Figure 5-1 数式のシンタックス 

定数

数値を入力する代わりに次の定数を使用可能です。

• q: 素電荷量 1.60217710-19

• k: ボルツマン定数 1.38065810-23

( )

,

( )

,

( )

,

( )( )

,,

Expression

Expression

Binomial
Operator

Monomial
Operator

Expression

Litetral

Constant

Variable

Built-in
Function

Read Out
Function

User
Function
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Function
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• e: 真空誘電率 8.85418810-12

リテラル

数値型または文字列型のリテラル (literal)を使用可能です。

• 数値型リテラル

数値を入力するには次のようにタイプ（入力）します。ここで []内は
省略可能です。

Dd[.d][E[S]d][s]
D: 0から 9の数値。

d: Dを 0 回以上繰り返すことを意味します。

E: 指数表記の Eまたは e。

S: +または -の符号。

s:プリフィックス記号。カンマ (,)で区切られた次の記号 (y, z, a, f, p, n, 
u, m, k, M, G)は、それぞれコロン (:)以下の値を表します。

y: 10-24, z: 10-21, a: 10-18, f: 10-15, p: 10-12, n: 10-9, u: 10-6, m: 10-3, 
k: 103, M: 106, G: 109

• 文字列型リテラル

表記したい文字列をダブルクオーテーション・マークで囲みます。文字

列にダブルクオーテーション・マークを含ませるには、次のようにしま
す。次の例は ABC”DEFを文字列にしています。

"ABC""DEF"

単項演算子と二項演算子

数式に使用可能な単項演算子 (monomial operator)と二項演算子 (binomial 
operator)を Table 5-1に記します。Table 5-1は演算子の優先順位、演算可能な

被演算子 (operand)の型も記しています。優先順位が同一の演算子が並んで

いる場合は左から右の順番で実行されます。

モジュール型の被演算子には、SMU、HPSMU、HCSMU、DHCSMU、
HVSMU、MPSMU、MCSMU、HRSMU、HRSMU/ASU、CMH、CML、
UHCU500、UHCU1500、UHVU、HVMCUが有効です。

NOTE 配列データ間の演算

配列データ間の演算は同じインデックスのデータ間で実行されます。
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Table 5-1 単項演算子と二項演算子

組み込み関数

Keysight EasyEXPERTに内蔵されている組み込み関数 (built-in function)を使
用できます。「組み込み関数 (p. 5-7)」を参照してください。

リードアウト関数

Keysight EasyEXPERTに内蔵されているリードアウト関数 (read out function)
を使用できます。「リードアウト関数 (p. 5-19)」を参照してください。

ユーザ関数とアナリシス関数

ユーザ関数 (user function)とアナリシス関数 (analysis function)は、変数名、

単位、定義式をひとつの組み合わせにして、ユーザが定義する関数です。

これらの関数は数値型またはベクター型のデータに有効です。関数を定義
するには｢ Function Setup (p. 2-47) ｣を参照してください。

定義式には数値型リテラル、定数 (q、k、e)、テスト結果データを保持する

変数、数値型データまたはベクター型データを返す組み込み関数を使用可
能です。アナリシス関数の定義式には、リードアウト関数も使用可能です。

優

先

度

演算子

被演算子の型

数値 ベクターa

a. 二次元配列。たとえば、一次掃引のインデックスを一次元方向に二次掃引のインデッ

クスを二次元方向に設定します。

文字列 モジュール

高

　

　

　

　

　

　

　

　

　

　

　

　

低

( ) 括弧 Yes Yes Yes Yes
NOT 論理否定 Yes Yes No No

^ 累乗 Yes Yes No No

*または / 乗、除 Yes Yes No No

単項演算子の +または - Yes Yes +: Yes, -: No No

二項演算子の +または - Yes Yes +: Yes, -: No No

>, >=, <, <= 不等号 Yes Yes Yes No
=, <> 等号、不等号 Yes Yes Yes No
AND 論理積 Yes Yes No No
XOR 排他的論理和 Yes Yes No No
OR 論理和 Yes Yes No No
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組み込み関数
組み込み関数 
Keysight EasyEXPERTの組み込み関数を説明します。関数はアルファベッ
ト順に並んでいます。関数名の括弧内の文字は変数を表しています。

abs(A) 数式 Aの絶対値を返します。 

使用例 B=abs(A)
データ型 A:数値、B:数値。または A:ベクター、B:ベクター。

acos(A) 数式 Aの逆余弦関数を返します。Aには -1から 1の値が有効です。

使用例 B=acos(A)
データ型 A:数値、B:数値。または A:ベクター、B:ベクター。

applyN1272ACorre
ction()

呼び出し時点での N1272Aの容量測定パスに対応した容量測定補正データ

を Firmwareに適用し、0を返します。

N1272Aが認識されない場合や、N1272Aの測定パスが容量測定パスでない
場合、0でない値を返します。

使用例 B=applyN1272Acorrection()
データ型 B:数値。

asin(A) 数式 Aの逆正弦関数を返します。Aには -1から 1の値が有効です。

使用例 B=asin(A)
データ型 A:数値、B:数値。または A:ベクター、B:ベクター。

at(A,B) 数式 Aに含まれるデータから、インデックス Bによって示されるデータを
返します。インデックスは 1から開始されます。Bが整数でない場合、A
のデータをリニアで補間した値が返されます。

使用例 C=at(A,B)
データ型 A:ベクター または 数値、B:数値、C:ベクター。

at(A,B,C) 数式 Aに含まれるデータから、インデックス Bと Cによって示されるデー
タを返します。Bと Cは、二次元配列の一次元方向と二次元方向にそれぞ

れ対応します。インデックスは 1から開始されます。

Bが整数でない場合、A[n,C]と A[n+1,C]の間をリニアで補間した値を返し

ます。ここで、nは n < B < n+1を満足する整数を示します。
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Cが整数でない場合、n < C < n+1を満足する整数 nを Cとみなして演算を

行います。

使用例 D=at(A,B,C)
データ型 A:ベクター または 数値、B:数値、C:数値、D:数値。

atan(A) 数式 Aの逆正接関数を返します。

使用例 B=atan(A)
データ型 A:数値、B:数値。または A:ベクター、B:ベクター。

atan2(A,B) 座標 (0, 0)と (A, B)を通る直線と X 軸が作る角度をラジアン角で返します。

使用例 C=atan2(A,B)
データ型 A:数値、B:数値、C:数値。あるいは A, Bのどれかがベクター

であれば、C:ベクター。

avg(A) 数式 Aに含まれるデータの平均値を返します。二次掃引を使用した場合、

各二次掃引ステップにおける一次掃引の平均値を返します。

使用例 B=avg(A)
データ型 A:ベクター または 数値、B:ベクター。

ceil(A) 数式 A値以上の最小整数値を返します。

使用例 B=ceil(A)
データ型 A:数値、B:数値。または A:ベクター、B:ベクター。

cond(A,B,C,D) 数式 A、B、C、Dを入力すると以下の値を返します。

• A < Bの場合、Cの値を返します。

• A Bの場合、Dの値を返します。

あるインデックスにおける Aまたは Bの値が無効だった場合、一つ前のイ

ンデックスにおける値を使用します。

使用例 E=cond(A,B,C,D)
データ型 A, B, C, D:数値、E:数値。あるいは A, B, C, Dのどれかがベク

ターであれば、E:ベクター。

cos(A) 数式 Aの余弦関数を返します。

使用例 B=cos(A)
データ型 A:数値、B:数値。または A:ベクター、B:ベクター。
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組み込み関数
delta(A) 数式 Aの差分を返します。次のように計算が行われます。

Dn = (A2-A1)  n = 1の時

Dn = (An+1-An-1) / 2  1 < n < Nの時

Dn = (AN-AN-1)  n = Nの時

ここで、

Dn インデックス nでの差分

An インデックス nでの数式の値

N 測定点数

バイアス同期掃引における一次掃引データの第一点目のインデックス値は、

常に 1です。

二次掃引出力データについては、二次掃引のステップ値を返します。

C-V Sweepの周波数データについては、全ての周波数値に対して演算が実

行されます。

使用例 B=delta(A)
データ型 A:ベクター または 数値、B:ベクター。

diff(A) 数式 A の微分係数を返します。次のように計算が行われます。

A’n = 0  n = 1の時

A’n = An-An-1  1 < n  Nの時

ここで、

A’n: インデックス nにおける微分係数

An: インデックス nにおける Aの値

N: 測定点数

使用例 B=diff(A)
データ型 A:ベクター または 数値、B:ベクター。

diff(A,B) 数式 Aを Bで微分し、微分係数を返します。次のように計算が行われま

す。

A’n = (A2-A1)/(B2-B1)  n = 1の時

A’n = (An+1-An-1)/(Bn+1-Bn-1)  1 < n < Nの時

A’n = (AN-AN-1)/(BN-BN-1)  n = Nの時
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ここで、

A’n: インデックス nにおける微分係数

An: インデックス nにおける Aの値

Bn: インデックス nにおける Bの値

N: 測定点数

バイアス同期掃引における一次掃引データの第一点目のインデックス値は、

常に 1です。

使用例 C=diff(A,B)
データ型 A, B:ベクター または 数値、C:ベクター。

dim1Size(A) ベクター変数 Aの一次元方向のエレメント数を返します。

使用例 B=dim1Size(A)
データ型 A:ベクター、B:数値。

dim2Size(A) ベクター変数 Aの二次元方向のエレメント数を返します。

使用例 B=dim2Size(A)
データ型 A:ベクター、B:数値。

exp(A) 数式 Aの指数値を返します。次の例は eAの演算結果を変数 Bに入力しま
す。

使用例 B=exp(A)
データ型 A:数値、B:数値。または A:ベクター、B:ベクター。

extract(A, n) 数式 Aの指定インデックスに対応する一次元ベクターを返します。

使用例 B=extract(A,n)
データ例 A: 数値またはベクター、

n: Aの二次方向のインデックス、

B: Aに含まれる一次元ベクター

Aが一次元ベクターの場合、n=1のみ許され、Aと同じ内容の一次元ベク

ターが Bに返ります。

Aが数値の場合、n=1のみ許され、Aを唯一の要素とする一次元ベクター

が Bに返ります。

floor(A) 数式 A値以下の最大整数値を返します。
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使用例 B=floor(A)
データ型 A:数値、B:数値。または A:ベクター、B:ベクター。

getDeviceId() Device IDを返します。

使用例 A=getDeviceId()
データ型 A:文字列（Device ID）

getDeviceIdSupple
ment()

テスト結果レコードの Device IDパラメータの末尾に補足する文字列を返

します。この値は setDeviceIdSupplement(A) (p. 5-16)によって設定されま
す。

使用例 B=getDeviceIdSupplement()
データ型 B:文字列

getN1272ABiasDel
ay()

呼び出し時点での N1272Aの容量測定パスに対応したバイアス変更待ち時

間（秒）を返します。N1272Aを用いた C-V Sweep (p. 2-28)測定の Delayに
設定します。

N1272Aが認識されない場合や、N1272Aのパスが容量測定パスではない場
合、0を返します。

使用例 B=getN1272ABiasDelay()
データ型 B:数値

getN1272AHVSMU
()

Configureウインドウの Device Capacitance Selectorで指定された HVSMUを
返します。N1272Aを用いた C-V Sweep (p. 2-28)測定の Unitに設定します。

N1272Aが認識されない場合や、HVSMUの指定が行われていない場合、空

値を返します。

使用例 A=getN1272AHVSMU()
データ型 A:モジュール

getN1272AMFCMU
()

Configureウインドウの Device Capacitance Selectorで指定されたMFCMUを
返します。N1272Aを用いた C-V Sweep (p. 2-28)測定の Unitに設定します。

N1272Aが認識されない場合や、MFCMUの指定が行われていない場合、

空値を返します。

使用例 A=getN1272AMFCMU()
データ型 A:モジュール

getN1272ASMU() Configureウインドウの Device Capacitance Selectorで指定されたMPSMUを
返します。N1272Aを用いた C-V Sweep (p. 2-28)測定の Unitに設定します。
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N1272Aが認識されない場合や、MPSMUの指定が行われていない場合、空

値を返します。

使用例 A=getN1272AMPSMU()
データ型 A:モジュール

getNumericData(A
)

変数名 Aと名前が一致する数値型変数のデータを返します。最後に実行さ

れた Application Testの Analysisパラメータ、または最後に実行された
Classic Testの Function Setupまたは Display Setupに定義されている変数に
対して有効です。変数はテスト定義内で有効です。

使用例 B=getNumericData("A")
データ型 A:文字列（数値データの変数名）、B:数値。

getRemarks() テスト結果レコードの Remarksに設定する文字列を返します。この値は、

setRemarks(A) (p. 5-16)によって設定されます。
使用例 A=getRemarks()
データ型 A:文字列。

getVectorData(A) 変数名 Aと名前が一致するベクター型変数のデータを返します。最後に実

行された Application Testの Analysisパラメータ、または最後に実行された
Classic Testの Function Setupまたは Display Setupに定義されている変数に
対して有効です。変数はテスト定義内で有効です。

使用例 B=getVectorData("A")
データ型 A:文字列（ベクター データの変数名）、B:ベクター。

index(A,B) 文字列 Aの先頭から、文字列 Bの検索を行い、最初に見つかった場所のイ

ンデックス（先頭が 0）を返します。次の例は 3を返します。

使用例 C=index("KEYSIGHT","S")
データ型 C:数値。

integ(A,B) 数式 Aを Bで積分し、積分値を返します。次のように計算が行われます。

n = 1の場合、 n = 0

n > 1の場合、 nは次式で与えられます。

ここで、

n =
2
1

i = 2

n

(y +y
i

)(x -x )
i-1 i i-1
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n: インデックス nにおける Aの積分値

yi: インデックス iにおける Aの値

xi: インデックス iにおける Bの値

あるインデックスにおける Aまたは Bの値が無効だった場合、その値は計

算に使用されません。

バイアス同期掃引における一次掃引データの第一点目のインデックス値は、

常に 1です。

使用例 C=integ(A,B)
データ型 A, B:ベクター または 数値、C:ベクター。

isValid(A) 数式 A値が有効であり double.NaN以外の値であれば 1、そうでなければ 0
を返します。

使用例 B=isValid(A)
データ型 A:数値、B:数値。

lastValid(A) 数式 Aの最後の有効な値のベクターを返します。有効な値が存在しない場

合は、値として NaNが返されます。

Aが二次元ベクターの場合、それぞれの最後の有効な値のベクターを返し

ます。

Aが一次元ベクターの場合、最後の有効な値のベクターを返します。

Aが数値の場合、その数値のベクターを返します。

使用例 B=lastValid(A)
データ型 A:数値またはベクター、B:ベクター

lastValid2(A) 数式 Aの最後の有効な値のベクターを返します。有効な値が存在しない場

合は、値として NaNが返されます。

Aが二次元ベクターの場合、それぞれの最後の有効な値のベクターを返し

ます。

Aが一次元ベクターの場合、最後の有効な値のベクターを返します。

Aが数値の場合、その数値のベクターを返します。

使用例 B=lastValid2(A)
データ型 A:数値またはベクター、B:ベクター

lgt(A) 数式 Aの常用対数値 (10を底とする対数 )を返します。
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A=0の場合、-Overflowを返します。

A<0の場合、数値の絶対値をとって、その対数値を返します。

使用例 B=lgt(A)
データ型 A:数値、B:数値。または A:ベクター、B:ベクター。

log(A) 数式 Aの自然対数値 (eを底とする対数 )を返します。

A=0の場合、-Overflowを返します。

A<0の場合、数値の絶対値をとって、その自然対数値を返します。

使用例 B=log(A)
データ型 A:数値、B:数値。または A:ベクター、B:ベクター。

mavg(A,B) 数式 Aに含まれるデータの移動平均を返します。 Bには平均に用いるデー
タ点数を指定します。インデックス nにおける移動平均は以下のように計

算されます。

n  rの場合

r < n  N-rの場合

N-r < nの場合

ここで、

xn : インデックス nにおける Aの移動平均

xi : インデックス iにおける Aの値

r : Bの値

N: 測定点数

あるインデックスにおける Aの値が無効だった場合、その値は計算に使用

されません。

xn =
r + n

1

i = 1

n+r

xi

xn =
2r + 1

1

i = n-r

n+r

xi

xn =
r + N-n+1

1

i = n -  r

N

xi
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バイアス同期掃引における一次掃引データの第一点目のインデックス値は、

常に 1です。

使用例 C=mavg(A,B)
データ型 A:ベクターまたは数値、B:数値、C:ベクター。

max(A) 数式 Aに含まれるデータの最大値を返します。二次掃引を使用した場合、

各二次掃引ステップにおける一次掃引の最大値を返します。

無効な値があった場合、その値は計算に使用されません。

使用例 B=max(A)
データ型 A:ベクターまたは数値、B:ベクター。

max2(A) 数式 Aに含まれるデータの最大値および最大値のインデックスを返しま

す。二次掃引を使用した場合、各二次掃引ステップにおける一次掃引の最
大値を返します。

無効な値があった場合、その値は計算に使用されません。

使用例 B=max2(A)
データ型 A:ベクターまたは数値、B:ベクター。

値へのアクセスは以下の様に行います。

• Aが一次掃引の結果場合

at(B, 1) : Aの最大値
at(B, 2) : Aの最大値のインデックス

• Aが二次掃引の結果の場合 (n: 2 次方向のインデックス )
at(B, 1, n) : Aの最大値
at(B, 2, n) : Aの最大値のインデックス

min(A) 数式 Aに含まれるデータの最小値を返します。二次掃引を使用した場合、

各二次掃引ステップにおける一次掃引の最小値を返します。

無効な値があった場合、その値は計算に使用されません。

使用例 B=min(A)
データ型 A:ベクターまたは数値、B:ベクター。

ratio(A) 数式 Aの比率を返します。次のように計算が行われます。

A’n = 1  n = 1の時
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A’n = An/An-1  1 < n  Nの時

ここで、

A’n: インデックス nにおける比率

An: インデックス nにおける Aの値

N: 測定点数

使用例 B=ratio(A)
データ型 A:ベクター または 数値、B:ベクター。

readThermometer
OfN1265A(A)

数式 Aで指定される温度計チャネルを用いて温度測定を実行し、測定温度

を返します。但し、関数実行時にクラシック・テストが実行されている場

合は、最新の測定温度を返します。温度計チャネルを有効にするには

「UHC Expander / Fixture (p. 1-106)」を参照してください。温度計チャネルが

有効でない場合は NaNを返します。

使用例 B=readThermometerOfN1265A(A)
データ型 A:数値（1または 2）、B:数値 (C)。

setDeviceId(A) 文字列変数 Aの値を、テスト結果レコードの Device IDパラメータに設定
します。この値は、関数実行後に作成されるテスト結果レコードすべてに
適用されます。A値が空文字列であった場合、この関数は何も実行しませ

ん。

使用例 B=setDeviceId(A)
データ型 A:文字列、B:数値。Bには常に 0が返ります。

setDeviceIdSupple
ment(A)

文字列変数 Aの値を、テスト結果レコードの Device IDパラメータに設定
します。この値は、関数実行後に作成されるテスト結果レコードすべてに

適用されます。A値が空文字列であった場合、この関数は何も実行しませ

ん。

使用例 B=setDeviceIdSupplement(A)
データ型 A:文字列、B:数値。Bには常に 0が返ります。

setRemarks(A) 文字列変数 Aの値を、テスト結果レコードの Remarksに文字列を設定しま
す。この値は、測定実行中に有効で、関数実行後に作成されるテスト結果

レコードすべてに適用されます。測定を終了するとこの値はクリアされま

す。

使用例 B=setRemarks(A)
データ型 A:文字列、B:数値。Bには常に 0が返ります。
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sin(A) 数式 Aの正弦関数を返します。

使用例 B=sin(A)
データ型 A:数値、B:数値。または A:ベクター、B:ベクター。

sleep(A) 数式 Aで示される時間（単位は秒）待機して 0を返します。停止操作に

よって待機を中断した場合は 0でない値を返します。

使用例 B=sleep(A)
データ型 A:数値、B:数値。

sqrt(A) 数式 Aの平方根を返します。

使用例 B=sqrt(A)
データ型 A:数値、B:数値。または A:ベクター、B:ベクター。

storeAt(A,B,C,D) 数式 Aに含まれるデータにおいて、インデックス Bと Cによって示される
データだけを D値と置き換え、それによって作成されるベクター データを
返します。 Bと Cは、二次元配列の一次元方向と二次元方向にそれぞれ対

応します。インデックスは 1から開始します。次の例はデータ A[5, 5]の値
を D値と交換したベクター データを変数 Eに入力します。

使用例 E=storeAt(A,5,5,D)
データ型 A:ベクター または 数値、B, C, D:数値、E:ベクター。

string(A) 数式 Aを文字列に変換した値を返します。

使用例 B=string(A)
データ型 A:数値 または モジュール、B:文字列。
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NOTE 数値－シンボル割り当てされた変数の変換

string関数の引数に、数値－シンボル割り当ての行われた数値変数を入力し

た場合、関数の実行結果には割り当てられたシンボルが返されます。文字

列変換された数字ではありません。数値－シンボルの割り当ては
Specification (p. 3-5)で定義されます。

次の数値－シンボル割り当て設定例におけるMode=0時の string(Mode) 
関数実行結果は、文字列 OFFであり、文字列 0ではありません。

パラメータ Mode、Value=0、Symbol=OFF

substring(A,B,C) 文字列 Aから、Bと Cによって指定される文字列を抽出し、その値を返し

ます。Bは抽出開始点（先頭が 0）、Cは抽出する文字列の長さを指定しま

す。Bまたは Cが整数でない場合は、小数点より上位の桁を用いて整数と

して扱います。次の例は文字列 Eを変数 Dに入力します。

使用例 D=substring("KEYSIGHT",1,1)
データ型 A:文字列、B, C:数値、D:文字列。

swmToModule(A) Keysight B2200/E5250スイッチング・マトリクスの入力ポート番号 Aに接
続されている測定モジュールを探します。測定モジュール名が返ります。

使用例 B=swmToModule(A)
データ型 A:数値（入力ポート番号 1 ～ 14）、B:モジュール。

tan(A) 数式 Aの正接関数を返します。

使用例 B=tan(A)
データ型 A:数値、B:数値。または A:ベクター、B:ベクター。

value(A) 文字列 Aを数値に変換した値を返します。 Aが数値型リテラルとして無効

な値である場合は 0が返されます。 

使用例 B=value(A)
データ型 A:文字列、B:数値。
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リードアウト関数
リードアウト関数は、解析ツール（マーカ、カーソル、ライン）に関する

さまざまな値を読みとるための組み込み関数です。これらの関数は、測定
結果の複雑な解析を行う場合に役立ちます。

リードアウト関数の結果を読みとるには、数値変数を使用します。次の例

はライン 1の X 切片データを変数 Aに入力します。

使用例 A=@L1X

NOTE このセクション全体を通して、関数の名前についている nは 1から 8の整数、

mは 1または 2の整数を示します。

リードアウト関数を X 軸、Y 軸に設定することはできません。

解析ツールが画面に表示されていない場合には、最新値を返します。

一度も表示されていない場合には、無効な値を返します。

アプリケーション・テスト定義内の ASSIGN、IF、FOR、Application Test、
Classic Testなどのコンポーネントでリードアウト関数を使用するには、そ

のコンポーネントの前に Auto Analysisコンポーネントを配置し、そのリー

ドアウト関数に対応する解析ツールを設定しておく必要があります。

マーカ用関数

@MI マーカの測定データのインデックスを返します。

マーカが補間データに置かれている場合、非整数値を返します。

@MX マーカの X 座標値を返します。

@MY マーカの Y 座標値を返します。

2つの Y 軸が設定されている場合、選択されている軸の値を返します。

@MYn マーカの Yn 座標値を返します。nは整数 (1 ～ 8)。
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カーソル用関数

@CX 操作の対象となっているカーソルの X 座標値を返します。

@CY 操作の対象となっているカーソルの Y 座標値を返します。

2つの Y 軸が設定されている場合、選択されている軸の値を返します。

@CYn 操作の対象となっているカーソルの Yn 座標値を返します。nは整数 (1 ～
8)。

ライン用関数

@LmCO ライン m (1または 2) の回帰計算の相関係数を返します。

ラインは回帰直線 (regression)モードでなければいけません。 それ以外の

モードでは無効値を返します。

@LmG ライン m (1または 2) の傾きを返します。

2つの Y 軸が設定されている場合、選択されている軸の値を返します。

次の式で傾きを計算します。スケールの設定によって異なります。

• X、Y 軸がリニアの場合

 = (y1-y0) / (x1-x0)

• X 軸がログ、Y 軸がリニアの場合 :

 = (y1-y0) / (log x1- log x0)

• X 軸がリニアで、Y 軸がログの場合 :

 = (log y1-log y0) / (x1-x0)

• X、Y 軸がログの場合 :

 = (log y1-log y0) / (log x1- log x0)

ここで、

 : ライン m (1または 2)の傾き。

x0 , y0 , x1 , y1 : ライン mとプロット領域枠との交点 (2つ )の座標値。

@LmGn ライン m (1または 2) の Yn 軸に対する傾きを返します。nは整数 (1 ～ 8)。

次の式で傾きを計算します。スケールの設定によって異なります。
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• X、Yn 軸がリニアの場合

 = (y1-y0) / (x1-x0)

• X 軸がログ、Yn 軸がリニアの場合 :

 = (y1-y0) / (log x1- log x0)

• X 軸がリニアで、Yn 軸がログの場合 :

 = (log y1-log y0) / (x1-x0)

• X、Yn 軸がログの場合 :

 = (log y1-log y0) / (log x1- log x0)

ここで、

 : ライン m (1または 2)の傾き。

x0 , y0 , x1 , y1 : ライン mとプロット領域枠との交点 (2つ )の X-Yn 座標

値。

@LmX ライン m (1または 2) の X 切片 (Y=0での X 座標値 ) を返します。

ライン mが X 軸と平行の場合、無効値を返します。

@LmY ライン m (1または 2) の Y 切片 (X=0での Y 座標値 ) を返します。

2つの Y 軸が設定されている場合、選択されている軸の値を返します。

ライン mが Y 軸と平行の場合、無効値を返します。

@LmYn ライン m (1または 2) の Yn 切片 (X=0での Y 座標値 ) を返します。 nは整

数 (1 ～ 8)。

ライン mが Y 軸と平行の場合、無効値を返します。

2 ライン表示に有効な関数

@IX ライン 1とライン 2の交点の X 座標値を返します。

次式で交点を計算します。

X =(y2-y1)/(2-1)
ここで、

X : 交点の X 座標の値。ログ・スケールでは 10X。

ym : ライン m の Y 切片の値。ログ・スケールでは値のログ値。mは
整数 (1 または 2)。
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m : ライン m の傾き。

ライン 1とライン 2が平行の場合、無効値を返します。

@IY ライン 1とライン 2の交点の Y 座標値を返します。

2つの Y 軸が設定されている場合、選択されている軸の値を返します。

次式で交点を計算します。

Y = y1+1 (y2-y1)/(1-2)
ここで、

Y : 交点の Y 座標の値。ログ・スケールでは 10Y。

ym : ライン m の Y 切片の値。ログ・スケールでは値のログ値。mは
整数 (1 または 2)。

m : ライン m の傾き。

ライン 1とライン 2が平行の場合、無効値を返します。

@IYn ライン 1とライン 2の交点の Yn 座標値を返します。nは整数 (1 ～ 8)。

次式で交点を計算します。

Yn = y1+1 (y2-y1)/(1-2)
ここで、

Yn : 交点の Yn 座標の値。ログ・スケールでは 10Yn。

ym : ライン m の Yn 切片の値。ログ・スケールでは値のログ値。m
は整数 (1 または 2)。

m : ライン m の傾き。

ライン 1とライン 2が平行の場合、無効値を返します。
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プログラム・ステートメント
Application Test定義のテスト実行フロー (test execution flow)を定義するに
は、プログラム・ステートメントを使用します。Test Definitionウインドウ
の Test Contents画面で Program Componentタブをクリックすると、利用可

能なステートメントがリストされます。｢ Program Component (p. 3-28) ｣も参
照してください。

Local Variable 
Definition

Application Test定義内で使用可能な、ローカル変数を定義します。セット

アップ・エディタについては｢ Local Variable Definition (p. 3-26) ｣を参照して
ください。有効な変数名、変数の型については｢変数と数式 (p. 5-3) ｣を参照
してください。ローカル変数はこの Application Test定義内でのみ有効です。

ASSIGN 変数に値または数式を定義します。次のように定義します。

<variable> = <definition>

ここで <variable>は定義する変数名、<definition>は値または数式を表して

います。

BLOCK BLOCK/END BLOCKブロックの始め。BLOCKと END BLOCKは対でプロ
グラム・リストに追加されます。これらの行間にテスト実行フロー（プロ

グラム）を定義します。このブロックではオプションとして、次のステー
トメントを使用可能です。

• ON ERROR

エラー発生時に実行させたいルーチンを、ON ERRORと END BLOCK
の間に定義します。FINALLYを使用する場合は、ON ERRORと
FINALLYの間に定義します。

• FINALLY

ブロック終了時に実行させたいルーチンを、FINALLYと END BLOCK
の間に定義します。

BLOCKと END BLOCKの間に定義されたステートメントは上から下へ順
に実行されます。プログラム実行中にエラーが生じなかった場合、
FINALLY以降に定義された行が実行されてから、ブロックは終了します。

エラーが発生した場合は、エラー・コードが@ERRORシステム変数に保
管され、ON ERROR以降に定義された行が実行されてから、ブロックは終

了します。FINALLYを使用している場合は、ブロックが終了する前に、

FINALLY以降に定義された行が実行されます。
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COMMENT プログラム・ラインにコメントを入力します。

END プログラムの実行を停止します。ENDステートメントの後には、FINALLY
によって定義されたルーチンが実行されます。

ERROR 強制的にエラーを発生します。本当のエラーではないので、@ERROR変数
にエラー・コードは保管されません。

FOR FOR/NEXTブロックの始め。FORと NEXTは対でプログラム・リストに追

加されます。これらの行間には、ループ中に繰り返し実行されるルーチン
を定義します。FOR/NEXTステートメントを入力するには次のようにしま

す。

FOR <variable> = <initial value> TO <terminate value> STEP <step value>

NEXT <variable>

ここで、<variable>はループ・カウンタとして使用される変数の名前、

<initial value>、<terminate value>、<step value>はそれぞれ、ループ・カウン

タのスタート値、ストップ値、ステップ値を示しています。

ループ・カウンタが <terminate value>に達する前にループから抜けるには、

EXIT FORステートメント を使用します。ループを抜けると、NEXTの次

の行が実行されます。

IF IF/END IFブロックの始め。これらは対でプログラム・リストに追加されま

す。IFステートメントには初期分岐条件を定義します。また、条件が満た

された時に実行されるルーチンを、これらの行間に定義します。次のよう
に入力します。

IF <expression>

END IF

ここで、<expression>は分岐条件です。このブロックではオプションとし

て、次のステートメントを使用可能です。

• ELSE IF <expression>

前の条件が満たされなかった場合に使用される分岐条件と、その条件が

満たされた時に実行されるルーチンを定義します。

• ELSE

全ての分岐条件が満たされなかった場合に実行されるルーチンを定義し

ます。
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LOOP LOOP/END LOOPブロックの始め。LOOPと END LOOPは対でプログラ
ム・リストに追加されます。これらの行間には、ループ中に繰り返し実行
されるルーチンを定義します。

ループから抜けるには、EXIT LOOPステートメント を使用します。ループ
を抜けると、END LOOPの次の行が実行されます。

プログラム例 1 テスト定義名：Vth_gmMax

Local Variables Definition
BLOCK
 !***** Integration Time Setting *****
 IF IntegTime="SHORT"

IntegMode = "MANUAL"
AdcFactor = 8

 ELSE IF IntegTime="MEDIUM"
IntegMode = "PLC"
AdcFactor = 1

 ELSE IF IntegTime="LONG"
IntegMode = "PLC"
AdcFactor = 16

END IF
 !***** I-V Sweep *****

Vth_gmmax
 !***** Analysis *****

Auto Analysis
END BLOCK
1行目：ローカル変数を定義します。

2行目：プログラムの開始。プログラムは END BLOCKで終了します。

3行目：コメント行。COMMENTステートメントを使用します。

4 ～ 13行目：変数 IntegTimeの値によって、積分時間の設定を変更します。

14行目：コメント行。COMMENTステートメントを使用します。

15行目：Application Testコンポーネントの Vth_gmmaxを実行します。
Id-Vg 特性を測定します。

16行目：コメント行。COMMENTステートメントを使用します。

17行目：Analysisコンポーネントの Auto Analysisを実行します。
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プログラム例 2 テスト定義名：NandFlash IV-Write-IV

Local Variables Definition
BLOCK
 !***** Integration Time Setting *****
 IF IntegTime="SHORT"

IntegMode = "MANUAL"
AdcFactor = 8

 ELSE IF IntegTime="MEDIUM"
IntegMode = "PLC"
AdcFactor = 1

 ELSE IF IntegTime="LONG"
IntegMode = "PLC"
AdcFactor = 16

END IF
 !***** I/V Sweep & Analysis Initial Characteristics *****

ForcePG2
Id-Vg_Initial
ResetPG
Auto Analysis

（19行目以降、次頁に続く）

1行目：ローカル変数を定義します。

2行目：プログラムの開始。プログラムは END BLOCKで終了します。

3行目：コメント行。COMMENTステートメントを使用します。

4 ～ 13行目：変数 IntegTimeの値によって、積分時間の設定を変更します。

14行目：コメント行。COMMENTステートメントを使用します。

15行目：Application Testコンポーネントの ForcePG2を実行します。
Keysight B1500に接続された Keysight 81110Aパルスジェネレータの Output 
2からパルスを出力します。

16行目：Application Testコンポーネントの Id-Vg_Initialを実行します。
Id-Vg 特性を測定します。

17行目：Application Testコンポーネントの ResetPGを実行します。
Keysight 81110Aをリセットします。

18行目：Analysisコンポーネントの Auto Analysisを実行します。
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（19行目以降、前頁から続く）

VthInitial = getNumericData("VthBefore")
VgateList = getVectorData("Vgate")
IdInitialList = getVectorData("Idrain")

 !***** Force Pulse *****
ForcePG1
ResetPG

 !***** I/V Sweep & Analysis after Write *****
ForcePG2
Id-Vg_Written
ResetPG
Auto Analysis
VthWritten = getNumericData("VthAfter")
IdWrittenList = getVectorData("Idrain")

END BLOCK

19 ～ 21行目：Id-Vg_Initialテストの Function Setupまたは Display Setupに
定義された変数 (VthBefore, Vgate, Idrain)の値をローカル変数 (VthInitial, 
VgateList, IdInitialList)に入力します。ASSIGNステートメントを使用しま
す。

22行目：コメント行。COMMENTステートメントを使用します。

23行目：Application Testコンポーネントの ForcePG1を実行します。
NAND 型フラッシュメモリのデータ書き込みを実行します。

24行目：Application Testコンポーネントの ResetPGを実行します。

25行目：コメント行。COMMENTステートメントを使用します。

26行目：Application Testコンポーネントの ForcePG2を実行します。

27行目：Application Testコンポーネントの Id-Vg_Writtenを実行します。
Id-Vg 特性を測定します。

28行目：Application Testコンポーネントの ResetPGを実行します。

29行目：Analysisコンポーネントの Auto Analysisを実行します。

30 ～ 31行目：Id-Vg_Writtenテストの Function Setupまたは Display Setupに
定義された変数 (VthAfter, Idrain)の値をローカル変数 (VthWritten, 
IdWrittenList)に入力します。ASSIGNステートメントを使用します。

32行目：プログラム最終行。
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